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Introduction and Precautions

T

This chapter introduces general information, including basic informa-
tion and precautions for the use of this manual and the software. You
must read this chapter before attempting to read the rest of the
manual or using the product.

1.1 Introduction ............... creerena . Intro-2

L2 Precautions ............ tesesenan R Intro-3
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Introduction and Precautions

1.1 Introduction

Thank you for purchasing the MEMOCAD-PRO Program Development Software to support
the MEMOCON-SC GL40-, GL60-, GL70-series Programmable Controllers.

MEMOCAD-PRO is equipped with a wide range of functions. These include two edit modes:
Offline and Online. Offline Edit Mode enables databases to be created and edited on a per-
sonal computer. Online Edit Mode, when the computer is connected to a Processor, enables
programs in the CPU to be displayed on the screen of the computer so that editing can be
conducted from the computer. Other functions include the Lister, which output lists of pro-
grams and data, and the Loader, which allows data to be loaded to the CPU or to be saved to
files.

This manual explains how to conduct basic operations, using screen displays 10 provide ex-
amples for each function. The term Processor is used for the following models of CPU in this
manual: GL40S1, GL40S2, GL4083, GL60S, GL60S0, GL60ST, GLB0S2, GLE0S3, GLE0H,
GL70H, GL60OHT and GL70HT.

To gainthe best results from programming, it is recommended that you read this manual care-
fully and famitiarize yourself with all the features and functions of MEMOCAD-PRO, practic-
ing as many operations as possible.

Note The information contained in this manual is subject to change without notice.

Trademarks

1} MS-DOS is a registeréd trademark of Microsoft Corporation, USA.

2) ATOK is a registered trademark of Just System Co. Lid., Japan.

3) PC-PR201 is a registered trademark of Japan Electric Co. Ltd., Japan.

4) ESC/P is a registered trademark of Epson Co. Ltd.
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1.2 Precautions

.2 Precautions

Please read this manual carefully before using MEMOCAD-PRO and be sure that you under-
stand fully the information provided in this manual, particularly the items described below.

User Registration

Version upgrades of MEMOCAD-PRO are provided for those users who have returned
the User Registration Card. We recommend you complete the Registration Card pro-
vided and return it to us upon purchasing this product. Users who are not registered wil
not be notified of upgrades.

Creating and Editing a Database

» Do not create or edit a database on a floppy disk.
If you edit a database on a floppy disk, an error may be generated because there is not
enough free space on the floppy disk. This may result in damage to the database. The
size of the database fluctuates greatly during editing and could cause the floppy disk to filt

up quickly. Always use a hard disk and check that there is enough free space available on
the hard disk before editing,

» Always make a backup copy of a database.

Ita database is damaged or lost, it is difficult to rebuild the database from scratch. Always
keep a backup of a database so that it can be restored with minimum effort.

+ Do not reset your computer or turn OFF the power supply while editing a database.

Data can bé lost unless correct methods are used to exit the Software. Never exit the
MEMOCAD-PRO by resetting the computer or turning OFF the power supply.

* Always make sure that there is enough free space available on the hard disk before editing.

While editinb a database, an error may be generated because there is not enough free
space. This may result in damage to the database. Always check that there is enough
free space available on the hard disk before editing. (Copying networks and comments
repeatedly can cause the database to more than double in size.)
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Before Operation

This section provides information on the operating environment nec-
. essary for using the MEMOCAD-PRO Software, such as MS-DOS,
. computer specifications, and how to connect to a computer to a PLC,
- The contents of the MEMOCAD-PRO Software package, basic key
functions, and the functions of each GL-series model are also de-

. scribed.
1.1 Operating Environment ....... Ceeseaas eees 122
1.2 Package Contents .......... trereas cevenes 1-6
1.3 Using this Manual ..... ceenes Ceesses ceenes 17

j 1.4 List of Functions for each GL-series Processor 1-11
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Before Operation
G e —
1.1.1 Computers

1.1 Operating Environment

This section explains the preliminary preparations and operating environment necessary for
using MEMOCAD-PRO. Before attempting to use MEMOCAD-PRO, be sure that you under-
stand the information contained in the following items.

+ Computers
See 1.1.1 Computers.

» MS-DOS
See 1.1.2 MS-DOS.

o CONFIG.SYS File
See 1.1.3 CONFIG.SYS File and 1.1.4 Creating a CONFIG.SYS File.

1.1.1 Computers

The necessary conditions for using MEMOCAD-PRO with a computer are explained below.
The following conditions apply to IBM PC/AT and compatible computers.

Main Memory
640 kilobytes minimum
(A minimum of 500 kilobytes of memory is required just to run the MEMOCAD-PRO.)

Hard Disk
20 megabytes minimum free space
MEMOCAD-PRO System: Approx. 6 megabytes are used.
Memory for data: From 1 to 10 megabytes are used.

If the number of programs is increased, more memory wil! be required.

Floppy Disk Drive
1 or more 3.5 inch 2HD or 5 inch 2HD drives
{When using a disk saved on the P150, a combined 3.5 inch 2HD/2DD drive is neces-

sary.)

Be sure that the computer is started in MS-DOS.
For information on MS»-DOS, see 1.1.2 MS-DOS._

—_12—



1.1 Operating Environment

M

Extended Memory
The MEMOCAD-PRO Software uses the user memory of the computer, and will not
use extended memory. If user memory becomes less than 500 kilobytes due to the use
of other applications, resulting in insufficient memory, then extended memory should
be provided for other applications to ensure that the user memory remains at the mini-
mum required level of 500 kilobytes,

Display
Both color and monochrome monitors can be used, but they cannot be used in high-
resolution mode.

1.1.2 MS-DOS

MS-DOS (Disk Operating System) is required to operate this software on a computer. This is
normally incorporated in the computer so that when the power is turned on, the system will
start up in MS-DOS.

MS-DOS Ver. 3.1 or later is required.

Be sure that MS-DOS has been installed on the hard disk of the computer before installing or
starting the MEMOCAD-PRO Software. The computer must be set up to start up in MS-DOS
in order to use the MEMOCAD-PRO Software.

1.1.3 CONFIG.SYS File

The CONFIG.SYS file sets the environment for operating a computer. The following settings
must be made in the CONFIG.SYS file to operate the MEMOCAD-PRO Software.

Buffers =24 (24 minimum)
Files = 24 (24 minimum)

1.1.4 Creating a CONFIG.SYS File

If there is no CONFIG.SYS fite, make one using a text editor (software for creating text files
and source files for programming). If a text editor is not available, you can make a CON-
FIG.SYS file using the MS-DOS EDLIN (Edit Line) command.

The following example shows how to make a CONFIG.SYS file using the MS-DOS EDLIN
command.

1) Enter the command: EDLIN A:/CONFIG.SYS

If the file does not exist, the If there is an existing file, the
following message will appear. following message will appear.
New file. The file has been read.

—13—




Before Operation
e s e e
1.1.5 Preparations for Connection with GL-series PLCs

2) Entering file contents:
Inserting: Press <line numbers|, then press the Enter Key.
Changing: Press <line number>, then press the Enter Key.
{Enter the desired line number in place of <line numbers.)
The line specified will appear. Enter text and press the Enter Key.

Example

1: *BUFFERS=25

After entering the text, press the Ctrl + C Keys or the Stop Key to exit input mode.

3) Deleting a line: Press <line number>D, then press the Enter Key.
(Enter the desired line number in place of <line number>.)

4) Viewing file contents: Press “L”, then press the Enter Key.
The contents of the file will appear.

1: BUFFERS=25
2: FILES=25

5) Exiting: Press “E”, then press the Enter Key to exit EDLIN and return to MS-DOS.

1.1.5 Preparations for Connection with GL-series PLCs ‘

Connection between a GL-series PLC and a computer is described below. This connection is
necessary for the following:

1) Conducting online programming operations
2) Using the Loader

Ports

Computer: RS-232C port
GL Series: MEMOBUS port for the IOP Module orthe COMM Module, located atthe front of
either module.

Connect the two ports with a MEMOBUS Cable. . ‘
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1.1 Operating Environment

Computer
’ — GL40, GL80, or GL70-series PLC

(-

il
2

[ hllll;

[] @ O ecan

—
-
—
-

=0 O
=
o)

— —
ALY U1 — IOP Modute or COMM Module

YenTm Y tme
T T

Programming Panel ports

RS-232C port (D-SUB 9-pin connectors) (Ne.1 to No.4)

Cable Models:
JEPMC-W5311-03 (2.5 m) .
JEPMC-W5311-15 {15 m) } D-SUB 8-pin connectors

Figure 1.1 Connection Between a Processor and a Computer

Note The power to the computer must be tumed OFF when inserting or removing the Cables. Se-
cure the connectors with screws so that the cables will not become loose or detached.

Contact your Yaskawa representative for purchasing the above Cables.
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Before Operation

1.2 Package Contents

The contents of the MEMOCAD-PRO Software package are described below.

1) Floppy Disks (3 Disks)

MEMOCAD-PRO MEMOCAD-PRO MEMOCAD-PRO

INSTALL DISK SYSTEM DISK #1 SYSTEM DISK #2

» Installation Disk

This disk contains the installation program to transfer the MEMOCAD-PRO System
onto the hard disk.

» System Disk #1

This disk contains the execution file and data files for MEMOCAD-PRO.
This disk and System Disk #2 contain the MEMOCAD-PRO System.

« System Disk #2

This disk contains the execution file and data files for MEMOCAD-PRO.
This disk and System Disk #1 contain the MEMOCAD-PRO System.

2} User’s Manual (this manual)

This manual explains the procedures forthe MEMOCAD-PRQO Software, including offline
and online operations, motion editing, printing, and using the Loader.

3) User Registration Card

When you purchase the MEMOCAD-PRO, we recommend you complete this card and
send it to us to registeras a user. Information on upgrades and other products willbe sent
to registered users only.
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1.3 Using this Manual

M

1.3 Using this Manual

To help understand the information contained in this manual, the following two items are ex-
plained in more detail below.

« Basic Key Operations
See 1.3.1 Basic Key Operations

¢ Reference Numbers
See 1.3.2 List of Reference Numbers Used

1.3.1 Basic Key Operations

The basic key operations for MEMOCAD-PRO are shown below.
1} tems are normally selected by pressing the Function Keys.

Example 1: Selecting 2. Offline from the Main Menu

T
t l £t / Muin Ma
Vareien 2-88 Comicione ur' TAKAM ELECTAT S GORFORATION

Database: Halp: <Hlt-H>
Hain Henu:

hu.elon

1. Swlect Active PLC

- .
4, Metien
5. List Rctive PLC
6. Leader
7. Utilicies
CE> te Exit te Dex
Enter Optisn: Bl
F—— —e— e YRS XA

Figure 1.2

Operation

Afterthe Main Menu is displayed, press F2. itis also possible to move the cursorto the
item to be selected, then press the Enter Key.

Example 2: Selecting F 3 (Register)

1.Tetive 2.[Jleck I.Qegister 4.(Mit 5.Mlabal 5.Bearch P.Ivds 0. Blev 9. Jeil
. 1
1 3
Figure 1.3
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Before Operation

1.3.1 Basic Key Operations cont.

Operation
Press F3. Itis also possible to press the letter displayed on the Menu in reverse video
(“R" in this case).

2) If the display covers more than one page, use the Page Down Key to go to the next page
and the Page Up Key to return to the previous page.

Example 1: Network Screen

<PAGE DOWN: <PAGE DOWN:
—— ———-
Network 1 Network 2 Network 3
<PAGE UP> <PAGE UP>
ittt ettt et [ —————

Example 2: Screen Display Listing Used Coils

o T g | <PAGEDOWN> S
Y| s—— [t - [ ey [0
T — o e— & = =i
B = — = o =i
o - — o] = =
—e— o— <PAGE UP> == S =i
T et Rt ——————— [ " HE WmEx

= 1 Calll Newsed W C Call Vel . =t Cafl Wmuped U1 Cpil Nesd
SEICK EBANOM: E‘E‘_-"“-'“.::‘,'*" '.g_::'-m Pose SIICK SBARCE: ’.-.m.-:“g’,.:z 'HN"-‘ o

Current page Next page
Figure 1.4
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' 1.3 Using this Manual

3) To exit the current operation or to return to the previous page, press the Esc Key.
Example

Press the Esc Key while editing the network, check that “Y” appears after the message,
and press the Enter Key to exit network edit.

twerk: ictive H

DU T, DNC NG ¥ Xwn oumi B apmr Dn
Figure 1.5

Menu level 0 indicates the first menu displayed during network editing. For details on
menu levels, see Appendix A List of Function Key Menus.

Iif the Function Menu at the bottom of the screen is higher than menu level 0, press the
Esc Key to return to menu level 0. It is possible to exit network editing only from menu
level 0.

Note When exiting, a message will normaliy appear asking whether or not to save
changes. If no message appears, some of the changes made may not be saved.
To save the changes, press the Alt + E Keys.

4) Press the Enter Key to confirm any numeric values and characters that have been en-
tered. -

Example: Entering Reference Numbers

e
Didak] - B1i24 SuMl-5512

Figure 1.6

Enter the reference number in the number input field, as shown in Figure 1.6, and press
the Enter Key to confirm the input.
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e

1.3.2 List of Reference Numbers Used

1.3.2 List of Reference Numbers Used

In this manual, a variety of reference numbers are associated with ladder element numbers,
network numbers, segment numbers, and so on. The following lists the types of reference
numbers used in this manual.

0??77?:.  Coil (output relay) 57777: Time register

D???7?: Link coil ) R??7?: Link register

1?27?:  Input relay ) L?: Network

M?7?7?7. M code relay §77?: SFCstep

N??27: N code relay SN7:7:  Action circuit network
27777: Stepping relay T???:  Transition

30?77: Input register G??7:7?: Subroutine network
37777: Constant register SEG?: Segment

4777?: Holding register

The permissible input range of numbers depends on which GL-series processor is selected
or connected (online). The permissible range will be shown on the screen each time an input ‘
is made.
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1.4 List of Functions for each GL-series Processor

1.4 List of Functions for each GL-series Processor

i

The features and functions available differ according to the GL-series model used. When
editing using the MEMOCAD-PRO Software, these differences and limitations change with
the model selécted or connected online. Refer to the table below for information on the differ-
ences between models.

Table 1.1 List of Functions For MEMOCON-SC Models

Features ' MEMOCON-SC Series

GL60S, | GL60S2, | GL60H, | GL70H, | GL40S1,
S0, §1 83 GLGOHT | GL70HT | S$2,53

64 kW program memory - - - Yes -
Stepping relays - - Yes Yes Yes
Set/reset for action circuits - - Yes Yes -
Using of link coils and time register step - - Yes Yes -

relays using the action circuit, transition
circuit, and subroutines

Transition comments - - Yes Yes -
Motion programmer - - Yes Yes Yes
Motion commands - - Yes Yes Yes
M code and N code relays - - Yes Yes Yes
YENET 3200 commands - Yes Yes Yes -

{MBUS, PEER, BROD, BOOK, POLL,
DIAG, SND, RCV)

Expansion registers - 83 only Yes Yes -
SFC editing Yes Yes Yes Yes -
Remote I/O . Yes Yes Yes Yes -
ASCII ' S1 only Yes Yes Yes -
PC Link S1 only Yes Yes Yes | Yes
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Installation and Start Up

i

This chapter describes how to install the MEMOCAD-PRO Software

on the hard disk of a computer and the procedures for starting up the 2
software.

2.1 Installation on the Hard Disk ..... vereasenn 2-2

2.2 Starting and Exiting MEMOCAD-PRO...... 2-4
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Installation and Start Up
2.1.1 MEMOCAD-PRO Installation

2.1 Installation on the Hard Disk

This section explains how to install the MEMOCAD-PRO Software.

2.1.1 MEMOCAD-PRO Installation

Perform the following procedure to install the MEMOCAD-PRO System on a hard disk.
Check that the computer has been started in MS-DOS. (The MEMOCAD-PRO System can-
not be used if the computer does not have MS-DOS.)

Example

in this example, the following drives are used.
Hard disk: C drive
Floppy disk: A drive

1) Insert the Instaliation Disk in the floppy disk drive of the computer.

2) Change the current drive to the drive in which the disk was inserted.

Shel M
At

Figure 2.1

3) Enter the install command and press the Enter Key.

An example of the install command with parameters is shown below.

Rndinetall sz 3

Figure 2.2

AMSINSTALL A: C:

The hard disk of the computer to which the software is being installed.
The drive into which the installation disk is inserted.

Install command

The Title Screen will appear.

Tnztall Fragraa Verl.H
SAFILESVGLARE , [NX
I LEENCLE 08 HLP

Figure 2.3
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2.1 Installation on the Hard Disk
“ﬁ
4) When ready, press the Enter Key.

5) After the following message is given, insert the next disk, and press the Enter Key.

[FIsass Insert TUSTEN BIEK I In BRIVUE ar.

Press any ey ts coentinue . . .

Figure 2.4

6) After the following message is given, insert the next disk, and press the Enter Key.

mp Llete: neta. &3 -
‘?hu- inzert H'Hh DISX 2 im DRIVE a3.
Frezz any key te eentinus . . .

Figure 2.5

7) After installation has been completed, press the Enter Key.

ted Iast

" . L)
%% aby key te centinue . . ,

Figure 2.6

Note If the wrong key is entered or the wrong floppy disk is inserted during installation, press the
Stop Key to cancel the process and start the operation from the beginning.
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Installation and Start Up
L
2.2.1 Starting MEMOCAD-PRO

2.2 Starting and Exiting MEMOCAD-PRO

This section describes the procedures for starting and exiting MEMOCAD-PRO. Depending
on the parameters specified during installation, an error message may be displayed on the
screen when starting MEMOCAD-PRO. This section also describes action to be taken when
this error message appears.

YASXAUA ELECTRIC COXPORATION
Hemeten~35C CLALGA-70 Laddar Lagic Develepmant Seftuare

!l!llﬁ ELECT![G CORPOMTIION accopts ne_ liability far any danages.
! indirect sr lost iz, lest savings er ether
!.n:ﬂ.nn ar censs tia & arising eut of th ue,
nizuze or innhﬂt’ te uss thit teftwara jew

13 h roco-mi that u:h nrunehn o thereughly tested uzing
hardwers and worl ta ansure tatal centrel syetem

h:nnky Pleazs Hhr tw th YASHAUN ELECRIC CORPOMATI Lie-an
greement for datails of cuttomer zupperc and warranty.

Prass (Enter> te ceatinum ...

Figure 2.7 Start Screen

2.2.1 Starting MEMOCAD-PRO

This procedure assumes that the system is located in a sub-directory called GL60S on the
hard disk (C drive) of a computer. The start command is GL.

1) Enter C:\>CD GL60S and press the Enter Key to move to the correct directory.
2) Enter C:\GL60S>GL and press the Enter Key to start the program.

The Start Screen will appear.

Yatiaua FLECTRIC CORPORMTION
Menacan-£C GLAAW 7R Ladder Legic Develeymant Seftuare

YASKAWA ELECTRIC CORPORATION accaptz ne liability fer any M’!a
imeluding indirect or st itz, lest zaviags or ethar
incidencal ar cons tinl 2 arizing out of the use.
nisuse eor inability €e use thiz zsftwars preduct.

1t h mcmnnl chat oaeb lr’u:otun b thersughly tastad ui.-y
1 hardwars and werk: anzures tetal centrel & &l
h-:-g:-lty Tlease refer te tll: !IS W ELECRIC CORPORATION Licenss
Agresmant for details of custemsr sup”at and warrant

Frezz {Enter} te centinue ...

Figure 2.8

3) Press the Enter Key.
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‘ 2.2 Starting and Exiting MEMOCAD-PRO

To exit and return to MS-DOS, press the Esc Key.

The Main Menu will appear.

R ——————————————

REROCON-SC CL4B-60.- 78
Ladder Legic D'u!.lr-qt Seftuars / Main Menu
Versisn 2.88 Copyright 1931 YASKAUM ELECTRIC CORFOBATION
Databasze: Help: <Mie—>
Main Mava:

.

Online

Hatien

Lixt Mctive PFLC

. r
7. Utilities
<E> to Exit te Dax
Enter Optisn: KN

— o — yaguaun ol

3.
4.
S.
]

Figure 2.9

Instead of the Main Menu, the following error message may be displayed:

“File Not Found C:\GLB0S\GL60S. TKB"

Inthis case, change the specified pathname, as outlined in 2.2.2 TKB File Specifications.
A batch file can be created to eliminate this process during startup.

if the parameter “/RA” is added to the start command, the program is automatically started
with the database last used.

2.2.2 TKB File Specifications

if MEMOCAD-PRQ is installed on a drive other than C drive, the following error message will
appear when the program is started.

“File Not Found C:\GL60S\GL60S.TKB"
In this case, use the following procedure to specify the correct pathname.
1) After the erfor message appears, press the Esc Key.

2) Select 7. Utilities from the Main Menu.

REMOCON-EC GLAR/S0-78
1 Ladder Lagic nun.-r-.e Softuare / Main Menu
Versisn 280 Copyright 1991 YASKAWA ELECTALC CORPOMMTIOW

Databaie: Help: <Alc-N)>

Enter Optien: [E

Figure 2.10
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Installation and Start Up
2.2.2 TKB File Specifications cont.

3} Select 1. Configuration from the Utility Menu.

= =, |

MEMOCON-SC CLAG/60L 78
Laddar Legic Develspment Softwars ~ Utilities

Databaze: Help: <ALt=H>

UTILITY Menu:

E. Es ripter E:!H:hl

3 Datakase Utilitias
4. Set temperary fils

{Ezc) te Return to Previsus Nemy
Enter Optien:

—ee———" YASKAUN =

Figure 2.11

4) Select 3. Key/Mnemonic Assignments from the Configuration Options.

KEMOCON-$C CGLARA68-79
| Ladder Legic Devslapment Seftware / Conf iyxratisn
Datahaze : MNelp: CAlr=i>

Canfiguratisn Optiens:

1. Screen Farasstars

2. Printer Parsmsters

<Exc¥ te Beturn te Main Aenu
Enter Optisn Number: ¥

e YASKAUR =

Figure 2.12

The Key/Mnemonic Assignments Screen will appear.

[
™ lm—tg:rm——-—mm: | ml £ iv ;-E .s‘él‘ﬁ *
ctive 3
0TOCH . L
B PLC: <Alc-H
L] GIeG: JETYLEC
1SMAPS

b e
LIERAY .

ONES: OTONE——F

TRITONE——
v

Direceory C:i\GLeBE\w.TKD
Quick Find: NN <Tab)> switch windew
S e

L. Mamild J.New File

Figure 2.13
5) Press the Enter Key.

When the setting screen is displayed, GL60S.TKB will be the default setting, so pressing
the Enter Key will set the correct pathname. If GL60S.TKB is not selected, select it and
press the Enter Key.
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2.2 Swarting and Exiting MEMOCAD-PRQ

The specified pathname is changed and the error message will no longer appear.

2.2.3 Exiting MEMOCAD-PRO

Exiting MEMOCAD-PRO
1) After completing operations, press the Esc Key to return to the Main Menu.
2) Press either the Esc Key or “E”.

Move the cursor to <E> to Exit to Dos.

NEMOCON-3C GLAS/G8.78
Ladder Layic Davalapment Saftwars / Maim Manu
Sarsien 2.08 Copyright 1991 YACKAUR ELECTRIC CORPORMT oW
Datalwmsze: Nelp: CALc—N>
Pain Menus

» Sslact Active PLC
OFf line

Online
Hatisn

- Lizt Active PLC
Laadar

. Utilities

— YasKAUN =

Figure 2.14

3) Press the Enter Key.
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Databases‘

This chapter describes the contents of a database, and the procedures
for selecting or creating a database, changing the selected drive or di-
rectory, and deleting unwanted directories. Temporary files, and
methods for controlling the database including deleting, copying, and
backing up databases are aiso described.

3.1 Selecting or Creating Databases ............ 3.2

3.2 Database Management .................... 3-16
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3.1.1 About the Database

3.1 Selecting or Creating Databases

The user files handied by MEMOCAD-PRO are called the database and are created on the
hard disk of the computer. To operate MEMOCAD-PRO, particularly offline, the user files (da-
tabase) must be selected as the target for operation. This section explains the procedures for
selecting an existing database and for creating a new database.

0 st oz | $elact Database ]
" — Thiten rLC: Ale)
oToeH LES
GIE: .{g&" ]l';l [HEN
LIEMT
b HES f |
LETTEY
TuTGRIAL
TTEME
0T OHES OTOME——+
Fontoe——+

Directerp  COLENS\DPw,CPC
Quick Fikd: IR <Tab> zwitch windew
B.Drfive J.Mabuild f.MHew Directery f.Dwlets Directery D.New|File

Directory Display Screen Select Database Screen

Figure 3.1

Note When adatabase has been selected, a temporary backup file of the data is created to protect
the data. Make sure there is enough free space on the hard disk for this temporary backupfile.
The amount of free space required is double the actual size of the database.

3.1.1 About the Database

Programs and data are created as separate files in MEMOCAD-PRO. Together these pro-
grams and data are called the database, and MEMOCAD-PRO uses this database as its tar-
get for operations.

A database consists of the following files.
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3.1 Selecting or Creating Databases

Example: The database is called “Test 1.”

TEST 1.CFG:

TEST 1.PR1:
TEST 1.PR2:

TEST 1.PRD: -

TEST1.DT1:

TEST 1.DTD:

TEST 1.DS1:

TEST 1.DS82: .

TEST 1.DSD:

TEST 1 .CMS:

TEST 1.PGT:

TEST 1.CML: ‘

TEST 1.XR1:
TEST 1.XR2:
TEST 1.XR3:
TEST 1.XRD:

TEST 1.BL1:
TEST 1.BL2:
TEST 1.BLD:

TEST 1.MS1:

TEST 1.MS2:

TEST 1.MSD:

TEST 1.REV:

Configuration data

This file includes data related to the configuration of the
Programmable Controller, such as device models and memory
allocation, which is set in the database. To select a database, specify
this file to represent the group of files comprising the database.

Ladder logic program data

The ladder logic program data is stored in these files.

Data files
Relations between the ladder programs and other data is stored in
these files.

Signal descriptors

Short comment data
Page title data
Long comment data

Cross reference data
This data is necessary to include cross references in lists to be
printed.

Block file data
Networks can be made into blocks and the blocks can be stored.

ASCIl message data

Description of amended data

When a new database is created, all the files listed above will automatically be created.
These files are not normally used separately.
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3.1.2 Creating a New Database

3.1.2 Creating a New Database

The following procedure is used to create a new database. Determine the following items be- ‘
fore creating a database.

« Name of the datahase: MS-DOS allows up to 8 characters.
= Location: A drive and directory on the computer.

« Setting the target Processor:  The model of Processor and free space allocation
{Can be changed afterwards.)

* Summary: The contents of target project and clients
(Can be omitted.)

1) Select 1. Select Active PLC from the Main Menu

This function can be selected from the Main Menu, as well as from other menus including
the Edit Menu, Lister Menu, and Loader Menu.

MEMOCON-5C GLAB/S8-78
Laddsr Legic hu-hrnl Software ~/ Hain Manu
Vervien 2.88 Capyright 1991 YAEKAWA ELECTRIC CORPORMNTION

Database: Help: <Alg-H>
Main Menu:

3 Gnlina

4. Hetim

5. List dctive PLC

€. Leadsr

7. Vrilities

<E> to Exit to Das

Eacer Optisn: B
——se— YASKAVA =)

Figure 3.2

The Selection Database Screen will be displayed.

Lalsct Databass l
<Ale-N>

T E————IN32E
0T OCE

I

ISTYLES
1SPHAPL LT

EE
ILETTER
TTERNS
0T —l:llﬂl'm—-b
TRI T OME-—=-——t

v

ctery  CI\GLEBS\.CFG
k Find: BIEFEENENEN  <Tak> switch wisdew
NSRAU

¥
@-Drive 3.Rebuild J.Nav Directery H.Delats Dirsctery B.Nev Fils

Dire
Guie!

Figure 3.3

2) Press the Tab Key to move the cursor to the left window displaying the directory tree. ‘
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3.1 Selecting or Creating Databases

3) Move the cursor to the directory in which you want to create the database.

Make sure that databases are created on the hard disk. When creating or editing a data-
base onafloppy disk there is a risk the disk will run out of free space, causing an error that
may damage part of the database.

It is recommended to create separate directories for databases. For details on how to
create a directory, refer to 3.1.5 Creating a Subdirectory for Each Database. For details
on how to change the specified drive, refer to 3.7.4 Changing the Specified Drive.

I Salect Databazs
9T0CD PLC: RCHLE by

)
OTOSM. —'—CID.YSTTLB
ISPMAPS Honme .

LETTES

TTERNG
—[NM——D
TRITOME -—

¥
Directery  Ci\GLERS\DR\».CPC J
i Find:
SKAUM

Quici M <Tad> svitch windew v
O.Prive N.Rabuild [.New Directery &.Delsts Divectery J.Mew Pile

Figure 3.4

4) Press F5 to select New File.

5) Enter the fite name in the input field.

[ Select Database |
Im__ﬂﬂg:'._"'"m“
L re—L

PLC: CAle-H>)

Pivectery  Ci\GLESS-DIN®_ CFS
Quick Find: (Tab> switch windew
TREXANA ==

A-Drivs Z.Mabuild fl.Mew Birectery I.Delvte Directery B.Hew File

Figure 3.5

1

Press the Enter Key. The screen for selecting the model of Processor will be displayed.

Ladder Legic Develapment Seftwara ~ Initinlize PLC

Sulect processer type:
= = or Bpace> te Tegyls {Enter> te Select

Figure 3.6
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3.1.2 Creating a New Database cont.

6) Press the Space Key to select the appropriate mode!, then press the Enter Key.

The PLC Configuration Display will appear.

PLC COMPIGURATION DISPLAY
Halp: <Ale—N>
Active MLC: TEST1
Processer: GLVDM Coily T #1%2
discrete inputai 4836
Memery Available / Allecated nput ress : 8512
Ladder : §4511 - 4512 Helding regz © 7999
Aetion : IUURE / SBESR Censtant reys - 8%
Tranzicisn : DOOE / SEN ta : w12
Subrsutine : DUOOE / DO rancitions 512
imar regs : #5123
Scan lawal 3 1 Link discretes : 1824
Segrancs 3 1 Link regs L -1
MEMONS Pavc : Mede  Parity Step  Baud  Addr  Belay
i: XM Evan 1 608 [ "a
2: R Even 1 %8 [.2Y [
3: R Evan 1 *%ee [} ]
4: RV Even 1 *%ad [ ]
Precezesr Temery IEsymenta [Plercs HEveten Statua
72 e YASKALG =

Figure 3.7

If Select Active PLC is selected from the Online Edit Menu, the PLC Configuration Dis-
play will not appear and the settings of the connected Processor will be used.

7) Specify settings if hecessary.

On this screen, it is possible to set the model of the Processor (CPU), allocate memory,
set the scan level, and set the number of segments (for two-level scanning). If no
changes are necessary, press the Esc Key to use the default settings. Forthe procedures
to set the above parameters, refer to 4.5.1 Processor Types and Configurations. The
items set here can be changed at any time.

Press the Esc Key. A message will appear asking if you want to save changes.

PLC CONFIGUMATION DISFLAY

N Hulp: <Alc—H>
Active PLC: TEET1
Precerzor: GL7AM

Memory Auvailabla / Allscated
Laddar : 64511t / 64512
/ e

Cailx 3
Pizscrate inputz: 409
fnput regs : 1512
Actiso 1

Tranzitisn ! SEOGS - BDOSE
Subrsutisa : SBBOE - BOOES

Scan lavel ! 1
Sugmants 1 1

WEMOBUS Perc @ Mede “ o e 4 Addr

1 1

2: K Even 1 7% ..l
3: KU Even 1 7680 [
4: N Even 1 7*%m "

Precesssr @esery [Pisgrants [Perts IRyeten Status
= ——— e ——

FASKAUA =i

Figure 3.8

If there are no changes then this step is omitted.

8) Enter Y and press the Enter Key. This will create a temporary file and retum to the Main
Menu.

For details on temporary files, refer to 3.7.8 About Temporary Files.

— 3.6 —




4

‘ 3.1 Selecting or Creating Databases

3.1.3 Selecting a batabase

When performing operations such as offline editing, listing, or loading, a database must be
selected for the operation. Databases are normally created on the hard disk of a computer. If
the database is on a floppy disk, copy it to the hard disk before selecting it.

The size of a large database can easily exceed one megabyte. When creating a database on
a floppy disk there is the risk that the disk will run out of free space white editing. This may
cause an error that may damage part of the database. Before editing a database on the hard
disk, make sure that the hard disk has enough free space.

1) Select 1. Select Active PLC from the Main Menu.

This function can be selected from the Main Menu, as well as from other menus including
the Edit Menu, Lister Menu, and Loader Menu. If attempting to edit without first creating
{or selecting) a database, this function will be automatically selected.

a— | Selact Davadass |
Te1) . —r
— L istecs rLC: PTETSm
cIns TETYLES
1SPHAPS Hoas .
ETe
L1RMT
EHES
LETTES
T
OTONES 0T OHE ———
[nnm—v
¥

, Dirsctery G:\GLG8S\».CPC
Quick Find: MR <Toh> switch windew
YAEKAUN
O.rive .Mabuild 0l.New Directery I.Delate Directery J.New Pils

Figure 3.9

The Select Database Screen will be displayed.

l Salact Databaze
FLO: CALE—WD

1SPMPS Dh.CrG

0T ONE«———

TRITOME———cceip
v

Birvectary C:7CLG@S\=_CPC
Quick Find: NN <Tab} switch windew
YASKALR

0.Prive F.Rebuild fI.New Birectery T-Delets Directery J.Mev File

Figure 3.10

2) Press the Tab Key to move the cursor to the left window dispiaying the directory tree.

3) Move the cursor to the directory where the desired database is stored.
|
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3.1.4 Changing the Specified Drive

The names of the files in the selected directory will be displayed in the file window on the
right.

[ seleet Database

Iw—:ﬁm!ﬂ——ﬂlﬁ?t
. oTOCh PLC: <Ale—H>|
OTCSHP: —EID-ISI!I.B
[SPHAPE

TERT.CFG
TEST1.CFG

LETTES
TU}_?_IIIL
0T OMES: OT ONE——>

. TR TONE-——m—ei

Diveccery CI\CLEES\DB\wu.CPFG
Quick Pind: HEENERNEE <Tad> switch windsw

.0rive F.Rebuild B.Mew Directery Jl.Delete Directery J.Mew Fils

Figure 3.11

4) Press the Tab Key or the Enter Key to move the cursor to the right to the directory con-
tents window.

~ [ sedoct Datamass |
TNDOVS —— SETEN ————\INI2¢
: o 0TOCH rLc: <ALe#>
GToeK 1M 1eTeLes
ps e
L1EwT
EHES
LETTEE
TUTORIAL
TTER
0T OMES OTONE————
L TR T OME e

Birectery  C:\GLGES\DE\»,CFG
Quick Find: RN (Tak? switch windew
TASKAUA —

[-Drive T-Beduild 0.New Dirsctary J.Delsta Directery J.New Fils

Figure 3.12

5) Move the cursor to the file name representing the database you wish to select and press
the Enter Key.

The database will be displayed.

At this stage, a temporary file will be created. For details for temporary files, referto 3.1.8
Aboutf Temporary Files.

3.1.4 Changing the Specified Drive

The following procedure explains how to change the drive when selecting or creating a data-
base on a different drive to the one currently specified.
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1) Display the Select Database Screen.

N—T-D0S | Salace Databera |
[YIKDOUS ——-eviTE———uiaze -

PLC: <hle-N>|

—GLERS

—PUNCT OSHP— —qrs"m
ISPHAPE TELI.CPG

—CHDEETS TEST1.CMG

[~CALTERAT

[~ZMIEHES

-PALETTES

[-TUTORIAL

-PATIERNG

TRITONE————t=

v

Diractery C:\CLLRS'\DE\»_CFC
Quick Find: NI  <Tab> svitch windew
VASKAWA o

0.Prive J.Tewmild fi.dew Di 'y D-Delete DE y J.MNev Pile

Figure 3.13
2) Press F1 (Drive).
The screen for selecting the drive will be displayed.

The drives that can be selected will be displayed.

[ Telsct Databaze '
Y8 TEN———WI K328
oTocD PLC: TEST1 <ALt=H>|

ISTYLER
[SFPrs

{Tab) awitch windew

Pirectsry  C\GLEES\DIN».CPC
Quick Find: —
i.0vive 0.Rebuild Q.New Directery L.Deists Diractery B.Mew File

Figure 3.14

3) Enter the Ieﬁer of the drive,

4) Press the Enter Key to change the displayed drive.

5) Create or edit a database.

Note Although selecting a floppy disk may be possible, it is not recommended because thereis a
risk that the floppy disk may run out of free space during the process. This may cause an error
that may damage part of the database. If a database is created on a floppy disk, copy it tothe
hard disk before proceeding.

3.1.5 Creating a Subdirectory for Each Database
A database consists of 20 or more files. The number of files will thus increase very quickly if

there are a lot of databases. Creating a subdirectory for each database is therefore conve-
nient for database management.
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3.1.5 Creating a Subdirectory for Each Database cont.

The following example shows how to create a subdirectory named “DB” under the GLE0S
subdirectory containing the MEMOCAD System.

1} Dispiay the Select Database Screen.

~ [ seluce Databese | I
YETER—m W IH32S
010cD PLC: PyT
1M TSTYLES
HHASH Mens.

OT OHES: OHE———

TRITONE~—F
Al

Directery C:N\GLGES\=.CPG
Quick Find: BN <Tob> switch windew

1.prive B.Rabuild O.New Directery D.Delate Directery J.Mew File

Figure 3.15

2) Press the Tab Key to move the cursor to the left window displaying the directory tree. .
3) Move the cursor to the subdirectory under which a new directory is to be created.

The subdirectory will be created under the directory in which the cursor is located. In this
example, the cursor is positioned on the GL60S directory.

[ tetece bacabass |
ric: <R1eH)|

0T ONE———

Ly TR] T ONE—-—=—

Birectery Ci\GLEBE\w.CPG
Quick Find: SIEEEEEERN  <Tab} switch window
VASKAUN ==

I.Drive J -Rebuild §.Mew Directery D.Delete Pirectery B.Mew File

Figure 3.16

4) Press F3 (New Directory).

The directory name input field will be displayed.

g . . [ $elect Database
TR ric: Ale-n>

Diractary C:\GLEEE\» CPC
Quick Find: {Tah> swikch windew PR
O.0vivs 2.Mabulld O.New Directery §-Balste Directary 3.Mew Fila

Figure 3.17
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M
5) Enter a new directory name.

Press the Enter Key to create the subdirectory.

— e ——————————
w Sxlect Databas.

b E————UTNIZE I— aee - I
0TOCDh FLC: <AL
Gllﬁ—'-tgl'ﬂ"m

s IEPHATE Hame .

o‘rm—[morm—-—o-
TRI TONE————ucpr
v

Directery C:\GLEES\=.CPG
Quick Find: IEINEEEE  <Teb> suitch window
TASKAYA ==

O-Drive B.Maduild Ql.Nev Pirectery D.Delete Directery J.New Pile

Figure 3.18

3.1.6 Deleting Unwanted Directories

The following pfocedure is used to delete a directory. Make sure there are no files contained
in the directory to be deleted.

1) Display the Select Database Screen.

\-T-D06 [ Selact Dasabasa ]
Cinhmous YSTEN-——UINIZE
010CH rLC: 1>
GINs TSTYLES
T Hona.
18
LI BT
EWES
LETTES
TUTORIRL,
TTEWS
GMES oTOHE———+
FToe——+

Directsry  C:\GLEEEww_CPG
Quick Fisd: BENNEEEEE  <Tsb> switch windew
YRERAN —

[ @.trive D.Rehuild O.Wew Directary D.Delsts Directery I Ko Piir

Figure 3.19

2) Press the Tab Key to move the cursor to the left window displaying the directory tree.

3) Move the cursor to the directory to be deleted.

—_——
N [ solace barabass |
'THDOWE: Y8TEN——UIN32E
- 0T OCP LGS SAlz—H>|
. CEM] JETYLES
AT Mane.
OTOME e
TRI TOME -
v

Dirertury  C:\CLEESDEwu.CPFC
Quick ¥ind: IR <Tak> switch wimdew R
0-Prive B.Mebuili D.Hev Directery I.Dalete Directery P.New File

Figure 3.20
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3.1.7 Correcting the Directory Configuration Display

4} Press F4 (Delete).

A confirmation message asking whether to delete the directory will appear.

Sslect Databaze
<A1le—H>

Bivectsry COGLAESDR\W.CPG
Quick Find: <{Tak> switch windaw

#-brive J.Jedbuild [.New Directery D.Dulsts Directery 3. Mew Fils

Figure 3.21

5) Enter Y and press the Enter Key.

The directory will be deleted.

This screen displays the database file names only. If other files, such as motion program
files and parameter files, exist in a directory, they are not displayed. A directory contain-
ing such files cannot be deleted. A warning message wili appear on the screen when the
| user attempts to delete this directory. If these files are not needed, exit MEMOCAD-PRO,
return to MS-DOS and delete the files, then delete the directory.

3.1.7 Correcting the Directory Configuration Display

The directory configuration displayed on the Select Database Screen defaults to the previous
configuration to save time searching for the current configuration.

If the current directory configuration is different from the previous one and the correct data is
not displayed on the screen, the following procedure is used to correct the data.

1) Display the Select Database Screen.

Select Databazw
PLC: LS b
Wone .
& TRITONE———F
Pirsctery  C:i\GLERS\DI\».CPG
Quick Find: IR  <Tab> switch windew s
3.Drive G.ReMuild [l.ew D4 y .Delats Di y B.New File T

Figure 3.22
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2) Press F2 (Rebuiid).

The correct data will be displayed.

3.1.8 About Temporary Files

When a database is selected or Created, a temporary file (@ @ @. XXX) will automatically be
created as a backup in case of damage to the database. If the database is destroyed, change

the name of this file and use it as the database. The temporary file will be created in the direc-
tory containing the MEMOCAD-PRO Systemn.

1. Setting M‘odes

1) Select 7. Utilities from the Main Menu.

FMEMOCON-SC GLAB/60 79
Ladder Logic Develepment Softuawe ~ Mpin Henu
Varsien 2.80 Cepyright l’r’ﬂsnu ELECTRIC CORPOMATION
Databaze: TEXT1

Halp: <AIT-ND>
Main Menu:

- Sslsct Active FLC
Of F1ine

- Online
Motisn

- Lisc fctive PLC
Laadur

Ll el ARTXT

S U e
<E> to Exit te Des
Enter Optien: B

———me— YAEKAWA =

Figure 3.23

Move the cursorto 4. Set temporary file from the Utilities Menu, and press the Enter Key
to display the Set Up Temporary File Screen.

“ MENOCON—$C GLAR-E8. 78
I Laddar Lagic Develspment Leftuare ~ Usilities
Databaze: Help: <ALt-H>

UTILITY Menu:

1. Canf tlan

2. Descripter Utilities

3. Databaze Utilities

<Ezc)> te Return ts Previeur Menu

Enter Option: EJ

—rw — i rmame—— 1 L 1. 1] J

| Figure 3.24

2) Press the Spdce Key to select the mode you want.

The preset mode becomes valid the next time MEMOCAD-PRO is started.
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3.1.8 About Temporary Files conL.

2. When Selecting or Creating a Database
Select or create a new database. .

Databases will automatically be copied to a temporary file when MEMOCAD-PRO has
been started using GLEGOMENU\RA \RR.

A screen will appear saying “Copying to Temporary File” and the database wil! be copied
1o the temporary file.

3. When Exiting MEMOCAD-PRO.
1) Exit MEMOCAD-PRO.

A message will appear if you want to save chages.

2) The default is “Y." Press the Enter Key.
if “N” is entered and the Enter Key is pressed, the version of the temporary file prior to
editing will be saved as the database and the edited version of the database will be dis-
carded.

If a database is selected while another database is being edited, the screen will display
“Save Changes?” If the Enter Key is pressed when “Y” is displayed, step b) will be per-
formed foltowed by step a) to save the modified data. If “N” is entered and the Enter Key is
pressed, step ¢), step b), and then step a) will be performed in order, and the modified
data will not be saved.

The changed contents will be saved.

a) When a database is selected or created, a temporary file for it will be automatically
created.

Database

| Copy

Temporary file
@aa.xXxX

b) When changes are saved, the saved contents and the temporary file both remain.

Database “The changed contents
will be saved.
Temparary file ‘
porary a@ae.xXxx
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c) When 6hanges are not saved, the changes are overwritten with the contents of the

temporary file.

Database

! I Copy

Temporary file

—315—
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3.2.I Deleting a Database

3.2 Database Management

The following options are available to manage databases.
» Deleting a database

« Copying a database

» Renaming a database

s Description of detailed information on a database

» Backing-up a database

3.2.1 Deleting a Database

The following proceduré is used to delete the database currently selected.

1) Select 7. Utilities from the Main Menu.

w

MENOCON-EC 7
Ladday loyic Develspmant $eituars / Main Menu
Uersion 2.00 Copyright 1291 YASKAUR ELECTRIC CORPOMIION

Database: TEETI Help: <Alt-—K)
Nain Henu:

1. Salsct Active FLC
2. OfFfline

3. Omline

4. Metism

5. List Active FLC
6. Laadex
IR

<E> to Exit te Deos
Enter Optien: B
| — YASIAUA =

Figure 3.25

2) Select 3. Database Utilities from the Utilities Menu.

|

NEMOCON-EC GLAB/EB-70
Laddsr Legic Develepmant Seftware / Utilities
Database: TEET1 Halp: <R1t-N)>
UTILITY Wenu:

1. Cenf tien
2. Dumcr. E-r Utilities
- et tasparary

CEze> to Fatwrw ta Previsusr Hewu
Enzar Optiem:

i P e arae— YAE R

Figure 3.26
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3) Select 2. Delete the Active PLC From Disk from the Database Utilities Menu.

[ it tapic sene i E Stbn " i
Databaze: TESTL Help:z <Ale-d>
DATABRSE UTILITY
1. Select Aerive PG

okl al' Y
Hiz
i
i

. ctive PLC
Optinize th letivl nc

<Est? te Beturn ts Previsus Menu
Enter Optisn: B

o — asEAA <)

Figure 3.27

A confirmation message asking whether to delete the database will appear.

L ERMEE DATABMSE
Database: TEITL Help: <Ale-H>

URHNING: NEOUT TQ EHASE ALL FILES FOR.

Do you want Lo delete tiaz datahase? I

— et YASKAWA »=

Figure 3.28

4) Enter “Y” after checking the contents, and press the Enter Key.

Always check the name of the database before executing.

3.2.2 Copying a Database

The foliowing procedure is used to copy the database currently selected to the specified drive
or directory.

1) Select 7. Utilities from the Main Menu.

1

‘ Lu-umh%"- 'c‘-:y‘f-s:'n iy ﬁsf::' 'u?ﬁmtlou 7
Databass: TEETL Wely: <ALth>
Main Menu:
g;hc: heeive PLC

1.
2.
3.
4.
5.
S

Pation
List fctive FLG
Laader

<E> ta Exit te Das

’ Enter Optisn: K
— — — S— YASXAUA

Figure 3.29
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3.2.2 Copying & Database cont.

2) Select 3. Database Utilities from the Utilities Menu.

—_—

HEMOCON-SC GLAR/GW 79
Ladder Lagic Pevalapment SeFtware # Ytilities
Help: <ALlt-H>

Databare: TEET1

UTILITY Penu:

1. Cenf tien

2, Pascripter Ueilities

<Eac?> to Bexwrn to Previsus Menu
Enter Opcion: B

Figure 3.30

3) Select 3. Copy the Active PLC from the Database Utilities Menu.

HEMOCON-SC_ClAR/48-78
Laddar Lagic Davelepment Ssfrwars / Patabaze Veilities
Databaze: TESTL Helps <ALe-H>
DATABASE UTILITY

1. Select Active FLC
2. Dalats tha Active FLC Frem Disk

AANE C et
5. Bachup the Rctive FLC
6. Bezters thw Actiuve FIC
7. Optimize the Mctive FIC
<Ezc> te Keturw te Fravieus Fenu

Entar Option: B

I=— ——a e — YASKAUN —

Figure 3.31

4) Move the cursor to the destination file or directory and press the Enter Key.

The procedure for specifying the destination drive and directory is the same as 3.1.3Se- ‘
lecting a Database. When changing the name of the database before copyingit, press 5

(New File) to enter a new name.

D08 Eelact Database ar
FVINDOVE 'lS‘l'oum——-HllB'.'s Directery ts Copy Inte
L Wocins TSTYLES FLC: IBTL e

— Liiren

-cMEG ETS TEST.CPC
|-CALTENRT TESTL.CPG
I~EMISHES
[-PALETTES
[-TUTORIAL

TTERNE

mm—l:nmm——r

TRETONE———+
v

Directary C:\GLERS\DIN\« CPFC
Quick Find: KN <Taby switch windsw <Entsr) aalect directary
YASKAWR =t

0.Drive 3.Mebuildi 0.Nev Birectery J.Mew Fils B.Quick

Figure 3.32
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3.2 Database Managemens

A confirmation message asking whether to proceed with the copy will appear.

Select Database or
Pirsctery te Copy Into

PLE: TESTL <Ale-H>

bireccery  C:\GLEESNDIN=, (PG
Quick Find: <Tak> switch windew <Enter> szelsct directery
Yasawm

Figure 3.33

5) Check the name of the database before executing.

The copy cannot be executed if the new database has the same file name as the source
file. Specify another file name for the new database and press the Enter Key.

3.2.3 Renaming a Database

The following procedure is used to rename the database currently selected.

1) Select 7, Utilities from the Main Menu.

Ladder Legic Bavels < Saft 7 Bain fer
- Ve nt e ny
Verzion 2.80 C-:Wll’lu urx-nsnm ELECIRIC CORPORATION

Dutabase: TESTL Malp: <Rlr-H>

Main Memu:
1. Salect Mctive PLC
2. OFfline

3. Online

4. Hetisn

§. List Active MC
&, Loader
IEEAETNTES

<E> te Exit tu Das

Enter Cptian: BJ

————

Figure 3.34

2) Select 3. Database Utilities from the Utilities Menu.

1
! HEMOCON-SC GLABSA-78
L ladder lagic Develepmnt Seftuare ~ Utilitiay
1 Databaze: TESIL Halp: <Alx—4>
UTILITY Memu:

i cl::ssu::‘ﬁ:uuh-
CExc> te Meturn ts Previews Meau
Entsr Opsien: W

—— o e Y A KA o
l Figure 3.35
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3.2.4 Specifying Details of a Database T

3) Select 4. Rename the Active PLC from the Database Utilities Menu.

MEMOCON=C_CLAB/G8-79 _I
Ladder Logic Development Softuars / Database Utilities
Database: TESTL Help: <A1t
DATABASE UTILITY
; Salact fctive

e
. Delete the Active PLC From Bisk
3. Copy the Active PLC

6. Manters tl- l w FLC
7. Dptinize the l:ciul Mg

CEzc> te Raturn ts Provieus Menu
Enter Opties: §i

| —— =mr YRERAUN

Figure 3.36

4) Enter a new database name in the input field.

HEROCON-SC_CLAB/68/79
Ladder Legic Duvelspeent Seftuwara ~ Batabase Utilities
Databaze: TESTL Help: <Ale-H>
DATAMSE UTILITY

b Opthizn tln llti\u ru:
<Ezc? te Return ta Previsuz femu
Eatar Opecisn: EI

Figure 3.37

5) Press the Enter Key.

3.2.4 Specifying Details of a Database

The following procedure is used to specify details of a new database, such as its purposes
and its author. This description can be pnnted together with ladder lists and other types of
data.

The contents of this description are described below.

» Page Header:
Enter the title of the database using up to 40 characters.
This can be printed on the top of each page of the ladder list.

» Project:
Enter the project name (if any) related to this database.

e PLC Model:
Enter the model of Processor.
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M R S

« Description:
Enter the purpose and the function of the project.

¢ Prepared by: |
Enter the name of the project engineer or programmer,

« Client: ‘
Enter the name of client company, plant, or facility.

1) Select 2. Offiine from the Main Menu.

CIAR %R 78
r Layic h nt Seftwars ~ Main Menu
Illl‘li.ln 2. - Cl.y?i’h! l,r'lsllﬂ ELECTRIC comnnon

Batabase: TEET1 Help: <ALt=N>
Hain Nemu:
1. Swulect Active PLC

I
4. RMetis
S List fctive FLC
6. Leader
7- Peilities
<E> te Exit te Dex
Enter Optisn: ER

L L N

Figure 3.38

2) Select 5. Database Details from the Offline Edit Menu.

MENOCOMN-£C CL4B-60-78
I Livdder Lagic Develepment Seftwars ~ Edit Menu |

Database: TEST: Bulp: <Ale=§)
OFf1ine Edit Manu:
1. Sohe: leu.u- M

Scmm:hl Punctian Charts
4 Descri

W

nht-nnu Dizypesitisn
<Eze> ta Roturs to Previsus Mena
Enter Option: EE _J
— — — = YATXRUN =

Figure 3.39

3) Enter the paQe heading in the input field and press the Enter Key.

5 DATAMSE DETAILS 1

Database: TERT Nelp: <RRt=H>
' Page Hesder: S
Prejoct
I MG Kodel
| Descripcien:
Frepared by:
1 Clieat

CA1t—E> te Save and Exit {Esc) to Quit
— — —

. | Figure 3.40
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3.2.5 Backing Up a Database

4) When the Enter Key is pressed, the cursor will move to the next item.

5) After a detailed description of each item has been completed, press the Alt + E Keys to
save and return to the previous screen

If you do not want to save the details entered, press the Esc Key. A confirmation message
will appear asking whether to save the data. Enter “N” and press the Enter Key.

The data created here is documentation data intended for printing, therefore the contents will
not affect the programs.

3.2.5 Backing Up a Database

A database can be destroyed by various kinds of accidents. It is recommendedto make back-
ups as often as possible.

Back up methods for MEMOCAD-PRO

Database Backup file

Back u
XXX.CFG ackw

X PR1
XXX.PR2

XX.2IP

Restore

XXX.ZIP file is an archive file which contains a group of 20 or more compressed data files.
Although the amount of compression depends on the contents of the program, files are nor-
mally reduced to less than half of their actual size.

To return the XXX.ZIP file to the database form, a restoring operation must be executed.

1. Creating Backup Files

The following procedure is used to create and name a backup of the database currently
selected in a specified drive or directory. When a database is backed up, a file named
XXX.ZIP (XXX is the name of the file) will be created. The XXX.ZIP file is a compressed
version of the database file, which is smaller in size than the actual database, making it
easier to store. The amount of compression ranges from 10% to 50%.
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‘“_7_-

1) Select 7. Utilities from the Main Menu.

Lt
Ladider h:t: Daus. r-ne Sa ftwars / Main Meny
Veraisn 2.08 Cupyrillll 19¥1 YASKAWA ELFCTRIC mmunu
Databaze: IET1 Help: CALt-N>
Hain Meno:

- falact Recive PLC

Of fline
- Online

Hation
- Lizt Active PLC
ader

IESTEYETETE

{E> ts Exit te Dus

Enter Option: J
— - e o YASXAU =Y

Figure 3.41

il ST

2) Select 3. Database Utilities from the Utilities Menu.

D ———

| MENOCON-SC CL4L- %878
Ladder Logic Devalopment feftwars ~ Utilitien l
Betabaze: TEET1 Help: <Alt-H>

UTILITY Manu:

1. Cenf cisn

2. Dascripter Utilities

<Ezt? te Return te Previous Mens
Eater Optien:

e —— T —— YASKAUN =

Figure 3.42

3) Select 5. Backup the Active PLC from the Database Utilities Menu.

%

I Ludder Legic Daveinpocnt Sefcimre s bacabase Urilities —l
Patabase: TEETL Halp: <Alc—#>
DATABRSE UTILITY
5o Beisit 150 T 1t prem Disk

3. Cepy tha fActive PLC
4, Renams the Ietlu- FLC

ktere
7. O'thi:- the ll:iul FC

CEvc? te Mmturn ta Previsus Menu
Enter Optiam:

—— T YASKAUN =

Figure 3.43
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3.2.5 Backing Up a Database cont.

The screen for selecting the backup destination will be displayed.

- [ Dirvectsry ts Backup lntul
1 —LYSY] YINI2E
s Lenorocn ML.C: TEETL <B1e—H>|
DTOENP— —EI'.'I‘S'I"LB
1SPRATS Hona .
[—OTEETS
—CALIBRAT
—EMUSHES
—PALETTES
—TUTORIAL
PATT]
‘—DUOTONES: OTONE———
+
TRITONE————
v

Pirectory  CoN\GLEGS\DINe FIP
Quick Pind: [N <Tahy suitch windew <Enter> nthet':mﬁory

f1.Drive Z.Meduild U.New Directary J.Hew Fils J.Quick

Figure 3.44

4) Press F5 (New File).

If you want to create a backup on another drive or in another directory, specify the follow-
ing before pressing F5. ‘

e Drive: Press F1 (Drive)

» Directory: Press the Tab Key to move the cursor to the left window displaying the di-
rectory tree.

5) Enter the name of the backup file in the input field.

l Pirectery to Rachup Inte
PLC: TESTL <ALe—N)|

Im——mﬂm—-——-unuz:
OTOCD
J—" 3

3
TOENP mmn—dﬂrvm
- HE 1

Dirsctery  C:\GLGBE\DEN» ZIF
Quirk Find: {Tah> switch windew <(Entwr} “ha‘!ﬂﬂ‘t.ﬂ_

A.Drive Z.Mebuild 0.Mew DPirectery H.New Pile J.Quick

Figure 3.45

6} Press the Enter Key.

A confirmation message asking whether to proceed with the backup will appear.

I Directary te Rachup I-tut
LG TESTL CALE-HD

Directery C1GLASEDING.ZIP
Guick Find: CTak) switch windsw <Enter) sslect direceery

Figure 3.46 ‘
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. 3.2 Database Management

Make sure the back up source and destination have been specified correctly. If an exist-
ing ZIP file is selected without entering a new file name, the existing ZIP file will be over-
written. The backup file created here cannot be used as a database unless it is restored.

7) Check the message contents, then press the Enter Key..

“Backup complete” will be displayed.

—_——_— T

Backap conplete

Hit any hey

Figure 3.47

8) Press the Enter Key.
The file XXX.ZIP will be created.

2. Restoring Backup Files

The following procedure is used to restore a backup file (XXX.ZIP). The term “restore”

used here means to return the compressed ile created in the backup process to the origi-
nal database file format.

1} Select 7. Utilities from the Main Menu.

HEROCON-IC CLAS-60-78
Uareton .00 Copyeine 130T PASKR ELECTAS Sonmoiar IO
Batabaze: TEST: Halp= <Rit=H)>
Hain Meoui
. lohee.lct’.u- e

Online
[

<E> to Exit ts Der
Eater Optian: EI

Figure 3.48
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3.2.5 Backing Up a Database cont.

2) Select 3. Database Utilities from the Utilities Menu.

[—_———————————————————— |

HEHOCON-SC CLAR-6R 79
Ladder Legic Bevelspment Seftwars / Urilities
Dacabasze: TESTL Halp: lc-H>

UTILITY Manu:

PRt i P

<Esc> te Beturn te Previous Menu
Enter Opcien: K

————— S——— FASKAWN =

Figure 3.49

3) Select 6. Restore the Active PLC from the Database Utilities Menu.

———— e ————————————— == |

MEMOCON-EC_CLALAR-78
Laddsr Lagic Develspmant Saftwars / Databaze Utilities
Batabaze: TEXT1 Help: <Alt-H>
DATRIMSE DTILITY

1. Select Mcrive FLC
g Dalate the ‘cth;ul:lnc Troa Disk

;Z Renans the Active FLC

Backup tha Active FLC
g. EEQ- t! Et!\u m

{Esc? te Raturn ts Previsus Menw
Encer Optien: OB

Figure 3.50

The screen for selecting the source file to be restored will be displayed.

RS 08 VS - —— I Select a Mescers Fils 1
- ocD PLC: TESTL <ALe=H>|
CTOSH GTNG. TISTYLES
ISPHAPS EIEITWAYSE
ET$
LIERAT
SHES
LETTES
-TUTORIAL
TIERNG
m—[wo‘mm—r
) TRI TORE =t
Dirsctery CCLEBS DI ZIF
Quick Find: IS {Tab> switch windsw
YASKAUA s
3.brive 8.Rebuild B.Mew Birectery J§-Mew File B.Quick

Figure 3.51

4) Move the cursor to the ZIP file to be restored and press the Enter Key.

If the ZIP file is on another drive or in another directory, specify this before carrying out
restoration of the file.
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e Drive: .  Select F1 (Drive)

* Directory:  Press the Tab Key to move the cursor to the left window displaying the di-
rectory tree.

The screen for selecting the restore destination will be displayed.

—
——
~—7-DOt |
i xDows YSTEN———UI 328
0TOCD ric: TERTL <ALe=H)|
CveToen KNG TSTYLES
e T
Lidiey
LETTEY
TUTGAIAL
TTEMNS
0T OMES O OME et
[rluous—+
¥

Directery Co\GLERET\DE\w.Z]P
Quick Find: NEVREEMEENEE CTab> switch windsu  (Enter)> anlect directary
ASKAWA

I1-Drive Z.Rebuild {.New Fivectary H.New Pile B-Quick

Figure 3.52

5) Select the destination directory for the restore file and press the Enter Key.

Pressing the Enter Key without changing anything here will restore the file in the directory
where the current database is selected. If you want to restore the file on ancther drive or
directory, specify that drive or directory and press the Enter Key.

A confirmation message asking whether to proceed will appear.

Im——grnm——ulmz:
0TOCD

-1y
GTOEM. TSIYLEE
ISFAPT

Directary  Ci\GLEBE\DI» ZIP
Quick Find: <Tab)> switch windew CEmterd> othﬂ'hb';c‘.t'rg

p Figure 3.53

6) Check the name of the database before executing.
1

When restoring a file, the name for the file output cannot be specified. For example, if a
backup file of a database named “TEST is to be restored, the database restored is al-
ways named “TEST.” If a database file with the same name already exists in the directory,
this file will be overwritten. It is recommended to take precautions so that this does not
happen.
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3.2.5 Backing Up a Database cont.

“Restore complete™ will be displayed.

Figure 3.54

7) Press the Enter Key.
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Offline Editing

This chapter describes the procedures and functions available for edit-
ing networks, editing subroutines, SFC editing, editing comments,
editing ASCII, and setting the system configuration.

4.1 Editing Networks ............ Citeetanane. 4-2
4.2 Editing Subroutines ...................... 4-81
4:;3 SFCEdting ...oovvvieninennnnnnnnnnnnnn. 4-84
4;4 Editing Comments ............ resesen eees 42137

4.5 Setting the System Configuration ........... 4-166

4.6 Editing for ASCII Modules ........ crecees 4-195
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M

4.1.1 Network Screern Configuration

4.1 Editing Networks

Network editing is used to input and edit ladder elements, to monitor and edit the status of all
references, and to copy, move, and find networks.

4.1.1 Network Screen Configuration

The following shows the configuration of the Network Screen.

Network number being displayed
Total number of networks

Targst Processor Database name
LT fictive PLES T L Assembly register:
\ Holds keyboard input
> Logic area
/ Prompt
BTG, e PR SHE PWr omm B OPRE OER T Mnemoric

4.1.2 Displaying Networks

The following procedures can be used to jump quickly to and display a network from what ‘
might be several thousands of networks for some programs.

« Jump 1o network display after starting MEMOCAD-PRO or to next or previous network:
Refer to 1. Dispfaying Networks on page 4-3.

« Jump 1o any network:
Refer to 2. Displaying Specified Networks on page 4-4.

« Mark any network, and jump to that network:
Refer to 3. Jumping fo Marks on page 4-5.
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j 4.1 Editing Networks
“%
‘i . Displayihg Networks

The following procedure is used to display the Network Screen.

1) Select 2, Offline from the Main Menu.

HEMOCON-SC GLARSB-78
Ladder Legic Devalsymant Luftuare .~/ Main Phrfsu,
Versisn 2.08 Copyright 19%1 YASXAWA ELECTRAIC CORMOMATION
Database: TEETL Nelp: <AIt~H>
Main Menu:

1. Salect Active PLC

40 Mecien
%. List Active FLC
6. Loader
7. Usilitiee

<E> ta Exit te Dea
Enter Optien: I

— S ——

Figure 4.1

2) Select 2. Networks from the Offline Edit Manw.

A database is required for edit a network offline. The Select Database Screen will thus
appear automatically if a database is not yet selected. Refer to 3.1.3 Selecting a Data-
base, and either select or create a database.

TEMOCON-SC G1A8/60/78
l Laddsr Legic Davelopmant Ssftusre ~ Zdit Menu _I

Patabass: TEETL Halp: CALt-N>
Offline Edic Mamus
1, Select Mctive PLC

4 D::::::to&omem Sharsr

E: t::::::vbg:f‘il:uuthn

7. ASCII Muzzages

8. CressReference Pisperitien

<Esc> te Meturn to Pravieus Menu

Enter Optisn: B

——rx — — =y YASNAUA =

Figure 4.2

The Network Screen will appear.

1

Toerks T GL7GN Retivs PLCT TESTT RN DN
n
L
J
o
5
;
17
B The THE S R mmvoomn mm opy mpu

Figure 4.3
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4.1.2 Displaying Networks cont.

« Display next network: Press the Page Down Key.

» Display previous network: Press the Page Up Key.

« Display last network: Press the Ctrl + End Keys.
« Display first network: Press the Ctrl + Home Keys.

When displaying the last network is specified, the cursor will actually jump to a blank network
after the last network.

2. Displaying Specified Networks

The following describes two methods used to display a specified network.

A. Using AR:

AR: (Assembly Register:} will appear on the upper right side of the screen. -
Enter the network number (Lxx) at AR: and press the Enter Key.

AR: cannct be entered while the Command Submenu (Figure 4.4} is displayed in the 1a-
bel area at the bottom of the screen. Press the Esc Key to exit the Command Submenu if it
is dispiayed, and then enter AR:. ‘

B. Using the MOVE Command

The MOVE command ¢an be used to move to screens other than the Network Screen.
The following procedure is used to specify a screen.

Looxx: Move to network number xxx.

SNxcnnn: Move to network number nnn of step number xxx.

Txxx: Move to transition number .

Sxxx: Move to step number 0z

Groocnnn:  Move to network number nnn of subroutine number xxx.
SEGx: Move to the first network of segment number x.

1) Press the Slash Key 1o display the Command Submenu.

% 1.0etive 2.00eck 3.Degister 4.0dic 5. Jsbal 6.Jearch 7.Jhde 8. .THav ¥.Juil

Figure 4.4

2) Press F8 (View). ' ‘
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m

An alternative method is to enter “V” from the Command Submenu.

The View Submenu will appear.

E‘ Viaw: 1.Besc 2.Zindew 3. Dark 4.Dnmark §.5uvp 6.Este ?7.vem 0.200n Deturn

4

Figure 4.5
3) Press F6 (Goto).

An alternative method is to enter “G” from the View Submenu.

The input window will appear to enter the address.

18 ¢ Lol DALCZ FTMKS oW w1 IEMEC  INENE 1
W ¥, UG OUS Fme owm pumn e e e

wa |

Figure 4.6

i

4) Enter the network or the SFC address (Lxx, SNxx) that will be displayed and press the
Enter Key.

The specified network or SFC will appear.

i

Shortcuts

a) Enter “VM" at AR: and press the Enter Key, or press the Alt + V Keys, to display the
View Submenu.

b) Enter“GOTO” at AR: and pressthe Enter Key, or press the Alt + N Keys, to display the
input window.

3. Jumping to Marks

Any cursor position marked during network editing can be stored in memory. If an often-

used position is marked, that position can be brought up instantly even while editing
ancther network.
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4.1.2 Displaying Networks cont.

1) Press the Siash Key to display the Command Submenu.

f 1.fctive Z.Mlock 3.0egiecar 4.0Hit 5.Flebal 6. Joarch 7.0hia 8. JHew 2.Joi)

Figure 4.7

2) Press F8 (View).

An alternative method is to enter “V” from the Command Submenu.

The View Submenu will appear.

f View: 1.@ewc 2.Bindou 1.Jark 4.Jemark S.Ienp €.Jote 7. 3pen S.200n [uturn

Figure 4.8

3) Move the cursor to the position that will be marked.

4} Press F3 (Mark).

An alternative method is to enter “M” from the View Submenu.

The cursor position will be marked.

Aithough the mark wili not appear on screen, the position of the mark will appear on the
bottomn left side of the screen.

Twerk: SO /SR [~ ] Fctive TLLT TRETL (15

Network No. Row

e

w: 1.0e%c 2.00ndew 3. D0rk 4.Jvnark 5. Tunp 6.Jete 7.5esw 8.z00n Jexars

o T L L )

Figure 4.9

5} Press F4 (Unmark) to cancel the mark. ‘
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!

An alternative method is to enter “U” from the View Submenu.

6) Press F5 (Jump) to jump to the mark even if the cursor is in another natwork,
An alternatiive method is to enter “J” from the View Submenu.

7} Press F5 (Jump) again to return to the original position.

Itis not possible to return to the original position if the cursor is not at the marked position.
The original position is the position of the cursor prior to jumping to the mark, and it will
appear on the left side of the mark position on the lower left side of the screen following a

jump.

1 i oant - -—( y—
o OO >

z e R -—éu—

il

]

3

b Jump position

b L—ﬂnmﬂ I

-Imark 5.0y 6.Iete 7.0een B.zeem Jatuvn
Figure 4.10
Shortcuts

a) Enter “VM” at AR: and press the Enter Key, or press the Alt + V Keys to display the
View Submenu.

b) Enter“M”at AR: and press the Enter Key, or press the Alt + M Keys, to mark the cursor
position. |

¢} Enter “UMK” at AR: and press the Enter Key to cancel the mark.

d) Enter“J”at AR: and press the Enter Key, orpress the Alt + J Keys to jump to the mark.

4.1.3 Exiting from Network Editing

The foliowing prdcedure is used to exit from network editing.

1) Press the Esc Key.
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4.1.4 Moving the Cursor on a Network

A confirmation message asking whether to exit will appear.

twork: ctive

h

oW

?

18C C LC1 LC2 NG JCOWURT RX1 PEC EMET ]nﬂlﬂ 1
Pw L n.1'.Il2 naWS a:le ,LBS e B“IIAI“' BU‘I ml!l! L]

Figure 4.11

If the Function Menu at the bottom of the screen is not at level 0 (initial menu), the Func-
tion Menu will shift closer to level 0 without a message. Press the Esc Key at level 0 to exit. ‘

2) Press the Enter Key.
Enter “N” and press the Enter Key, or press the Esc Key to continue editing.

A message will appear asking whether to optimize the database.

Multiple network editing generates excess sections in data files that make the file much ‘
larger than is needed. This is why the database is optimized when network editing is com-
pleted. It may take some time to optimize the database, depending on the number of net-
works and the editing work involved. Press the Esc Key to cancel optimization. When this

is done, optimization will be continued the next time you exit network editing.

If optimization will take too long, we recommend savingthe databasetoa P150 disk using
the loading function, and then loading the data into the database to rebuild the data. {Re-
fer to 9.8 Converting P150 Disk Data.) ‘

3) Retumn to the Offline Edit Menu.

4.1.4 Moving the Cursor on a Network

The following procedure is used to move the cursor on the Network Screen.

Moving the Cursor

Moving up, down, left or right: Press the Up, Down, Left or Right Cursor Key.
Moving to the upper left (Home Position): Press the Home Key.
Moving to the lower right (End Position): Press the End Key.
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i

Moving to the left edge: Press the Ctrl + Left Cursor Keys.
Moving to the right edge: Press the Cirl + Right Cursor Keys.
Home position

'\

(Home)

Keystrokes are
in parentheses.

Left |ww (Ctri+ ) —.-— (Cti+ —) =ssmp| Right

N\

(End) -

\

End position

4.1.5 Entering Elements Using Function Keys

. Display the Element Menuin the label area at the bottorn of the screen, and select the function

from the menu using a function key (F1 through F10). All ladder elements are assigned to
function keys.

Referto Appendix A List of Function Key Menus for more details on elements that will be dis-

piayed.
F1 (DISC): Discrete I/O
. F2 (TC): Timer, counter

F3 (CALC1):  Calculation function 1

F4 (CALC2): Calculation function 2

FS5 (TRANS).  Type of data transfer

F6 (CNVRT):  Type of data conversion

F7 (MTRX1): Matrix

F8 (SPEC): Skip, subroutine, stepping switch, ASCI instruction, COMM instruction, EX-
PANSION REGISTER instruction
F9 (YENET): YENET
F10 (MOT1):  MOTION instruction

To display the next menu, press the Shift Key while a function key menu is being displayed.

Example: Entering 00001

. 1) Move the cursor to where the element will be entered.
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4.1.6 Entering Elemenis Using Mnemonics

2) Press F1 (DISC).

The discrete /0 function keys will appear.

T TE T Yl MRDTHE Y Y

Figure 4.12

3) Press F1 (NOC).

The element will be entered, and an input field will appear.

Figure 4.13 ‘

4) Enter 00001 and press the Enter Key.

Cwerks ctive g

e ninhes
Red ranyeod MWL -WB152 AWG DAMAT - DI K24 SHML-5%12 28301-23299

)]
Lab ) W R FRSE 1 1=-HS 190 NI - Ny

Figure 4.14

Press the Esc Key to return to the previous menu.

4.1.6 Entering Elements Using Mnemonics ‘

Each element has a unique mnemonic. Enter the mnemonic at AR: 1o input the element.
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Mnemonics are displayed with the Element Menu.

s ]

-3

g

3

3

5

7

Bl ik M s boy g om0, g Eement

Figure 4.15

1) Move the cdrsor to where the element will be entered.

2) Enter the mnemonic of the element at AR:. {Example: NOC for NO contact)

tvorh= 1 PRI RN dcelvs FLC: TENTT SN CIENAN ]

.l X, 1
W T MUS TUP Tms Pun omn Smk dnm mw

Figure 4.16

1

3) Press the Enter Key.

The element will be entered, and an input field for the address will appear.

Figure 4.17
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4.1.7 Entering Horizontal and Vertical Shorts

4) Enter the address and press the Enter Key.

I Ref vanges: HAAAL - M
HLALL - Y

Figure 4.18

4.1.7 Entering Horizontal and Vertical Shorts

The following procedure is used to enter horizontal and vertical shorts.

Horizontal short

|
N

_‘

-— Vertical short
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1) Move the cursor to where the horizontal or vertical short will be entered.

Swork: ctive H

i

U Ao

=Y

E’.EE The DUS PUS Fme mun amm Pl Op§ men
‘ -
Figure 4.19 Horizontal Short

Ewark: et ive

i

T W WX

[ Sl ——— I

Eﬁﬁf The PUS THE Tme Tam e B il

Figure 4.20 Vertical Short

2} Press F1 or F2 to display the Ladder Element Function Menu,

An alternative method is to press a function key between F3 and F10 1o display the Lad-
der Element Function Menu, and then press F8 (-} or F9 (I} while holding down the Shitt
Key.

3) Press F8 (=) or F9 {D).
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4.1.8 Changing Elements

The horizontal or vertical short will be entered.

Bl B e ey M Eay M T4 T

Figure 4.21 Horizontal Short

[

L b W v ek M T T %d T

Figure 4.22 Vertical Short

Refer o A. Deleting an Elementon page 4-24or B. Deleting Vertical Shorts and Elements on
page 4-25 for more details on deleting horizontal shorts, or C. Deleting a Vertical Short on
page 4-26 0t B. Deleting Vertical Shorts and Elements on page 4-25for more details on delet-
ing vertical shorts. :

Shortcuts

Enter “HS" or “VS” at AR: and press the Enter Key to enterthe horizontal or vertical short
directly.

4.1.8 Changing Elements

The following procedure is used to change ladder elements that have already been input.
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Example: Chénging the ADD Instruction to TIMER (T0.1).

1} Move the cursor to the element (ADD) that will be changed.

— LA Wcelvs FLC: TESTT AK: NN

7|

181 C
m
,

Figure 4.23

2) Press F2 (TC).

The timer/counter function keys will appear.

I ——I

T1. 0. 7. g H
He i Yhe MER W2 3 -3, m

l

Figure 4.24

1

3} Press F2 (T 0.1}.

The element (TIMER) will be input, and the input field will appeatr.

Figure 4.25

Press the Esc Key at this point to cancel the change. The original element (ADD) will ap-
pear.
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e
4.1.9 Changing Reference Numbers

4) Enter the address and press the Enter Key.

WetTve PO TESTE W5 I |

The I TLE TR O Y 8 9 Wy

Figure 4.26

4.1.9 Changing Reference Numbers

The following procedure is used to change the reference number of ladder elements.

1) Move the cursor to the element with the reference number that will be changed.

Figure 4.27 : ‘

2) Press the Enter Key.

if a reference number is already entered at AR:, that value will be entered at the address
at the cursor position when the Enter Key is pressed. If nothing is entered when the Enter
Key is pressed, a range of addresses that can be entered will appear, and a message will
appear asking for the address at the cursor position. Enter the address and press the
Enter Key. The reference number can also be changed by selecting Cell from the Edit
Submenu. Here again, a message will appear asking for the address at the cursor posi-
tion.
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A range of addresses that can be entered will appear, and a message will appear asking
for the address. :

Luter vofeseare ounker
33 AMRAL-HRIYS LWHAL - 104%6 DAWI-01029 SUMI-5512 2M1H1-21299
HoH1L-ME A MS1EL-HY (4B NHBT - HUHAE

£Eai > te yue

Figure 4.28

3) Enter the new address and press the Enter Key.

T2 ictive

I

£C 4 MANS  JCNU. -2 FEC 'ENET %‘I
II.III. mwz m:llngt %‘E ,:WS l-\lfI "IIAI? i;l'-lll aw’ l’l

HUHiLZ —A]

Figure 4.29

4.1.10 Inserting

The following procedure is used to insert blank rows, columns, and networks.

Netuwork: OOG1 0881 CL76H fictive FLC: TESTL Ak:
H - i
ar Insert a blank network atter the Insert a network
network currently being displayed. block (Copy).
L Il .

P . Insert a blank row.
1 ‘ Insert a blank network prier to the

insert a blank coiumn. network currently being displayed.
? [ 1

Insert: 1.5olumn 2.ibw 3.Jext network 4.Frevious network 5.dlock

Figure 4.30 Insert Menu
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4.1.10 Inserting cont.

1. Inserting a Row

The following procedure is used to insert a blank row in a network.

1) Move the cursor to where the row will be inserted.

[~ Wictive FLE: TRRTI AN

l—‘—ﬂ»ﬂln*ﬁ"“_}
B The NS TUT PEHE WY OTN I 2B I
Figure 4.31

2) Press the Slash Key to display the Command Submenu.

[ 1.0ctive 2.0leck 2.[egizter 4.02it S.Mebal 6. Jenrch 7.Jnds 8. JHaw 2. Feil

Figure 4,32

3) Press F4 (Edit).
An alternative method is to enter “E” from the Command Submenu.

The Edit Submenu will appear.

[ |_—m_|m1-1—]
f Etit: 1.J011 2. 4Jecriptor 3. Jegnant 4.0haert 5.[elete G.zlapshet ?.[recesser '

Figure 4.33

4) Press F4 (Insert).
An alternative method is to enter “I” from the Edit Submenu.

The Insert Submenu will appear.

f Inzert: 1.Jolwan 2.0ww 3.0t netverk 4.[revieus netwerk 5.Meck

Figure 4.34 '
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5) Press F2 (Row).
An alternative method is to enter “R”™ from the Insert Submenu.
A row will be inserted.

A row cannot be inserted where an element crosses two rows or when there is no roomto
insert a row below the insertion position.

Swerki ctive

-—— Inserted row

Pz %5, oue wue sms xwn s s oge mon

Figure 4.35

Shortcuts

a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu. -

b} Enter“IM” at AR: and press the Enter Key, or press the Insert Key to display the Insert
Submenu. :

¢) Enter “IR" at AR: and press the Enter Key to insert a row.

2. Inserting a Column

The following procedure is used to insert a biank column in a network.

1} Move the cursor to where the column will be inserted.

{ = HME, —— - I

[ LC2 RAME O3] REL FEC EMET ID0T1
1‘-:5 kwe n{l“? n:?dl ,ws lJ.l:I "va ,WI wm LUn

Figure 4.36
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4.1.10 Inserting cont.

2) Press the Slash Key to display the Command Submenu.

% 1.Ictive 2.Flock 3.Degister 4.0dit 5. Elehal 6.8varch 7.0nde 8.0Hew ?.J0il

Figure 4.37
3) Press F4 (Edit).
An alternative method is to enter “E” from the Command Submenu.

The Edit Submenu will appear.

| -

Edit: 1.Je1l 2.dlkcripter 3.Bugment 4. Jhsert 5.Drlets 6.3lnpulet 7.Drecenzer

Figure 4.38

4) Press F4 (Insert).

An alternative method is to enter “I” from the Edit Submenu.

The {insert Submenu will appear. .

f Insert: 1.Bolwm Z.Jew 3.0ext astwerk 4.Jreviaus nutwerk 5. Jeck

Figure 4.39

5) Press F1 (Column).

An alternative method is to enter “C” from the Insert Submenu.

A column will be inserted.

Inserted column

I1SC C L1 [eRLce RANE  JCNURT -1 PEC ENET I%H.
1 rlﬂ! %3 e ’WS LV %7 ”M mws ]

Figure 4.40
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A column cannot be inserted if there is no room to the right of the insertion position.

Shortouts
a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.

- b) Enter“IM" at AR: and press the Enter Key, or press the Insert Key to display the Insert
Submenu.

¢} Enter "[(}” at AR: and press the Enter Key to insert a column directly.

3. Inserting a Network

The following procedure is used to insert a blank network.

1) Move the c(:rsor to where the network will be inserted.

2) Press the Slash Key to display the Command Submenu.

f' t.Detive 2.0leck 3.0egister 4. (it §.Mebal ¢.Farch ?.Dvie K. THew 73011

Figure 4.41

3) Press F4 (Edit).
An alternative method is to enter “E” from the Command Submenu.,

The Edit Suﬁmenu will appear.

f!ﬂ:: 1.3ell Z.decripter . Bagnent 4.0nvare S.delete 6. npehet 7.Grecazser

Figure 4.42

4) Press F4 (Insert).
An alternatiw_é method is to enter “I” from the Edit Submenu.

The Insert Submenu will appear.

f 1 Insort: L.Bolumn 2.00w 3.Jext metwerk 4.Brevieus natusrk 5.Mack

|
‘ Figure 4.43
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4.1.10 Inserting cont.

5) Press F3 {Next Network) or F4 {Previous Network).
An alternative method is to enter “N” or “P” from the Insert Submenu.

A network will be inserted immediately before or after the network currently being dis-
played.

Shortcuts

a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.

b) Enter“IM” at AR: and press the Enter Key, or press the Insert Key to display the Insert
Submenu.

c) Enter “INN” or “IPN” at AR: and press the Enter Key to insert a network immediately
before or after the currently displayed network.

4. Inserting a Network Block

The following procedure is used to copy and insert a block of networks.
1) Display the network that will be inserted.

2) Press the Slash Key to display the Command Submenu.

E 1.Jctive 2.[leck 3.0egister 4.(Kit S.J ekl 6. Jearch 7.Drndo 8.]Hew . Ji1

Figure 4.44

3) Press F4 (Edit).
An alternative method is to enter “E” from the Command Submenu.

The Edit Submenu will appear.

f Bdic: 1.3011 2 diiscripter 1. Jagment 4.Jasert 5.MTalete 6.slapebet 7.Jrecesser

Figure 4.45

4) Press F4 (Insert).
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h—_
An alternative method is to enter “I” from the Edit Submenu.

The Insert Submenu will appear.

f Inzert: 1.Bolumn 2.0aw 3.Jext network 4.Brevieus netwerk 5. {Nlack

Figure 4.46

5) Press F5 (Block).

F5 (Block) cannot be used if a network block does not exist. Referto 7. Defining Blockson
page 4-58 for more details on the procedure for creating a network block.

An alternative method is to enter “B” from the Insert Submenu.

A network block will be copied immediately before the network currently being displayed.

Shortcuts

a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.

b) Enter“IM” at AR: and press the Enter Key, or press the Insert Key to display the Insert
Submenu.

i
‘

4.1.11 Deleting

The following procedure is used to delete elements, cells, blank rows, blank columns, and
networks.

GL78H Active PLG: TESTL AR:

1
'

5} | Delete 2
Delete an element and cel! Delete a blank row network block
5 -
Delate an element Delate a blank column Delete a network
? b

Delete: 1.Jllement 2.cel® 3.%alunn 4.0ow 5.Tetwork 6.Mock

Figure 4.47 Delete Menu
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1. Deleting an Element

The following procedure is used to delete an element from a network.

A. Deleting an Element

1) Move the cursor to the element that will be deleted.

2) Press the Slash Key 1o display the Command Submenu.

| —
1.fecive 2.J0eck 3.0wgister 4.4t 5. Hebal C.Bearch 7.Tnde 8.7Hsw ?.Jei]

Figure 4.48

3) Press F4 (Edit).

An alternative method is t0 enter “E” from the Command Submenu.

The Edit Submenu will appear.

H ]

Edit: 1.Jnll 2 dJecripter 3.Begnent 4.0nsert 5.Dnlata G.xlnpibat 7. recesner

Figure 4.49

4) Press F5 (Delete).

An alternative method is to enter “D” from the Edit Submenu.

The Delete Submenu will appear.

% Dalste: 1.Mlement 2.colll 3.Jolumn 4.0ow 5.D0twerk &.[lsck

Figure 4.50

5) Press F1 (Element).

switch to Function Menus from the Ladder Element Menu for a function key between F1

An alternative method is to enter “E” from the Delete Submenu, or press the Shift Key to ‘
and F10, and then press F7 (Delete).
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The element will be deleted.

Shorteuts

a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu,

1

b) Enter“DM”at AR: and press the Enter Key, or press the Delete Key to display the De-
lete Submenu.

c) Enter “DE" at AR: and press the Enter Key 1o delete the element.

B. Deleting Vertical Shorts and Elements

1) Move the cursor to element (with the vertical short) that will be deleted.

twark: et ive

LA O .~ NS N

=

E’fri’ The S SUT WS WD STm 3 Zam mwn

2) Press the Slash Key to display the Command Submenu.

t.Iktive 2.0leck J.Teyister +.0dic S.Jekal 6.Jearch 7.Tnis 0.0Hew . il

]

H -

Figure 4.51

3) Press F4 (Edit).
An alternative method is to enter “E” from the Command Submenu.

The Edit Submenu will appear.

| —
Fdit: 1.]e1) 2.dJecripter 3. Fagnent 4.Oneert 5.Dnlete 6.sTnpaint 7. 0-scesser

Figure 4.52

— 425 —



Offline Editing
4.1.11 Deleting cont.

4) Press F5 (Delete).

An alternative method is to enter “B” from the Edit Submenu.

The Delete Submenu will appear.

[ [_»1tuuvix— ]
Delete: 1.Jlement 2.celll 3.Joluna 4.Jew 5.Ietwerk €.Mlack

Figure 4.53

5) Press F2 (Celi).
An alternative method is to enter “L” from the Delete Submenu.

The element and vertical short will be deleted.

Shortcuts
a) Enter “EM” at AR: and press the Enter Key to dispiay the Edit Submenu.

b} Enter “DM” at AR: and press the Enter Key, or press the Delete Key to display the De-
lete Submenu.

c) Enter“DEL" at AR: and press the Enter Key to delete the element and vertical short. ‘

C. Deleting a Vertical Short
1) Move the cursor to the vertical short that will be deleted.

1SC (- LE1 LC2 FANE  BCNURT X1 PEC ENET 1
i ¥ m?.ua i 4 'IAIS ws '?JJ') Bw: ul-l!

2) Press F1 or F2 to display the Ladder Element Function Menu.

An altermnative method is to press a function key between F3 and F10 to display the Lad-
der Element Function Menu, and then press F10 (:) while holding down the Shift Key.

I—mmm. —!

wawm%wvmw

Figure 4.54 ‘
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3) Press F10 (3).
The vertical short at the cursor position will be deleted.

Shortcuts

Enter “OS” at AR: and press the Enter Key to delete the vertical short at the cursor posi-
tion. ‘

2. Deleting‘a Row

The following procedure is used to delete a blank row from a network.

1} Move the cursor to the row that will be deleted.

2) Press the Slash Key to display the Command Submenu.

‘ I‘“MMIM] ‘—-i
1.0ctive 2.Qleck 3.[uyister 4.0Kit 5. Bisbal 6. Boarch 7.Dnds 8. JHew 7. 3011

i
i

Figure 4.55

3) Press F4 (Edit).

An alternative method is to enter “E” from the Command Submenu.

The Edit Submenu will appear.

. fﬂiﬂ 1.3011 2.00ecripter 3. Begment 4.0Dnsere S.[elate ‘.l:h)lr
Figure 4.56
4) Press F5 (Delete).

An alternative method is to enter “D” from the Edit Submenu.

The Delete éubmenu will appear.

H ? -

Belets: 1.Menent 2.colll 3.3nlunn 4.00w 5. Detwerk 6.Dleck

Figure 4.57
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5) Press F4 (Row).

An alternative method is to enter “R” from the Delete Submenu.

The row will be deleted.

A row cannot be deleted if there is an element in the row.

Shortcuts

a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu,

b) Enter“DM” at AR: and press the Enter Key, or press the Delete Key to display the De-
lete Submenu.

c) Enter “DC” at AR: and press the Enter Key to delete the row. ‘l
3. Deleting a Column
The following procedure is used to delete a blank column from a network.

1) Move the cursor to the column that will be deleted.

2) Press the Slash Key to display the Command Submenu. «

% L. Jetive 2.Meck I.Degissar 4.JMit 5.Flabal 6.Juarch 7.Inde 8. DJev Y. Joil

Figure 4.58

3) Press F4 (Edit).
An alternative method is to enter “E” from the Command Submenu.

The Edit Submenu will appear.

[ I—ﬂﬂﬂﬂl—il
Edic: 1.J01l 2.d0ecripter 3. Jegmant 4.Dnsert S.Galete &.3Japahet ?.Brocesrar

Figure 4.59

4) Press F5 (Delete).
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An altemative method is to enter “D” from the Edit Submenu.

The Delete Submenu will appear.

5) Press F3 (Column).

Figure 4.60

An alternative method is to enter “C” from the Delete Submenu.

The column will be deleted.

A column cannot be deleted if there is an element in the column.

Shortcuts

a) Enter “EM" at AR: and press the Enter Key to display the Edit Submenu.

1

b) Enter“DM”atAR: and press the Enter Key, or press the Delete Key to display the De-
lete Submenu.

c) Enter “DR” at AR: and press the Enter Key to delete the column.
4. Deleting a Network
The following procedure is used to delete a network that is being displayed.
1)} Move the cursor to the network that will be deleted.

2} Press the Slash Key to display the Command Submenu.

f 1.Jotive 2.00sck 3.Oeyivter 4.[Hit 5. Flebal 6.Bearch 7.0nde 0.THew 7. 211

Figure 4.61
3} Press F4 (Edit).

An alternative method is to enter “E” from the Command Submenu.
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The Edit Submenu will appear.

| q

[— HHWAL ——l

Edit: 1.Fwll 2. .d@scripter 3.Deymant 4.0nsert 5.Dnlece G.adnpshat 7.0recesser

Figure 4.62

4) Press F5 {Delete).
An alternative method is to enter “D” from the Edit Submenu.

The Delete Submenu will appear.

H - d

Dulste: 1 Hewsnt 2.cell 3. Jelunn 4.[ow 5.Jetwerk 6.[Reck

Figure 4.63

5) Press FS (Network).
An altemétive method is to enter “N” from the Delete Submenu. ‘l

A confirmation message asking whether to delete the network will appear.

< LCL LC2 RAMS  JCMURT RRL FEC ENET ot
m:: - m’-‘l! %4 xl-i-l‘S e n!{\i? ,Wl ulﬂ! e

Figure 4.64

6) Check to see if the contents of the confirmation message are correct, and if so press “Y”
and the Enter Key to delete the network. “N” is initially entered so the deletion can be
canceled in case the Enter Key is pressed by mistake.

Shortcuts €|

a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.
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b) Enter“DM”at AR: and press the Enter Key, or press the Delete Key to display the De-
lete Submenu.

¢) Enter “DN" at AR: and press the Enter Key to delete thé network.

5. Deleting a Block of Networks

The following procedure is used to delete a block of networks.

1) Press the Slash Key to display the Command Submenu.

i——mim—!l ——]
ctuork e ks MM - Wiy
B T3 «Dleck 3.0

yirter 4. Wit S.Fakal §.Jearch 7. Dvde B.Biew v. 3011

Figure 4.65

2) Press F4 (Edit).

i
An alternative method is to enter “E” from the Command Submenu.

The Edit Submenu will appear.

r—m-u-m: ﬁl
AL - HHME T

scripter 3. Jegnent 4.0neare 5. Delote C.xlnpshe:r 7. [hecenser

rt ek flae ko

Figure 4.66

3} Press F5 (Delete).

An alternative method is to enter “D” from the Edit Submenu.

The Delete Submenu will appear.

{mnm —

P
i

o4 2.colll 3. Jolumn 4.Jaw §.Detverk 6. [Mleck

Figure 4.67
4) Press F86 (Block).
F6 (Block) cannot be used if a block of networks does not exist.

?
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4.1.12 Undoing the Last Change

An alternative method is to enter “B” from the Delete Submenu.

A confirmation message asking whether to delete the block will appear. ‘I

Figure 4.68

5) Check to see if the contents of the confirmation message are correct, and if so press “Y” ‘l
and the Enter Key to delete the block of networks. “N” is initially entered so the deletion
can be canceled in case the Enter Key is pressed by mistake.

The block of networks will be deleted.

Shortcuts
a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu. ‘l

b) Enter“DM"at AR: and press the Enter Key, or press the Delete Key to display the De-
lete Submenu.

4.1.12 Undoing the Last Change il

The following procedure is used to undo the last change.

1) Press the Slash Key to display the Command Submenu.

{ 1.Tetive 2.[0eck 3.Oegistar 4. 41t S.Kebal & Bparch 7.Jnde 0.THew 1. Jeil

Figure 4.69

2) Press F7 (Undo).

An alternative method is to enter “U” from the Cormmand Submenu.
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The Undo/Redo Submenu will appear.

f UnduRada: 1.Jvdo lazt change 2.0kds changer 3. Jlsar all changes

Figure 4.70 .
3) Press F1 (Undo Last Change).

An alternative method is to enter “U” from the Undo/Redo Submenu.

The last change will be undone.

The last change cannot be undone from another network. Deletions, copies, and other
actions for entire networks also cannot be undone.

Shorteuts

a) Enter “UM” at AR: and press the Enter Key, or press the Alt + U Keys to display the
Undo/Redo Submenu.

b) Enter “UN” at AR: and press the Enter Key to undo the last change.

4.1.13 Redoing the Last Change

The following procedure is used o restore the status prior to undoing the last change.

1) Press the Slash Key to display the Command Submenu.

f 1.Tkcive 2.Bleck 3.0ugister 4.345t 5.Pebal 6.Jarch 2. Drie 8. Hew 2. Joid

1

Figure 4.71
2) Press F7 (Undo).

An alternative method is to enter “U” from the Command Submenu.

The Undo/Redo Submenu will appear.

f Unde Bade: 1.Tnis Iaxt chengs 2.0wde changes 3.JBlear all changes

Figure 4.72
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4.1.14 Clearing All Changes

3) Press F2 (Redo Changes).

An alternative method is to enter “R” from the Undo/Redo Submenu.

The status will be restored to what it was prior to undoing the last change.

After a change is undone, it cannot be redone if another change is made.

Shortcuts

a) Enter “UM” at AR: and press the Enter Key, or press the Alt + U Keys to display the
Undo/Redo Submenu.

b) Enter “RE" at AR: and press the Enter Key to redo the changes.

4.1.14 Clearing All Changes

The following procedure is used to undo all changes made since the current network was
displayed.

1) Press the Slash Key to display the Command Submenu.

F 1.Jetive 2.00eck 3. Degister 4. it 5.Flebal €. Bearch 7.Inde 0.1Hew 7.B0il

Figure 4.73

2) Press F7 (Undo).

An alternative method is to enter “U” from the Command Submenu.

The Undo/Redo Submenu will appear.

f Unde/Reds: 1.0nde lazt changs 2.0side changaz 3.Jiear all changes

Figure 4.74

3) Press F3 (Clear All Changes).

An alternative method is to enter “C” from the Undo/Redo Submenu.
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All changes to the network being displayed will be cleared.
Only changes made to the currently displayed network will be cleared.

Shortcuts

a) Enter “UM” at AR: and press the Enter Key,
Undo/Redo Submenu.
i

or press the Alt + U Keys to display the

b} Enter “CAE” at AR: and press the Enter Key to clear all changes.

4.1.15 Searching

The following procedure is used to search for s

pecified addresses or instructions {ladder ele-
ments). '

1. Searching for Addresses
1) Press the Siash Key to display the Command Submenu.

[1
{ 1.3ctive 2.[ock 3. 0epictor 4.(Hit 5.XNobal 6.Jearch 7.Jnde B.JHeu 7. Jni)

Figure 4.75
2) Press F6 (Search).

An alternative method is to enter “8" from the Command Submenu.

A screen for specifying the address will appear,

taarch
u' i Address : RN

<PAUIP>> Mddress<-Addr & Ineec~>Inatrugtion<->Table Search <=CPGIN)
<Ezc) te Quit {Enter) te Dogin

Figure 4.76

3) Enter the address and press the Enter Key.

[ P ———

CPQUP) Bddresa<=2ddr & Insg{->Inatruct isn{—>Takls twarch C—<PCDM>
<Esc) vo GQuit {Enter> ts Begin

Figure 4.77
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A confirmation message will appear asking whether to execute the search.

fddrezz L
(PGUP>-)> Addrszzl->Mddr & Inst{->Instructisn{->Takls Seatrch {—CPGIN>
{Ezc)> te Quit CEnter> te Beyin

Figure 4.78

4) Confirm by entering *Y", and press the Enter Key.
Enter “N” and press the Enter Key, or press the Esc Key to cancel the search.

A search will be executed.

Figure 4.79

The first occurrence will appear, and the cursor will move to that address.

Ri—1 —

A

ISC (4 1> 7 44y, <Emter} t Cay, 3 finizh EMET 1
PHH. i!wI! Fross wr) te stay, {Exc !_plw’ mm

Figure 4.80 ‘

Processing after a Search
Editing the network displayed: Press the Enter Key.

(The search will end at that network.)
Displaying the previous occurrence: Press the Up Cursor Key.

Displaying the next occurrence: Press the Down Cursor Key.
Ending the search and returning to the original network:
Press the Esc Key.
Switching search screens: Press the Page Up or Page Down Key.
Shortcuts

Enter “S” at AR: and press the Enter Key, or press the Alt + S Keys to display the screen ‘
for specifying the address.
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m
2. Searchihg for Instructions and Addresses

1) Press the Slash Key to display the Command Submenu.

f 1.3ctive 2.Mack 3.Degizcer 4.[024¢ $.Bekal 6.Poarch 7.0nie 8. JHew 7. 2011

Figure 4.81

2) Press F6 (Search).
An alternative method is to enter “8” from the Command Submenu.

A screen for specifying the address will appear.

1

!r““ s ——

CPUPY~> Adidress(—>Midr & Inat<->Inztruct ian(->Tabls Laarch <—(PCDM>
CEac)> te Quit <Enter> te Begin

Figure 4.82

3) Press the Page Up Key.

1

A screen for specifying the address or instruction will appear.

Eearch
I[ Adiruss + I
Thstruction :
I

PGUR3-> Addrerz<-Xddr &_Inst<(-3astructisnd~Tadle $oaveh L—CPCDN
<Ese> te Quit {Eatur) te Begin LT3/K4> Mave of Curesr

Figure 4.83
4) Enter the ac;idress and press the Enter Key, or press the Down Cursor Key.
Move the Cl.jH'SO!' down.
5) Enter the instruction {(mnemonic) and press the Enter Key.

The elemeni mnemonics will appear together with instructions at the function keys, and
can be selected by pressing a function key.

Ssarch
Addyw : SRt
ﬂ-l Thstruceien [T

<PCUPY=> Nddrase(-Mddr B_Inat{->lastruckisn<->Table Learch <—CPGDNY
<Enc> te Quit <Enter> te Bogin LI3/¢1> Mava of Curar

Figure 4.84
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A confirmation message will appear asking whether to execute the search.

-~

|

Sesarch

Aidress s i
Inztructisn @ NOC
<PQUP-)> Mdrass<->Adir & lnot<->lnltmi:ehn<->llhh Search <=<PCDH>
L

<Esc> to Quit <Enter)> to Be {13/1> Mave of Curssr

Figure 4.85

6) Confirm by entering “Y", and press the Enter Key.
Enter “N” and press the Enter Key, or press the Esc Key to cancel the search.

A search will be executed.

Figure 4.86

The first occurrence will appear, and the cursor will move to that address.

twark: LG T Wctlve FLOT TESTT AR |

1se niﬂ Press <1 7 K>, CEnter) te stay, (Eac) fuhh.]hracgr mwT1

Figure 4.87

Processing after a Search
Editing the network displayed: Press the Enter Key.
(The search will end at that network.)

Displaying the previous occurrence: Press the Up Cursor Key.

Displaying the next occurrence: Press the Down Cursor Key.
Ending the search and returning to the original network:
Press the Esc Key.

Moving the Cursor

Switching search screens: Press the Page Up or Page Down Key. ‘
Address/mnemonic: Press the Up or Down Cursor Key.
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Shortcuts

Enter “S” at AR: and press the Enter Key, or press the Alt + S Keys to display the screen
for specifying the address.

3. SearchinQ for Instructions

1) Press the Slash Key to display the Command Submenu.

f 1.Iktive 2.[leck 3.0egizeer 4.[it 3.Bekal 6.Bearch 7.Thie 8.JHaw ¥.Jeil

Figure 4.88
2) Press F6 (Search).

An altemati\}e method is to enter “S” from the Command Submenu.

A screen for specifying the address will appear.

!r“"‘ T —

SPQUPI=> Mdrsss(->tddr & Insc<->Inztructisnt-3Takle Search (~(PCIN>
<Fzcd te Quit {Entar) _ta Beyin

Figure 4.89
3) Press the Page Up Key twice.
An input screen for entering the instruction (mnemonic) will appear.

The element mnemonics will appear together with instructions at the function keys, and
can be selected by pressing a function key.

Searceh
il
I[ ' Inztruction @ NN

{PGUP>-> Addrezs(-8ddr & Inst{->Inztructisnd->Takls Search {—~PCIN>
<Esc)> te Quit CEnter) te Begin

I Figure 4.90

4) Enter the instruction (mnemonic) and press the Enter Key.

Search
l{ Instruction : CIINEEE

PGUF>=> Address(-Dhddr & lnec<->lastructisnC=>Tably Swarch <=CPGDN>
<Ezc)> ta Quit CEntar) te Bayin

Figure 4.91

—4-39 —



Offtine Editing
4.1.15 Searching cont,

A confirmation message will appear asking whether to execute the search.

. D

Iastruction = NOC

CPGUP>—> Addrezs-idr & [ast{->Instruction(=>Tahls Search <(—CPCDN>
€Ezc> te Quit <Enter} to Bagin

——

Figure 4.92

5) Confirm by entering “Y", and press the Enter Key.
Enter “N” and press the Enter Key, or press the Esc Key to cancel the search.

A search will be executed.

Figure 4.93

The first occurrence will appear, and the cursor will move fo that address.

tvork: GalE/BEE % Wceive FLC: TES1L  AK: |

T
W

18C C {| Prazz <1> 7 <I>. <Enter> tu stay. {Exc) finiah ENET qgl’l.
Lyt F' Ii — a wr R

Figure 4.94

Processing after a Search
Editing the network displayed: Press the Enter Key.
(The search will end at that network.)
Displaying the previous occurrence: Press the Up Cursor Key.
Displaying the next occurrence: Press the Down Cursor Key.
Ending the search and returning to the original network:
Press the Esc Key.

Switching search screens: Press the Page Up or Page Down Key.

Shortcuts

Enter “S" at AR: and press the Enter Key, or press the Alt + S Keys to display the screen ‘
for specifying the address.
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4. Displaying a List of Found Addresses

The following procedure is used to display a fist of networks found with a specified ad-
dress (instruction) after a search is completed.

1) Press the Slash Key to display the Command Submenu.

f i.lctive Z.[eck J.Cegister 4.Jdit 5.Mlsbal 6.Bearch 7.Inde 8.Disv ¥.Jpil

Figure 4.95
2) Press F6 (Search).

An alternative method is to enter “S” from the Command Submenu.

A screen for specitying the address will appear.

= Esarch

Address ]

CPAIP>=> Address<->Mddr & Inat<{->Instructisn<->Tapble Ssarch PG>
{Esc)> te Quit {Enter)> ts Begin

Figure 4,96

3) Press the Page Up Key three times.

A screen for specifying a list search will appear.

Mddrexs s An
<PQUP)> Mddrezal-Mdir & In-:(—)lnstmthn(-)fﬂh Ssarch (—<PCDN>
{Epace> ts Tagyle <Esc) te Quit {A1t-E> to Pegin

Table Search
Netwark renge: W
Inzstyuctisn : Specify Mnemsnic :

Figure 4.97

4) Enter settings needed for the search, and press the Alt + E Keys.

1

Takle Search
ll[ Hatwerk renge: All Legic

Instruction : Lpecify Wnemenic : MOC

L] 2
e e e
CPEUPY-) Mdidress-d0ddr & Inst<-inztructiont sTakle Foon
<Exc> te fuit CAIt-E> te Bagin

Figure 4.98

A search will be executed.

. Figure 4.99
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Occurrences will be displayed as a list after the search is completed.

e —————|
| Search Matches }
Pasabase: TEST1 Holp: <Alt-H>

The follswing matchas ware Found:
Network No.
<Emc? to Quit
Quick Find: I S

Figure 4.100

A maximum of 40 network numbers matching the search criteria will appear per screen. If
the desired network number does not appear on that screen, press the Page Up or Page
Down Key to display previous or next screens.

5) Move the cursor to the number that will be displayed and press the Enter Key.

The network will appear, and the cursor will move to the relevant element.

twork: SBGL 0LE cxive

-t
Ll

q & » Tabls. ter) te Stay ... -!]
185 Preza {13 / (1), {Nema) Fer CEater) te £t ivicired

Figure 4.101

Processing after a Search

Moving to the previous or next relevant element from the screen displayed:
Press the Up or Down Cursor Key.

Stopping at the network displayed: Press the Enter Key.

Returning to the original network: Press the Esc Key.

Returning to the list: Press the Ctrl + Left Cursor Key.

Settings

A. Network Range

All logic: Search for all networks (including SFC action, transition condition, and
subroutine circuits) in the database.
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Current area:  Search only the program area currently displayed.
Block: Search networks defined as a block.

From the cursor position:
Search the current area from the present cursor position to the end of the
area.

Specify: Specify a network range to search.

Example: Specifying an Area from Network 1 to Network 10.

Network range: Specify 1 through EEEE (Maximum of 22)

1

B. Instructions (Specify the Desired Instruction (Ladder Element).)

Specify: Mnemonicitems will appear. Specify the desired element using the mnemonic.

H

The element mnemonics will appear together with instructions at the function
keys, and can be selected by pressing a function key.

Exémple: NO Contact (4 )

Instruction:  Specify Mnemonie: ?@Iﬂ

Specify with the mnemonic of the element.

Any: Search all elements.

1

C. Address (Specify the Desired Address.)

Specify: Search items will appear. Enter the desired address or range.

Any: Search all addresses.

i

Moving the Cursor

Switching Setarch Screens: Press the Page Up or Page Down Key.
Moving to the next or previous item: ’
‘ Press the Up or Down Cursor Key.
Moving to the next item: Press the Enter Key.
Reversing items: Press the Space Key, or the Left or Right Cursor Key.
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Shortcuts

Enter “S" at AR: and press the Enter Key, or press the Alt + 8 Keys to display the screen ‘
for specifying the address.

4.1.16 Editing Registers

Register Editor is used to edit numbers stored at register addresses. Some registers are write
protected and cannot be edited. The addresses listed below can be edited.

40001 to 40512: Output registers
40513 to 49999: Holding registers
RO001 to R1024: Llink registers
50001 to 50512: Time registers
AD001 to A7FFF: Expansion registers

1. Displaying the Register Editor Screen

There are two ways to display the Register Editor Screen using the cursor.

A. Cursor on an Element with a Register Address

When the cursor is on an element with a Register Address, the contents of the register for
that element will be displayed.

1) Press the Slash Key to display the Command Submenu.

f 1.0ceive 2.0knck 3.0eginter 4.[lit 5_.Mlekal 6. Bearch ?.Jnds 8.JHew 4311

Figure 4.102

2) Press F3 (Register).

An alternative method is to enter “R” from the Command Submenu.

The Register Editor Screen will appear.

L :tu- Tar Wetwork: WL Felp: ALc—H>
Bescriptien | Moy ¢ Dec | Wex ]#sciz
- M aSEE | saNS
urce ] w il | eBEO
l_ wrca  BE3 | 4Rl ehh | el
£t Saurce P 40984 008 | aee
! Sewrcs  BES| 4DORS N | ek
Dazt | 48818 |mes | e
Dazt 2 48811 e | e
Dast G| A2 e | e
Bast: 4| 40811 S | et
best L 1] aae | e
i — Al '——! '
Binary Edic: st bit ar bit et AL) lank all
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Moving the Cursor

Moving up :or down a screen: Press the Ctrl + Page Up or Page Down Keys.
Moving up or down: Press the Up or Down Cursor Key.
Moving to the next or previous page: Press the Page Down or Page Up Key.

+ When moving to the next or previous page, 17 addresses continuing from the next or
previous page will appear.

+ When moving up from the top row or down from the bottom row, the addresses being
displayed will shift up or down by one.
Shortcuts

Enter“ER” at AR: and press the Enter Key, or press the Alt + R Keys to display the Regis-
ter Editor Screen.

B. Cursor Not on an Element with a Register Address

If the cursor is on an element without a register address or in a position without an ele-
ment, a window will appear to enter the register address that will be edited or displayed.

1) Press the Slash Key to display the Command Submenu.

F 1.Tetive 2.[Meck 3.Qegiscer 4.[Hit 5.Flabal . Jearch 7. Jnde 0.Diew ¥.3uil

1

Figure 4.103

2) Press F3 (Register).

An élternative method is to enter “R” from the Command Submenu.

The Input Address Window will appear.

The Input Address Window will already have 40001 entered when it first appears. Enter
the address and press the Enter Key to change the address in the window.

Figure 4.104

. The Register Editor Screen will appear.
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3) Enter the address that will be edited and press the Enter Key.

Yegiater Elltor Fatwerk: S0R1 Walp: GRIeH>?
Description | Reg & bac | uex [ascis

b2
Al

3
bl 4
4min S
e
Lt

|—‘1 M | —— I

Binary Edic: et bit lear Wit st A1l Lank all

Figure 4.105

The first 17 consecutive addresses from the specified address will appear,

Moving the Cursor

Moving up or down: Press the Up or Down Cursor Key.
Moving to the next or previous page: Press the Page Down or Page Up Key.

« When moving to the next or previous page, 17 addresses continuing from the next or
previous page will appear.

* When moving up from the top row or down from the bottom row, the addresses being
displayed will shift up or down by one.

Shortcuts

Enter “ER” at AR: and press the Enter Key, or press the Alt + R Keys to display the Input ‘
Address Window.

2. Editing Procedure

Register address data will appear in binary, decimal, hexadecimal, and ASCII. Move the
cursor to the respective field and edit the field. Changing one field will automatically
change the other fields.

Moving the Cursor
Moving to the binary, decimal, hexadecimal, or ASCII areas:

Press the Ctrl + the Left or Right Cursor Keys ‘
Moving left or right in the binary area: Press the Left or Right Cursor Key.
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A. Editing in Binary

i
When the cursor is in the binary area, a Binary Edit Menu will appear in the label area at
the bottom of the screen. Move the cursor to the bit to be edited and set the bit.

.
o
1
o

ter [tar twwrk:
I'é'ﬂ
Descriptisn [ Mgy B

AECII

HIH
HilHH

BMn Edits et it lear bit wk A1l lank all

Figure 4.106

Changing individual bits to 1 (ON): Press F1 (Set Bit), orenter a 1.

Clearing a bit (OFF): Press F2 (Clear Bit), or enter a 0. )
Changing all bits to 1 (ON): Press F3 (Set All).
Clearing ali bits (OFF): Press F4 (Blank All).

B. Editing in Decimal

Pressthe Ctrl + the Left or Right Cursor Key to move the cursor to the decimal area. Enter
the number in decimal.

'l:é'm‘m..—.. Fetwerk: WL

wlp: t
TESTL
Description | Ney & Binary Bec_ | Mex [nzenn
oy Sceces suverves | "HLY | Soe
slding vey [ 40083 | DEGONGESSeeeswee | seew | Beso
ny 43084 | 50000000-90000000 ( oues | sees
GUIA] oy | e | oeeessesteeens | Sove [ Sess
olding ray | Swmws 00 | seee
oy roy | Gemsess sesseres o
a3 o3 ,-:' SSiasees weasuse | Sees | Boss
rog | sam Sooetes | seee | sess
g roy | 408y souonese | sen | vese
ng rey | 48812 | socosEss-eeeeesss | bees | nese
nyg 483 [ [ ]
aliing reg $35:4 | seoesses-seeeeess | oes | mesd
 idin Sasy! MOSSates-sueateas | seee | seee
» 6 | S608086s-00sebues | seea
| BEEEIE M=

Figure 4.107
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C. Editing in Hexadecimal

Press the Ctrl + the Left or Right Cursor Key to move the cursor to the hexadecimal area. .
Enter the number in hexadecimal.

E‘!En- Edlter Wetwerk: SOl Halp: Thlc-W>
THN
Pescriptisn I Rey Rinary Hex {RECII

AdAH L

a

d
L
HEIHIHE

g rog | 8810
rag 48811
rey | 40812
rey | 40813
ng reg | 404
s
rog | 4OM2E
roy | 40W17

i

{mam ——

1 nonte s CHUMA bEEED

Figure 4.108

D. Editing in ASCII

Press the Ctrl + the Left or Right Cursor Key to move the cursor to the ASCl| area. Enter

the ASCII text.
T‘d!ﬁlur Editer Ratwark: EL Felp: ¢RTTHY
Duscription | Rey Binary dec | Mex {ascix
Wmi g Sobhotes-S00000as | sese | wews | DN

ny ray | 4 Senotadd-Sossesss | Sawe | seee

sliing reg PASESEDD o8 | Sabs | eses

o reg | 4wt ESAANES- 80 | saes

m rog | 4nmes SENSANE beoe | ssse

1} roy | smmas SINEN0S 88 | esse

wlding rey | 48087 = mes | seee

sliing rey | abbt Soesesse-seastens | 5080 | B8

reg | st 000000 S0000R0S | G888 | BESE

reg | 40010 SOSES00S-00000NNN | 088 | BaSG

olding rey | 48811 OOOEEESS-S0R00NN | PRSe | SMeG

ny rey | AOB12Z SROGORGE-00000000 | OV | Shis

olding rey | 40813 SELG00E-S0A00000 | DOOS | Seed

olding rey | 40814 SOSSE0G-S0N0000 | 0908 | bete

olding rey | 48815 SOLBESS-DS0RRRS | e | Soew

olding rey | 48815 SOLBOESS-0000000E | mak | Sd08

olding rey | 49817 SLESEEG-00000008 | BeiG | wee

Figure 4.109 ‘

4.1.17 Editing Coils and Relays

The following types of editing and displays are available for coils and relays.
« Setting disable and enable status (Forced ON/OFF)

» Displaying coil use status

« Searching for duplicate coils

« Searching for coils from relays (trace/retrace)
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1. Setting Disable and Enable Status (Forced ON/OFF)

Coils can be disabled so that coils and relays can be forcibly tumed ON or OFF. When a
coil is disabled, ON and OFF control from a scan will be ignored, and only forced ON and
OFF control from the computer will be possible. The Enable/Disable function is used to

simulate the operation that will be performed when the program is actually written to a
Processor.

1) Press the Slash Key to display the Command Submenu.

f 1.Dcvive 2.Fleck 3.Ougivter 4.04It 5. Mebal 6. Foarch 7. Tnds 8. Tiow 3.3011

Figure 4.110
2) Press Fg (Coil).

An alternative method is to enter “C” from the Command Submenu.

The Coil Submenu will appear.

f Coil: i.Dhabls 2.Disakle 3.2n 4.0F S.edit diJable ¢.Dead ?.0Qrece 8. {ntrace

: Figure 4.111

3) Move the cursor to the coil or relay to be disabled.

4) Press F2 {Disable).

An alternative method is to enter “D” from the Coil Submenu.

{

The coil or relay at the cursor position will be disabled.

“DF” or “DN” will appear at the coil with that address if it is disabled.
DF: Disabled and turned OFF
DN: Disabled and turn ON

Figure 4.112
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5) Press F3 (ON) to disable and turn ON the coil or relay.

An aiternative method is to enter “O” from the Coil Submenu.

Figure 4,113

6) Press F4 (OFF) to disable and turn OFF the coil or relay.

An alternative methed is to enter “F" from the Coil Submenu.

Figure 4.114

7) Press F1 (Enable) to cancel the disable.

An alternative method is to enter “E” from the Coil Submenu. F/N or DF/DN will disappear
when Enabie is selected.

When one coil or relay is enabled or disabled, then all other coils and relays at that same ad-
dress will be enabled or disabied.

Note A coil or relay that is not disabled cannot be turned ON and OFF.

Shortcuts

a) Enter “CM” at AR: and press the Enter Key to display the Coil Submenu.

b) Enter “DIS” at AR: and press the Enter Key to disable the coil or relay at the cursor
position.

c) Enter “FN” at AR: and press the Enter Key to disable and turn ON the coil or relay.

d) Enter “FF at AR: and press the Enter Key to disable and turn OFF the coil or relay.

e) Enter “EN” at AR: and press the Enter Key to cancel the disable.

2. Disabling from the Disable Table Edit Screen

The following procedure is used to display the disabled status of a maximum of 510 ad- ‘
dresses on screen to tum them ON or OFF.
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1) Press the Slash Key to display the Command Submenu.

{' t.Detive 2.Mack 3.Drxtntar 4.0dit 5. Xiebal 6. Buarch 7.Dnde . Haw 7. 0011

Figure 4.115

2) Press Fg (Coil).

An alternative method is to enter “C” from the Command Submenu.

The Coil Submenu will appear.

i

fﬁ.ﬂ: 1.Gnakle 2.Bicable 3.0 4.00F S.edic diBable 6.0xed 7.frace 8. Datrace

, Figure 4.116

|
i

3) Press F5 (Edit Disable).

An alternative method is 1o enter “S” from the Coil Submenu.

The Coil Disable Table will appear.

COTL BITATLE TANLY
EL23456 78 22456789 123456789
it :  FOOFFPRO BaR1x: —OFOFOPOF- 23
SE3x: (O P | e |t
e S o | ot | e int]
i B Miix
zgrg e ] %2:: — g;: ———
1T S P ————
i s ———— 20—
PRy —— -32.\‘. e r—— M23x: —————
24dx: ———— 25N ~——rrer—— M2hx: ———————
27— " ———— Yy e
i ——— ML x: ————— [T ————
i ————— A ———— S ————
MIhx: ————m MIPx: ——— M ————
M ———— WAl —— e Bl ————
B —— | Pt | il
W45 i | aroH
Rt —————— Lt ey —
—:_ENABLE 0 - Coil Bivabled (On) ¥ = Coil Disabled (OFL>
Wex & ! Pe < IPrev P, SPyDnNaxt P
&2 te Return xt Pa
Jpadie 2.2 3. 1 r!-l‘-ll"ll

Figure 4.117
Editing Procedure
F1orE: Enables the status of the address at the cursor position.
F2 or 8: Disables the status of the address at the cursor position.
F3 or O: Tums ON the status of the address at the cursor position,
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F4 or F: Turns OFF the status of the address at the cursor position.
F5 or A; Enables the status of all addresses. ‘

F6 or C: Changes the type of address. The type of address changes as shown below
each time the key is pressed.

Coil » Link Coil — Input Refay - M, N Code Relay
(From 00001} (From D0001) (From 10001} (From N, Mxxxx}

Enter an address in the Quick Search field to display the page with that address.

Moving the Cursor

Next or previous page: Press the Page Down or Page Up Key.
First or last page: Press the Ctrl + Page Down or Page Up Keys.

Shortcuts

a) Enter “CM” at AR: and press the Enter Key to display the Coil Submenu.

b) Enter “EDT" at AR: and press the Enter Key to display the Coil Disable Table.

3. Displaying Coil Used Status

The following procedure is used to display the Coil Used Table.

1) Press the Slash Key to display the Command Submenu.

[’ 1.Jccive 2.000ck 3.Megister 4.Jiic S.BFabal 6. Bearch ?-Thde 1. Jiew 9.D011

Figure 4.118

2) Press F9 (Coil).

An alternative method is to enter “C” from the Cornmand Submenu.

The Coil Submenu will appear.

f Coil: 1.Qrable 2.Hizabls 3.3 4.00F 5.edit ¢iBable .Jeed 7.Jrace f.0ncrace

Figure 4.119 ‘
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3) Press F6 (Used).
An alternative method is to enter “U” from the Coil Submenu,
The Coll Used Table will appear.

Coils in use will appear with a “U."

1

— COILYED TABLE
123456789 23456 78Y 123456789
e eetd sl lix: —WUN——— 02 2
Sy —u:u-— i — S
Bz —— ) 'y ™
Sy g e iy
| R T D)X e L ——————
L T A ——————— P ———————
[l e Y ——————— R ——————
21y e S22 23y
[y e — [ — [T o —
BRZ7x D e BR2EE Ry e
[T o — [ e — [t e ——
W3y, ————— M ————me S ——
M ———e AP m—— T N—
me F+iph f-t7on
X! —— s 3 —
BB45x: . B e
[ Y .I’:: ———— S ——————
= ¢ Cail Unused U i Cpil Used
SWICK SENBGH: te Ret LPelp>Prev P, {Pgbny>Hext P
el. Ehil:“t‘nlh 2.’-‘1-:.-.&.! e
1 .
Figure 4,120

Operating Proéedure

« F1 or R: Rebuild Table
Checks duplicate coils. {Refer to 4. Searching for Dupficate Coils on page 4-53.)

i

sF2orC;
Switches betwgen Coil and Link coil.

» Quick Search:
Enterthe address that will be displayed and press the Enter Key. The page withthat address
will appear. .

Shortcuts
a) Enter “CM” at AR: and press the Enter Key to display the Coil Submenu.

b) Enter“CR”atAR:and pressthe Enter Key, or press the Alt + C Keys to display the Coil
Used Table.

4. Searching for Duplicate Coils

Duplicate coils may occur in instances such as when programming is copied during pro-
gram editing.;The following procedure is used to check for duplicate coils by rebuilding
the Coil Table, and then to change addresses when duplicate coils are found.

1) Press the Slash Key to display the Command Submenu.

|

f 1.Bctive 2.Meck 3. Degistar 4.[Hit S Mebal k. Juwarch 7.0vie 0. Baw 7. Ji)

Figure 4.121
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2) Press F9 (Caoil).

An alternative method is to enter “C" from the Command Submenu,

The Coil Submenu will appear.

f Coil: 1.Bnable 2.[Huadle 3.Dn 4.00F S.edit ¢18able & Leed 7.0eace 3.Qucrace

Figure 4.122

3) Press F6 (Used).
An alternative method is to enter “U” from the Coil Submenu.

The Coil Used Table will appear.

Coils in use will appear with a “U.”

—TOIT. ULED TAELE

23456792 B12345679% ®123456797
. V——U— L Uil — DR2x =
B3 ——— Ak [
e ———-—— [ S0
-rx: ——l— BB = iy ———————
-2y: ——l— L3l —— A ————
PWHSx: mmmffm LGN ———————— BRLPK = ———
Lx? —em———— Yz mm—— el ————————
Mig: —————— elx: —————— 23ns e
24 ———— e BE26N: —mmmm—
27w ———— o, ——————— e —
o —————— Lk —— 2% ——————
BETiy: ——— ) — 5N ——
[ —— I ——— OB ——
< 1 P — Bl ———————— T e
I ———— [ s L e —
BBASx: ———mmm— W6 = B4 7x
.l —————— L ] sEx

= i Coil Unused V 1 Geil Uzed
WICK SEARGH: to R {PglipdPrev ¥ {Pgbn>Haxt P.
¢> te Keturn P- v Pa
1.0ebuild table 2.sddress &ﬂ e

Figure 4.123

4) Press F1 (Rebuild Table).

An alternative method is to enter “R” from the Coil Used Table Screen.

Rebuildanyg Coil Uned Tables

Figure 4.124

A message will appear if duplicate coils are found.

Figure 4.125 ‘
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5) Press the Enter Key to move the cursor to the first coil of the duplicate coils.

o LB, fey e

Figure 4.126

6) Press the Up or Down Cursor Key to move to the next or previous coil.

1

7) Press the Enter Key to change the address.
8) Press the Space Key to find and display other coils.

9) Press the Esc Key to cancel the operation.

H

Shorteuts

a) Enter “CM” at AR: and press the Enter Key to disptay the Coil Submenu.

b) Enter“CR"atAR: and pressthe Enter Key, or press the Alt + C Keys to display the Coil
Used Table.

5. Searching for Coils Using Relays (Trace/Retrace)

The following procedure is usedto find and display coils with the same address as a relay.

1} Move the cursor to the relay that will be used to find the coil.

Figure 4.127
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2) Press the Siash Key to display the Command Submenu.

T —

1. xeive 2.Jlack 3.Dagister 4.Bdic 5. Habal 6. Bearch 7.0nds B.0Hew 9.3i2

Figure 4.128

3) Press F9 (Coil).
An alternative method is to enter “C” from the Command Submenu.

The Coil Submenu will appear.

% Coll: 1.0Qnable Z.[Hsable 3.In 4.0F S.edit difladle 6.Ined 7.0vace 9. Qetrace

Figure 4.129

4) Press F7 (Trace).

An atternative method is to enter “T" from the Coil Submenu,

Coils with the same address as the relay will appear.

Figure 4.130

5) Press the Esc Key to cancel the operation.
6) Press the Enter Key to stop the search at the coil position.
7) Press the Home Key or press the Ctrl + Home Keys to return to the previous coil position.

8) Press F8 (Retrace) after editing is completed in order to return the cursor to the original ‘
relay.
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An altemative methed is to enter “R" from the Coil Submenu.

Shorteuts

a) Enter “CM" at AR: and press the Enter Key to display the Coil Submenu.

b) Enter “CT” at AR: and press the Enter Key, or press the Alt + T Keys to display coils
with the same address as the relay.

¢) Enter “CRT" at AR: and press the Enter Key to retum the cursor to the original relay.

4.1.18 Processing Blocks

The following procedure is used to group and edit (copy, move, or delete) multiple ladder ele-
ments or networks.

s Element Block

A group of elements can be defined as a block.

Z/

Blocks can be copied or moved
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* Network Block

Block

77, 5
V/////

/A Copy
Net:vork // &

Move

&\\\_

Save

(Biock file)
* A biock file can be saved as a file containing only networks.
& A block file can be accessed (toaded) into another database.

1. Defining Blocks

The following procedure is used to define a group as a biock. Blocks are either cell blocks
that group multiple elements or network blocks that group multiple networks.

Network Block

<

End network

1) Move the cursor to the starting network of the area that will be defined as a block.
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2) Press the Slash Key to display the Command Submenu.

‘[
1.Xctive 2,Mock J.Bhpister 4.0d1t 5, Flenal S.Boarch 2.1hic B 010w 1. Jei. ‘

1

Figure 4.131
3) Press F2 (Block).
An alternatiye method is to enter “B” from the Command Submenu.

The Block Submenu will appear,

Black: 1.3011 2. Jetusrk

Figure 4.132

4) Press F1 (Cell) or F2 {Network).
An alternative‘ method is to enter “C" or “N”

from the Block Submenu.

The Cell Block or Network Biock Submenu will appear.

! i
f Call Black: 1.[leck 2. Jnbleck 33wy 1.00ve 5.0y 6. 0Delete /

Figure 4.133

1

I ]
f&tnrﬁ Meck: 1.@gck 2. hhleck 3.2epy 4.70ws S.Dunp 6.Telets ?-Juve 0.0nad ,

Figure 4.134

5) Press F1 (Block).

An alternative method is to enter “B” from the Cell Block or Network Block Submenu.

6) Move the cursor to the end point of the area that will be defined as a block.
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With a network block, move the cursor to the end point and press the Esc Key to remove
the submenu (make AR: available), and then move fo the end point network. Refer to 2.
Displaying Specified Networks on page 4-4. .

7) Press F1 (Block).

The cells or networks will be defined as a block.

Starting natwork: End natwork:
Network¥ 1 Row 4
Column 3

L

!—40|¥1b1nl~—]
y toh R1os k1 Pl
]

Nacwur! 1 .11. black 3.Jepy 4.Ieve 5.Dump 6.Dnlete 7.3nva 4. Pead

1 1
Starting point: Network#1 End point: Network#1

Figure 4.136

With a cell block, specifying the starting and end cells will define asquare areaasa biock
with these two points as opposite corners. The biock will appear in reverse video. With a
network block, specifying the starting and end point networks that specify a block will de-
fine that area as a block. The block will appear in reverse video. in both cases, the area
defined as a block will appear atthe lower left side of the screen.

Note Multiple blocks cannot be defined at the same time. Cancel the current block before defining
the next block.

Shortcuts

a) Enter “BLM” at AR: and press the Enter Key, or press the Alt + B Keys to display the
Block Submenu.

b) Enter“BCM’ or “gNM” at AR: and press the Enter Key 10 display either the Cell Block
or Network Block Submenu.
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c) Enter “BCB” or “BNB” at AR: and press the Enter Key to define a Cell or Network
Block.

2. Ungrouping a Block (Unblock)

The following procedure is used to cancel an area defined as a block.

1) Press the Slash Key to display the Command Submenu.

fi 1.0ecive 2.Qleck 3. Degister 4.0iir 5.Blabal %.Jwarch 7.0nds §.Jisv ¥.Jeil

Figure 4.137

1
2) Press F2 (Block).

An alternative method is to enter “B” from the Command Submenu.

The Block Submenu will appear.

1

{ Blsck: 1.Jell 2. etuwerk

Figure 4.138

3) Press F1 (Cell) or F2 (Network).

An altemative method is to enter “C” or “N” from the Block Submenu.

The Cell Block or Network Block Submenu will appear.

[

f Y T, Dboch 3.2m0w 4. 3ove 5.5omp €. Do 1ute ]

Figure 4.139

—— WL ~—]

Jpbleck 3.Jepy 4.30ve 5. Sumy 6.Deleve 7.Zave [N T¥}

Figure 4.140

~4-61 —




Offline Editing
e s —
4.1.18 Processing Blocks cont.

4) Press F2 (Unblock).
An alternative method is to enter “U” from the Cell Block or Network Block Submenu. ‘

The cell or network block will be canceled.

Shortcuts
a) Enter “BLM” at AR: and press the Enter Key, or press the Alt + B Keys to display the
Block Submenu.

b) Enter“BCM” or “BNM" at AR: and press the Enter Key to display either the Celi Block
or Network Block Submenu.

¢) Enter “UCB” or UNB at AR: and press the Enter Key to cancel the Cell or Network
Block.

3. Copying or Moving Cell Blocks

The following procedure is used to copy or move a block of cells to a specified location.

1) Move the cursor to where the block will be copied or moved.
The block can also be copied or moved to another network.

2) Press the Slash Key to display the Command Submenu.

f W 4.0dit 5.0akal 6. Jearch 7.Drvde 8. .Diev ¥.Jwid

Figure 4.141 ‘
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3) Press F2 (Block).

An alternative method is to enter “"B” from the Command Submenu.,

The Block Submenu will appear.

Hmlnmmm-nﬂm 1.1l 2. Jetuark

Figure 4,142

4) Press F1 (Cell).

1

An alternative method is to enter “C” from the Block Submenu,

The Cell Block Submenu will appear.

f"'ﬂmmwyz.mm 322y 4.30ve 5.Bomp €. Dulece

Figure 4.143

5) Press F3 (Copy) or F4 {(Move).

An alternativé method is to enter “C” or “M” from the Cell Block Submenu.

. The block will be copied or moved.

After a move, the cells defined as a block will automatically be ungrouped.

Note Be sure to define the block that will be co

] pied before executing Copy or Move. Refer to 1.
Defining Blocks on page 4-

58 for more details on the procedure for defining blocks.

Shorteuts

a) Enter “BLM” at AR: and press the Enter Key,

or press the Alt + B Keys to display the
Block Submenu.

b) Enter “BCM” at AR: and press the Enter Key to display the Cell Block Submenu.

. ¢} Enter “CCB” or “MCB” at AR: and press the Enter Key to copy or move the block.
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4. Deleting Cell Blocks

The following procedure is used to delete cells defined as a block. ‘

1) Press the Slash Key to display the Command Submenu.

E TR RN | que 5.Basal 6.Beareh 7.3uis 8. Biow 7,305

Figure 4.144

2) Press F2 (Block).

An alternative method is to enter “B” from the Command Submenu.

The Block Submenu will appear.

%m«k: 1011 2.Intwerk

Figure 4.145

3) Press F1 {Cell).

An alternative method is to enter “C” from the Block Submenu. ‘

The Cell Block Submenu will appear.

f T TN, Taaleck 3.3ewy 4.Dbve 5.emp 6.Melace

Figure 4,146

4) Press F6 (Delete). ‘
An alternative method is to enter “D” from the Cell Block Submenu.

A confirmation message will appear asking whether to proceed with the deletion.

W&.Nhﬁ 3.3epy 4.50ve 5.Dunp 6. Dolace

Figure 4.147
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5) Check to see if the contents of the confirmation message are correct, and if so press “Y”
and the Enter Key to delete the cell block. “N” is initially entered so deletion will not be
executed in case the Enter Key is pressed by mistake.

The block of cells will be deleted.

Note Be sure to define the block that will be deleted before executing Delete. Refer to 7. Defining
Blocks on page 4-58 for more details on the procedure for defining blocks.

Shortcuts

a) Enter “BLM” at AR: and press the Enter Key, or press the Alt + B Keys to display the
Block Submenu.

b) Enter “BCM" at AR: and press the Enter Key to display the Cell Block Submenu.
¢) Enter “DCB” at AR: and press the Enter Key to delete the cell block.

5. Copying or Moving Network Blocks

The following procedure is used to copy or move a block of networks to a specified loca-
tion. ‘

The group defined as a block can be
copied or moved

1) Move the cursor to where the networks will be copied or moved.

2) Press the Slash Key to display the Command Submenu.

I } |—umem ‘—-]

Pk Blac kI BAME b
11 1T |

tar 4.0t 5. Blebal 6. Zearch 7.Jvis 0. Hew .11

Figure 4.148
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3} Press F2 (Block).

An alternative method is to enter “B” from the Command Submenu.

The Block Submenu will appear.

[——‘——"MH‘H ‘——'——J

lock: 1.Jell 2. etwerk

Figure 4.149

4) Press F2 (Network).

An altemative method is to enter “N” from the Network Block Submenu.

The Network Block Submenu will appear.

[-—i—llrmm —I

Ltk Bl kD WAWL . AAAY
Netwer! ck: 1.iflec N

Figure 4.150

5) Press F3 {Copy) or F4 (Move).
An alternative method is to enter “C” or “M” from the Network Biock Submenu.

The networks will be copied or moved between the network displayed and the previous

network. ‘

After 2 move, the networks defined as a block will automatically be ungrouped.

Note Be sure to define the block that will be copied before executing Copy or Move. Referto 7.
Defining Blocks on page 4-58 for more details on the procedure for defining blocks.

Shortcuts

a) Enter “BLM” at AR: and press the Enter Key, or press the Alt + B Keys to display the
Block Submenu.

b) Enter “BNM” at AR: and press the Enter Key to display the Network Block Submenu.

c) Enter“CNB” or “MNB" at AR: and press the Enter Key to copy or move a network be- ‘
tween the network displayed and the next network.
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6. Deleting Network Blocks

The following procedure is used to delete networks defined as a biock.

1) Press the Slash Key to display the Command Submenu.

!—mmm j
WKL
1

tor 4.0dic §.Hokal i.Puarch 7.[Jvde 8. JHow 9. =il

i Lk Blockt vl
minFry

Figure 4.151
2) Press F2 (Block).

An alternative method is to enter “B” from the Command Submenu.

The Block Submenu will appear.

lk ik ——]
e b 4] IoAAd At -
lack: 1.J011 2.28twerk

Figure 4.152

3) Press F2 (Network).

An alternative method is to enter “N” from the Block Submenu.

The Network Block Submenu will appeatr.

[——l-muu 11— I
i
|

«lhbleck 31.Jopy 4.30ve 5.0unp 6.@nlace 7-Bave 3.Joad

' i4i4]
ck: 1.0

Figure 4.153
4) Press F6 (Delete).
An alternative method is to enter “D” from the Network Block Submenu.

A confirmation message will appear asking whether to proceed with the deletion.

T3 ch: 1.eck .Inb1eck 3.0epy 1.T0ve §5.0unp 6. [elste 7 Buve 0.[nad

Figure 4.154
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Note

5) Check to see if the contents of the confirmation message are correct, and if so press “Y”
and the Enter Key to delete the cell block. “N" is initially entered so deletion will not be
executed if the Enter Key is pressed by mistake.

The network block will be deleted.

Be sure to define the block that will be deleted before executing Delete. Refer to 1. Defining
Biocks on page 4-58 for more details on the procedure for defining blocks.

Shortcuts

a) Enter “BLM” at AR: and press the Enter Key, or press the Alt + B Keys to display the
Block Submenu. '

b) Enter “BNM*at AR: and press the Enter Key to display the Network Block Submenu.

c¢) Enter “DNB" at AR: and press the Enter Key to delete the network biock.

7. Jump to a Block

The foliowing procedure is used to jump quickly to a network in a block from another net-
work.

Cel! Block

Jump,
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Network Block

1) Press the Siash Key to display the Command Submenu.

f 1.lecive 2.Mleck 3. Begiarer 4.301t 5. Makat 6.Jearch 7.Jnds 3. 0ew ?. 311

i

Figure 4.155

2) Press F2 (Block).

An alternative method is to enter “B” from the Command Submenu.

The Biock Submenu will appear,

F ’ Rlack: 1.3e11 2. Detuverk

Figure 4.156

3) Press F1 (Cell) or F2 (Network).

An alternative method is to enter “C” or “N" from the Block Submenu.

The Cell Block or Network Block Submenu will appear

1

4) Press F5 (Jump).

An alternativq method is to enter “J” from the Cell Block or Network Block Submenu.
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The cursor will jump to the network in 1the block.
The cursor jumps to the home position of the network in the block. With a network block,
the cursor jumps to the first network in the block.
Note Be sure to define a block before executing a jump. Refer to 1. Defining Blocks on page 4-58

for more details on the procedure for defining biocks.

Shortcuts

a) Enter “BLM” at AR: and press the Enter Key, or press the Alt + B Keys to display the
Block Submenu.

b) Enter “BCM" or “BNM" at AR: and press the Enter Key to display eitherthe Cell Block
or Network Block Submenu.

c) Enter“JCB” or“JNB" at AR: and press the Enter Key to jump to the network or cellin
the block.

8. Saving and Loading Edited Networks

The following procedures are used to save a network block or to load a saved network
block anytime at another location (including loading to other databases).

Block library

m

13 l
Load

l Accessed in the desired location

A. Saving a Network Block

1) Press the Slash Key to display the Command Submenu.

[—-* HHHH L 4—"]

Wan - MR
e A 4. iit 5.Dekal &.Bearch 7.Inde B.Dtev 7.3w1l

Figure 4.157

2) Press F2 (Block).
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An alternative method is to enter “B” from the Command Submenu.

The Block Submenu will appear.

—idHul ——]

leck: 1.Jell 2. Jetuark

Figure 4.158
3) Press F2 (Network).
This function is not available on the Cell Block Submenu.

An alternative method is to enter “N” from the Block Submenu.

The Network Block Submenu will appear.

I—whmml ‘]
e £ l bleck 3.Jepy 4.Dove 5. Duwp G.Gulaty Z.dnve 0. Jead

Figure 4.159

4) Press F7 (Save).

An aiternative method is to enter “S” from the Network Block Submenu.

\-@ L Selest Black File I
Im——:ﬁg%—*—ulmzl Sava

PLC: TEET1 <A Ie=H3)
OTOSH] CINT: JSTYLES
ISPIAPS
1383 TEST . BLD
LIERAT
ENES
LETTES
-TUTORIAL
ITTENNE

0T OME s
TR TOME~———r
hd

Birpete: C: \GLESS \BINw, ELD
Quick Piads ] {Tad> switch windew

YAEXAUA
B.Prive D.Rebuild O May Directsry D.Delete Directary N.Mew File

Figure 4.160

5) Specify wherei to save the networks.

Specify the diréctory and the name under which the networks will be saved. There is no
need to specify anything if the networks are to be saved under the same name in the
same directory as the database currently in use. Press F5 {New File) to save the net-
works under another file name, and then enterthe new name. Specify the drive and direc-
tory as outlined in 3.7 Selecting or Creating a New Program File (Database) in order to
change the drive and the directory.
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If a block file is given the same name as a database and that database is deleted or co-
pied, then the biock file will be deleted or copied at the same time. Be sure to store the
block file in another directory or save the file under another name to keep the file separate
from the database. When two or more files are saved under the same name, the newer

files will overwrite the clder files.

6) Press the Enter Key.

The network block will be saved.

At Select Nleck Fils II
Im——dg}%—-——wmu Save

{FLc: TESTL <ale-N>]

5— 8
OTaSH TETYLES

Directery  CiCLASE\Din=.BLD
Quick Find: CTab> switch windaw

Hatwerk Block: 1.Mleck Z.lnbleck 3.Jopy 4.Tave 5. Dunp &.0nlvce 7.3mve

Figure 4.161

When the network block is saved, three files named filename.BL1, filename.BL2 and file-
narne.BLD will be created. These three files make one block data, and will appear simply
as a BLD file on the screen.

Note Be sure to define a block before executing a jump. Referto 1. Defining Blocks on page 4-58 ‘
for more details on the procedure for defining blocks.

Shortcuts

a) Enter“BLM” at AR: and press the Enter Key, or press the Alt + B Keys to display the
Block Submenu.

b) Enter “BNM” at AR: and press the Enter Key to display the Network Block Submenu. ‘

¢) Enter“NNB"at AR: and press the Enter Key to specify the where the networks will be
saved.

B. Loading a Block File
1} Display the network where the block file will be ioaded.

The block will be inserted between the network currently displayed and the next network.

2) Press the Slash Key to display the Command Submentl.

f 1.Jetive Z.[leck 1.Degizter 4.04ic 5.Pokal é.Jearch 7.0vie s Diww ¥.20il

Figure 4.162
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3) Press F2 (Bloqk).
An alternative method is to enter “B” from the Command Submenu.

The Block Submenu will appear.

% Block: 21.3e11 2. Tetwerk

Figure 4.163

4) Press F2 (Network).

An alternative method is to enter “N” from the Block Submenu.

The Network Block Submenu will appear.

f Wetwerk Risck: 1.0leck 2.Dsbleck 3.Ppy 1.30ve S.Dunp 6.Jnlets 7. 3ave 3. [ead

Figure 4.164
5) Press F8 (Load).
An alternative method is to enter “L” from the Network Block Submenu.

6) Move the cursor to the file to be loaded and press the Enter Key.

To change directories, press the Tab Key to move the cursor to the Directory Window,
select the desired directory and press the Enter Key.

NP0t | Select Black Pila I
-ulm——tc,:“m—-—ulm: Lead

0T
AT [ ———eeeed T [ DES K—————-JAPANES E PLC: TEETL

[=PHOTORN] GING JSTYLES

IEFMAPS Tﬁ.m

CR1t—H>|

Directery C:\GLERE\DE\w.BLD
Quick Find: RN <Tak> switch windew I

D.0riva . Rebuild B.Hew Directory J.Buletes Directery

Figure 4.165
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The block file will be loaded.

The networks that were inserted will remain defined as a block.

Select Block File
Ll

POt
-\llm————l::!‘!ﬂl——ﬂﬂﬂﬁ
0T
PLC: TESTH RUBEL b

Dirsctary  CGLABS\DIN=.JLD
Quick Find: <Tak> switch windew _ |

YASKAMS —
Metwerk Nleck: 1.Bleck Z.Jhbleck 3.3epy 4.3ove 5.0ump 6.Dolote 7.Jave §.0ead

Figure 4.166

[—mmm -———J

i wan
hblsck 3.3spy 4.Deve S Tuny E.Drlecs 7. Jave 0.0nad

Figure 4.167

Shortcuts
a) Enter “BLM" at AR: and press the Enter Key, or press the Alt + B Keys to display the
Block Submenu.

b) Enter “BNM" at AR: and press the Enter Key to display the Network Block Submenu.

c) Enter “LNB” at AR: and press the Enter Key to load the block files.

4.1.19 Globally Replacing Addresses

The following procedure is used to change addresses automatically. Quick Find allows a se-
ries of addresses 10 be set at one time, and allows element restrictions as well. Comment and
register data can be imported from any database during global replacement.

1) Press the Slash Key to display the Command Submenu.

% 1.%ctive 2.H1eck 3. Geyiscer 4.0dit 5.Jiebal 6. Jparch 7.Tndo 8.Blew 9.Jbil

Figure 4.168
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2) Press F5 {Global).
An alternative method is to enter “G” from the Command Submenu.

The Globai Replace Screen will appeatr,

Clebal Meplace
B
»: H €
Whiress T pecify

LI s
Busery : Cs
Mpietor Bata: Copg

CEze> to Quit <hlt=E> tu Bagin

pIsc  yrc L2 BN IoRNT BRI B B aa 1
Pl ¥ e owe TR W any MmO

Figure 4.169

3) After ali settings are entered, press the Alt + E Keys to start globa! replacement.

When the Enter Key is pressed at the iast item (Register Data), a confirmation message
will appear asking whether to proceed with replacement. Enter “Y” and press the Enter
Key to start global reptacement.

Figure 4.170

Moving the Cursor

item details: Press the Up or Down Cursor Key, or press the Enter Key.
Change setting details: Press the Left or Right Cursor Key, or press the Space Key.

Shortcuts

Enter “G” at AR: and press the Enter Key, or press the Alt + G Keys to display the Giobal
Replace Screen.

Settings
1) Network Range

1

Network Range is used to specify the range of networks where global replacement will
oceur,

1
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All Logic: Targets all networks in the database, including the SFC action, transition
condition, and subroutine circuits.

Current Area:  Targets only the program area currently dispiayed.
Block: Targets networks defined as a block.

From the Cursor Position:
Starts replacement from the present cursor position and continues tothe

end of the current area.
Specify: Specifies the network that will be replaced.

Example: Specifying an Area from Network 1 to Network 10.

Network range: Specify 1 through TREIE (Maximum of 22}

2) Instructions

Instructions are used to specify whether replacement will be limited to a instruction {ele-

ment). ‘

Specify: Limits target elements.
Enter Element Mnemonics at “Mnemonics.”

The element mnemonics will appear together with instructions at the function
keys, and can be selected by pressing a function key.

Example: NO Contact {4 +) ‘

Instruction:  Specify Mnemonic: [!TIE

Specify with the mnemonic of the element.

Any.  Searches all elements.
3) Address
Address is used to specify the replacement address.

Search: Specifies the address to be replaced.
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Replace: Specifies the replacement address.

Example: Replacing 00001 with 00010

Search: 00001 —I l‘
00001
Replace: 00010 -
00010

Example: Replacing 00001 to 00010 with 00031 to 00040

Search: 00001-00010 ~| — H }— |

00001 00002 Q0003 00004

Replace 00031-00040 — | |~ }— |-

00031 00032 00033 00034

4) Replace Mode
The Replace Mode can replace automatica'lly or with confirmation,
Confirmation Replacement: Enter “Y” or “N" to confirm or skip replacement. If the item

does not need to be replaced, enter “N” to move to the next
occurrence without replacing the current occurrence.

5 % WUe TUT Sme Ry omn xn opm mun

] Figure 4.171

Automatic Replacement: Replaces all occurrences automatically,

5) Source Data;base

The Source Database is set when comment and register data are copied or moved to an
address that was replaced.
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Current Database Name: Imports data from the currently selected database when data
is copied or moved.

New Source Database:  Imports comment and register data from another database.
Be sure to specify the database on the Select Database
Screen.

6) Comment Data
Qomment Data sets comment data for an address that was replaced.

Copy: Copies data from the database address (search address) specified in
Source Database, and places the data at the address that was replaced.

Move: Moves data from the database address (search address) specified in
Source Database, and places the data at the address that was replaced.

No Change: Data will not be copied or moved.
7) Register Data

Register Data sets register data for the address that was replaced. The settirig details
and setting procedure are the same as that for comment data.

Refer to the example in 5.1.2 Adjusting Reference Numbers and Copying Comment Data for
more details on these settings.

4.1.20 Backing Up a Database During Editing (Snapshot)

The following procedure is used to backup the database currently being edited. A backup is
made as a precautionary measure in case a large portion of the program is deleted acciden-
tally or a database is corrupted during editing. Time and effort will not be lost as long as the
backup is updated during program editing. A Snapshot can be thought of as an extra backup
during editing. Referto Backing Up and Restoring Databasesfor more details on fully backing
up databases.

1) Press the Slash Key to display the Command Submenu.

% 1.5tive 2.[leck 2.0egistar 4.0dit 5.Flebal 6.Jearch Z7.Inie 8. Haw 9. 20i1

Figure 4.172

2) Press F4 (Edit). '
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An alternative method is to enter “E” from the Command Submenu.

The Edit Submenu will appear.

f Edit: 1.Je1l 2.dfecripter 3. Jagrane 4.Drewre 5.0nlete G.alapehet 7.0Brecazser

Figure 4.173
3) Press F6 (Snapshot).
An altemative method is to enter “N” from the Edit Submenu.

A confirmation message will appear asking whether to proceed with the snapshot.

l Saap.bat Datahaze? B ”

18C c LC1 [ ] ICHoRT oL FEC EMET
1w FW! n?.1.!! %I‘R nmsm Lue a“E!I'J FI-Ill ab‘!

i

Figure 4.174

4) Press the Enter Key.
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A database named !Snap! will be created and stored in the same directory.

Gupying: TESTLI.FKD to “SNAPI.FRD

i

i WO, VNS NS TS Wur OOy NN OOV WY

Figure 4.175
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[~CLABE:
IGINE TYLES
M EFTMPE
[—-CTE ]
[—-CALIEMAT
P-BRUSHES
[~PALETTES
(—=ENTORI AL
|:=orm—l—mo:m——»
v
Dirwctory C:\GLESS\DIn=.CPG
Ouick Find: HMEENIAEE <Tad’> svitch vindew
VALK =
O-Prive U.Mebuild [ New Directery J-Dalste Directsry H.New File

Figure 4.176

When two or more files are saved under the same name, the newer files will overwrite
(update) the older files.

Note Make sure there is sufficient free space on the hard disk before executing a Snapshot be-
cause a database with exactly the same data as the currently selected database is created.
The name and directory for a Snapshot cannot be specified. If there is a Snapshot for another
database already in the directory, that snapshot will be overwritten. ‘

Shortcuts

a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.

b) Enter“AS"atAR: and press the Enter Key to display the execution confirmation mes-
sage.
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4.2 Editing Subroutines

When the same circuitis written often in a ladder program, storing the circuits as subroutines
enables the circuit to be accessed from the ladder program at any time, and the circuit only
needs to be built once. The subroutine circuit will be executed when the GOSUB instruction is
ON. Memory should be allocated to subroutines before editing. Referto 2. Allocating Memory
on page 4-168 for more details on allocating memory to subroutines prior to editing.

4.2.1 Entering the GOSUB Instruction

1) Display the Network Edit Screen.
2) Mave the cursor to where the element will be entered.

The GOSUB instruction must be executed at the very end of the network. Entries cannot
be input in the area (slashed line area) after the GOSUB instruction.

f/// T e T
Y B

In the above situation, the coll is actually entered above the GOSUB instruction so that it
will not interfere with the instruction.

e

3) Press F8 (SPEC).
An alternative method is to enter “GOSUB” at AR: and press the Enter Key.

A Function Menu like Skip or Subroutine will appear.

)

F+CORY! '
il Bt T

i

= B Epma 1

Figure 4.177

4) Press F2 (GOSUB).
5) Enter the subroutine number and press the Enter Key.
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The range of subroutine numbers is GO0 to G99.

4.2.2 Displaying Subroutine Networks

1) Move the cursor to the GOSUB element.

Figure 4.178

2) Press the Slash Key to display the Command Submenu.

H [

1.0ctive 2.0leck 3.Dugistar 4.2dit S.Hlebal 6.Foarch ?.0nde §.Jisv 9. Jeil

Figure 4.179

3) Press F8 (View).
An alternative method is 1o enter “V” from the Command Submenu. ‘

The View Submenu will appear.

|

[ { ——CH1 11
Visu: 1.Desc 2.0indouw 3.3krk 4.Jnmark 5.0wyp ¢ Tets 7.5sen 0.zeen Decurn

Figure 4.180

4) Press F7 (Zoom).
An alternative method is to enter “Z" from the View Submenu.

The Subroutine Edit Screen will appear.
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5) Press F8 (Zoom Return) from the View Submenu after editing is completed in order to
return to the original network.

An alternative method is to enter “R” from the View Submenu.

Shortcuts

a) Enter “VM" at AR: and press the Enter Key to display the View Submenu.

b) Enter“Z” at AR: and press the Enter Key, or press the Alt + Z Keys to display the Edit
Subroutine Screen. (Enter “ZR” and press the Enter Key, or press the Alt + X Keys to
return to the Network Screen.)
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4.3 SFC Editing

SFC stands for Sequential Function Chart. SFC is a new PLC language that takes conven-
tional serial sequence control system items written in ladder language and expresses them
as a block diagram similar to a flowchart so that the entire structure can be grasped at a
glance, and so that programming will be easier. Refer to MEMOCON-SC GL608 Designand
Maintenance Manual (manual No. SIE-C815-14.1)for more details on SFC. This manual can
be obtained at your GL60 sales outlet or business office.

4.3.1 SFC Screen Configuration

The following describes the SFC Screen configuration.

1 /2 3 4
% Few: 8 Gol: 1‘ﬂé fictive PLC: 14—1!?_:_5

Figure 4.181 ‘

1) SFC number currently displayed:
The SFC number S000 is used for the currently displayed SFC flowchart and numbers
S001 and on are used for steps.

2) Coiumn and row display for the current cursor position

3) Target Processor:
The model of the Processor can be changed.

4) Database Name

5) Assembly Register: '
The assembly register stores input (text and numbers) from the keyboard.
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6) Logic Area

7) Labe! Area:

Function key menus corresponding to function keys F1 to F10 wili appear in the label
area. Various menus can be displayed depending on the operation.

8) Prompt

9) Mnemonic:

The SFC input field is comprised of 10 rows by 8 columns numbered 0 through 9. Since
row 0 and row 9 are used exclusively for From andTo, steps and transitions are enteredin
the 8 x 8 area from row 1 to row 8.

Rows 1 through 8 are divided into upper (step) and lower (transition) rows. Since all fields
in the vertical direction cannot be monitored on the display at the same time, use the Up
and Down Cursor Keys to scroll through and view other rows.

Actual field size
1 2 3 4 5 6 7 BColumn

......... 0 Row (From row)
1 1°1-1 1 Row
[ -1-1-1-1-1-1-1-1 2Row

F -1 "1"1-1-1-1-1-<4 8Row
9 Row (To row)

Figure 4.182

4.3.2 Displaying the SFC Screen

The following procedure is used to display the SFC Screen.

1) Select 2. Offline from the Main Menu.

HENOCON-£C CLAL-C8-78
Verstan 2:5% Eopimivne T TASKIOR ELECTATS omfhaTIow
Bavabaze: TESTL Nalp: <ale-H>
Bain Menu:

1. Select Active PLC

40 Retien

5. List Active PLC
6, Leader

7. Utilicies

<E> xo Exit to Des

Enter Optiens [

Figure 4,183
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W
4.3.2 Displaying the SFC Screen cont.

2) Select 3. Sequential Function Charts from the Offline Edit Menu.

A database is required for offline SFC editing. The Select Database Screen will thus ap-
pear automatically if a database is not selected. Referto 3.1.3 Selecting a Database, and
then either select or create a database.

HENOCOWN-EC CLABAR/78
Ladder Legic Davelophent Seftwars / Edit Meaw
Catabasxe: TESTL Halp: <Alt-H>
Offline Edit Memu:

1. Salect Active MLC
2. Natworks

. Descripcers
. Database Details

+ Proceszer Cenfiguratisn

. RECIT Maszzages

. Crassheference Dispenitien

CEzc> to Ratwm t¢ Pravisus Menu
Entar Optisn: [

-3,

Figure 4.184
The SFC Screen wili appear.
Pl oo Sy 2 2 8 3 3 =
Figure 4.185 ‘
Moving the Cursor
Moving up, down, left or right: Press the Up, Down, Left or Right Cursor Key.

Moving to the upper left (Home Position): Press the Home Key.

Moving to the lower right (End Position): Press the End Key.

Moving to the left edge: Press the Cirl + Left Cursor Keys.
Moving to the right edge: Press the Ctrl + Right Cursor Keys.

1. Displaying the SFC Expanded-screen

The following procedure is used to display step action, and transition condition circuits, ‘
and to move to the expanded-screen used for macro steps.
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1) Move the cursor to element to be zoomed.

Fﬁf“!lﬁ wy NTTUGITT TS dctive FIET TESTT AN TGN

i.lkctive 2.[Meck call 3.afc eide 4.Biic 5.3march 6. Dnde 7.0iaw

Figure 4.187

3) Press F7 (View).

The View Submenu will appear.

View: 1.Mesc 2.Bindew 3.5ark 4.Innark 5.0unp 6.Jote 7.500n 3.200m Teturn

Figure 4.188

4) Press F7 (Zoom).

The cursor V\{ill move to the action circuit.

Ework: [IT°H ctive H

RX1 ENET 1
Wi Tl THE TNE DS Man omm M doo o

1

Figure 4.189
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4.3.2 Displaying the SFC Screen cont.

if the cursor is on a macro step, it moves to the macro step expanded-screen, but if the
cursor is on a transition, it moves to the transition condition circuit.

Press F8 (Zoom Return) from the View Submenu or enter “R” to return to the original screen
from the top of the zoom.

Note Although Zoom Return can be used to return to the original screen from the location moved to
using the ZOOM command, Zoom Return cannot be used to retum to the SFC from the loca-
tion moved to using the GOTO command. Use the GOTO command again in that case.

Shortcuts

a) Enter “VM” at AR: and press the Enter Key to display the View Submenu.

b) Enter“Z” at AR: and press the Enter Key, or press the Alt + Z Keys to move the cursor
to the action circuit.

c) Enter“ZR” at AR: and press the Enter Key, or press the Alt + X Keys to retum to the
original screen.

2. Displaying a Specified SFC

The following procedure is used to move quickly to a specified Edit Screen (Network,
SFC, Subroutine) by setting an address.

1) Press the Slash Key to display the Command Submenu.

S 087
1.Becive 2.5leck coll Y.afc Tode 4.[lic 5.Bearch ¢ Dl ?.THew

Figure 4.190

2) Press F7 (View).

The View Submenu will appear.

SONe w7
I
Visw: 1.Deac Z.Dindew 3.Fark 4.Dwark S.Jwep é.Inte 7.50en B.zeem Doturn

Figure 4.191

3) Press F6 (Goto).
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The Address input Window will appear.

Eg&l !??laﬂllgg& ﬂm ] -] [] i /] [t ]
Figure 4.192

4) Enter the address and press the Enter Key,

Coil and element addresses are not valid entries. Be sure to enter Lxx, SEGx, Gooinn,
SNxocnn, Sxx, or Txx.

Shorteuts
a} Enter “VM” at AR: and press the Enter Key to display the View Submenu.

b} Enter “GOTO" at AR: and press the Enter Key, or press the Alt + N Keys.

3. Jumping to Marks

Thefollowing procedure is used to mark a position in order to retum quickly to the marked
position while editing at other position.

1) Move the cursor to the position to be marked.

2) Press the Slash Key to display the Command Submenu.

Toms

‘ 195 7
1.Jctive 1.Jleck cell 3.afc Jede 4.0it 6. Bvarch & Dois 7. Jiaw

Figure 4.193

3) Press F7 (View). .

The View Submenu will appear.

i
Sl a7
b
Utew: 1.Besc 2.Dindev 1. Jark 4. Damark S.Dunp 6.Jvke 7.5san B.zeen Jeturn

Figure 4,194
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4.3.3 Exiting from SFC Editing

4) Press F3 (Mark).

The cursor position will be marked.

The mark position will appear at the lower-left side of the screen when a mark is set.

Figure 4.185

Press F4 (Unmark) from the View Submenu to cancel the mark.

5) Press F5 (Jump) to jump to the mark.

Shortcuts

a) Enter “VM" at AR: and press the Enter Key, or press the Alt + V Keys to display the
View Submenu. ,

b) Enter“M”atAR: and press the Enter Key, or press the Alt + M Keys to create a mark at
the cursor position.

c) Enter“J” at AR: and press the Enter Key, or press the Alt + J Keys to jump to the mark.

4.3.3 Exiting from SFC Editing
The foliowing procedure is used to exit from SFC editing. ‘

1) Press the Esc Key.

A confirmation message asking whether to exit will appear.

E's.r'cxl "lmzuﬂll-gg!a ﬂrg/ml'l 2 3 [-] 3 g
Figure 4.196 ‘
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It the Function Menu at the bottorn of the screen is notatlevel O (menuinitially disptayed),
the Function Menu will shift closer to level 0 without a message. Press the Esc Key at
level 0 to operate the Exit function.

1

2) Press the Enter Key.
Enter “N” and press the Enter Key, or press the Esc Key to continue editing.

The Edit Mepu will retum.

]

4.3.4 Moving the Cursor on the SFC Screen

The following procedure is used to move the cursor on the SFC Screen,

Moving the Cursor

Moving up, down, left or right: Press the Up, Down, Left or Right Cursor Key.
Moving to the upper left (Home Position): Press the Home Key.

Moving to the lower right (End Position): Press the End Key.

Moving to the left edge: Press the Ctrl + Left Cursor Keys.

Moving to the right edge: Press the Ctrl + Right Cursor Keys.

Home position

N

(Home)
Keystrokes ara
in parentheses.

Left | (Ctrl + ) —--— (Cti+ —) smadp| Right

N\

{End}

i | \

End position

Figure 4.197

4.3.5 Entering Elements Using Function Keys
Display the Element Menu inthe label area at the bottorn of the screen, and select the function

from the menu using a function key (F1 through F10). All SFC elements are assigned to func-
tion keys.
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4.3.5 Entering Elements Using Function Keys cont.
F1{INSTR):  Steps and transitions
F2 (BRANCH): Branches and intersections
F3 {(LOOP): Loops
F4 (TO/FR):  Toand From

Example: Entering S001

1) Move the cursor to where the element will be entered.

FTC: SOl You: T Cal: 7 &M Rctive PLC: TESIT  AR: BN |

vl

—

Pgn s Do Tom 3 2 2 2 a m

Figure 4.198

2) Press F1 (INSTR).

The function keys for steps and transitions will appear.

e MR PEh Yihe B T Ol T
Figure 4.199

Referto the Appendix A List of Function Key Menus for more details on elements that will
be displayed.

3) Press F1 (STEP). ‘

Press the Esc Key to return to the previous menu.

The element at the cursor position will appear along with a message asking for the ad-
dress.

Figure 4.200
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“—ﬁ

4) Enter the address and press the Enter Key.

4.3.6 Entering Elements Using Mnemonics

Each element has a unigue mnemonic. Enter the mnemonic at AR: to enter the element.
1) Move the cursor to where the element will be entered.

—

1

BE ML MY 1 3 1 1 owm

Figure 4.201

Entries cannot be input or an error may occur at some positions. For more details on the
SFC, refer to items 5 and 6 Write Protected items in SFC Programming provided in ME-
MOCON-SC GL60S Design and Maintenance Manual (manual No. SIE-C815-14.1 ).

2} Enterthe mnemonic of the element at AR: (Example: STEP for a step) and press the En-
ter Key.

Mnemonics are displayed together with the Element Menu.

Figure 4.202

The element at the cursor position will appear along with a message asking for the ad-
dress.

Figure 4.203
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4.3.7 Changing Step and Transition Numbers

3) Enter the address and press the Enter Key.

Do not use the same step or transition number twice.

4.3.7 Changing Step and Transition Numbers

The following procedure is used to change step and transition numbers.

1)} Move the cursor to the step ortransition number that will be changed and press the Enter
Key.

A message asking for the reference number will appear.

EFC TN N Tour 1 &IF 2 BN ccliwe FIZ: TEXTT AR
»

TEEL

Figure 4.204 ‘

Press the Esc Key to cancel the change and return to the original reference number.
2} Enter the step or transition number that will be changed and press the Enter Key.

The step or transition number will change.

HETR NCH TR G
£PC1 -S”Pl:z % msm 2 2 a I a o

Figure 4.205

4.3.8 Insertion ‘

The following procedure is used for a variety of insertions during SFC editing.
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4.3 SFC Editing
:
Row Insertion: Inserts a row on the SFC Screen.
Column Insertion: Inserts a column on the SFC Screen.

1. Inserting a Row

The following procedure is used to insert a blank row on the SFC Screen.

1) Move the cursor to where the row will be inserted.

A row cannot be inserted if there is no room to insert a row below the insert position.

Room for at least two rows is needed because two rows are inserted at the same time
with Row Insertion.

i
1 B H ictive 2
L]

somi
Thé1

NSTR Ml 14 0 TR
1t Dgu ﬂ-gga Il':m i 1 a 2 a m

Figure 4.206

1

2) Press the Slash Key to display the Command Submenu.

1.Dctive 2.[0leck coll 2.25c Dede 4. (Wit S.Bearch §.Tnde 7.THaw

Figure 4.207
3) Press F4 (Edit).

The Edit Submenu will appear.

i

Edic: 1.3e)1 2.d0mcripters 3.eXchange 4.0hsare 5.0slate G.olhpadet

Figure 4.208
- 4) Press F4 (Insert).
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4.3.8 Insertion cont.

The Insert Submenu will appear.

Ingart: 1. Jeepstr 2.0ranch J.Jeeyp 4.00~fren 5. Jolumn &.0sw

Figure 4.209

5) Press F& (Row).

A row will be inserted at the cursor position.

PRI 1 Wow: I Cal- 7 (EIGEI  Acelee FLC: TESTT  AK: DNANEAN |
-
i
Fggl ’sur“czw Iﬁ& Btm a 3 g ] ] m
Figure 4.210
Shortcuts
a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu. ‘

b) Enter“IM"at AR: and press the Enter Key, or press the Insert Key to display the Insert
Submenu.

¢) Enter “IR” at AR: and press the Enter Key to insert a row at the cursor position.

2. Inserting a Column

The following procedure is used to insert a blank column. ‘
1) Move the cursor to where the column will be inserted.

A column cannot be inserted if there is no room to the right of the insertion position.

Pum mposm mma 1 2 1 @

Figure 4.211 ' ‘
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2) Press the Slash Key to display the Command Submenu.

-

1.%ctivn 2.0Lsck coll J.fc Deda 4.(Bit 5. Bearch 6. Dods 7. [Haw

Figure 4.212

1

3) Press F4 (Edit).
The Edit Submenu will appear,

=i

Edic: 1.J011 2.ducriprers 2.alkhange 4.0hzert 5.Delats S.slmpabet

Figure 4.213

4) Press F4 (Insert).

The Insert Submenu will appear.

Tasert: 1. 3copstr 2.[0ranch 3. 0oap 4.Js—Frem 5. Tolumy [38-"7)

Figure 4.214

5) Press F5 (Column).

L

A column will be inserted at the cursor position.

| LR Taw: TR0 (RINMN . dccivs PLC: TESTT AN SNENEEN
w1

Figure 4.215
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4.3.9 Deleting

Shortcuts

a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.

b) Enter“/IM” at AR: and press the Enter Key, or press the Insert Key to display the Insert
Submenu.

¢) Enter “IC" at AR: and press the Enter Key to insert a column at the cursor position.

4.3.9 Deleting

There are several commands available here depending on the type of deletion. Select and
use the appropriate command.

Delete Element: Deletes elements on SFC and Network Screens.
Delete Column/Row:  Deletes blank rows and columns.
Delete SFC: Deletes the SFC Screen currently displayed.

1. Deleting an Element

The following procedure is used to delete an element or ceil.

A. Deleting an Element ‘

1) Move the cursor to the element that will be deleted.

NETR m% wgﬂl b ] ] a m

SPCL IPC2

Figure 4.216

2) Press the Slash Key to display the Command Submenu.

’ 1.Tecdive 2.0leck coll J.afc Dede 4. [Mit S.Bearch 6.Dnde 7. e

Figure 4.217 '
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3) Press F4 (Edit).

The Edit Submenu will appear.

Ediz: 1,311 2.d8scripters J.eichonge 4.0nzert S.Dnlete G.alnpalut

Figure 4.218

4) Press F5 (Delete).

The Delete Submenu will appear.

Delete: 1.Menent Z.celll 3.Jelumn 4.0ew S.Baws

Figure 4.219

5) Press F1 (E[ement).

The element will be deleted.

E;ﬂ’g lﬁ#&ﬁll‘ﬁg& ﬂ'gg‘ll a [-] 3 a @

Figure 4.220

Shortcuts

a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.

b) Enter“DM”at AR: and press the Enter Key, or press the Delete Key to display the De-
lete Submenu.

¢) Enter “SDE” at AR: and press the Enter Key to delete the element.
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4.3.9 Deleting cont.

B. Deleting an Element with a Branch or Loop

1) Move the cursor to the element with the branch or loop to be deleted.

&B'&l Frrg% Wgﬁl 1 -] ]

Figure 4.221

2) Press the Slash Key to display the Command Submenu.

TG
1.Tetive 2.00eck cell 3.afc Doda 4.0t S.Jearch 6.Deds P7.0Hew

Figure 4.222

3) Press F4 (Edit). ‘

The Edit Submenu will appear.

.

Edit: 1.Jell Z.dJecriptars J.alkhange 4.0nsert S.Delete 6.3]npehat

Figure 4.223

4) Press F5 (Delete).

The Delete Submenu wili appear.

] p:: - I

Selete: 1.Jlenent 2.colll 3.J0lunn 4.0ew S.0nxe

Figure 4.224

5) Press F2 (Cell).
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The element and its branch or loop will be deleted.

) o7
Przmesm mma 2 4 1

Figure 4.225

Shortcuts

a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.

b) Enter“DM”atAR:and press the Enter Key, or press the Delete Key to display the De-
lete Submenu.

¢) Enter “DEL" at AR: and press the Enter Key to delete the element and its branch or
loop.

C. Deleting a Branch or Loop

1) Move the cursor to the element with the branch or loop to be deleted.

—ﬁl»ﬁlﬂju—I

Figure 4.226

2) Press any key between F1 and F4.
The Element Menu will appear.
3) Press F9 if the branch or loop moves up from the transition,
4) Press F1q if the branch or loop moves down from the transition.
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4.3.9 Deleting cont.

Only the branch or loop will be deleted.

b Ty Tsie D‘l; ‘

Figure 4.227

Shortcuts
a) Enter “DTB" at AR: and press the Enter Key if the branch or loop moves up from the .
transition.

b) Enter“DBB"atAR: and press the Enter Key if the branch or loop moves down fromthe
transition.

2. Deleting Rows and_Columns

The following procedure is used to delete blank rows or columns. ‘

1) Move the cursor to the row or column that will be deleted.

ctive
wl

?um ¢

T2

E’f-’c’;""a‘p‘éz“"’ﬁ& mma ] [} 3 a m

Figure 4.228

2) Press the Slash Key to display the Command Submenu.

1.3ktive 2.Jisck cell 3.sfc Jede 4.3dic S.Zearch &.Jnds 7 Jisw

Figure 4.229 ‘
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3) Press F4 (Edit).

The Edit Submenu will appear.

Editz 1. .31l Z.ddecripters J.edchangs 4.Dniers 5.{hlete .2 Dapahat

Figure 4.230
4) Press F5 (Delete).

The Delete Submenu will appear.

Belate: 1.Jlamant 2.collf 3.J01umn 10w S Jage

Figure 4.231

5) Press F3 (Column) or F4 (Row).

The row or column will be deleted,

Figure 4.232

Note Aroworcolumncannotbe deletedifthere is an elementin the row or column. Delete two rows

when deleting a row because the SFC Screen sets a row aside to enable step and transition
input for each row.

Shortcuts

a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.

b} Enter“DM" at AR: and press the Enter Key, or press the Delete Key to display the De-
lete Submenu.
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4.3.9 Deleting cont.

c) Enter “DC” (delete column) or “DR" (delete row) at AR: and press the Enter Key to
delete the row or column,

3. Deleting an SFC Screen

The foliowing procedure is used to delete the currently displayed SFC Screen.

1) Display the SFC Screen to be deleted.

T Tous T Goli T CLAW Rctiws FLC: TEETT  RF: N
vl
s

™

o2
Tk

Pag moomn oxma 1 @ @ m

Figure 4.233

2) Press the Slash Key to display the Command Submenu.

1 Dctive 2.[lwck vell J.xfc Dhds 4.0t §.Bemrch 6.Dnds ?.THew ‘

Figure 4.234

3) Press F4 (Edit).

The Edit Submenu will appear.

Edit: 1.0s11 2.&0keripters 3.olchange d.0nnert S.Delece 6.3dapulec

Figure 4.235

4) Press F5 (Delete).

The Delete Submenu will appear.

Delete: 1. [Remant 2.c010 2.Jeluen 4.0ev 5. Jege

Figure 4.236
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5) Press F5 (Page),

A confirmation message will appear asking whether to proceed with the deletion.

Figure 4.237

6) Check to see if the contents of the confirmation message are correct, and if so press “Y”

and the Enter Key to delete the screen. “N” is initially entered so deletion wilt not be
executed in case the Enter Key is pressed by mistake.

The SFC Screen will be deleted.

Figure 4.238
Shortcuts
a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.

b) Enter“DM"at AR: and press the Enter Key, or press the Delete Key to display the De-
lete Submenu.

¢) Enter“DP”at AR: and pressthe Enter Key to display the execution confirmation mes-
sage. :

4.3.10 Undoing the Last Change

The following procedure is used to undo the last change,
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4.3.11 Redoing the Last Change

1) Press the Slash Key to display the Command Submenu.

1.0ctiva 2.0sck coll 3.3fc Inde 4.[JWit S.3earch 6.0nds 7.JHew

Figure 4.239

2) Press F6 (Undo).

The Undo/Redo Submenu will appear.

Bade/Rade: 1.0vds last changs 2.0eds changes 3.Jlaar all changes

Figure 4.240

3) Press F1 (Undo Last Change).

The last change will be undone.

Shortcuts

a) Enter “UM” at AR: and press the Enter Key, or press the Alt + U Keys to display the
Undo/Redo Submenu.

b) Enter “UN" at AR: and press the Enter Key to undo the last change.

4.3.11 Redoing the Last Change

The following procedure is used to restore the status prior to undoing the last change.

1} Press the Slash Key to display the Command Submenu.

1.3ecive 2.B0eck coll J.afc Jade 4.0Hit S.3earch &é.Dnde 7.0Hew

Figure 4.241

2) Press F6 (Undo). ‘
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The Undo/Redo Submenu will appear.

1
1

| Unds Reda: 1.Dnde last changs 2.0ede changur 3, Jlear all changes

Figure 4.242

3) Press F2 (Redo Changes).

A change cannot be undone after making another change or moving to ancther SFC
Screen. -

The status will be restored to what it was prior to undoing the last change.

Shorteuts

a) Enter “UM” at AR: and press the Enter Key, of press the Alt + U Keys to display the
Undo/Redo Submenu.

b} Enter “RE” at AR: and press the Enter Key to redo the changes.

1

4.3.12 Clearing All Changes

The following procedure is used to undo all changes made since the current SFC was dis-
played.

1) Press the Slash Key to display the Command Submenu.

1.Detive 2.[leck coll 3.afc Jede 4.(Hit S.Bearch §.Drde 7. JHew

Figure 4.243
2) Press F6 (Undo).

The Undo/Redo Submenu will appear,

" UndeBede: 1.Indo last change 2.[eds changes 3.Jlear all changes

. : Figure 4.244
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4.3.13 Searching
3) Press F3 (Clear All Changes).
All changes to the SFC displayed will be cleared.
Only changes made to the currently displayed SFC will be cleared.
Shortcuts
a) Enter “UM" at AR: and press the Enter Key, or presé the Alt + U Keys to display the
Undo/Redo Submenu.
b) Enter “CAE" at AR: and press the Enter Key to clear changes made to the currently
displayed SFC.
4.3.13 Searching ‘
The following procedure is used to search for specified instructions (elements) oraddresses.
1. Searching for Addresses
1) Press the Slash Key to display the Command Submenu.

1.Dceive 2.[leck eoll 3.afc Inde 4.ic 5.Jmarch 6.Inda 7.Bisw

Figure 4.245

2) Press F5 (Search).

A screen for specifying the address will appear. ‘

“’""“ .+ e —

PGP Mddress<-Dtddr & Iast<=pInstructien{->Tabls Ssarch (-—<PGPHY
<Esze) ta Quic {Entar)> te Beyin

Figure 4.246

3) Enter the address and press the Enter Key.

[“‘"‘ —_ E—

CPCUPY-) Mddresa<-YAdbr & Insti{->Instructiont-)Tabls Search {~(PCDK>
{Esc) ta Quit <Enter) te Bagin

Figure 4.247
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.

A confirmation message will appear asking whether to proceed with the search.

Mdress sl
SPOUP>=)> Address{->Addr & 1neti->Instructioni->Takle Swarch (~(PGDN}
{Ezsc)> ts Quic <Entar> te Bagin

Figure 4.248

4) Confirm by entering “Y”, and press the Enter Key.

Enter “N” and press the Enter Key, or press the Esc Key to cancel the search.

A search will be executed.

s arehoan Progrsge

Network: SHAK

Figure 4.249

The first occurrence will appear, and the cursor will move to that address.

Figure 4.250

Processing after a Search
Editing the network displayed: Press the Enter Key.

‘ {The search will end at that SFC or network.)
Displaying the previous occurrence: Press the Up Cursor Key.

Displaying the next occurrence: Press the Down Cursor Key.
Exiting the search and returning to the original SFC:
. Press the Esc Key.
Switching search screens: Press the Page Up or Page Down Key.
Shortcuts

Enter “S” at AR: and press the Enter Key, or press the Alt + S Keys to display the screen
for specifying the address.
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2. Searching for Instructions and Addresses

1) Press the Slash Key to display the Command Submenu.

1.0cvive 2.0leck cell I.xfc Jede 4.0dit 5.8earch 6.0nide 7.0iew

Figure 4.251

2) Press F5 (Search).

A screen for specifying the address will appear.

F”“ - e—

<PaP-> '“l‘l"(-”m [ Iﬂll(')llimthn( ~>Tabls Search (—PCDN>
to Quir <Fater> ta Bagin

Figure 4.252

3) Press the Page Up Key.

A screen for specifying the address or instruction will appear.

= Saarch

fddress :
lns:mthn z

CPEUPF-> Adireass(~Mddr & In:t(-)l-:tn:thn( ~)Tahls tsarch <~
<Esc> ta Quit <Enter> to Begin LT32¢4> Houva of ﬁm-r

Figure 4.253

4) Enter the address and press the Enter Key.

Move the cursor down.

5) Enter the instruction {mnemonic) and press the Enter Key.

The element mnemonics will appear together with instructions at the function keys, and
can be selected by pressing a function key.

Ssarch
Instructisn
SHuP>-> l“ﬂu(-)lur & _Insté=21nstruct leni{=>Tahls tsarch ¢(=<PCIN>
<Esc) t <Enter> ts Bayin €T27¢i> Move of Curser

Figure 4.254
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1

A confirmation message will appear asking whether to proceed with the search.

Search =—0
A =
Inatruction ITEr
CPGURY-> Addrass<-Hddr & Inst{-dInstruction{—>Tabls Ssarch <—~CPCIN)>
{Exc> to Quit <Enter> te Begin L1/KL> Mave of Curser

Figure 4.255

1
1

6) Confirm by entering “Y”, and press the Enter Key.
Enter “N” and press the Enter Key, or press the Esc Key to cancel the search.

A search will be executed.

Figure 4.256

The first occéurrence will appear, and the cursor will move to that address.

. o h
'S‘Pg 's‘!l-l. Prage (1> 7 (1>, CEntar> te ﬁ <Esc> Finish [l m
Figure 4.257

Processing after a Search
Editing the network displayed: Press the Enter Key.
(The search will end at that SFC or network.)
Displaying the previous occurrence: Press the Up Cursor Key.
Displaying the next occurrence: Press the Down Cursor Key.
Exiting the search and returning to the original SFC:
; Press the Esc Key.

Moving the Cursor

Switching search screens: Press the Page Up or Page Down Key.
Address/mnemonic: Press the Up or Down Cursor Key.
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Shortcuts

Enter “S” at AR: and press the Enter Key, or press the Alt + S Keys to display the screen
for specifying the address.

3. Searching for Instructions
1) Press the Slash Key to display the Command Submenu.

1.Jccive 2.00eck cell 3.sfc Pede 4.0E1¢ $.Fearch & Dvis 7.JHew

Figure 4.258

2) Press F5 (Search).

A screen for specifying the address will appear.

Swarch
Address : I
CPEUP-> Addressd—Aidr & Inst<=>Instructisn(->Table Esarch <{—<PCDIN>
CEse) te Quik <{Entar) ta Begin
Figure 4.259 ‘

3) Press the Page Up Key twice.

An input screen for entering the instruction {(mnemonic) will appear.

The element mnemonics will appear together with instructions at the function keys, and
can be selected by pressing a function key.

Search
‘[ instruccion - NI

<PCUP>-> Sddress<—>Mddr & Inpt<=>Inztructisn{-)Tadly Ssarch <~CPCDN>
{Esc> ta Quit {Entat} te in

Figure 4.260

4) Enter the instruction (mnemonic) and press the Enter Key.

Search
‘[ Instructisn : SIFENER

(PCUP>-> Address<=dAkir & laaté->Instructisnd{->Tabla Search <—CPCIN>
<Ezc)> te Quit {Entar> te Bagin

Figure 4.261
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A confirmation message will appear asking whether to proceed with the search.

’ Inastruction : STEP
' <raur>-> Addrays<-hddr & Inze{->Instructisn<—>Tabls Ssarch {—<PCDN>
CEsc) ta Quit {Eater> so Begin

Figure 4.262

5) Confirm by entering “Y”, and press the Enter Key.
Enter “N” and press the Enter Key, or press the Esc Key to cancel the search.

A search will be executed.

Figure 4.263

The first ocdurrence will appear, and the cursor will move to that address.

NEITR ’UI! Frezs (1> / <i>, <Enter> te stay. <{Escd> fhhh.lb o]
SPCt sr ———

; Figure 4.264

Processing after a Search
Editing the network displayed: Press the Enter Key.
(The search will end at that SFC or network.)
Displaying the previous occurrence: Press the Up Cursor Key.
Displaying the next occurrence: Press the Down Cursor Key.
Exiting the search and returning to the original SFC:
| Press the Esc Key,

Switching seémh screens: Press the Page Up or Page Down Key.

1

Shortcuts

\
Enter “S” at AR: and press the Enter Key, or press the Alt + S Keys to display the screen
for specifying the address.
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4, Displaying a Table of Found Addresses

The fellowing procedure is used to display a table of addresses (instructions) after a
search is completed.

1} Press the Slash Key to display the Command Submenu.

1.Decvive 2.0ck coll J.efc Tpde 4.[ic 5.Mearch 6.Jns 7.Jiew

Figure 4.265

2) Press F5 (Search).

A screen for specifying the address will appear.

<PCUP>—) Adiress<->tddr &k Inst{-dInscructisn{->Takle Ssavch {—<PCDK>
<Exc) te Quit <Entar> te Bewin

Figure 4.266

3) Press the Page Up Key three times.

A screen for specifying a table search will appear.

Pddre: : A
{PGUPF>~> I“ﬂsl(Z;Iﬁ.r L] ln:zl(-)inttmth-(-)'lﬁh Search {—(PCDN>
Space> to Teygla <Esc)> to Quit <Alt~E> te Bagin
=-

Takls Search
SPFC range z W_
( Instruccian @ Spacity fmesanic

Figure 4.267

4) Enter the settings needed for the search, and press the Alt + E Keys.

= Tahla Saarch

s BN |
lltxg.bﬂ : Specify Hnewenic 1 STEF

Adiress H Sp-eifi: Search :W
SPQUPY=)> Address$=2Addr & Ingt<=>Inatructieni->Takls Searc
CEsc> te Quit CAlt-E> to Begin

Figure 4.268

A search will be executed.

Figure 4.269 ‘
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Occurrences will be displayed in a table after the search is completed,

I Search Matchaz I
Databaze: TESTL Walp: <Ale-H>
The follewiny satches were found:
EEHETN

<Esc)> tu Quic

v YASKAWA =
— L

* Figure 4.270

5) Move the cursor to the number that will be displayed and press the Enter Key.

The SFC Screen will appear, and the cursor will move to the element.

1

NETR q! Preaz (1) / 1>, (Homa} for Table. <Enter} te Stay ... .I] m
$rCL —

Figure 4.271

Processing after a Search

Moving to the previous or next occurrence from the screen displayed:
’ Press the Up or Down Cursor Key.

Stopping at the network displayed: Press the Enter Key.

Returning to the original network: Press the Esc Key.

Returning to the table: Press the Home Key.

Settings
1) SFC Range

All SFCs: Searches for all SFCs in the database.
Current SFC: Searches only the SFC area currently displayed.

From the cursor position:
Searches from the present cursor position to the end of the current area.
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2) Instructions: Specifying the Element to Find

Specify: The mnemonic input area will appear. Specify the element t¢ find using the ‘
mnemonic.

Example: N.O. Step ({ })

instruction:  Specify Mnemonic:

Any: Searches all elements.

3) Addresses: Specifying the Address to Find

Specify: Specifies the address to find.
Any: Searches all addresses.

Moving the Cursor

Moving to the next or previous item:
Press the Up or Down Cursor Key.
Moving to the next item: Press the Enter Key.
Reversing items: Press the Space Key, or the Left or Right Cursor Key.

Shortcuts

Enter “S™ at AR: and press the Enter Key, or press the Alt + S Keys to display the screen
for specifying the address.

4.3.14 SFC Mode Submenu

The SFC Mode Submenu is a special Command Menu for SFC editing.

SFC Mode: 1.Bondition setting 2.Fimulation 3.lked display

Figure 4.272 SFC Mode Submenu

F1: Starting Up the Condition Setting Menu.
The F1 function sets conditions for initializing (starting), resetting, and presetting the '
SFC.
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F2: Starting Up the Simulation Submenu
The F2 function sets simulation status, such as active, disabled, and hold, useful for de-
bugging and other operations. Only simulation settings are availabie in offline editing,
and online editing must be entered after the settings are loaded into the CPU in order for
them to become functional.

F3: Starting Ub the Used Display Menu
The F3 function displays a list of step and transition numbers as weli as program use sta-
tus.

1. SFC Initialization

Thefollowing procedure is used to set startup settings used for initializing and starting up
the SFC program. The SFC will start up when the conditions that are set go into effect.

1) Press the Slash Key to display the Command Submenu.

T 1.Deeiva 2.MMeck cell 3.afc Tede 4.1t S.Bvarch 6. Jhde 7.THeu

Figure 4.273

2) Press F3 (SFC Mode).

The SFC Mode Submenu will appear.

SPC Mede: 1.Jendition setting 2.Fimulation 3.Ieed display

Figure 4.274

3) Press F1 (Condition Setting).

The Condition Setting Submenu will appear.

1

Candition Setting: 1.[hitialize 2.[eset 3.(ezat

Figure 4.275

1

4) Press F1 (Initialize).
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A screen for SFC Mode Initialize Screen will appear.

fctive PLUT TERIT TFCASEE = TRITIALTZE =

n: REF 8 _EIATUS
TN

i

<Alt-E> te Save and Exit
B-fut Refd L.Statur On T.Status OFf 0.Clsar Parwmwter

YASKAWN sl

Figure 4.276

*5) Enter the reference number that wiil be the start condition at AR:.

6) Press F1 (Set Reference Number).

The reference number can also be set by pressing the Enter Key after entering the refer-
ence number at AR:.

et

Na RER & STATUS
1

<Alt-E> te $awa and Exit
3.5et Raff P.Sratus On T.Statux OFF J.Clear Paramstsr

Figure 4.277

7) Press F2 (Status ON) or F3 (Status OFF) to select initialize condition ON or OFF. ‘

8) Press the Alt + E Keys to save the settings.

An alternative method is to press the Esc Key and enter “Y” or “N” when the confirmation
message appears asking whether to save changes.

Note A network that is not SFC must be created in order to turn ON a coil.

Shortcuts
a) Enter “SMM” at AR: and press the Enter Key to display the SFC Mode Submenu.

b) Enter“SCM”at AR: and press the Enter Key o display the Condition Setting Subme- '
nu.

—4-118 —




; 4.3 SFC Editing

¢) Enter“INIT” at AR: and press the Enter Key to display the SFC Mode Initialize Screen.

2. Reset Setting

Reset Setting inactivates steps in SFC processing (no processing). Muitiple settings can
be used for reset conditions.

1) Press the S]ash Key to display the Command Submenu.

J 1.Jetive Z.[leck coll 3.sfc Jude 4,01t S.Bearch 6.Jnde 7. Diew ’

Figure 4.278

2) Press F3 (SFC Mode).

The SFC Mode Submenu will appear.

l | SFC Meds: 1.Jeadition setting 2.Bimulation J.lked display !

Figure 4.279

3) Press F1 (Condition Setting).

The Condition Setting Submenu will appear.

i
' Canditison Setting: I.0hitialize 2.0zt 3. Prezet

Figure 4.280

4) Press F2 {Reset).

The SFC Mode Reset Screen will appear.

{N1t-E> te Save amd Exit —
i.50¢ Relf L $tatus On B-Svatus OFF 0.Clear Paransrer

HTHERIHIT

[N

Figure 4.281
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4.3.14 SFC Mode Submenu cont.

A maximum of 8 steps can be reset per condition, and 64 conditions can be set in total.

5) Enter the reference number at AR:.

Press the Page Up or Page Down Key to switch input screens after the 16th reference
number.

Resetting all condition settings (setting to ALL) initializes conditions and resets all pro-
grammed steps.

6} Press F1 (Set Reference Number).

7) Press F2 (Status ON) or F3 (Status OFF) to select reset condition ON or OFF.

o
o

]
I ES
FHETEEE TS
&

STEF N0 ~ REGISTER MO

it - PRME PR = J

TG &

<A1t-E> teo Save amd Exit
O-Set Mef? . $Status On D.Scatur OFF J.Claar Paramster

Figure 4.282

8) Move the cursor to the setting area for step numbers.

9) Enter the step number at AR..

If an input Register (30001 or higher) is set instead of a step, the step with the register
data will be reset.

Register Data : ‘
| 30001 ] 20 | so20isset

10) Press F1 (Set Step).

tive

.t REF B STAIUS STEF WO ~ REGISTER MO
% iseki ON B — —— ——— —— ——— ——— —=
] m— — T e e e ———— ——
4 — — T e e e ——— —
§  mmm— —— e ——— — ——— ——
£ mm— — e o e ——— —_—
- S T e e —————
g —= — ———— . — - — —mn — ——
[P s ——— m——— ——— — —— i ——
i —— e —— m—— — —— e —m— ——
1 — T ——— e
12 —— - L —— e —
1] — e ——— —— —— — ——— — ——
14— — —— e —— thi—— — —— — i
1§ em— —— . —— e ——— e — it
16 —— @ — ——— . —— ——iin — —— — ——
<Alt=E> te Save and Exit
H-Set Stap 5.Clear Stop 0 S.Clasr Paramster
Figure 4.283
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11) Press the Alt + E Keys to save the settings.

Shortcuts

a) Enter “SMM” at AR: and press the Enter Key to display the SFC Mode Submenu.

b) Enter “SCM"at AR: and press the Enter Key to display the Condition Setting Subme-
nu.

¢) Enter “RESET” at AR: and press the Enter Key to display the SFC Mode Reset
Screen.,

3. Preset Settings

The following procedure is used to activate (process) a step where SFC processing was
terminated. Multiple settings can be used for preset conditions.

1} Press the Slash Key to display the Command Submen.

1.]etive 2.Meck coll 3.sfc Dade 4.1t S.8earch &.Inde 7 Disw

Figure 4.284

2) Press F3 (SFC Mode).

The SFC Mode Submenu will appear.

$7C Mede: t.Jenditisn setting 2.Bimuletion 3.Deed dizplay

: ~ Figure 4.285

3) Press F1 (Condition Setting).

The Condition Setting Submenu will appear.

Condtitien Satting: i.Dnicialize 2.0nnst 3.0rezet

Figure 4.286
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4) Press F3 (Preset).

The SFC Mode Preset Screen will appear.

— MCt H - H =
STEF W0 7 REGISTER w0

¥
Ia
-

o T S R

I
TNt

<Ale-E> ta Save and Exit
YASKRUR
U.Sot Refs Y.ftatus On B.Status OFf D.Clear Paramster

Figure 4.287

A maximum of 8 steps can be reset per condition, and €4 conditions can be set in total.

5) Enter the reference number at AR:.

Press the Page Up or Page Down Key to switch input screens after the 16th reference
number.

6} Press F1 (Set Reference Number).

7) Press F2 (Status ON) or F3 (Status OFF) to select preset condition ON or OFF.

¥
gt
"
-
»
=1
e
“

cEive =
[ STEP NO # RECISTER MO

!

T BT PRI

T
TN

B
[N

"
3

<ALt-E> ta Save and Exit
.Ser Raft P.Stavus On [l.Ztatus OFf J.Clear Faremster

YASINUN m—

Figure 4.288

8) Move the cursor to the setting area for step numbers,
9) Enter the step number at AR:.

If aninput register (30001 or higher) is set instead of a step, the step with the register data
will be reset.

Register Data
I 20 | soz0isset ‘
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i

10) Press F1 (Set Step).

a
|
<
.

Ne REF & STRAIUS STEF NQ # REGISTER NO

; 100 oM iz IBTD —— — .

3 mm— — ————— e e T T
4 m— —— e e T T
[-J T — — e e —— e — o
[ — — e e —— e L T
b B — ——— e —— e e . T
. —— —— —— — e —— e —
[ S — — e e m—— e o
N — — —_—— —— e o — L
11— — —_—————— e T LT
12 o ] -— ——— | T — — . ———— e
13 — — — e ——— e —— e
14 —— - ——— T T
15 — ————— —— e —— e e
16— ————— e — ——— —— —

TATKAUR —
i.Sec Scep B.Claar Step .Clsar Paranster

Figure 4.289
11) Press the Alt + E Keys to save the settings.

Shortcuts

a) Enter “SMM” at AR: and press the Enter Key to display the SFC Mode Subrmenu.

b) Enter“SCM” at AR: and press the Enter Key to display the Condition Setting Subme-
nu.

c) Enter“PRE” at AR: and press the Enter Key to display the SFC Mode Preset Screen.

4. Simulation Settings

Simulation Settings are useful for debugging programs with SFC simulation operation.
Only simulation settings however, are available offline, and online editing must be en-
tered after the settings are loaded into the CPU in order for them to become functional.

A. Active Function

The Active function activates steps which are in the normal processing order. Processing
automatically moves to the next step.

1) Press the Slash Key to display the Command Submenu.

|

1.Jctive 2.[Heck cell 3.efc Jude 4.0Mit 5.Zearch &.Dvis 7. DHaw

Figure 4.290

2) Press F3 (SFC Mode).

i
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4.3.14 SFC Mode Submenu cont.

The SFC Mode Submenu wili appear.

SFC Mode: 1.Benditien setcing 2. 3sulation 3.Jead dizylay

Figure 4.291

3) Press F2 (Simulation).

The Simutation Submenu will appear.

Simulacian: 1.Dctive 2.Disable 3.Ib1d 4.0msec 5.Jlsar all 6.[Wit status

Figure 4.292

4) Move the cursor to the desired step.
5} Press F1 {Active).

Processing will begin from the step at the cursor position.

Original processing that was in progress will continue unchanged.

Shortcuts
a) Enter “SMM" at AR: and press the Enter Key to display the SFC Mode Submenu.

b) Enter “SSM” at AR: and press the Enter Key to display the Simulation Submenu.

c) Enter “ACT” at AR: and press the Enter Key to start processing from the step at the ‘
cursor position.

B. Disable Function

A disabled step will not become active even when its turn to execute comes around. The
Disable function disables steps so they will not execute during program editing or other
operations.

1) Press the Slash Key to display the Command Submenu.

1.Jktive 2.[leck coll 3.efc Tade 4.BKit 5.3sarch 6.Jnds 7.JHew

Figure 4.293 - ‘
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1

2) Press F3 (SFC Mode),

The SFC Mode Submenu will appear.

‘ SPC Meds: 1.Jeaditisn zetring 2.JHalatisn 3.Dsed display

Figure 4.294

3) Press F2 (Simulation).

The Simulation Submenu will appear.

Simulatien: 1.jktive 2.Jisable 3.I01d 4.0eset 5.F0ear all &.it svatus

Figure 4.295

4) Move the cursor to the desired step.

5) Press F2 (Disable).

Press F4 (Reset) to cancel the Disable function.

The step at the cursor position will be disabled.

Shortcuts

a) Enter “SMM” at AR: and press the Enter Key to display the SFC Mode Submenu.
i
b) Enter “SSM" at AR: and press the Enter Key to display the Simulation Submenu.

¢) Enter “DA” at AR: and press the Enter Key to disable the step at the cursor position.

C. Hold Function

I a step on hold becomes active when its turn to execute comes around, active status will
be maintained and processing will not continue until the hold is canceled.

1) Press the Slash Key to display the Command Submenu.

1.Jetive 2.Bleck coll 3.0fc Tnde 4.0 S.3earch §.Jnda 7.[Hew

Figure 4,296
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2) Press F3 {SFC Mode).

The SFC Mode Submenu will appear.

SPC Made: 1.Jenditien setting 2 Bimilacien 3 Jked dizplay ‘

Figure 4,297

3) Press F2 (Simulation).

The Simulation Submenu will appear.

Simulatisn: 1.3ctive 2.Bizable 3.Jsld 4.Jeser 5.Jlear a1l &.JHit status !

Figure 4.298

4) Move the cursor 10 the desired step.
5) Press F3 (Hold).

Press F4 (Reset) to cancel the Hold function.

The step at the cursor position will be on hold.

Shortcuts
a} Enter “SMM" at AR: and press the Enter Key to display the SFC Mode Submenu.

b) Enter “SSM” at AR: and press the Enter Key to display the Simulation Submenu. ‘

¢) Enter “HLD” at AR: and press the Enter Key to put the step at the cursor position on
hold.

5. Single-screen Editing for Simulations

The following procedure is used to execute the three simulation operations described in
Simulation Settings, based on a list from the Edit Screen.

1) Press the Slash Key to display the Command Submenu.

1.fcties 2. 0Neck coll 3.2fc Fode 4.0dit 5.3earch &.Drde 7.JHew

Figure 4.299 ‘
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2) Press F3 (SFC Mode).

The SFC Mode Submenu will appear.

SPC Mede: 1.Janditien setting 2.Hmulasion 3.]sed display

Figure 4.300

3) Press F2 {Simulation).

The Simulaiion Submenu will appear.

i
3

! timulatien: 1.Jktive 2.Misabls 3.002d 4. Qeset 5. Mear ail §.Biic status

Figure 4.301

4) Press F6 (Edit Status).

The Step Status Display will appear.

<A1t-E> ts Gava and Exit
D~ active B - disabls H - eld I - active k hald
o

Figure 4.302

5) Select a simulation function from the Function Menu.

Refer to 4. Simulation Settings on page 4-123 for more details on all simulation opera-
tions,

6) Press the Alt + E Keys to save the sattings.

Shortcuts

a) Enter “SMM" at AR: and press the Enter Key to display the SFC Mode Subrnenu.

‘ —4-127 —



Offline Editing

<
4.3.15 Displaying SFC Use Status

b} Enter “SSM” at AR: and press the Enter Key to display the Simulation Submenu.

¢) Enter “FORED" at AR: and press the Enter Key to display the Step Status Display.

4.3.15 Displaying SFC Use Status

The following describes the list display for SFC step and transition numbers in use.

= #ctive PLE: TESTL Ttey Uzs Bivplay Felpt AAlcH> —=

RS
EW2x:z seerererae
S85x: L E
S0x:
$ilx:
Sldct
St
£28x:

e :

] £20x: -

£ 1 -

: o :

: -- : - Sedx: :

2 -- H - S -

S H S5Bx: rresrieran
A = Wersal ftep (Actissm Clrcuits) N - Racre stap CExpamided View)
<Esc> te Betum fp—

Figure 4.303 SFC Use Status Display

S001 to S512 are all displayed.

(Example on the feft)
9123456789 i ;
I0Bx: TITT-T--- * Steps S001 to S007 will be used in the program.
Steps S004 and S007 are macro steps.

Figure 4.304

Operations cannot be applied to items on the list because the list is strictly for display pur-
poses only. The same is true for the transitions list display. ‘

Transition Use Status

8123456789
I88x: TIIT-T---

Figure 4.305

“T" will appear at transitions in use.

Displaying Steps and Transitions

The following procedure is used to display a list of all step (S001 to 8512) and transition (T001 '
to T512) numbers and also indicates whether they are in use in a program.
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1) Press the Slash Key to display the Command Submenu.

1.Tctive 2.[0eck cell 3.ufc Tude 4.0dit S.Bearch 6.Thds 7.JHav

Figure 4,306

2) Press F3 (SFC Mode).

The SFC Mode Submenu will appear.

i

SPC Mode: 1.Jendicisn serting 2.Bimulatien 1. Dend dispiay

Figure 4.307

3) Press F3 (Used Display).

The Used Display Submenu will appear.

Uspd Dizplay: 1i.Bepe wsad Z.0ransitisny weed

Figure 4.308
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4.3.16 Processing Blocks

4) Press F1 (Steps Used) or F2 (Transitions Used) to display the respective Use Display

Screen.

Since the Steps Used and Transitions Used are simply displays, individual elements dis-

A — MWermal Step {Mctism ciregé:l)

a> te Return

N - Macre :tep (Expended View)

7= fctive FI&T TEBI Ttey Uss Visplay Hely: <AL =
BL2345670% BL2I4S678Y ®L2345678Y
Sl s n-- Shix: - == SR2x: -
s - -- £85x .
P Sllx:

122456797
s TITT-T==-

Figure 4.309

{Ezc> te Return

Figure 4.310

played here cannot be changed.

Shortcuts

a) Enter “SMM"” at AR: and press the Enter Key to display the SFC Mode Submenu.
b) Enter“SUM” at AR: and press the Enter Key to display the Used Dispiay Submenu.

¢} Enter“STEPU” for Steps or “TRANU" for Transitions at AR: and press the Enter Keyto
display the respective Use Display screen.

4.3.16 Processing Blocks

Defining Block:
Defines a block of multiple elements,
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4.3 SFC Editing

Editing BIocIfs:
Uses the block functions to edit blocks (copy, move and delete).

» Copying or Moving a Block:
Copies or moves a specified area defined as a block to any location.

» Deleting a Block:
Deletes elements defined in a biock.

1. Defining Blocks

The fo!lowihg procedure is used to group and edit (Copy, Move and Delete) multiple ele-
ments defined as a single block. '

1) Press the Slash Key to display the Command Submen.

e

1.Ictive 2.[leck call J.ufc Jods 4.(Mit 5.Bearch €.Drdte 7.Mew

% Figure 4.311

2) Press F2 (Block Cells).

The Celi Block Submenu will appear.

-

Call Black: t.MMeck 2.Thblack 3.Jepy 4.Teve §.0unp 6.elece

Figure 4.312

3) Move the cursor to the first element (starting point) in the area that will be defined as the
block on the screen.

4) Press F1 (Block).

. L] soa? I — :,lm.--—]
TG
ck: L.Elack .0chlsck J.Jepy 4.Tave S.Dunp 6.[elete

Figure 4.313

5) Move the cursor to the last element {end point) in the area defined as a block.

1
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4.3.16 Processing Blocks cont.

8) Press F1 (Block).

Only one block can be defined at a time. Ungroup the block after a block operationis com- ‘
pleted before defining the next block.

Press F2 (Unblack} to ungroup the block.

The area displayed in reverse video with the specified starting and end points at opposite
comers will be defined as a block.

The area defined as a block will appear at the bottom-left side of the screen.

Starting point: S000  End point:
Column 1, row 3 Column 2, row 3

Figure 4.314
Shortcuts
a) Enter “BLM” at AR: and press the Enter Key, or press the Alt + B Keys to display the
Block Submenu. ‘

b) Enter “BCB" at AR: and press the Enter Key to define the biock.

2. Copying or Moving a Block

The following procedure is used to Copy or Move an area defined as a blockto any loca-
tion.

1) Define the block. ‘

Referto 1. Defining Blocks on page 4-131 for more details on the procedure for defining
blocks.

Ll

l

Figure 4.315
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2) Move the cursor to where the block will be copied or moved.

When specifying the location where a block will be copied or moved, specify the step row
for steps and the transition row for transitions.

3) Select F3 (Copy) or F4 (Move) from the Cell Block Submenu.

S006 7 S
1 TO0E R
ck: L.llack Z.Tnbleck 3. 0upy 4.30ve §5.Tuwp 6.Delete
i

Figure 4.316

4) The block will be copied or moved.
A block can be copied or moved to another SFC as well.

The block will automatically be ungrouped after a move.
1

Figure 4.317

5) Enter addresses for the elements after the elements are copied.

| Coll Wisck: 1.Dlack 2.Dvblack 3.Japy 4.3eve 5.Tunp 6.Qelete

Figure 4.318

Shortcuts |

Enter “CCB” for Copy or “MCB" for Move at AR: and press the Enter Key to copy or move
the block.

1
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4.3.16 Processing Blocks cont.

3. Deleting a Block
The following procedure is used to delete a defined block. ‘

1) Define the biock.

Referto 1. Defining Blocks on page 4-131 for more details on the procedure for defining
biocks.

2) Press F6 (Delete) from the Cell Block Submenu.

Figure 4.319

3) A confirmation message will appear asking whether to proceed with the deletion. Check
to see if the contents of the confirmation message are correct, and if so press “Y" and the
Enter Key to delete the cell block. “N” is initially entered so deletion will not be executed in
case the Enter Key is pressed by mistake. ‘

Rctive PLU: YIS .5

Figure 4.320

The area defined as a block will be deleted.

el

Col} Black: 1.Dleck 2.Ikblack 3.Jepy 4.5ove S.0wp ¢.0Dnlece

Figure 4.321 ‘
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Shortcuts

Enter “DCB" at AR: and press the Enter Key to delete the cell block.

4.3.17 Backing Up a Database during Editing (Snapshot)

The following procedure is used to back up a database during SFC editing. A backup is made
as a precautionary measure in case a program is deleted accidentally or a database is cor-
rupted during editing. Time and effort will not be lost as long as the backup is updated during
program editing.

1) Press the Slash Key to display the Command Submenu.

i.Ictive 2.[Meck coll 3.afc Tede 4.[Mit S.Barch 6.Jvde 7. JHew

Figure 4.322

2) Press F4 (Edit).

The Edit Submenu will appear.

Edit: 1.Je1) Z.&ecriptere 3.e3change 4.0naert S.Delete G.sTupeimt

Figure 4.323

3) Press F6 (Snapshot).

4) Press the Enter Key to proceed with backing up.

Figure 4,324
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4.3.17 Backing Up a Database during Editing (Snapshot) cont.

5) A database named “ISnap!” will be created and stored in the same directory.

When two or more files are saved under the same name, the newer files will overwrite
(update} the older files.

Note Make sure there is sufficient free space on the hard disk before executing a Snapshot be-
cause a database is created with exactly the same data as the currently selected database.
The name and directory for a snapshot cannot be specified. If there is snapshot for another
database already in the directory, that snapshot will be overwritten.

Shortcuts

a) Enter “EM" at AR: and press the Enter Key to display the Edit Submenu.

b) Enter“AS"at AR: and press the Enter Key to display the execution confirmation mes-
sage.
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4.4 Editing Comments

The following types of comments are created with MEMOGAD-PRO.
« Signal descripfors

¢ Short commeﬁts

» Page title

s Long comments

These comments can be printed together with ladder diagrams mainly when creating lists,
such as ladder lists, and are used to describe networks as well as individual elements. The
comments can be edited and referred to when editing ladder programs (network editing). Da-
tabase comments are displayed along with ladders even during online ladder editing, and
comments can be displayed and edited online with any Processor. Editing functions like Ex-
clusive Copy, Move and Delete are also available here.

4.41 Displaying Comments on Network and SFC Screens

The following procedure is used to display the Comment Window in a corner of the screen in
order to refer on-screen to the signal descriptor for the address at the cursor position.

1. Displaying the Comment Window

1) Display the network.

2) Press the Slash Key to display the Command Submenu.

PEC
B The NG THE FEE NN Sum Sk 2pm muen

Figure 4.325

3) Press F8 (View).

f 1.Tctive 2.Meck 3. Qegizter 4.0dit 5.Flehal 6.Boarch 7.Inds &.JMaw 1.3041

Figure 4.326
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4.4.1 Displaying Comments on Network and SFC Screens cont.

4) Press F2 (Window) from the View Submenu.

View: 1.0esc 2.Zindew 3.3ark 4.Jemark S.Dunp 6.Bete 7.Seen E.300m Qeturm

Figure 4.327

The Comment Window will appear.

Fatusrk: W01 A00] TL Werlve FLC: TEXTE &%z

.

ZHEEEEE, .. ... .. rrereennarnrrrrrreitsarersrarseransserrosasarey — y—

B

]

5

E

P .
Utsw: 1.(eac 2.Bindsw 3.Jark 4.Dwark 5.0kwp €. Jots 7.500m S.zeen Deturn

Figure 4.328

Shortcuts

Enter “TW" at AR: and press the Enter Key to display the Comment Window.

2. Displaying Descriptors on Screen

1) Press the Siash Key from the Network or SFC Screen.

2) Press F3 (View).

E Visw: 1.Desc 2.Dindew 3.3ark 4.Demark 5.0y 6.Jote 7.50en §.x00n foturm

Figure 4.329

3) Press F1 (Descriptor) to display the signal descriptors of all addresses on screen.
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When sigﬁal descriptors are displayed, the display screen is enlarged so the entire
screen cannot be seen. Use the cursor to scroll through the screen.

Press F1 (Descriptor) again to return to the original screen,

twerk: ot ivg

Figure 4.330

Shortcuts

Enter “TS" at AR: and press the Enter Key to display the signal descriptors of all address-
es on screen.

4.4.2 Creating Comments

Comments can be attached to Network and SFC Screens that have been created, as well as
to the reference numbers for individual elements on those screens. Comments can be re-
ferred to on personal computer Network Screens or on printed lists, and are useful for checks
and maintenance on program details.

Comments vary in the number of characters that can be entered and usage.
i
1) Signal Descriptors
Settings
= Characters per line: Up to 10 characters

* Number ofrlines: Up to three lines

Features ‘
o
a) Facilitates notes on functional roles or other information about refays and coils used at

each address.

b) Prints above the elements in tadder lists when the lists are printed out.
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4.4.2 Creating Comments cont.

¢) Can be referenced from the Network Screen.

2) Short Comments

Setlings

¢ Characters per line: Up to 48 characters

* Number of lines: Up 1o four lines

Features

a) Facilitates notes on functional roles or other details about relays and coils used at
each address.

b) Allows notes to be written mainly on coil and network addresses.

¢) The large number of characters that can be entered allows more detailed explana-
tions than that provided by the signal descriptor.

d) Short comments for ladder lists are printed on the upper-right side of the coil or below
the network in the ladder diagram (depending on the type of printer). Network short
comments are printed on the upper-left side of the network. ‘

Note Short comments other than those for coils and networks will not be printed in
ladder lists.

3) Page Title
Settings ‘
» Characters per line: Up to 64 characters
« Number of lines: One line
Features
a) Allows network notes.
b) Prints as a header or network title when a ladder list is printed.
4} Long Comments
Settings
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M

» Characters per line: Up to 255 characters
s Number of lines: Up to 1,000 lines
Features

a) Allows long sentences to be created in the database separate from the database,

b) When along comment (number) is specified in a network, long comments for that net-
work can be included during printing.

These comments can be printed on a ladder list or on their own.,

1. Displaying the Comment Input Screen

The following procedure is used to display the Comment Input Screen.

A. From the Ladder/SFC Screen

1} Seiect 1. Seiect Active PLC from the Main Menu to select a database.

Comments cannot be created if a database is not selected.

| Salecy Database
ne: TESTL LT

TEET .CPC

FENAPT _CPC

C3\CLERE\DIN=, (PG
IR <Tah) suitch windew
YASKAUS =

B-Prive B-Rebuild [.Mew Pirsctery D.Delets Directery B.Mew Pile

Directa:
Quick !”!:d!

Figure 4.331

2) Display a Network or SFC Screen.

1T H B etive

: P BaT 1
P T ShE ue Wme my vm wp e my
|

i

Figure 4,332
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3) Move the cursor to the address for which comments will be created.

tworks TL7W Weclve FLO: TESTL [ ). CO—

— = Nl
RILAY
Fos TEST

View: 1.Jesc 2.Rindew 3.Jark 4.Jamark 5.0unp ¢ .Jote 7.Z0em §.x00a oturn

Figure 4.333

4) Press the Tab Key.

Shoricuts

The Comment input Screen will appear.

Ehart Ceomment Ne.
Ivalid werd siza)
I 8 werds/ line 1

Lang Comment Munbar: # B> far trailing
Page Titla:

<A1t-E> te Eaws and Exit <Ezc) te gquit
i B OOE E OO kL | !mu

Figure 4.334

Enter “EE" at AR: and press the Enter Key to display the Comment Input Screen.

B. From the Descriptor Address Table

1} Select 2. Offline from the Main Menu.

2} Select 4. Descriptors from the Offline Edit Menu.

m

| Loy Lot SRS SR | i e |
Database: TEST2 Baly: <Ale=i>
OFfline Edit Mesuc
1. Select Active FLC

2. Netwer]
3. tial Pahction Charts

6. Prace o G:.}li;urq $ 1]
- szar Con tien
'.?. 'IKGCH_Ih.sx-'.: o R

<Exc> t» Motarn ts Frevisus Henu
Enter Optien: B

_— — AT =

Figure 4.335

—4-142 —




‘ 4.4 Editing Comments

3) The Descriptor Address Table will appear. Move the cursor to the reference number that
will be edited and press the Enter Key.

|_ Ladder Lagic Develepment Softwers - Descripter Address Tabls j
Database: TESTI Nalp: <Ale-4>
Dezcripter Addresses in Davabaas:

< > Prav {PyDn> Moxt
Pad Miress: OEEE T T

<Eac} tes guit
d-Bleck J.Edit I.Cets J.Saarch N Leny

Figure 4,336

A message will appear if there are no addresses with comments. Press any key to display
the table,

Press the Enter Key if there are no comments in the Address Table. The reference num-

ber input field will appear. Enter a number and press the Enter Key to display the Edit
Screen,

The Comment Edit Screen will appear,

CAIL-H> For Nalp

Long Comment Mumbar: @ {-~83) For trailing
Page Title:

<M1t-X> to Sava amd Exit (Egc) te quit
bk E E T Kk '™

Figure 4.337

Moving the Cursor

Moving up, down, left or right: Press the Up, Down, Left or Right Cursor Key.
Moving to the next or previous page: Press the Page Down or Page Up Key.

¢ Press F3 (Goto) from the Edit Menu and enter an address in the input field to move to
the address that was entered.

|
* An altemative method for moving to an address is to enter the address in Find Address
from the Descriptor Address Table.

|
2. Displaying‘ the Descriptor Address Table

The Descriptdr Address Table is a List Display Screen for discrete addresses and regis-
ters with comments as well as reference numbers for networks.
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4.4.2 Creating Comments cont,

The following procedure is used for opening the Comment Input Screen and creating com-
ments as well as for copying and deleting the comments of target reference numbers.

1) Select 2. Offline from the Main Menu.

HENOCON-SC GLAS/ 6870
Ladder lagic hv-hrn: Seftuare ~ Main Panu
Garsien 2.08 Copyright 1391 YASXAWA ELECTRIC CORPOMIION
Dacabase: TEET1 Help: <Ale-H>
Hain Menu:

1. Seleck fotive PLC

- Matisn

. List ketive FLC
- Leader

. Brilities

<E} te Exit te Des
Eater Optien: B

E —— =r—— YASMAYA

RS

Figure 4.338

2) Select 4. Descriptors from the Offine Edit Menu.

NEMOCON-SC CLAB/EA/78
Ladder Legic Develspmant Seftware ~ Edic Memu
Patabaze: TESTL Help: <A1t->
Offline Edit Menu:
1. Salsct Active PLC
2. Metwerks
3. 3 neinl Punctisn Charts
e Datalis

6
7. RECIT] Wassamex
1. Crasshefurence Dizpesition

{Ezc> to faturn te Previsus Menu
Eatar Optisn: El

—_—— —i YASKAWA
Figure 4.339
The Descriptor Address Table will appear. ‘
[ Ladder Layic Developmeat Faftware < Descripter Mdrers Tadle |
Database: TEST1 Ralps <A1e-H)>
Dezcripeer Adiresses in batabaze:
—

<Pylp> Prav (Pghn> Maxt
Find Address: SN

<Exc)> te quit
J-Mack H.Edic D.Gate J.Search J.Leny

Figure 4.340

A message will appear saying comments could not be found if there are no comments. ‘
Press the Enter Key once to switch to the Descriptor Address Table.
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Moving the Cursor

Moving up, down, left or right: Press the Up, Down, Left or Right Cursor Key.
Moving to the next or previous page: Press the Page Down or Page Up Key.

3. Entering gommenfs

The following procedure is used to enter comments.
1) Display the Comment Input Screen.

Referto 2. Displaying the Descriptor Address Tableon Page 4-143for more details on the
procedure for displaying the screen.

@A-N> For Kelp

Bezcripter Hamber
[valid werd atize]
[ & werds/ line ]

Chart Commgnt Me.
Cvalid werd sizel
[ 8 verdss line ]

pivie)

BunE e

Lang Comnent Nunber: @ <=BE> For trailing
Page Title:

1
<Alt-E> te Save and Exic <Esc> o quit

SN N N B SEE <EE 7R

Figure 4.341

2) Enter comments from the keyboard.

Bezcripter Nunber
[valid werd aize}
[ § wardar line )

Ale-H> for Mely
1> SAMPLECON

2> RN

EH

Short Coument He. :
€0 verdss line } 3

Loag Conmant Munber: o <-83> for trailing
Page Title:

<Alt-E> t» Save and Exit <Bxc) te quit
kK F E ¥ FE LT

.

Figure 4.342

Press the Tab Key to save the comments.

4. Copying Comments

The following procedure is used to copy comments from one address (reference num-
ber) to another address.
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4.4.2 Creating Comments cont.

1} Select 4. Descriptors from the Offline Edit Menu.

2) Press F1 (Block).

The Block Edit Menu wili appear.

3) Move the cursor to the first address (starting point) that will be defined as a block, and
press F1 (Block).

When copying comments from just one address, Move the cursor to that address. There
is no need to define a block for one address.

4) Move the cursorto the last address {(end point) that will be defined as a block, and press
F1 (Biock).

5) Press F3 (Copy).

[ Capy Dezcripter Blasck l ‘

Database: TEETL Nalp: <Ale=i> J

W Conmpnds
tapt szt BEBEL <Alt=E> te Capy
End  Adivesas: BE1 {Ese> to quit

MIF
Bescripters te Capy:

Addrezs Copy Fathed: Equal Nhﬂl__lgdnﬂl
g
=
Figure 4.343 ‘
6) Set the copy details.
7) Press the Alt + E Keys.
8) Check the details and enter “Y™ or “N".
9) Press the Enter Key. ‘

Comments to be Copied

« All: Copies all comments

» Specify: Selects the type of comment when the Tab Key is pressed.

Address Copy Method
+ Same Offsets
Block
00001 00011
00002 Copy 00012
00004 | —» 00014
00009 00018 ‘
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“‘%
» Continuous Addresses

Block

00001 00011
00002 Copy 00012
00004 —_— 00013
00009 00014

5. MuHltiple (;ogies

The following procedure is used to copy comments from one address to multiple ad-

dresses orto copy comments from an address (reference number) to a series of address-
es at one time.,

1) Select 4. Descriptors from the Offline Edit Menu.
1

2) Press F1 (Block).
The Block Edit Menu will appear.

3) Move the cursor to the first address (starting point) that will be defined as a block, and
press F1 (Block).

When copying comments from just one address, move the cursor to that address. There
is no need to define a block for one address. '

4) Move the cursor to the last address {end point) that will be defined as a block, and press
F1 (Block).

5) Press F7 (Fill).

6) Set the copy details.

I Fill: Capy Ome Descripter ts Many. I
i Database: TESTL Halp: <Ale-H>

W Conmands :
+s3  DIET <Rlt-E> ta Fill
<Es

6> te quit

Descripters to Copy: A1l

—— — — YASKAVS )

Figure 4.344
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4,4.2 Creating Comments cont.

When the Tab Key is pressed with Copy Comment specified, a screen will appear to se-
lect the commentto copy. Press the Space Key to display the comment that will be copied
in reverse video.

= e —————————— e |

I Fill: Cepy One Dezeripe Salect Pegcripter Fialds: “

Datahass: TESTL Bescripters: ?

W k|
I'THN Y

Ezm mllﬂ m

End  Ndddresa: Sl

Shert Comments:
Dewcriptera e Cepy: Specify

Wkl

Page Title:
lang Commant:

{Spacs) to toyyle
<Esc> to retumn

Figure 4.345

7) Press the Alt + E Keys. ‘
8) Check the details and enter “Y” or “N”.
9) Press the Enter Key.

Block: Groups an edit area when multiple comments and networks will be edited as a

group. ‘

Unbilock: Ungroups a block.

Note Press F5 (Jump) after a block is defined in order to move the cursor to the first address in the
block.

6. Moving Comments

The following procedure is used to move comments from one address (reference num-
ber) to another address.

1) Select 4. Descripters from the Offline Edit Menu.
2) Press F1 (Block).
The Block Edit Menu will appear.

3) Move the cursor to the first address (starting point) that will be defined as a block, and
press F1 (Biock).

When moving comments from just one address, move the cursor to that address. There ‘
is no need to define a block for one address.
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4) Move the cursorto the last address (end point) that will be defined as a biock, and press
F1 (Block). :

5) Press F4 (Move).

8} Set the move details.

[ Mave Destriptar Eleck |

Help: <Alt=N>

3 saney l AL ve Feve [
APt H -E> ¢t
End lﬂn::ﬂ L1 <Esc> !: quit
!!M: h
Bescriptars te B

Databage: TEST1

Figure 4.346

When the Tab Key is pressed with Move comment specified, a screen will appearto se-

lect the comment to move. Press the Space Key to display the comment that will be
moved in reverse video.

L Heva Bascripter Selsct Dascripter Flelde:
Databaze: TEET1 Duscriptere: ?

tart akl B
End  Mddrezs: SBO81

I H
Dascriptars te Meve: Specify Shert Commants:

2 Title:
ﬁ Conmant:

{ipace} t» tagyls
(E::‘; te I:.l:rn
o] b —m—

Figure 4.347

7) Press the Alt + E Keys. "
8) Check the details and enter “Y” or “N".

9) Press the Enter Key.

The comments no longer exist at the original location once they are moved,

7. Deleting Comments

The following procedure is used to delete comments.
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4.4.2 Crearing Comments con!.

1) Select 4. Descriptors from the Offline Edit Menu.
2) Press F1 (Block).
The Block Edit Menu will appear.

3) Move the cursor to the first address (starting point) that will be defined as a block, and
press F1 {Block).

When deleting comments from just one address, move the cursor to that address. There
is no need to define a block for one address.

4) Move the cursorto the last address (end point) that will be defined as a block, and press
F1 (Block).

5) Press F6 (Delete).

6) Check the details and enter “Y” or “N”".

[ Lidder Leyic Develupaent Seftware ~ Dascripter Address Tedls |

Databaze: TESTL Help: <Alt-—¥>
Pescripter Mddreszwz in Databaze:

Delrte Deceriptor Bddeew.es fror datahoe:

1

Please Confarn YoMy = K1

{Pylp> TFrev (Pghad> Maxt
Find Mdiress: Pl b

<Est> te guit
3-Bleck 3.Unblack T.Copy D.feve J.Jump J-Delacte H.F111

TASKAN —mm

Figure 4.348

7) Press the Enter Key.

8. Searching for a Text String

The following procedure is used to search comment data for a specific text string.
1) Select 4. Descriptors from the Offline Edit Menu.

2) Press F4 (Search).

[ Search Descripter Datubase ]
Database: TEETL Holp: <Alt-w>
I Descripters te Ssarch: A1l

Search Address Range: All

Saarch For Text: T

Conmands :
<ALt=E> teo Cearch
CEzc) te quit

Figure 4.349
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3) Set search details.

Svarch Dezcriwter Databaze _I
Datadise: TESTI Help: <ALe=N>
Dascr: te Search:  Lpecif, Desciy: 1213
ipters * pedty ﬂ::t'= 1234 Title Lang
Ssarch Address Ranga: Wlack Prem Adirezs: BoUBL

e Address: BOOE1

Search For Toxt: AN

Enter the text
Commanda: string to find
l &5t aan \
— T— — YASKAUM J
Figure 4.350
Comment Items to Find
o Ail: Searches all types of comments.

* Specify: Selects the type of comment to search for when the Tab Key is pressed.
Find Address Area

« All: Sgarches all addresses.

» Block: S;aarches the currently defined block area.,
» Specify: S;;ecifies the search area (enter the starting and end addresses).
Specify Text to Find
» Enter the text string to find in the input field.
4) Press the Alt‘f+ E Keys.
5) Check the détails and enter “Y” or “N".
6) Press the Enf(er_ Key to execute the search.

7} After the search results are displayed, move the cursor to the desired address andpress
the Enter Key.

Press the Esc Key to return to the Descriptor Address Table.

The Comment Input Screen will appear for the address selected with the cursor.
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4.4.2 Creating Comments cont.

9. Moving the Cursor

The following procedure is used to move the cursor to the address number that will be
displayed.

1) Select 4. Descriptors from the Offline Edit Menu.

2) Press F3 (Goto).

The Address Number Input Screen will appear.

Laddar Legic Devslapnent Geftvare / Descrigter Address Table |
Batabaze: TEST1 Nalp: CAle—H>
Bercripter fdiresses in Databass: 1

!!

<Pglp> Preu {Pgba)> Next
Entar tha Addresa te Dirplay: NN J

YAEXAUA
B-3sck 3 Edit D.Cate I.Search J.Leny I

Figure 4.351

3) Enter the address number to be displayed and press the Enter Key. ‘

The cursor will move to the address number that was entered.

| Ladber Logic Development Suftuare ¢ Dascripter Address Table |

Database: TELST1 Help: <ALt-H>
Puscripter Addreszes in Databasa:

<Pylip> Prav <(Pybn> Next

I M
L
y N

Find Address:
<Esc? t» quit

— YA XU
3.Blsck J.Edit D.Gets D.Search J.Lang

Figure 4.352

The cursor will move to the address even if the address number was entered directly in Find
Address.

10.Registering Comments
The following procedure is used to register comments to function keys.

1) Select 4. Descriptors from the Offline Edit Menu.
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2) Select the cémment address that will be edited.

1

3) Move the cursor to the end of the text that will be registered.

SRICHD Far Help

Dezcripter Musber
{valid verd yize)
[ 6 vards/ line |

L.
Ivalid vard size)
18 wardss 1ine )

Lavy Conment Munber: @ (88> far trailing
Page Title:

<AIt-E> to Save and Exit <Eac> te quit
1-2_3_1—5-6_7_l_!
|

Figure 4.353

4) Press Shift F + 2.

The question mark (?) represents a function number (1 through 9).

Dexcriptar Mumber 1) RELAY
[valid ward zize] 23 POR TEXT
U6 wvards/ line } 3>

$AIt—H> Far Nalp

Shert Commont Me. 1
(valid werd size] 2:
[0 werdss line ] ::
Leng GCosment Musbar: @ C-38> for trailing
Page Title:

A1s-E> te Save and Exit CEse) te quit

l:l 1INTEN S !-_.‘— SHENN EE “EE I ’m‘.

; Figure 4.354

The comment will be registered to the function key of the number specified for the ques-
tion mark {n.

The text string that is registered will remain until another comment is registered to that loca-
tion.

When using a registered comment, move the cursor to where the comment will be used and
press the function key where the comment is registered.
1

i

4.4.3 Editing Long Comments

The following procedure is used to open the Long Comment Input Screen.
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4.4.3 Editing Long Comments cont.

Press the Alt + L Keys from the Comment Input Screen or press F5 (Long) from the Comment
Address Table.

] LONG COMPENT EBITOR I
Database: TEPTL Welp: cAle—>

Campands:
P!N)I(M') te Edit Hext/Previsus Cemmen
{Ctr1-Pgdbn/ Ctrl-m to Rdit Next/Previsus ‘hmt that Exists
-R> ta Edit Next Svailakle Conm

CEntar> te Edit Leng Comenta
CEsc> t» Quit

Enter comment mualer te sdit. CEzc)> te exit: [N

—c— YA XAV =

Figure 4.355

The Long Comment Editor function allows iong sentences to be created separately in the da- '
tabase.

Up to 999 lines with a maximum of 255 characters per line can be created.

If a long comment number is specified on the Comment Input Screen for a network address,
the long comments will print together with that network in the ladder list.

Specify comment on the Comment Input Screen.
1: Long comments will be printed above the network.
—-1: Long comments will be printed below the network.

1. Entering Long Comments

The following procedure is used to enter long comments.
1) Move the cursor to where the comment will be entered.

2) Enter the comment.

AEAAARAAAARREEEREERRCCCCOCOLEDD] DDDEEEEEEEEES
EENHRHHHHNITLL I L 1L DJJJITSI.
PP PP GO000000G RRARRRRRRICESSSESSEE TTTTT TITT TUUIRIUNDRIL

[-1nsert £.Delets D.Splic D.Jain B.Unde J-Bleck ¥.Maryis E.Su-

Figure 4.356
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3) Press the Ehter Key to change lines.

2. Inserting Rows

The following procedure is used to insert rows in long comments.

1) Move the cursor to where the row will be entered.

nnnnan-mlmnmmnnmmmmmrm I
HNWHRHMKHNTITIETLIT LIS 00000000 L LLLLLLLL LT TR HNNNNNRO00000
PR PPT P PPOOQ00000OARRRAIRARNRE £ 55

111112222233333
$IESSSTITITTIITTITUULIUIUIY .

—— L0 ]
B.Inzert B.Dalste O.Split D.Jein J.Unde N.0leck B Margis JY.Save -

Figure 4.357
2) Press F1 (Insert).
E ® L T 25571 3 1 Hele: RIS
e A R L L e oo T

111112222233313
SSESTEESETTTTTTTTTITULLUUVUBLY .

YARKN
0-Innert P.Delete O.Eplic D.Jain A.Unds 3-Bleck B.RBurgin [[.Save

Figure 4.358

i

3. Deleting Rows

The foliowing procedure is used to delete rows in leng comments.

1) Move the cursor to the fow that will be deleted.

TITTTTTITUSULUUUWD .

nuuunmnmmmmm
HUNNNMRMHRIIEITINE] FRRRIJJ 3T TI00000MKINLLLLLLLLLLNATPTITTINNNNNNNNNHO00000
1112222233333

———
D.Inserc §.Delats B.5plit D.Jein B.tinds E.Dleck H.Margin J.Save

Figure 4.359
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CORERT=0B Pargins [ 1 35%7 T &2 Welp: >

2) Press F2 (Delete).

ARRAAANANASRIRRREARRCCCCCCCCCCODDDDDDDPDEEEEE EERFEFFFFFIFIFPCOCOCCECEG
HNRHNNENNNTI [T1T1 11T SJTIIII,
PP PPPOOA00QQQORRRRRRRRRS SESE S SRS TT T TITT T TIRULBLSUULY .

B.lasert H.Dalesa f.Eplic I.Jeim J.Unds J.Black B.Rargin [ Save

ESHRERT =0 Warglns T 1 2557 I 1 T Help: ARG |

Figure 4.360

4. Splitting Rows

The following procedure is used to split a row in long comments.
1) Move the cursor to where the row will be split.

2) Press F3 (Split).

ARAMARARARIRARERRERCCLCCOCCCCD OB DDODD D EEFEEEEEEEF FFFFFFFFFGLGCGEGRGG
WHHMEEMRHNT T TI1E T L0023 8000000 LLLLLLLLL
TR RMMMNNO000000000

PPPPTTP PP POOG0QOOUGG RRRRRRKN TTITIITIT

fl.1nzert G.Delete B.Split T.Jein J.Unis N.Bleck f.Margis [.fave '

Figure 4.361

Note The cursor position marks where the row splits.

5. Joining Rows

The following procedure is used to join two rows in long comments.

1) Move the cursor to the first of the two rows that will be joined.
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Note

2) Press F4 {Join).

BODD r

AARAAAAAAN RRREE NS RRRCCCCTCCOCD DD E EFF R PP PPN FFRPOCOOGCOC0G '
HENNNHHHMK 1] L LT L. 3.0 000000000 LLLLL T12.1.
mmmnmmmmgsmss:ssrn"t

|
—

L O.Inzert §.Delscs D.5314t T.doin B.unde B.Bleck &.Margin @0 fave

T

Figure 4.362

6. oin

The following procedure is used to undo a row entry or deletion.

Press F5 (Undo).

Undo applies only<to the row where the cursoris Positioned. Entries or deletions priorto mov-
ing to that row as well as row splitting or row joining will not be undone.

7. Block Editing for Muitiple Rows

The following section describes block editing for multiple rows, and includes the editing
functions given below.

» Defining a block
* Moving and copying

*» Deleting a block

A. Block Editing

The following p}ocedure fs used to define and ungroup a block of long comments.
1) Select 1. Select Active PLC from the Main Menu.
2) Select the datapase that will be edited.
3) Select 4. Descriptors from the Offline Edit Meny.
4) Press F5 (Long)i from the Descriptor Address Table,

—4-157 —




Offline Editing
4.4.3 Editing Long Comments cont.

5) Press F6 (Block) from the Long Comment Input Screen.

6) Move the cursor to the lines that will be defined as a block.

7) Press F1 (Block).

1T axsananara R SREERRRRCCCCCOCCCCDRDDODDODDEEE]
HNHHHNMRHHITTT 111 11 T I JIN301S
A PTITE Y FRgun ey RRERRR I K L Lt ot

PASKAUR ==

0-31lsck §.Unbleck O-Capy Q.Meve A.Juny B.Del

Figure 4.363 ‘

Press F2 (Unblock) to ungroup the block.

Press F5 (Jump) to move the cursor to the first line in the block.

B. Copying and Moving a Block

The following procedure is used to Copy of Move a block of long comments. ‘

1) Select 1. Select Active PLC from the Main Menu.

2) Select the database that will be edited.
3) Select 4. Descriptors from the Offline Edit Menu.
4) Press F5 (Long) from the Descriptor Address Table.

5) Press F6 (Block) from the Long Comment Input Screen.

e U o TR e 1 T AEAY]
AREAARRARA Dmmm’m
MHERHMHRANIILIEIL] EIJSIETIII:

FYPTRIE CEEEEETT 1 TITTTIUUOOLLBONY .
YASKAUR ==
B.91ack D.Unblech D-Copy D-News B.dusp J-Del

Figure 4.364
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m

6) Move the cursor to the lines that will be defined as a block.
7) Press F1 (Block).
8) Move the cursor to where the block will be copied or moved.

9) Press F3 (Copy) or F4 (Move).

PEERLLET LG G G
FIMAAARTN NN NN BN NN O GO 00U,
Mg ",

ARRRAAAAR A BERRR NN ERBCCCCCCLCCCD DD DDDDN D DEEEEEE L EEEFFRFFFFFIFOOAGLCCCCE
RNIMMNNHHT T 1111110305001 30000000 L LLLLL L LL L e e e e p NN HNNNO00000
PP IPPOONQQQQQARARRKKERR NS

SECEEEESETTTTTTITITOOULLGILUL .

YA
01-Black §.Unbleck 0.Copy J.-Mevs J.Junp 3.Del

Figure 4.365

Note The lines defined as a block will be copied or moved to the line where the cursoris positioned,

C. Deleting a Block

The following procedure is used to delete a block of long comments.
1) Select 1. Select Active PLC from the Main Menu.
2) Select the daiabase that will be edited.
3) Select 4. Descriptors from the Offline Edit Menu.
4) Press F5 (Lo%\g) from the Descriptor Address Table.
5} Press F6 (Blc;ck) from the Long Comment Input Screen.
6} Move the curéor to the rows that will be defined as a block.

7) Press F1 (Block).

8) Move the cursor to the block that will be deleted.

9) Press F6 (Delete).
10) Block details that will be deleted will appear. Enter “Y” or “N”.
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4.4.3 Editing Long Comments cont.

11) Press the Enter Key.

Warginz | 1 2557 ¥ 1 Welp: chlc-HF |
|

RARAMARRA MR R RRREERCCCCCCCCOC D DD D DD DD EEFEEEEEEEFFFFFFFFFFCGCOGCCOO00

HUHNRURNNNI LTI TR X N JJJ 3304,

PPPPTFT PP POOGGGQQQQQRRARRKRRRRRS SESSSSSES TTTTTIT TTIVULRLIUUVD .

AR A RRARA DY BEBRELLKLL
PHHBEHEHHTT LI TT)
el B W L LD T el Ty

TASKAUN ——
B-Bleck T -Undleck J.Copy D-twve A.Juny N.Del

Figure 4.366

8. Setting Margins

The foliowing procedure is used to set the left and right margins of the comment input
area.

1) Press F7 (Margin).

2) Enter left and right margins as indicated on the screen display.

MARRARR AR BEERERRRRBCCCCCCCCCCDDD] ‘
MHNNRHAWNNIET LT D 11T D JJJ5 00 300 T00000KKKNLLLE LLL LLLM ST NNNNNNNN00000C:
PR FP T PP PO QOURRRRRARRRRRS £ 333!

SESRSITITIITITTUNRNUINULY ..

Enter Left Margin
Brter ki TG

—— PAEKA
B.Invert J.Delace 0.Tplit 0.Jein J.Unde B Bleck f-Margin JJ.tave

Figure 4.367

The margins are initially set to provide the maximum area allowing up to 255 characters to be
input.

Left and right margin range: Left margin: 1 to 33 characters
Right margin: 43 to 255 characters.

9. Saving Long Comments

The following procedure is used to save long comments.

Press F10 (Save). ‘
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4.4.4 Adjusting Network Comments

When a network created with MEMOCAD-PRO is loaded into a Processor, edited {Insert or
Delete) onaP150 or other device, and then returned to the database on the personal comput-
er, the network will not be properly aligned because the network and the network comments

will no longer match. The Network Comment Adjustment function matches network com-
ments with the actual network.

Network Inserted on the P150

Database
Loaded into the CPU
Network 1 Network 2 Network 3
{comment 1) (comment 2) (comment 3)
{CPU)
Network 1 Network 2 Network 3
Network insarted prior to Network 2
by the P150.
Network 1 Network 2 Network 3 Network 4
(New) (Cid 2} {Old 3)
Returned to the database.
Network 1 Network 2 Network 3 Network 4
{New) (Old 2) (Old 3)
{comment 1) (comment 2) (comment 3)
@ Network comments adjusted
Network 1 Network 2 Network 3 Network 4
{New) (Old 2) (Old 3)
{comment) (commant 2) (comment 3)

1

This adjustment ié not necessary with oniine editing on MEMOCAD-PRO because the net-

work comments will be moved automatically in line with network insertions and deletions as
long as a database is selected.

|
1
|
|
|
|
|
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4.4.4 Adjusting Network Commenis cont,

1. Network Insertion

1) Select 7. Utilities from the Main Menu.

e e ———————————yy

MEMOCON-$C ClAA 4R 78
Liddsyr Ligic Devsls nt Seftuare # Maln Meau
Usrsisn 2.08 Capyright 1991 Yagiaus FLECTRIC COXPOMTION
Databasze: TEST1 Relp: <ALc-H>
Main Manu:
1. Select Motivr FLC
g. OffLine
40 Fatisn
5. Lixt Active PFLC
C. Leadsr

[ERENTIEA

<E> to» Exit te Dez

Figure 4.368

2) Select 2. Descriptor Utilities from the Utility Menu.

- 1

HENOCON-SC GLARCR-78
Ladder Logic Bevelspaent Leftware ~ Utilicies
Datakase: TESTL Help: <AlT-H>
UIILITY Peau:
1. Cenfiyuracien

. Bat e Gtilities
4. $ot tonpsrary File
{Eze> te Moturs te Previsus Henu
Enter Opsion: ER

————— YASIAUA =

Figure 4.369

3) Select 1. Adjust Network Pointers from the Descriptor Utility Options.

HENCCON-SC CLAR-G8/78
Ladier layic Develspment Saftuars / Descrist Utilitiss

Databaze: TEET1 Nelp: <RIt—W)>

DESCKRIFf NTILITY Optiens

!. imﬂwn 'um allllll

<Esc> te Baturn te Previsus Henu
Enter Optisn: EN

L —

Figure 4.370 ‘

1i
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4) Select 1. Move Pointers Up due to Network Insertion(s) from the Adjust Options.

MEMOCON-1C (1486878
Ladder Lagic Bavelepnent Saftusre ~ Adjust Netwerk Peinters
Database: TEET1 Malp: <HIt=H)

<Esc> to Metwrn te Pravieur Henu
Entay Optisn: EJj

Figure 4.371

A screen will appear asking for the network number that was inserted.

5) Enter the first number of the network range that was inserted and press the Enter Key,

I MCGUE POINTERS DF DUE TO MUMG IMSERTIONCS>
Patabase: TEETL Mulp: <Alt-M>

Enter Fivst New Matwirk [nserted:

Figure 4.372

6) Enter the last number of the network range that was inserted and press the Enter Key.

l MWOUE FOINTERS UP WUE TO MUNG INGERTIONCED I
Datahage: TEST1 Halp: <Ale-R>

Eater last New Hetuerk Inserted : [VENRENE

Figure 4.373

The network comments will be adjusted.
\

Note The number of thé network that was inserted must be entered in order to adjust the network
comments. Check to see what number was inserted during editing.
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4.4.4 Adjusting Network Comments cont.

2. Network Deletion

1) Select 7. Utilities from the Main Menu.

—_———

GLWS 078
» Legic D-u nt Softuare ~ Main Menw
Verstan 1008 Comiciome 13T TheRADA ELECTRIG COXPOMTION

Databaze: TESTI SHelp: <Alc-—N>
Main Memu:
Sol.et Metive FLE
0!'!'1

1.
2.
3.
g lh !.nn
5 I'-u!n-
<E» 8 Exit te Des
Entar Optien: HI

e YAEKAUS =]

Figure 4.374

2) Select 2. Descriptor Utilities from the Utility Menu.

T2
HEMOCON-£C CLAR-GR- 70
Ladder Lagic Develepmesnt Seftwars ~ Utilities
Databaze: TEST1 Halp: <Ale-H>
UTILITY Henu:
1. Cenf i tien
- itilicias )
4. Sst temperary Filx
{Ezcy te Meture teo Previsus Menu
Eatar Optien: EX
[——= o — YREXWUA =

Figure 4.375

3) Select 1. Adjust Network Pointers from the Descriptor Utility Options.

m

MEMCCON-EC GLMLAR- 0
Laddsr Lagic Devalepment Software / Dazcript Urilitiss
Database: TESI1 Help: <Alt-M>

DESCRIPT BTILITY Optisns

!- imﬁ!ﬂn lm Etih.ll

{Esc)> s» Meturn te Previsus Menu
Enter Optisn:

YASKAUR =

Figure 4.376 ‘
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4) Select 2. Move Pointers Down due to Network Deletion(s) from the Adjust Options.

HEHOCON-SC GLAB-GB.-78
Laddar Legic Develepmant feftware ~ Aljust Hetwerk Peincars l
Database: TESTL Halp: <Ale-H>

f CEre> tu Fotwmn to Pravieus Heau
Enter Oytion: B}

N ———

Figure 4.377

A screen will appear asking for the network number that was deleted.

5) Enter the first number of the network range that was deleted and press the Enter Key.

NOUE POINTERS DOWN DOE TO MUNG DELETIONCE> ]
Database: TESTL Welp: <A2C-H>

Enter Firat Ol Netwerk Deleted: [EMENEEED

- ..

Figure 4.378

6) Enter the last number of the network range that was deleted and press the Enter Key.

L MOUE POINTENE POVN BUE TO MUNG DELETIONCE> ]
:
Batabane: TESTL Kalp: <AlE-n>

Enter Last Old Matuwwrk Daleted :

: Figure 4.379

The network comments will be adjusted.

Note The number of the network that was deleted must be entered in order to adjust the network
comments. Check to see what number was deleted during editing.
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4.5 Setting the System Configuration

The following procedure is used to define the Processor configuration, /0 Module allocation,
PC Link allocation, ASCIl Module, High-speed Station allocation and the YENET routing
table.

Refer to 6.12 System Configuration for more details on the procedure for setting the Proces-
sor directly.

1) Select 2. Offline from the Main Menu.

m

MEMOCON-SC CIAL G078
Ladder Legic Davals) t Seftware /7 Hain Menu
Usreien 2.00 Capyright 1991 YRSIAWA ELECTRIC CORPORATION

Dasabasze: TEST1 Nelp: <Ale=d>
Neis Menu:

1. felsct Active FLC

T

4. Matisn

§. List Active ML .
6. Loads

-
7. Urilicies
<E> te Exit te bex
Enter Optisn: EJ

Figure 4.380

2) Select 6. Processor Configuration from the Offline Edit Menu.

HENOCON-3IC GLARS0- 7
Ladder Legic Develspment Seftware / Edit Menm
Database: TEST1 Nalp: <Ale-H>
Offline Edit Menu:
1. telect hctive PLC
2. Natwe:
A, Sequential Punctiem Charts
4. Daxcripters
5. Databaie Details

. S TAgES
8. Creasshafarence Dispesitien
CEsc? to futwa te Previsus Memu

Encer Option: I
—— YASKNUN == ‘

Figure 4.381

The Processor Configuration Options will appear.

@

HMENOCOH-EC CLAL/GA-78
Ladday Legic Bavelepmant Loftwars / Precezszer Confisuratisa

Batahase: TERTL Help: <Alt—H>
PROCESSOR CONFIGUMIION Optisni:
D T R S L L UL IR
e [0 Card Descr as
3 Allecasisn
4, Link Rllecatiss
5. AZCI! Medule Allscatien
6. dighzpeed Statisw

7.
CEag> to Metwre te Proviews Memu
Enter Option: H

e —————————— AT =]

Figure 4.382
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: 4.5 Setting the System Configuration

4.5.1 Processor Models and Configurations

This section describes all settings for the target Processor, These settings can be changed at
.any time.

1. Setting the Processor Model
The following procedure is used to set the target Processor model.
1) Select 1. Processor Type/Configuration from the Processor Configuration Menu.

The PLC Configuration Display Screen will appear.

FLC CONFICUMTION DISPLAY
Help: <Alx-#>
Botive PLC: TERTY
Mrocesser: GLEMI Coils T 192
Piscrete inputs: 48%
| Nemery Availabls ~ Allecated Ingut rege : 512
Laddsx i C4462 s EA512 Melding vegs 'y
Rct I ./ SeaeS Conztant reys 406
Transitien : DOOMA ~ BOOUG ta 12
B 't ¢ AN / BRbey Transitiens .12
F_reg 12
Scan level : 1 Link discrates : 1B2¢
nta 21 Link regs 4
MEMOBUE Purt : Mede Parity Stap | Addr Delay
1 Evan 1 %00 -t -
2: KU Evan 1 7% [ ] [
3: KU 1 e .. [ ]
4: KV Even 1 *"ae L} ]

IFrecesser Wenery Resmente Wrorts MEyston Status [
e p—————

Figure 4.383

2) Press F1 (Processor) from the PLC Configuration Display Screen to set the Processor
model.

LG CONFICURATION DISPLAY
Melp: <Hle-H>
fctive PLC: TERT1

Precezzer: GL7WM Ceily i 2
Dizcirete inputs: 48%
Memery  Muailabls / Bllecated "ﬂt ragy : 0512
Laddar 1 e4%6Z 64512 Helding rups t 7999
Actien ] Conztant regs : 4%
Iransition : DOOEE / SOONG bcape s 8512
Subrsutine : BOOOE / BNOOS Irantitions H Ei;
P PRt H

. Scam lawel : 1 dnk dizcrecer ; 1824
Segments = 1 dn! 1824

¢ HENOBUS Tert @  Hede Parity Step Tl Addr Dalay

1r NN 1 -l

2 My Even 1 e [} -

3 XU Even 1 %M [ [ ]

4: MY Even 1 " 1 -

{IPrecesver Miesery [EEeguent: MPercs BB ycten Ttatus
N ———— e ——— e

Yatiaye =

Figure 4.384

Be sure to change the memory ailocation when switching to a Processor with a different pro-
gram memory capacity.

These settings will be reflected in other areas, such as during ladder program editing. The
range of reference numbers for instructions will vary depending on the Processor model se-
lected here. -
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4.5.1 Processor Models and Configurations cont.

Note The Processor model will switch as shown below each time F1 is pressed.

GL60S — GL60S1 — GLB0S0 — GL60H — GL70H — GLEOHT
T : $
GL60S2 «— GL60S3 « GL40S3 « GL40S2 « GL40S1 « GL70HT

2. Allocating Memory

The following procedure is used to allocate user memory to action, transition condition,
and subroutine circuits.

1) Press F2 (Memory) from the PLC Configuration Display Screen.

Referto 1. Setting the Processor Modelon page 4-167 for more details on the procedure
for displaying the PLC Configuration Display Screen.

A screen for allocating memory will appear. ‘

Rctive PLC: TEST1 Help: <Ale-i>

Fragrem Arsa Size (X werds)

Ladder

Rctian w

Transivien -

Subsroutine [ ]

TOTAL €3

[ o maTEr | ) |

<Eze> te Meturn te Penu <Space’ to Extended Megister size Tegyle
<Ale-E> te Save and Exit vas

Figure 4.385

2) Set the ladder as well as the action, transition condition and subroutine circuit memory
allocations so they equal the total memory that is availabie.

Moving the Cursor ‘
Moving up or down: Press the Up or Down Cursor Key.

3) Press the Esc Key.
4) A confirmation message will appear asking whether to save the settings. Enter “Y” or “N.”
Total memory varies with the Processor.

Expansion register settings are enabled only when the GL60S3, GL60H, GL60HT, GL70H or
GL70HT is selected.

3. Setting Port Parameters

The following procedure is used for port settings necessary for printing. These settings
will not be written to the Processor even though the Loader function is used. Be sure to ‘
set the Processor settings in the Online Mode.
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1) Press F4 (Ports} from the PL.C Configuration Display Screen.

1

Referto 1. Setting the Processor Modelon page 4-767for more details on the procedure
for displaying the PLC Configuration Display Screen.

The Function Menu will switch to set parameters.

FLG COMFIGUMATION DISFLAY

Helps <Mle=H>
Mctlve PLC: TEST1
Frecesser: GL7M Colls : 8192

Piserste inpucs: 489

fMenery  Available / Allscated lnﬁt g 3 W52
r P obE2 £ 64512 v liiny regs T 719
Aceion i NS - SON Constant regz @ 40%
Trangition 1 G000 - SOUN8 Stope : W51
Subreutine : SOO08 / OOER Iransitiens = 9512
Timer regs : #5122

Scan level : 1 Link discretes @ 1024
Soymants i 1 Liak regs T 1624

MEMOMUL Pert : Mede Parity Step Bund Addr Delay
T = e
NG v

; Figure 4.386

2) Press any key between F1 and F4.

Press F5 (Addr) to display the device address input field.

FLC CONPICUMTION DISPLAY
Nelp: <Ale-H>

Activa FLC: TEXT1

Precesser: GL7M Caily : 3192
bixcreta inpute: 4%

femary  Availabls / Allscated "ﬂt rega : 512
T : G462 - 54512 Helding regs IRl
Rckisn : BEEEE - ShONS COnvERRT regs  © 409
Iranzitien : GEBOS - SOBOS Etape : W12
Subrsuting : BOODG -~ BOOOE ranzitions : W12
s regs = 512

Scan level : 1 Link dizcretes : 1024
Saymants & 1 ink regs : 1m24

MEMONOE Pert : Meda Parity $tep Baud Adar Dalay
e ———er e e e e Y

Figure 4.387

3) Enter the de\fice address and press the Enter Key.

4} Press F6 (Deiay) to display the delay time input field.

PLC COMPLGUMATION DISPLAY

Balp: CAle-N>

Sctive FLC: TEST1 N
Frecesser: CL7W Cally = 8
Discrate inpute:
Hemery Mvailabls s Allecated nﬂt regx s
Laddsr : 64462 - §4512 Ko lding regs
Actian : GNEER / SEBNS Conztant regs : 489

Iranzition : GOONE  BEGGE tapa H
* Subreutine : SOGBE - SO0 rangit isna

iner reg: : 5
Scon Iawel : 1 Link dizcrates @
[ =1 Link regs BT

| KEMONSE Pert : Mede  Parity Step  Beud  Addr

Figure 4.388
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5) Enter the delay time in 10 ms increments and press the Enter Key.

6) Press the Alt + E Keys to save the settings when they are all entered.

The settings for each parameter is given below.

F1 Mode: ASCIl or RTU

F2 Parity: None, odd and even

F3 Stop: for2

F4 Baud: 150, 300, 600, 1,200, 2,400, 4,800, 9,600 or 19,200 baud

F5 Addr: 1 through 247 (device address)

F6 Delay: Time before sending after receiving a instruction (10 ms increments)

Note (1) This function is for printing settings. Be sure to write it to the Processor in the Online
mode. Refer to 3. Setting Port Parameters on page 4-168 for more details.

(2) Moving the Cursor
Moving up or down: Press the Up or Down Cursor Key.

(3) The factory-set communications parameters when the Processor is purchased are
listed below. Leave the settings as given in the figure unless its absolutely necessary to
change them.

Table 4.1 Processor Communications Parameter Factory Settings

F1 F2 F3 F4 F5 F6 ‘
Mode Parity Stop Baud Addr Delay
RTU Even 1 9,600 001 0

4. Setting 2-level Scanning

All networks are divided into a maximum of eight segments. The scan level is setin order
to reduce scan time by setting one segment as a high-speed segment (executed every ‘

scan) and the rest as low-speed segments (number of segments - executed once per
scan).

Set the following in order to execute the 2-level scan.
a) Scan level settings
b) Segment allocation

Refer to MEMOCON-SC GLB0S Design and Maintenance Manual (manual No. SIE-
C815-14.1) for more details.

5. Setting the Scan Level

The following procedure is used to set the scan level. Segment aliocation is not available 1
unless the scan level is set to 2.
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1) Press F3 (Segments) from the PLC Configuration Display Screen.

Referto 1. Setting the Processor Modelon page 4-167for more details on the procedure
for displaying the PLC Configuration Display Screen.

The Segment Assignment Screen will appear.

N SEGIENT ATE]CMIENT
#ctive FLCZ TESTL Help: <Alt-H>
$can lavel: 1
Segmant Start Matwork
1 ({02 ]

<AIt-E> chanpe Scan

<Esc> te Betwrn te Menu <A1t-D)> ta Dulste kK

<A1t-E> te favs and Exit A1t~1> to Insert a Segment
e — —— = YRS KA

Figure 4.389

2) Press the Alt + S Keys {Change Scan Level).

3) Set the Scan Level to 2.

Press the Alt + S Keys to switch between Scan Level 1 and 2.

The Scan Levelcannotbe setto 2 witha GL40S1 » GL40S2 or GL40S3 type Processor, so
segments cannot be allocated with these Processors.

6. Allocating Segments

The following procedure is used to allocate segments.
1) Press F3 (Segments) from the PLC Configuration Display Screen.

Referto 1. Setting the Processor Modeion page 4-167for more details on the procedure -
for displaying the PLC Configuration Display Screen.

2) Press the Alt + S Keys (Change Scan Level).
3) Set the Scan Level to 2.

Refer to 5. Setting the Scan Level on page 4-170 for more details on the procedure for
setting the scan level.

4) Press the Alt + | Keys to insert the number of segments required.
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Up to eight segments can be set.

m

[ SEGENT ASSICNIENT i
Active FLC: TEET1 Nalp: <hlt-H>
Scan level: 2
Seyhent Start Netverk
1 by
2 1
3

<Alt-E> chamge Scan I.-v-l
te b!ll':”:l rl-nu <Alt-D> te Delete $

<Esgd
{A1E-E> to Save {Alt-1> te Inzert a
=_-===ﬁ nsmn

Figure 4.390

5) Move the cursor to Segment 2.

Active FLC: TEETL Help: <Ale-H>
Scan lavel: 2
Segnent Srart Netwerk
1 [ %

<A1t-$> change Scan lavel
(Esc> » Meture to Menu <Alt—D> te Dalets Segment
Als-I> fe Tave aod Exit <Alt~I> te Intert & Zagment ‘

PASKAUA =

Figure 4.391

6) Enter the first network number for segment 2 and press the Enter Key.

e — ————— |

[ SEGMENT AS$ICMMENT |
hetive PLC: TESTL Balp: <Alt—H> ‘
Scan level: 2
Segment start Metwerk
1 [ .
2 | _ ¥}
3
£Alt-5> change Scan Level
s Haturn ts Mamu <A1t-D> te Bylate £ Tt
(llc—E) tl Save and Exic <Alc-I> te Inyart a Segment
== YASKAUA =

Figure 4.392
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7) Enter network numbers all the way to the last segment as described in the preceding

step.

[

SECHENT ASTIGNIENT

Active PLC: TESTL
Scan lsvel: 2

Malp: <Ale-d>

Sagmant

ftart Matwork

[ 3
2 ¥}

CALt-E> change Scan Level

<Exc> te Mturn te Menu CAle-D> te Bulste SO!-“
<Alt-E> te Save snd Exit <A1t-1> ta [nsert a Segment i
e e —— e ———— . YRENR =
Figure 4.393

8) Press the Alt + E Keys to save the settings.

To delete a segment allocation, move the cursorto the segment that will be deleted and press
the Alt + D Keys.

7. Adding Segments

The following procedure is used to add segments.

1} Press F3 (Segments) from the PLC Configuration Display Screen.

Referto 1. Setting the Processor Modelon page 4-167for more details on the procedure
for displaying_the PLC Configuration Display Screen.

1

2) Press the Alt + S Keys (Change Scan Level).

Refer to 5. Setting the Scan Level on
setting the Scan Level.

page 4-170 for more details on the procedure for
3) Press the Alt + | Keys (Insert Segment) to insert a segment.
Up to eight segments can be set.

Note The segment that was added will be deleted if the scan level is changed.

Examples of entries when adding segments are given below.

Example: Allocatiing the Following 30 Networks

* 1 through 10 — Segment 1
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+ 11 through 20 — Segment 2

¢ 21 through 30 — Segment 3

Operating Procedure
1) Press F3 (Segments) from the PLC Configuration Display Screen.

2) Fromthe Segment Assignment Screen, press the Alt + | Keys (Insert Segment) once for
each segment to be added.

3) Move the cursor to Segment 2.

4) Enter the first network number for Segment 2.

5) Move the cursor to Segment 3.

6) Enter the first network number for Segment 3. ‘
7) Press the Enter Key.

8) Press the Alt + E Keys to save the settings.

——— e —————————— ———— ]
| SEGHENT AES1CHIENT ]
fctivs PLC: TESTL Help: <AYE~H>
Scan lewsl: 2
Sagmant ttart Netwerk ‘
1 [
z L1
3
<A1:=5> changs Scan lavel
<Ezcy> ta Returh te Menu <A1t=D> te Dalate h!--t
<A1t=E> te Save and Exit <A1t-1> te Inzert a Segment
YREXAUA =y
-
8. Deleting Segments ‘

The following procedure is used to delete segments.

Operating procedure

Press the Alt + D Keys (Delete Segment) to delete segments in order from the end to
towest number at #1.

%ﬁ-ﬁ;—iﬁ

wctive MIC: TEST1 Malp: <AIt-N>
Scan lewel: 2
Sugment Start Metwark

1] &

-2 change Scan Lavel ‘

<Ale
{Ezc)_  te Futurw te Mesu <Alt-D¥ to Dulate at
<Alt-E> to Saws amd Exit <Alt=]> ta lnzert & Segimnt
YASRAUN =
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1

9. Setting System Status Allocations

The following procedure is used for system status allocation to enable CPU error status
as well as the status of all Modules to be monitored even with the CPU stopped.

1

1) Press F5 (System Status) from the PLC Configuration Display Screen.

Referto 7. Sétring the Processor Modelon page 4-167for more details on the procedure
for displaying the PLC Configuration Display Screen. System Status Allocation is only
available when GL60H, GL60HT, GL70H or GL70HT is selected.

[ SYSTEN STATOS ]
Active PLG: TESTL Help: <ATe-H>
REFERENCE (L] ]
SIZE "e
TARLE L]
€Exc)>_  ta Maturn te Menu
<Alt~L> te Save and Exit
= — —_— S YASKAUR =

Figure 4.394

2) Enterthe reference number, number of registers (size), and status table number from the
keyboard.

Reference number setting range:  4xxxx or Rxxxx
Size setting range: 1 through 106
Status table number setting range: 1 through 106

3) After the settings are entered, press the Alt + E Keys to save them.

4.5.2 /O Allocation

IO Allocation is used to specify channels, stations, and racks, and to allocate I/O status to
each slot. Referto Appendix D /O Configurations of GL Series for more details on the proce-
dure for configuring 1/O sections like channels and racks.

1. Displaying the I/O Allocation Screen

The following procedure is used to display the I/O Allocation Screen.
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1) Select 2. Offline from the Main Menu.

. GRS 78
Ladder t $oftwire ~ Main Mo
Varzien 2.8 Gom“ht urnsm ELECTRIC eomnou

Database: TEET1 Nelp: <Rlt-N)>
Main Menu:
1. Salect Active ML

]

Metien

List Rcxive PLC

Leadar

Uriliciss

<{E> te Exit t» Daa

Enter Option:

e ——rrream YRS KAV

sena

Figure 4.395

2) Select 6. Processor Configuration from the Offline Edit Menu.

MEMOCOM-$C CLARG8/78
Laddar lagic Develepwent Seftwars / Edit Mewu

Dutabase: TESTL Talp: <ALC-E>
0ffline Edit Menu:
1, Select Nctive PG
::I .m:::ﬁl Puactisn Charts
5. Databaze Butails

3. Cresslmferance Dispbsitisn
CExc> te Naturn te Provieus Menu

Encer Optisa: [
r——— — YASKRWA ‘

Figure 4.396

3) Select 3. /O Allocation from the Processor Configuration Options.

HENOCON-SC CLAR 078
Laddar Legic Develepmant Ssftwirs ~ Frocesser Configuratise
Batabaze: TESTI Help: <hlt—H>
PROCESSOR CONFIGURATION Oprisns:

1. Prac T # Configuratis
3 pfine 1v0 Lrd Descripeiess

- X3
2. KECII l\l‘:iu lll’.].-cnhn
'6’. gi h—speed Statien

<Ezc? to Returm te Provieus Memu
Enter Optien: K

Figure 4,397
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The Traffic ‘Cop /O Allocation Screen will appear.

o INPUTE == CHANNEL: 1 MCK: 1

SLOT REF 2 ngllﬂt CARD REF® 2 S{gm CARD
1 - » — —— [] —_—
2 —— ¥ _— —— . —
] — . — —— . —
4 _— . —_ —— . r——
s — . —_— — " ——
& —— . —_— — 1 ———

<A1t=E> ve Tave amd Exit <Eac)> te guit

140 Cavdy §.Descriptere JJ.Delace I Chann

Figure 4.398

2. Setting Channels

Channels and stations must be specified for remote station /O allocation. The following
procedure is used to display stations on screen when channel 2 or higheris set. (There is
no station at channel 1.)

1) Display the Traffic Cop I/O Allocation Screen.

Refer to 1. Dispiaying the I/O Allocation Screen on page 4-175 for more details on the
procedure for displaying the Traffic Cop I/O Allocation Screen.

2} Press F4 (Channel).

it 3 wlp t

we INPUTE wn CHANNEL: 1 MACK: 1
DISCRETES RECISTERS

sLoT REF & POINIS CaARD REF & 13 CARD

1 — 5 i) —

E Enter Channsl Mumber te Edit:

3

<A1t~E> te Save amid Exic <Eme> te quit

Figure 4.399

3) Enter a channel number (2 or 3) and press the Enter Key.

1

j
A rack must be specified if multiple racks are used.

Refer to Appendi:x D IO Configurations of GL Series for more details on the procedure for
configuring remote /0.

Channels cannot be set for the GL40.
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3. Setting Stations

Channels and stations must be specified for remote station I/O allocation. A maximum of
31 stations can be specified per channel. The following procedure is used to display sta-
tions on screen when channel 2 or higher is set. (There is no station at channel 1.)

1) Display the Traffic Cop /O Allocation Screen.

Refer to 1. Displaying the I/O Alfocation Screen on page 4-175 for more details on the
procedure for displaying the 1/O Allocation Screen.

2) Press F5 {Station).

3) Enter a station number (1 through 31) and press the Enter Key.

Pat. T

s THPMUTS ww CHANNEL: 2 SIRTION: 1 MACK: 1
DISCRETES RECISIERE

Slliﬂ'f MF 2 mll.ﬂ'ﬂ CARD KEF B PIXE

3

; Enter ttatien Munber te Edic: XN

[]

? ———— [ 3 — — » —_—

L — ] — — » _—

CR1t-E> ts Save and Exit <Ezc> te quic

Figure 4.400

A rack rmust be specified if multiple racks are used.

Refer to Appendix D I/O Configurations of GL Series for more details on the procedure for
configuring remote 1O.

4. Setting Racks

The following procedure is used to specify up to five racks for channel 1, and up to four

racks for channels 2 or 3. The GL40 does not have channels 2 and 3, so only four racks
can be specified.

1) Display the Traffic Cop /O Allocation Screen.

Referto 1. Displaying the I/O Allocation Screen on page 4-175 tor more details on the
procedure for displaying the Traffic Cop I/O Allocation Screen.

2) Press F6 (Rack).

Press the Page Up or Page Down Key to change racks. Rack numbers increase or de-
crease by one each time the key is pressed.
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3) Entera rack number (1 through 4).

T, = H i B 3

< we INMITS == CHAMNEL: 2 STATION: 16 MACK: 3
PISCRETES RECISTERS
S{&T REF & POI=1E CRAD MEFe SEZE CARD
H
; Enter Rack Munlar te Edit:
[
[] — ] —_— —— . —

<Alt=E> te Cave and Exit <Ezc> ts gquit

210 Cards . Bescriptors [.Delute J.Channul . Statism J.

Figure 4.401

4) Press the Enier Key.
5. Switching between Input and Output Screens
The following“ procedure is used to switch between Input and Output Screens.
1) Display the Traffic Cop /O Allocation Screen.

Refer to 1. Displaying the I/O Alfocation Screen on page 4-175 tor more details on the
procedure for displaying the Traffic Cop I/O Allocation Screen.

2) The screen switches between input settings and output settings each time F8 is pressed.

g (3
"o OUTPUTE w  CHMSKEL: 2 EIATION: 16 mex: 3
DISCRETES RECISTERS
sLot1 REF & POINIE CARD REF 8 $1ZE CARD
1 ] . — h— . i
2 — » —_— — ] —
T2 — F — — M [P
Y ——— . — —— o —
5 — H — — M —
' — . — — M —_—
7 —_— N J— —_— . ——
» —_— » —_— —_— . i
[ — . —_— —_— . —
1 CAlt-E> te fave and Exit <Esc> %0 quit
-1/0 Cards 3.Descriyte. -Channal N-Station J.Rack J.Status 173

Figure 4.402

6. )/O Allocatio

I/O Allocation describes various allocation procedures,
Allocation items are described in the following order.
1) Setting reference numbers for registers
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2} Setting the number of registers

3) Entering I/O card descriptions for registers

4) Setting reference numbers for discrete /O
5) Setting the number of discrete 1/O points
&) Entering ¥/O card descriptions for discrete /O
7) Displaying the allocation status list
7. Setting Reference Numbers for Registers
The following procedure is used to set reference numbers for registers.
1) Move the cursor to the register s;etting for Slot 1.
The cursor will move each time the Tab Key is pressed. ‘

2) Enter the address and press the Enter Key to move the cursor automatically to Size.

3 ™H H [t

ne QUTPUTS w=  CRANMEL: 2 SIATION:
REGISTERS
a1 IZE

..
-
]
g
w

DISCRET
TLOT RET 3 NI:IB

[HH]
HTHTE
T

11

]
L »
Description: <User-dafinable)

<A1t-E> te Save amd Exit CExc) T guit

.10 Cards 3. Dezcriptars J.Belete fi.Channel J.Statiss J.Rack .Status J.-lnpues

Figure 4.403

8. Setting the Number of Registers
The following procedure is used to set the number of registers (size}. ‘

Enter the number of registers and press the Enter Key.

The cursor will move automatically to Card.

't .3

hi
L

me OQUTPUTE we  CHAMMEL: 2 STATION:
SCRETES

..
-
]
B
[~]

8
§!
a
]
E o

[

$LoT

:

I
T

HHHHIT

<Ale-E> te Save and Exic

CEsc> te gquit

e J.Channsl JI.-Ctatien J.

Figure 4.404
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4
9. Entering I/O Card Descriptions for Registers

The following procedure is used to enter I/O card descriptions (names for I/O Modules
mounted in slots) for registers. /O card descriptions are not written to the CPU during
loading, but will be printed as slot data when 1O allocation is printed from the Lister.

1) Press F1 (I/O Cards) from the function fabel.
A list of /O cards will appear.

2) Move the cursor to the desired card and press the Enter Key.

1

3 H Hala: RIS
e OUTPUTS = COANNEL: 2 STATION: 16 MCK: 3
SLOT REF 0 n}OImB CaRp REF % mﬂ'gm CARD
"2 E]
1 — » —— Ae0eL N [
2 —— " r— —_— a —_—
3 r——— 1 —_— — a —
4 —rr— a —r— —_— ] _—
5 —— . — —_— » —
7 —_— H — —_ . p——
. _— ] — —— . —
s —— » — rr— [] —_
Dazcriptien: (User—definable}
i
CAXM~E> ta Save amid Ewit CEze> to quix
-1/0 Cards §.Dascripters Il Delete I Channel B Statien J.Rack B.5tat

; Figure 4.405

All /O Cards are stored in the list, and can be selected from the list. Be sure to select a data-
base prior to selecting an I/O Card. The Card column may be left blank,

10.Setting Réference Numbers for Discrete I/O

The following procedure is used 1o set reference numbers for discrete i/0.

1

1) Move the cursor to the discrete /O for Slot 1.

2) Enter the address and press the Enter Key to move the cursor automatically to Points.

The xxxx pariofthe address (1)oox or 0xxxx) mustbe inthe formof (8 xn +1). (n=0, 1, 2,
etc.) .

13 LH nlp: t

e QUIPUTE ®s  CHANMEL: 2 STATION: 1C MCX: 3

DISCHETES RECIETERS
PoiNTS % EIZE

”

onqnmﬁuung

TN
e
HitE:

[THITHE

<Alt-I> te Save ant Exit CEso> te guit

B.1/0 Cards R:-Deseriptors {1 Belste 2:Orannel J-Seatinn B.Rack J.Status D-Inpues

/ Figure 4.406
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11.Setting the Number of Discrete I/O Points

The following procedure is used to set number of discrete I/O points.

Enter the number of points and press the Enter Key.

The number of discrete I1/O must be a multiple of 8.

The cursor will move automatically to Card.

t H g 3
ws QUTPUIS ==  CHAMMEL: 2 STATION: 16 MACK: 3
DISCRETES REGILTERS
SLOT REF & PFOINIS  CARD RKEF & SIZE CARD
% el 3% A 40081 : —_—
3 —_— . — — B e
H — . — —— . —_—
5 o . —_— e ] e
i —_ . —_ — 8 —
? — . — —_— . —_—
B —_— . ——— —— . r—
1 [ —— —— [ ——
Descriptien: (User—dafinable?
<Alt~E> te Sawe and Exit <Erc? ta quix
120 Cards J.Descripcors [.Bolste J Channel J-Station J -Back i Status J.1nputs

Figure 4.407

12.Entering /O Card Descriptions for Discrete /O ‘

The following procedure is used to enter names for IO Modules mounted in slots. /O
card descriptions are not written to the CPU during loading, but will be printed as slot data
when /O allocation is printed from the Lister.

1) Press F1 (VO Cards) from the function label.

A list of I/O Cards will appear. ‘

170 CARD DESCRIFTIONS

R2611 JAMSC-B2E11 UDC 16-pa input
PEC-D2S80 100208 JAC L6-paint sutput

=i MIC-B25M 100208 YAC Int sutPput
JAMEC-BZ2608  12/24 UDC if-—peint sutPar

MRC-] 12724 UDC I2-peint sutput

e JAMSC-E2ER4  12-24 UDC lnt wutput
22606 JAMEC-E2E06 5712 UDC 32 INE SUTput

<Pgbn> Maxt
{Enter> ta Sslect an 10 Card {Ezc) te guit
i — v puta

Figure 4.408

2) Move the cursor to the desired Card and press the Enter Key.
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The I/O card description will be entered at the siot that was selected.

e QUTMUTE ==  CHANNEL: 2 STATION: 1& kack: 3
DISCRETES REGISTERS
§! XEF B roglzn's SIZE

TN

[T
il
TS

Descriptisn: JAMEC-R2CE7 5712 UDC 32-paint input

4Ale-E> te Save and Exit (Esc> te quit

.10 Carda §.Descripte:

Figure 4.409

All /O Cards are stored in the list, and can be selected from the list. Be sure to select a data-
base prior to selecting an I/0O Card. The Card column may be left blank.

13.Displaying the Allocation Status List

The following procedure is used to display a fist of points used, maximum addresses, and
other information for discrete I/O and registers.

1

1) Display the Traffic Cop IO Allocation Screen.

Refer to 1. Displaying the I/O Allocation Screen on page 4-175 for more details on the
procedure for displaying the Traffic Cop I/O Allocation Screen.

2) Press F7 (Status) to display the Allocation Status List.

Figure 4.410

|
4.5.3 PC Link Allocation

PC Link is a communications system for transferring coil and register data at high speed be-
tween GL60S1, GL60S2, GL60S3, GL40S, GL60H, and GL70H Processors. Communica-
tions are conducted over coaxial or fiber optic cables, and up to 32 stations can be connected
together in a PC Link communications network with each GL PLC serving as a station.
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The CPU at each station communicates through an IF64 Link Module at that station. The IF64
has its own memory (called Link Memory) for link data, and the CPU at each station transfers
link data by reading and writing the Link Memory of that station’s [F64 according to allocation.
By the same token, the IF64 transfers link data between stations according to ailocation.

With Link Memory, the write area for each station is determined by allocation. The IF64 at
each station periodically sends link data written by its CPU to all stations, and the |F&4 at all
other stations writes the link data that it receives into its own Link Memory. This ensures that
the contents of the IF64 Link Memory at all stations will be exactly the same.

The flow of Link Data between stations is shown below.

Link Memoryat g -----~-
each station e

[}

. :
Station #2 Write - -—
Station #3 Write -— -
Station #4 Write = — :I -4

Figure 4.411 Link Data transfer

Note Writing Link Data as shown in Figure. 4.411 means writing o IF64 Link Memory.
The Link Data must be allocated for CPU reference. If allocation is not set for CPU
reference, then input data will be 0 or OFF.

Link data is either discrete or register data with reference numbers determined as shown in
the table below.

Table 4.2 Reference Numbers

Type Reference Number
Discrete data DO0001, D0002, DO0O3, DO004, ..., D1024
Register R0001, R0002, RO003, RCO04, ..., R1024
Use the IF68 Optical Link Module with fiber optic cables. ‘
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““

1) Select 2. Offline from the Main Menu.

GlAB 8™
Laddsr Le iA: t Seftware / Main Menu
Versisn 2.98 Gn;yruhe 1#"}!:"“ ELECTRIC Nm‘ﬂﬂl

Databage: TEST1 Help: <Alt-H>
Main Manu:

1. Sslace Active PLC
4. Mation

5. List Active FLC
6. Leader

7. Urilities

<E> te Exit te Dos
Enter Option: B

Figure 4.412

2) Select 6. Processor Configuration from the Offline Edit Menu.

Ladter Logt Broeiamiens ot evas / Eise neme |
Datahsse: TESI1 Halp: <ALlt-M)>
Offline Edit Menu:
1. Salect dctive FLC
57 Sremartial Functisn Charts

. Descriptere
. Database lhtaila

[ hnhhl:zzo Plapazitien
<Ezc> to Meturn ta Pravisus Meau
Enter Opcien: [N

Figure 4.413

3) Select 4. Link Allocation from the Processor Configuration Options.

L Ladder Legis hu-hmgm.nn Conf iguratien —I
Dakabaze: TEST1 Help: <Ale—H>
FROCEFFOR CONFIGUMTION Opcians:
t Frnnnx-

T f iguration
hfiﬂ g‘ [ T :rinhno
1.0 llheaclon

atisn

!
- N
; - !gah-snod Statien

CEst) te RMeturn te Previsus MHenw
Enter Optien:

Figure 4.414
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e
4.5.3 PC Link Allocation cont.

The Link Allocation Screen (Individua!l Allocation Mode) will appear.

Patabaze: TESTL T—OF LIRK: [RBIDTEUAL SLLRATION RODE ﬂ.lp: [ ="}
DISCRETE DISCRETE REGIETER
2 POINTS L] POINIE REFR SIZE

1

28
21
22
23
24

A A W G

TR

T
TR

[HTITHIHIHT
"
W

HHTERERTE

HRERINRR

TR
[LHHHTEETATH

LALt=E> te Save and Exit SExc) te Ouit

Figure 4.415

Link Allocation takes the form of either individual allocation or batch allocation.

« Individual Allocation: Writes to stations connected to a personal computer. Data must ‘
be written with the Loader in Offline Mode.

¢ Batch Allocation: Directly connects online and allocates data to all stations
through Link Communications {only available in Online Mode).

1. Reference Numbers for Discrete I/O

The following procedure is used to allocate discrete reference numbers for all stations. ‘
1) Move the cursor to the discrete I/O of the station that will be allocated.

2) Enterthe reference number and press the Enter Key to move the cursor automatically to
Points.

The first address at all stations must be in the formof (16 xn+1). (n=0, 1, 2, etc.)

o | nohh Tolls NP EIZE | o | mhe Polwme  aERe 2z
;| e EER o - Bli—m— = =
il = = = Dl oo T =
| o= = /= = § = = =
7| - - — — 23 | —— —— emmem e
S| === —— = = ) S —
B —/—— — —/— — ) s ———
¥l — —— —/— — Bl —— — —
14| — — — —— k] — — —_—
Bl — — — — Ui —— — — —
<Alt=E> te Save and Exic <Esc> to Guit
Figure 4.416
2. Number of Discrete /O Points _ ‘

The following procedure is used to allocate number of discrete 1/O points to each station.
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; 4.5 Setting the System Configuration
““

1

1) Move the cursor to the number of points to be changed.

The discrete 1/O points used with PC Link are D0001 to D1024. Enter the number of
points (multiple of 16) for each station so it falls within this range.

2) Enter the reference number and press the Enter Key to move the cursor automatically to
reference number.

it a3 alyp 3
DBISCRETE REGISTEN DISCRETE REGISTER
& REF POINTE NEFR  $IZE a2 KEFE POINTS REFE SIZE
1 —_— — ————
e e O e
2 3 — —— — e 19 — — —_— —
4 — — 28 — — —_— —
2 — g ——— — % —— — — r—
7 — — — 23 —— — — e
B —_— — — 24 — — —_— —
. ” — — —_— * —_—— — —
1| —— —— —_— % —_— — —
1] ——— a—— —_— 27 —_— — — —
12] —— —— — 1] —— — — ——
13] e —— — 9 — — —
14] —— — — 3| —— — ——
15] —— — — —— 32 — —— —
1w — — — — 32 —— — —
<A1t-E)> ts Save apd Exit CEsc) te Quit
Figure 4.417

3. Setting Reference Numbers for Registers

The following procedure is used to aliocate register reference numbers to each station.

1) Move the cursor to registers at slot 1.

2) Enter the address and press the Enter Key to move the cursor automatically to Size.

2 s 3
DISCRETE REGISTER PIS E REGISTER
a REFS POIMIS REPR SIZIX |2 REFS POINIE XEFS &I
N Pl —= — —
T | ——— — — 19 | —  ——— —_—
4 — e — —— 29 — — —— ——
I3 — — —— 21 —— —— — ——
T —— . — —— 22 — —— —
] — — —_— — 23 —— —— —_—
' — —_— 24 — — —_—
’ — _ 2% — —_— m—
w — —— = 26 | m——  — e
1] — — — — 27 —— e —— —
12 —— — — 2% — —— —
13| ——— - —— — 29 —_— — — ——
14| ——— — —_—— w| — — —
15 — — —— n —_——— —_— —
"B — — — 2 —_— —_—
. CA1t-E> e _Save and Exit CEzc) te Quit
1
Figure 4.418

4. Setting the Number of Registers

The following procedure is used to set the number of registers (size).

Enter the nunjber of registers and press the Enter Key.
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4.5.4 ASCII Module Allocations

The cursor will move automatically.

8 g nry t
DISCRETE REGISTER DISCRETE RECISTER
2 FEFR POIMIT REFE 13X 1 2 NIS REFR $IZE
1] peoe: ssic  reesi seme 7| — - — —
o — — — @ — — — —
| — — — — | — — — —
4 — — ——— -] _ _
H —_— e —— 2| — — — —
& — — —_— 22 _ ——— ———
2 — — —_— — » — — ————— ——
B —_— ——— — 24 — —— — —
) P — ——— — 25 — — r—— —
i9| — — rr— — 26 — —— — ——
11| ——— r—— — 27 — — r—— r—
12| — — —— — FT] —— —— — —
13| e — ——— 29 —— am—— — ——
gl m—m = |8l == — =
15] —— — — — N —_— —_—
16] m— m— — — 32 — — —_— —
<Ale-E> tu Save and Exit <Esc) te Quit
.
Figure 4.419

Changing settings: Press the Tab Key to move to where a change will be made, and enterthe ‘
change.

Deleting an entry: Move the cursor to the reference number or number of registers that will
be deleted, and press the Alt + D Keys.

After entering the settings, press the Alt + E Keys to save changes and exit.

The register range used with PC Link is R0001 to R1024. ‘

4.5.4 ASCIl Module Allocations

The following procedure is used to specify the channel used (2 or 3) on all ASCII Modules
connected to the remote line. ‘

1) Select 2. Offline from the Main Menu,

HEMOCON-EC CLABAR 7%
Laddar Legyic Mhr-nt Seftuara / Main Meny
Uarzien 2.0 Copyright 1771 YREKAUA ELECTRIC COXPOMATION
Batabaze: TESTL Help: <ALt-N)>
Hain Manu:

1. Swlact Active MLC

40 Wetion

S. List fctive PLC
6. Lander

7. Usilivies

<E? ta Exit to Des

Enter Optisn: B

Figure 4.420
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2) Select 6. Processor Configuration from the Offline Edit Menu.

HENOCON-EC CLAB/CB-70

Ladder Legic Develspaent Seftuars ~/ Edit Minu
Database: TESTL Help: <Alt-H>
Offline Edix Menu:
1. Salwet Active PLC
2. Matwarks
3. Sequancial Punctisn Chares
4. Pescripters
S. Database Details

Tisages |

- Crezsh

tEsc) te Awturn te Proviews Nemu
Eaver Option: [

— — Pvar- YrExAua =

Figure 4.421

3) Select 5. ASCII Module Allocation from the Processor Configuration Options.

MEMOCON-£C GLASS0-78

l Laddsr Legic Develepment Seftwars - Pracesser Canfigurat isn —'

Database: TEET1 Help: {ALE-ND
PROCEESON CONPICUMATION Optiena:
1, Precesser T # CanFiguratisn
2. Define 1/0 Descriptisns
3. 170 Bllacation
4. Link Allecation

- od Stat

7. -

<Esc> ta Retura ts Previeus Hemu
Entar Oytien: Y

—— — —— == YRSKAUA =i

1 Figure 4.422

4) Move the cursor to the Module number for allocation.
5) Enter the channel number (2 or 3) and press the Enter Key.

6) After the settings are entered, press the Alt + £ Keys to save them.

it ™ T [ 3 it

i
:
g

L DL FYNTITY

LALL-I> te favs and Exit LEsc)> ta Quic

Figure 4.423

Special data processing instructions are used to transfer data between the ASCII Module and
ASCil devices. These instructions must be in the form of messages that stipulate data /O

format. Each message is given a number (message number), and is stored in the memory of
the ASCH! Module.
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4.5.5 High-speed Station Allocations

4.5.5 High-speed Station Allocations

The following procedure is used to specify the stations and channels (2 or 3) for which high-
speed I/0 processing will be performed in a 2-level scan. Remote station I/0 data allocated to
high-speed stations will be executed, referenced, and updated during the high-speed scan.

1) Select 2. Offline from the Main Menu.

CLARSL-70
Ladder legic Davalapment Esftuare ~ Main Menu
Tersion 2.00 Cepyright 19‘rnnmn ELECTRIC CORPOMTION

Database: TESTL Halp: <ALt-ND>
Main Mepw'
1. Select Mctive PLC

- 3

4. Metisn

5. List Rctive ML
« Londer

7. Utilicies

<E> te Exic te Des

Enter Optisn: EH
e o— VAN = ‘

Figure 4.424

2) Select 6. Processor Configuration from the Offtine Edit Menu.

e e ————————— = |

HENOCON-SC GLALS0-78
Ladder Lagic Develspmant Seftuars -~ Edit Menu
Patabasw: TEETL Help: <ALE-H>
Offline Edit Mamu:

1. Salact Active FLC

2. Metumrks

3. Sequsntial Functisn Charts

4. Frripters

5. Databazs Details

N ]

9. Creszheference Dispesitisn
<{Ezc> te Futirn te Frevisus Mesu
Eater Optien: [N

YATKAUN =

Figure 4.425 ‘

3) Select 6. High-speed Station from the Processor Configuration Options.

MEMOCON-SC CL4L4L- M
Laddar Lagic Davelepment Seftuars / Precazzer Canf iguratisn
Datadase: TESTL Nalp: {N1t-W)>
PROCESEOR CONFIGURATION Optiena:
1. Pre T 7 Confiyuratien
Ihl“i:::lﬂlo g:i Dezcriptisn:
1-0 Allacatien

2.

i.

4. iLdnk Allocatism

5. ASCI] Mmdnle Allscation

{Eac? te Maturs te FPrevisws Mesu
Enter Optien: B

|l YASKRUR

Figure 4.426
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4) Move the cursor to the reference number that will be set.

5) Press the Alt + E Keys to save the data.

tabaswi T mips 3

DISCRETE RECIETER
INMUT OUTPUT

REFE  POINTS NEFR POINTS
18817 $E16  SORI7 W32

UTRIT
SIZE

-

lllllll.g
Irrvrris|s

THmE:

JHIH
[T
JHIH

ATIAWNe

[T
i
i
i

{ALt-E> te Save and Exit CExc> te Quit

Figure 4.427

Allocation is not necessary for a one-level scan.
A maximum of 8 stations can be specified as high-speed stations.

Refer to the MEMOCON-SC GL60S Design and Maintenance Manual {manual No. SIE-
C815-14.1) for more details on high-speed station allocation.

Be sure to set the scan for two levels if itis not set already. Refer to 5. Setting the Scan Levels
on page 4-170 for more details.

Note Input restrictions related to high-speed allocation
(1} Channel number: Remote channel 2 or 3

(2) Station number: 1 through 31

i

(3) Discrete address: 00001 to 04098 or 10001 to 14096
Addresses must be entered in multiples of 16 plus 1. (nx16+1)

(4) The number of points entered for discrete addresses must be a muitiple of 16. Refer-
ence addresses plus the number of inputs cannot exceed the address range given
above, 1

(5) The same address cannot be defined twice for high-speed allocation. If an address is
already used in the allocation table, a warning message will appear asking t¢ check
that entry.

4.5.6 YENET Allocations: Creating a Routing Table

The following procedure is used for settings needed in order to communicate with YENET
optical LAN systems.
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4.5.6 YENET Allocations: Creating a Routing Table cont.

YENET Configuration

YENET is a loop communications network that uses fiber optic cable. A maximum of 126 sta- ‘
tions (nodes) made up of a combination of masters and slaves can be connected together in

the network. The network is mainly for large-scale systems because it can handle iarge-vol-

ume data transfers at high speed. Multiple YENET networks are connected by bridges that
allow stations {nodes) on one YENET to communicate with stations (nodes) on another YE-

NET.

Master

Slave

Line server

YENET3200 Network ‘

Personal computer
Programming Pane!

YENET YENET

Allocation (YENET numbers and bridge numbers) is needed in order to communicate with
stations (nodes) on another YENET loop.

1) Select 2. Offline from the Main Menu.

MERMCCON-SC  GLA068-70
Laddsy Lagic Devels: wt Seftvare / Main Manu
Version 2.08 Copyright 19%1 YASXKAWA ELECTRIC CORFORATION

Patahare: TESTL Nalp: <Alt-H>
Main Menu:
1. Sulect Bctive PLC

4. Patisn

5. List #ctive PLC
k. Laader

7. Utilities

<E> te Exit te Das
Enter Optien: Hl

Figure 4.428
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%

2} Select 6. Processor Configuration from the Offline Edit Menu.

MEROCOR-CC GLALSL-70
Ladder Legic Develspment Ssftware # Edit Menu
Batabase: TEST1 Haly: CALe-4>
OfFline Edit Meau:
= Enlact Active PLC
- datwrks

+ Saquential Functien Charts
desC:

: Datenate Beraile

. 0 AEeE
9. Cresshefereace Dispesitisa
<Esc) te Meturn te Previsus Henu
Enter Optien:

Figure 4.429

3) Select 7. YENET from the Processor Configuration Options.

2 REMQCON—EC GLASSR-79

Ladder Legic Develspmant teftuare ~ Precesser Conf igurat fan
] Database: TEST1 Nalp: <Alc-H>
' PROCETIOR COMPIGUMTION Optiems:

. axner T 7 Coaf iguratisn
+ Bafine ]

1

2. b Vel Pescriptiens
'

3. I/0 Alleca

4. Liak Allecatisn

S. #ECI1 Meduls Allecatien

£ N ed Ctat:

<Ezc> te Meturn ta Proviexs Menu
Enter Optien: EI

— — —YATHAUM J

Figure 4.430

4) Press the Up Cursor Key to move the cursor to the name location, and enter the name.
5) Enter the YENET number.

€) Enter the brit;Ige number.

7) Enter comments.

Names can be entered using up to 16 characters.

8) After allocatign is completed, press the Alt + E Keys to save the allocations.

T,

e Tp: G

HANE:
8 |YEMET® BRIDCES COMENT 3 |YENETE MRIDGE® COMMERT
1| a2 e BUILD LiNE i | -— —

2 n 12 | === —_

|l — —_ 14 | — j—

s | — — 15 | —= —

s | — — 16 [ — —_

7| — — 17 | =— —_

o | — —_ 18 | —— J—

% | — ——— 19 | wme p—
18 | — —— Iz. —_— —_—

XA1t—¥) te Save and Exit LEse> to Quic
.
Figure 4.431
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4.5.6 YENET Allpcations: Creating a Routing Table cont.

The name and routing table will be deleted if the 32001F Module is reset. Reload the data if
that happens.
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4.6 Editing for ASCII Modules

m—“
4.6 Editing for ASCIl Modules

Messages are created in order to write data to an ASCH Module. A maximum of 1,024 mes-
sages can be created. The messages that are created are written and set to communications
destination devices in the IF71ASCH Modules using the Loader function.

4.6.1 Displaying the ASCIlI Message Editor Screen

Special data processing instructions are used to transfer data between the ASCII Module and
ASCII devices. These instructions must be in the form of messages that stipulate data I1/0
format. Each message is given a number {message number) that is stored in the memory of
the ASCIl Module. The following procedure is used to open the ASCII Message Editor
Screen. ‘

1) Select 2. Offiine from the Main Menu.

¢
Ladder Layic huhr-nt Softwars ~ Hain Meny
Version 2.88 Capyright 1991 YASKAUA ELECTRIC CORPFORATION
Databaye: TEST1 Help: <Alc-H>
Hain Henu:

1. G-I-E: Rotive FLC

-
4. Netisn

§. List Active FLC
6. leadey

7. Brilities

<E> te Exit te Des

Enter Optisn:
——— —— ~—- YASKMUN

Figure 4.432

2) Select 7. ASCII Messages from the Offline Edit Menu.

MEMOCOR-SC CLAB68-7
Ladder Logic Develepment Seftware ~ Edit Menu
Database: TEPTL Help: <Alt-H>
Offline Edit Menu:
= Selsct Active MLC
= Hatwsrks
« Sequantial Punctisn Charts

- Hezcre are
- Database Details

. Precesser Conf i; *ien
i. E.sﬁionneo Ch.ﬁ!:hn

<Esc> ts Metura te Previeus Menu

Enter Optien: NI
————- ——— A G KA g

VA b

il

Figure 4.433
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4.6.2 Editing

The ASCII Message Editor Screen will appear.

T R T ———————

fctive FLG:TERTL Help: <Ale—H>
Moduls Numder: 1 NMessagws svailable: 1824 Werds availakle: 32768
Nunber Yerds Nunber Verds Husher Uardz MNuaber Verds busber Werds
m ;s [ 3 [~ " ms? »
;i [ ] . e [ [

e . m? e 1 w4 . w5 »
a4 o i e . e . e []
"es s [ =+ [ -1 +
o] T ] 4 . . . a2 [
"e? s 9 35 . e . 3 *
et . a2 o a3 [ ] [ ®
"y . 33 . w37 . sl [ 3
s [] e [ ] [ =] . -2 » 3 £ 3
it s o Y . 53 . ea? *
i " M ] . s [ -] s
] s a7 8 1 . s 1] s
“-id . e " a2 . esE " =uw» .

{lEdit JACepy Pelate Flasdack Hedule BRMiT
YAEHNUN =
Figure 4.434
.
Moving the Cursor ‘

Moving up, down, left or right: Press the Up, Down, Left or Right Cursor Key.
Selecting the message number to be edited:
Press the Enter Key.
Moving to the next or previous page (from message number 1 to 1024):
Press the Page Down or Page Up Key.

4.6.2 Editing

The following describes functions defined at the function keys on the bottom of the ASCI|
Message Editor Screen. The description here begins with the Edit function defined at F1 or
the Enter Key.

1) Move the cursor to the message number that will be edited. ‘

2) Press F1 (Edit} or the Enter Key from the ASCIil Message Editor Screen.

oy

SEATE
Rctive FLC:TEST1 Nalpz <Ale=H>

Hodule Number: 1 Messages availabla: 1812 Verds available: 32543

Hunher Wards Humbsr Vords Nuaber Words Wunber Yerds HNumber Verds’

W s L3 -2y ) 3 57 "
i 2 [ 1] [ ] ) a s [l
a3 02 o? L] [ =0 a S . "sy ]
[ ] [ ] [ 1] » .32 a 46 [ 3 [ 1] L]
[ 4 [ ¥4 » | =k a -7 2 [, ] L]
e 4 "z " i34 a 4 i ] -2 .
a7 4 .21 [ ] L=t a [ ] » 3 a
o 4 .22 ] "3 1] " [ [yl a
[ it 4 "3 [ ] ;|7 | [ 3 [] s .
[ 1] b5 Y "4 ] M2 a ",s2 [ ] e a
[ -} 4 |25 [} 3y a [ ] "e7 L]
[ H 4 [ 11 [ ] M40 | 3 [ ] et ]
[ k] 4 [ ¥4 [} 41 | 3 55 . e L]
[T EL] [ -1} [ ] 42 [ ] s » " L
Edic WCapy [Pelots IPlaybeck Feduls WRuiv
YRIKAWA o
Figure 4.435
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The Edit Messages Screen will appear.

Xt (F4d ntagur reRt ECIT - CRY 1a; 1.}

Figure 4.436

1. Text

The following describes the text function defined at F2 that is used to enterorchangetext.

1) Press F1 from the Edit Messages Screen to switch to the next functions.

s 1T Length: S Toslztire: WBE  Mvallalle: 30RT  THREENT ]
np -
b betten -
t
20E g Aateger rees SCII . CR> La &
Figure 4.437

2) Press F2 (Text) from the Edit Messages Screen.

Xt axt nregur rens ECIT 1] CRY 1a K

Figure 4.438
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4.6.2 Editing cont.

3) Enter text in the Text Edit Messages Screen that appears.

Figure 4,439

4) After the text is entered, press the Alt + E Keys to save the text.

2. Integer Data

The following describes the integer function defined at F3 that is used to enter or change
integer data of n digits for m units.

1) Press F1 from the Edit Messages Screen to switch to the next functions.

2) Press F3 (Integer) from the Edit Messages Screen.

hi3 axt Ateger Tons SCI I . CR> agback

Figure 4.440

3) Enter the display prefix in the input screen that appears.

Figure 4.441 ‘
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4) Press the Enter Key after the prefix is entered, and enter the length.

dnayed TR Lingth: Gl Tagliters’ BT Feallad e TOR0 — TREERT ™
E; .f -

ttem —

xt oxt ntager rees {4911 ce CR> La; k

: Figure 4.442

5) Ifthe wrong prefix was entered the firsttime, press the Enter Key once more to re-enterit.
6) After the text is entered, press the Ait + E Keys to save the text.

3. Integer Data (Zeroes)

The following describes the zeroes function defined at F4 that is used to enter or change
integer data of n digits for m units.

1) Press F1 from the Edit Messages Screen to switch to the next functions.

2) Press F4 (quoes) from the Edit Messages Screen.

xt et nteger rees $C11 . CR> hack

Figure 4.443

3) Enter the display prefix in the input screen that appears.

L L LI O
| Feofox €1 %) EEB J A Loayth L #)

Figure 4.344
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4.6.2 Editing cont.

4) Press the Enter Key after the prefix is entered, and enter the length.

Xt (133 hteger reeR ISCIT L] CR> 1a: k

Figure 4.445

5) lithe wrong prefix was entered the first time, press the Enter Key once more to re-enter it

6) After the text is entered, press the Alt + E Keys to save the text.

Difference Between Integer ‘min’ and Zeroes ‘mJn’

= min prints spaces at the leftmost digits if the specified length is not filled.
+ mJn prints zeros at the leftmost digits if the specified length is not filled.

4. ASCH Data

The following describes the ASCII function defined at F5 that is used to enter or change ‘
ASCII text.

1) Press F1 from the Edit Messages Screen to switch to the next functions.

2) Press F5 (ASCIH) from the Edit Messages Screen.

Saages TG0 Langth: SS0B sisterz: WK Mvallabls: 3258 [WSERT |
[ tap —
I battem -
Xt axt nteger rews SCLI CR> Layback
Figure 4.446

3} Enter the display prefix in the input screen that appears.

Figure 4.447 ‘
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M

4) After the text is entered, press the Alt + E Keys to save the text.

xt aut wrager fa.l L] TCI T . CR> layback

Figure 4.448

5. Spaces

The following describes the space function defined at F6 that is used to enter or change
Spaces.

1) Press F1 from the Edit Messages Screen to switch to the next functions.

2) Press F6 (Space) from the Edit Messages Screen.

% oxt Ateger ress SCII - CR> 2 1 3

Figure 4.449

3) Enter the display prefix in the input screen that appears.

Frofax C1-99> LY x

Figure 4.450
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4.6.2 Editing cont.

4) After the text is entered, press the Alt + E Keys to save the text.

Figure 4.451
6. Carriage Returns ‘

The following describes the carriage return function defined at F7 that is used to enter
carriage retums.

1) Press F1 from the Edit Messages Screen to switch to the next functions.
2) Move the cursor to where the carriage retum will be entered. ' ‘

3) Press F7 (CR) from the Edit Messages Screen.

Ei:lm: -0 Length: BG Tagistare: GO tvailabla: 3RI5 TREERT
i

'OSCTI EBT' ./ 1
- battam -

xt Pexe [Wincayer ress JWSCII s JRKCR> TPlayback -

Figure 4.452

7. Binary Data

The following describes the binary function defined at F2 that is used to enter or change
binary data of n digits for m units.

1)} Press F1 from the Edit Messages Screen to switch to the previous functions.
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2) Press F2 (Binary) from the Edit Messages Screen.

vieus dnap; o x cal at ntrel dendar Iayhack

Figure 4.453

3) Enter the display prefix in the input screen that appears.

Pretas <1-9vy FF B ug Lennyel €1-14)

Figure 4.454

4) Press the Enter Key after the prefix is entered, and enter the length (number of digits). 4

wious inar, "% tal At trel Jondar la K

Figure 4.455

5) Ifthe wrong pfefix was entered the first time, press the Enter Key once more to re-enter it.

6) After the text is entered, press the Alt + E Keys to save the text.

8. Hexadecimal Data

The following ﬁescﬁbes the hexadecimal function defined at F3 that is used to enter or
change hexadecimal data of n digits for m units.

. 1) Press F1 from the Edit Messages Screen to switch to the previous functions.
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4.6.2 Editing cont.

2) Press F3 (Hex) from the Edit Messages Screen.

visus 13 tal at ntral lendar 1a K

Figure 4.456

3) Enter the display prefix in the input screen that appears.

= Howader aaal dabar =————
Frefas ¢1-982 ELI I 2 Lenyth-¢i-4)
' . L.

_INEERTICTINCINEN]

Figure 4.457

4) Press the Enter Key after the prefix is entered, and enter the length. ‘

visus A 9% tal At ntrel lendar 1a

Figure 4.458
5) Ifthe wrong Prefix was entered the first time, press the Enter Key once more to re-enter it.
6) After the text is entered, press the Alt + E Keys to save the text.

9. Octal Data

The following describes the octal function defined at F4 that is used to enter or change
octal data of n digits for m units.

1) Press F1 from the Edit Messages Screen to switch to the previous functions.
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4.6 Editing for ASCIT Modules

2) Press F4 (Octal) from the Edit Messages Screen.

isus inar nx 11 at ntrel lendar Layhack

Figure 4.459

3) Enter the diéplay prefix in the input screen that appears.

Todetal oy m—

Prefie <199 LZ9 0 3 Longth-¢1-b>

Figure 4.460

i

4) Press the Enter Key after the prefix is entered, and enter the length.

%-..-—rr Length: W Jeglacars: WM feallbles 234 TROENT—
% el
- battem =~

vises inar: (13 tal at atrol lsndar 1a X

Figure 4.461

' 5) It the wrong prefix was entered the first time, press the Enter Key once more to re-enterit.
8) After the text is entered, press the Alt + E Keys to save the text,

10.Repeat

The following describes the repeat function defined at F5 that is used to repeat a speci-
fied message a set number of times.

1) Press F1 from the Edit Messages Screen to switch to the previous functions.
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4.6.2 Editing cont.

2) From the Edit Messages Screen, move the cursor to the beginning of the message that
will be repeated.

3) Press F5 (Repeat) from the Edit Messages Screen.

:..,.: T Tanyth: BB Jaglsters: GolS  Avallable: J27CF  [RSERT |
op =
 hottem =
v isus An L3 tal At ntral lawdar 1n 13
Figure 4.462 ‘

4) Enter the prefix that will be repeated when the input screen appears.

Figure 4.463 ‘

You cannot repeat more than once.

5) Pressthe Enter Key after the prefix is entered, and move the cursor to the end of the mes-
sage that will be repeated.

Be sure to add a closing parenthesis ").” ‘

./.B.I.I.I./.lll.'
REXAM

ELECTRIC CORPORRTION’ .5X."BR* ./, 18X.’
i TN | )

Figure 4.464
6) Press F5 {Repeat).

11.Control Codes

The following describes the control function defined at F& that is used to setcontrol codes ‘
for ASCII devices.
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1} Press F1 from the Edit Messages Screen to switch to the previous functions.

2) Press F6 (Control) from the Edit Messages Screen.

visus inaxr lex sal 31 ntrel landar Ta k

Figure 4.465

i
3) Enter the control code using decimal numbers in the input screen that appears.

Figure 4.466

~

4) After the text is entered, press the Alt + E Keys to save the text.

vious dnas *® ta) at nErel Jendar 1a 13

Figure 4.467

12.Calendar .

The foliowing describes the calendar function defined at F7 that is used to set formats
used when a calendar is output.

4

1) Press F1 from the Edit Messages Screen to switch to the previous functions.
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4.6.2 Editing cont.

2) Press F7 (Calendar) from the Edit Messages Screen.

Tyt TR Tenythe W Teglaters W FoallibleT T2R0  TREDT |
top =

I Battom -

1eus inar X tal 3 tral Landar Layback
Figure 4.468
3) Enter the register data (1 through 8) in the input screen that appears. ‘

Figure 4.469

Refer to 4.1.(2) Message Symbols in MEMOCON-SC GL60S ASCIl Modules User's ‘
Manual (SIE-C815-14.4) for more details on calendar settings.

4) After the text is entered, press the Alt + E Keys to save the text.

vieus inar! (1.3 tal at ntrel lsndar 1a; k

Figure 4.470

13.Playback

The following describes the playback function defined at F8 that is used to display edited
ASCII messages in output format. The function is used to set formats used when a calen-
dar is output.
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Press F8 (Playback) from the Edit Messages Screen.

0t {113 nteger rees £CIT - CR> layback

Figure 4.471

SERASS NS LIRIRR R KNSR ESNARNENSNS RSN RATT
[ YRSXAWA ELECTRIC CONPOMT[OM i
TERTERRERIEN R RENARARERIT M SARERERELHNNNRE

Press any hoy to _centinug

Figure 4.472

4.6.3 Copying

The following describes the copy function defined at F2 that is used to copy the contents of
one message to another message.

1) Press F2 (Copy) from the ASCIl Message Editor Screen.

2) Move the cursor to the number of the source message to be copied and press the Enter
Key.

ITAEN
fetive PLCTERTL Help: <Alt—H)>

" Medyls Mumber: 1 Hessages available: 1812 Verds available: 32543
Nunber Usrdy Nuider Werds Hunber Words Munber erds Hunber Verds

g =

w -t [ -3 [ "] a  mes? []
- T ] a4 [ [

¢ o3 E2 Wy [ 1 [ . sy [
[} [T ] . ez " e [ ] [
e 1 sy [ [T [ I
[T 4 saze [ [ o 862 [
-7 4 w2y [ 11 3 sy . a3 .

! .. 4 [T . sy s N4 [
[ 4 W [T . 1 o s .
T I T . . s2 . e [
| oeedi 4 .S . [ 5 7 1]
| .l 4 W [ ] ] ] [
(4] 4 =27 8 ey i eSS e e []

. M2 . s « wa [

b Arel by MINERENEYE LKD) LT

; Figure 4.473
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4.6.4 Deleting

3) Move the cursor to the number of the message to receive the copy and press the Enter
Key.

(e —— —————————— e TR I —————— ‘

fetive PLC:TESTL Nelp: <ALt-H>
Hedule Hunbsr: 1 Hessages available: f1H2  Werds availabla: 32543
Nunber Werds Nunbar Usrd: HNunber Words HNosber Werds Nunder Uerds

[ 2 2y a -7 [ ]
a2 [] a [ a
[ ] [ ] a ".sy .
[ 7] [} . s [ ]
s 4 . [ [ ]
[~ 4 1 Ha 1] .2 [ ]
._r? 4 w7 [ ] 03 1]
[ L] a e "
.y 4 a s 1]
e 11 [ ] s L]
.1 4 [ ] 7 ]
¥ 4 ] sl 1]
3 4 [ 1) L]
4 . ] L]
PN -t )

B =~

Figure 4.474

4) Enter “Y” as indicated by the confirmation message that appears.

I — 3 L T e | ‘

Mctive PLC:TESTL Nelp: <Alt-H>
Hedule Humbsr: 1 Hexzages available: 1011 Nerds avallable: 32461
bunher Uprdz Hunbey Verd: Nunber Usrds Nunber Words Nunber Vards
2 [ k] . a2y

AuNn.!l!!g!!!!
o3
=AAAD-‘A\“"=.
!
Ll
Lo I DL LT L]
!mgu!u!ggg!a!g
SESSEEEDEEEEae
o
assasaassaaaas

.
.
M & 3
o 2 3
i 0 ee3s s
ms B ey ¥4
- T ) e
-7 B e 3
mE 8 e il
Wil Fcepy DPelete I layheck Bfeduls Wuic . ‘
Figure 4.475

4.6.4 Deleting

The following describes the delete function defined at F3 that is used to delete messages
stored in the ASCH Module. ‘

1) Move the cursor to the number of the message to be deleted.

2) Press F3 (Delete).

Mccive FLC:TESTL Help: <Ale—H>
Meduls Nosder: 1 Nessapes availabla: 1811 Yerds available: 32461
Nunber Uerds MHunbar Werds HMHumber Yerds HNunber Verds Husber Werds

[} ” .,s7

. L] » wse .
L] 82 1] .5y a
[ o a) . 1] "|sh []
4 1] [ []
[ 4 ] .2 []
-7 1 1] [ 1] L]
e 1 . -ed ]
s 4 1] -es 1]
[ X ] 11 » 13 ]
[ F3 4 [] .e7 1]
a2 4 [] [ 1] 1]
-3 4 » |t [ ]
-.i4 18 [ - L]

Edic ICepy [Pelets IFlavhack Jedule BRuit

2
g
5

Figure 4.476
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3) Enter “¥” as indicated by the confirmation message that appears.

IZTage
ictiu FLG: TEBT1 ’ Nelp: <AIt-H>
Modiile Musber: 1 Messages available: 1812 Werds avallahle: 32543
Hunber Uerds MHumbsr Werds Musber Werds Humder Wrds Nusber Yerds

W [t [ ] 2 W0 8 es7 ]
[itd e s e [ ] ]
- 82 el? s el . e [ ] s
[ [T . w32 . e . e .
i 4 emy 5 33 a7 [ []
[ 4 e ] [ -] . 2 [l
w7 4 e s S s st [ ] .
[ 4 w2 ¢ i [ [T ]

. . 4 ee23 . W? 1 s s S ]
miE 11 et . . s -1 .
[ 4 em [ 1] " s " M7 ]
[Tt ] 4 2 ] §  MSa [ .
[TE] 4 W7 . e 8 mss s et [
Wi 18 s [t . WS " wn [

Edit WCopy [HPeloxe TPlayhack Bieduls Muit

Figure 4.477

4.6.5 Playback

The following describes the playback function defined at F4 that is used to display edited
ASCII messages in.output format.

1) Move the cursor to the number of the message to be deleted.

T

Active FLC:TESTL Help: <R1c-M>
Heduls Nunkey: 1 Mezsagew available: 112  Werds availabla: 51
Hunher Werds MWumber Verds Munber Words Husber Werds Nunbar Werds

W [ 1] . ey w43 5 8857 [
i 8 M i e T [
[ s Wi o s [ .
et s & 32 . e . e [
-5 4 ey ] . W7 . i .
| . 4 eze [ 5 e . a2 [
ne? 4 w2 s eays . a4y 8 el ]
s 4 w22 1 [ ] [ .
208 4 =i [ 1] . e8s: s Eeds .
-ie  1x e e e & s [ .
it 4 e [ 1] s w53 . 86?7 .
[ F 4 eme ] 8 B54 . e a
.3 4 am? . e a s [ 1] 1
- 18 e » ez s s L) [
) i d

Figure 4.478

2) Press F4 (Playback) from the ASCII Message Editor Screen.

SEESRRRERSIEREIRRERNEEESURERRNENEILEIERELERT

H " YALKAWA ELECTRIC CORPORATION =
SRTERSIIEREREESINNEERRRRSISSNTERRISLEARANED

Press any ey te_centinue

Figure 4.479
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P -
4.6.6 Selecting Module Numbers

4.6.6 Selecting Module Numbers

The following describes the Module function defined at F5 that is used to change ASCIH Mod- ‘
ule numbers (1 through 8).

1) Press F5 {Module) from the ASCII Messagé Editor Screen.

r% B Forags Hiter ——mm—m——————
Mctive FLC:TESTL Saly: <Alc-N>

Podi:le Nundar: 1 Mersages available: 1012  Verds available: 32547
Nunber Yords Nuaber Yerd:s Nunber Werds MNuaber Usrds Humber Werds

IW [} [ : 1 . B0 . .7 [ ]
i a mn . G4 1 s .
o83 82 M7 Mt 8 s a s .
-4 [ ] a2 . a ee .
- 4 ey e s . eM? el .
- 4 28 . o4 T ] . 2 s
7 4 21 . s s W . W) .
[ 4 oz a3 ] 2] .
[ 4 023 .37 [ 1 sS .
w18 1r 24 e s [ s s .
[t 4 5 ] [ & .? »
.2 4 26 ] [ ] ] »
[ %] 4 .e? . " 0SS s ey »
mi4 15 w2 [ [ 5 W "
Tew Hosdo e Rototrss O30

Figure 4.480

2) Enterthe Module number that will be edited when the Module number input field appears.

TRAgY

Acties PLC:TERTL Mulp: <Ale—H>
Medule Mmbar: 2 Hezsages available: 1024  Werds available: 3278
Munber Yords Nusber Yerds MHumber Usrds Husher Vewds Number Words

m s s w2 I 57 ]
,ié ] s e [ ] 8
a3 . W7 s i - . MY .
— s sEE . 2 . e ] .
[ s ey ] o M7 . i .
[~ ] " 34 . =a . a2 .
[ 1 s 21 = s 9 8863 »
[ s 22 5 % s mese [ E]
-y B 3 . 37 § 851 1 S ']
mie [ I ] 5 2 e [
.1 I . .y s w63 a7 H
-z " e . s s ses4 T e ]
] 7 . 8 865 . ey .
[t [ ] 1 e [ T W ]

[Edit PCopy Pelate D layback BPdule BRuit
e e e——

Figure 4.481
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This chapter describes the following editing functions of MEMO-
CAD-PRO to provide more efficient program editing,.

1. Program Merge: Merges multiple programs
2. Independent Comment Editing:

: Allows comments to be created and edited using
commercially available text editors.

5.1 Merging Multiple Programs ........... cees S22

5.2 Converting Comment Data Files .. ......... . 58
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Advanced Offline Editing

5.1 Merging Multiple Programs

Program merging is used to combine ladder programs from other databases into a single da-
tabase. This allows multiple programmers to work separately on parts of a program that,
when completed, are merged into a single program.

Example

The following procedure describes how ladder programs created in separate databases by
programmer A and programmer B are merged into a single database.

Programmer A’s program: Networks (L1 through L50)
Coil Reference Numbers (00001 through 00100)
Database Name: APRO ‘

Programmer B's program: Networks (L1 through L50)
Coil Reference Numbers (00001 through 00050)
Database Name: BPRO

Program after merging:  Networks (L1 through L100)
Coil Reference Numbers (00001 through 00150)

Database Name: CPRO ‘

Programmer A's Programmer B's
database database

Networks N

Program iibrary

QDI

Copy comments

Copy comments and register data

and register data New database

Merge

Block change the reference numbers

Figure 5.1 Overview of Program Merge
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‘ 5.1 Merging Multiple Programs

In this example, there will be duplicate reference numbers {same number used more than
once) after the programs are merged. The reference numbers in programmer B's program
are changed and adjusted as a block, but it is more efficient to allocate reference numbers to
each programmer in advance in order to avoid duplication.

5.1.1 Merging Networks

The following must be performed in preparation for merging. Programmers A and B create
programs in their respective databases. Programmers A and B define the edited networks as
a block, save the block, and exit from editing.

Comments and Register Data may be created in advance because they can be copled from
other databases..

Referto 8, Saving and Loading an Edited Networkon page 4-70formore details on the proce-
dure for defining blocks and saving networks. In this example, the blocks are saved as APRO
for programmer A and BPRO for programmer B.

1) Create and select a new database where the programs will be merged.

Referto 3.1 Selecting or Creating Databases for more details on the procedure for creat-
ing and selecting databases. In the example, the new database is named CPRO,

2) Display the Edit Network Screen.

Figure 5.2

3) Press the Slash Key to display the Command Submenu.

f 1.%tive 2.Meck 3.Begiacer 4.001r 5.Xebal &.Bearch 7.D0ds 8. Diew 7. Je5l

Figure 5.3
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5.1.1 Merging Networks cont.

4} Press F2 (Block).

The Block Submenu will appear.

E Black: 1.3e11 2. ntwerk

Figure 5.4

5) Press F2 (Network).

The Network Block Submenu will appear.

f Hetwark Black: 1.Hsck 2.Dablack 2.Jepy 4.500ve 5.0unp C.Enlste 7.J3ave 6.0ead ‘

Figure 5.5

6) Press FB8 {Load).

The Select Block File Screen will appear. ‘

DOC Selsct Black File
—WINDOUS: E——————WIN32S Lead

ﬂ-_—.ﬂml—“—-‘—\llﬁmﬁ PLC: CPIO ROy by
—PNOT ORHP— il 3 TETYLES
ISPMPS
omeers b
P=CALIKMT CPRO.ELP
—ERANES TEST.XLD

[—PALETTES

—TUTORIAL

~PATTERNE

—mww—l—llﬁ‘l'“——b-
v

Directery  C:\CLEBE\DINe BLD
Quick Pind: HIEEEEEN {Tah} switch windeu
A — Yaslawm
'y

4.Prive . emuild §.Mew bi D-Dulets ¥

Figure 5.6

7} Press the Tab Key to move the cursor to the left side of the screen (Directory Display).

This procedure is used to select a Block File. The desired file will appear on the right side
of the screen (Select File Screen). The desired file does not have to be displayed from the
top of the file.

8) Move the cursor to the subdirectory containing the APRO Block File.

This procedure is used to select a Block File. The desired file will appear on the right side
of the screen (Select File Screen). The desired file does not have to be displayed fromthe ‘
top of the file.
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5.1 Merging Multiple Programs

9) Press the Tab Key or Enter Key to move the cursor to the Select File Screen on the right
side of the screen.

10} Move the cursor to the file (APRO) that will be loaded, and press the Enter Key.

The network block will be copied.

Networks loaded as a block will remain defined as a block.

== — MY

a] W.rhg
1 I

<Dndbleck 3. Jepy 4.T0ve 5.Dunp 6.Dnlste 7. 3nve E.Joad

Figure 5.7

11) PressF2 (Uriblock) fromthe Network Block Submenu (Figure 5.6) to ungroup the defined
block.

12) Press the Ctrd + End Keys.

The last network will appear.

Hotwurk Mlack: 1.Meck 2.Dnblsck 3.Jepy 4. Deve S.0unp 6.Qelate 7.Juve ¢ Gead

Figure 5.8

The cursor actually jumps to the next blank network after the last network.

13) Press F8 (Load) again from the Block Submenu (Figure 5.6).

1
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5.1.2 Adjusting Reference Numbers and Copying Comment Data

The Select Block File Screen will appear.

\=r=D0E falsc: Fleck Fila
[~ NPOVE: g_}n—-—-—uuuzs Lead
[-AT|—————ATIDERK——~——JAPANESE PLC: CPRO Cale-ild)
ot T o

o L
LIERAT B
EHES TEST.HLD
TUTORIAL
TTERRE
M—rﬂ!ﬂdﬁ—b
v

Pirectory C\GLEES\DE\w. ELD

Quick Pind: DN <Tahd switeh windaw
—
O.Drive Z.Muduild B.Wew Di 'y I.Palats b: 'y
.
Figure 5.9

14) As was done with APRO earlier, move the cursor to BPRO and press the Enter Key.
The BPRO Network Block will be copied.

The biock will be copied and inserted between the network currently being displayed and ‘
the previous network rather than after the network currently being displayed. The reason

the next blank network after the last network is displayed is that the copied networks will
merge and be inserted after the last network.

15) Press F2 (Unblock) from the Block Submenu (Figure 5.6) to ungroup the defined block.

Shortcuts
a) Enter “BNM"at AR: and press the Enter Key to display the Network Block Submenu. ‘

b) Enter “LNB” at AR: and press the Enter Key to display the Select Block File Screen.

5.1.2 Adjusting Reference Numbers and Copying Comment Data

The following reference numbers were used in the networks that were merged in the exam-

ple. ‘

APRO: 00001 through 00100
BPRO: 00001 through 00050

Duplicate numbers cannot be used because they will result in duplicate coils. Moreover, only
ladder programs are loaded and not the comments in Block Load. The following procedure is
therefore used to copy all necessary comment data from APRO and BPRO into CPRO, andto
change the reference numbers in BPRQO in order to eliminate duplication. The function used
for these changes is Global Replacement.

1) Press the Slash Key to display the Command Submenu.

[ semmn ] ML) I
1.0ctive 2.Beck J.[agister 4.5t 5. Blebal 6. Toarch 7.Drde 8.Jlew ¥.Jeil

Figure 5.10
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5.1 Merging Multiple Programs
2) Press F5 (Global).

The Global Replacement Settings menu will appear.

tuerk: 15

R
1

AbD
m——

Glabal Raplace
e

twark range: ALl Legic

Imstruction : Spacif Mremenic @ NOC
ll.:r::: " H B::ﬂ‘: Ssarch r 10GW1
Baplac de : Ste Replacs
L H _
8.:1-&- ML = GPJ

Descripters Ec-”
Negister Data: Cepy

<Ezc> te Quic <Alt=E> te Begin
186 C 1 LC2 MRS JCMURT R%1 PEC EMET  {[J0T1
L1 ’M 'alnlﬂ Il:IJM nws e % ,I-N mu! Lua

1

Figure 5.11

3) Enter the settings shown in Figure 5.12 and Figure 5.13,

Refer t0 4.1.19 Globally Replacing Addresses for more details on the procedure for en-
tering these settings.

4) Press the Alt + E Keys to execute the global replacement.

Shown below are the settings used to copy the APRO database comments to 00001 through
00100 without changing reference numbers between networks 1 and 50.

Glabul ."hfu:t i3 Epecif 1
td ge: Epacify
: lultmlm : Epecify Hnomenic
Address : Specify Laarch
Baplace meds : Cantinusus
g:una ML ‘a:.m
scripters
Begister Nava: OO

{Space’ te Toggle {Esc’ te Quit <Alt=E> te Bugin

Figure 5,12

Shown below are the settings used to change reference numbers 00001 through 00050 to
00101 through 00150 between networks 51 and100 when copying BPRO database com-

ments.
G
R it ove 7 51 te 100  (ECENEIN
[nstractisn : Specify Mnemenic @ COIL
Rddrezz = Epmcify Search i SUEL-88858
Raplace : BULI01-88158
Baplace meds : Cantisusus
Berrristece | Gia
Mﬁtlr Pata: h
<Epacad ¥o Tegyls {Ezc) ts Quit <AIt-E> ke Beyin
Figure 5.13
Shortcuts

Enter “G” at AR: and press the Enter Key, or press the Alt + G Keys to display the Global
Replacement Settings menu.
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5.2.1 Converting Database Comment Data to a Text File

5.2 Converting Comment Data Files

Comment data can be converted into an ordinary text file that can be edited in MS-DOS, and it
can be edited and stored as an independent file. if a comment file is created separately as a
text file in advance, then the file can be loaded and merged into the database later after the
database programs are completed.

Text file: Filename. TXT

From database to text file

sk skl koK

skoksKkk R

From text file to database

5.2.1 Converting Database Comment Data to a Text File

The following procedure is used to convert database comment data to a text file.

The text file will be created in MEMOCAD-PRO text format that can be edited with commer-
cially available text editors.

ATi grmant IDiDesc. |Desc. [Desc.
<Format> AT grment |31 3hort Comment {Short Commsnt [Shart Comment 1Short Comsent
Alignamnt. e
Aligrmgnt. [T|Page Titles
<Example> '
P 00001 [D{RELAY  |FOR TEST |

00001 Y3(TEST TEST TEST TEST TEST TEST TEST TEST TeST |
1 I

<Alt—H> Fer Nelp

Descripter Mumber
[valid werd size]
[ 6 words/ line }

-

: TEST TESY TEST TEXT TEXT TEXT TEST IEST TEST

v

b}
{ ¥ words’ line ]

"
¥
AWNE Wl

Leng Conmant Mumber: 1 C=#3) for trailing
Page Tisle:
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] 5.2 Converting Comment Data Files

As shown above, comments that are not entered, such as the Short Comments in lines 3 and
4, as well as header comments, will not be converted.

1) Select 7. Utilities from the Main Menu.

Laddar Legic Dewsls c..: hl‘tﬂ # Main Rena
Versisn 2.80 Capyright 1301 ThsKAUR ELECTRIC CORPOMMTION
Databuss: TESTL Holp: <Alc-H>
Main Mewa:

+ Sslact Rotive PLC
OFFLina

| 3
2.
3. Online
4. Metis
13
]

<E> te Exit teo Bex
Eater Optisn: [l

w Figure 5.14

2) Select 2. Descriptor Utilities from the Utility Menu,

1

HEMOCON-SC GLABASB7W
laddey Legic Develepmant Seftware / Urilicies
H Database: TEITL Help: <A1t-H>

UTILITY Manx:

1. Cenfi tion

37 Box Comperary File

<Esc)> to Juturn ts Previsus Henu
Enter Optien: E

Figure 5.15

3) Select 2. Import/Export Yaskawa Database from the Descriptor Utility Options.

PEMOCOM-EC GLAB/AR-78
Laddar Legic Develepment foftwars ~ Dezcript Utilitias
Database: TEST1 Malp: <A1c=H>

BESCAI?T UTILITY Optiens

1. Adjust Hetuerk Peinters

<Exc> te Meturn te Previeus Wanu
Enter Optisn: BI

Figure 5.16
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M

5.2.2 Converting from Text File to Database Comment Data

4) Select 2. Export data from a database to an ASCII text fite from the Import/Export Yaska-
wa Database Menu for comment data.

MENOCON-SC CLAB54-78 I
Ladder Legic Develepment Seftwars 7 Duscript Utilitiss
Database: TEST1 Help: <AIt-H>
Imparc/Expart YACKAWA Database
Sohct lht-hn-

1.

. N
T3
Ew.or: hn fnn » hn.h.u te & nnlui IIl! File
Inpere data Frea a standard PIF File te a databaze
Clean up a databese uxing a standard BIF file
<Esc> HRaturn te previeus mea

Enter Optisn: EB

roawil

———— e YASKALM

Figure 5.17

The input screen for entering the name of the text file will appear.

MEMOCOM-1C CLAM/60- 7
Ladder Logic Develapment Seftwars / Descrips Urilicies
Databare: TESTL Helps <Alt-H>

Mame «f .IXT File s sxpert te: [IEYNNEEN
<Entar}> te beyin <Ezc? te camcel

Figure 5.18

5) Enter the file name and press the Enter Key.

A default database name will be used if a name is not entered. Enter aname to create a
file with another name. When a file is created, if another file with the same name exists,
the newer file will overwrite the older file.

A text file will be created.

Do not change the file format when editing the file with a text editor.

5.2.2 Converting from Text File to Database Comment Data

The following procedure is used to read the contents of text files into database comment data.
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5.2 Converting Comment Data Files

1) Select 7. Utilities from the Main Menu.

mw“hh‘:l’ft Hain My
I A S
Careisn 280 Capyrisht 1991 TASKAUR ELECTALE BORPORNTION

Databaze: TESTL Help: <ALe-HY

Hain Menu:
1. Selsct Active PLC
2. OFflins

3. Onlime

4. Mat

5.

[ i

<E> te Exit te Dux
Enter Optien: EJ

Figure 5.19

2) Select 2. Descriptor Utilities from the Utility Menu,

HENOCOW-EC CLAS/S8-78
l Ladder Legic Pevelapment Seftwvars / Utilities
Database: TESTL Help: <Alx-¥>

UTILITY Penu:
1. Configuration

+ Bat w Utilities
4. Tt tenperary Fils
<Eac)> te Beturn ts Previsus Memu
Enter Optien:

Figure 5.20

3) Select 2. Irﬁport/Export Yaskawa Database from the Descriptor Utility Options.

| HEMOCON-EC CLALGR-78 |
Ladday Leyic Bevelapmont Exftuvare Bescripe Utilities
Databasza; TEST1 Help: <Mlt-4H>

DESCRIPT UTILITY Optiens

1. lﬂu: Network Pointere

-(I'a:) te Roturn te Provieus Memu
Inter Optisn: El

Figure 5.21
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Advanced Offline Editing
5.2.2 Converting from Text File to Database Comment Data cont.

4) Select 3. Import data from an ASCII text file to a database from the Import/Export Yaska-
wa Database Menu for comment data.

= ————————— —————————— |

MENOCON-£C CL4G/68-78
Ladder Legic Devalspagnt $eftware ~ Descript Utilitiss
Databaze: TEET1 Melp: <Alt—H>
inpart/Expert YREXAUR Datahasae

falect Database
Expart dats from a databaze te an ASCI] text file
st At o BT TR

1.
2.

Art SATE Frem & WAL e ta a ztandard DIV
Inpert data frem & standard DIF file ts a database
Clean up a using a daxd DIF Fils

{Excr Return te previsus wasm
Enter Option: [
PASKAUM

Figure 5.22

A screen for selecting the text file name will appear.

~ [ #elece 1xr Pi2e |
TMDOVS: S TEN———WINIZE
rLC: TEET1 <AL=
Tl AL ———JIAPRIEE
OT! CING: JSTYLES
1EPHAPS
ETS
LINWT
LETTES
UTORIAL
TTERMG
m—l—mou:—>
v v
Directsry  GinCLEBS DI TXI
Quick Find: RSN =~ <Teb> svitch windsv
TASEAA
B-Drive 3.Babuild O.Hew b w O Delets v

Figure 5.23

5) Move the cursor to the file name and press the Enter Key.

Moving the Cursor ‘
Moving up, down, left or right: Press the Up, Down, Left or Right Cursor Key.
Switching between the left and right windows: Press the Tab Key.

Switching Directories
Press the Tab Key to move to the Directory Window on the left side of the screen. Position
the cursor at the desired directory and press the Enter Key.

Switching Drives
Press F1 (Drive) to specify the drive.
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5.2 Converting Comment Data Files

A choice of three conversion methods will appear.

Ry W
Database: TESTL Help: CAlt-H>
Thees types of lapert are pessible:

~ Useful fer adding te Files
L T oo g f oy atding o ¢

2. Overiay existing databags - Useful far updating Files
av all records are updated with the new data.

3. Creats wev database = Useful For rebuilding files
ar the databara iz Firet cleared of all existing data.

<Ese> Retwrn to Jwevieus menu

Figure 5.24

Methods Used to Convert to Database Comments

1. Add to existing database:  Adds comments for new addresses. The contents of
addresses that already have comments will not be
changed.

2. Overlay existing database: Adds new addresses that overwrite the same existing
addresses, and leaves existing addresses that are not
in the text file unchanged.

3. Create new database: Clears all comment data in the database, and converts
the text file.

6) Press the function key with the appropriate number to select the method.

An alternative method is to move the cursor directly to the item and press the Enter Key.

The file will be converted.

5.2.3 Cleaning Up Comment Data

When networks are repeatedly inserted and deleted, comment data that is no longer needed
remains inthe database and may print when the Comment Listis printed. The size of the data-
base grows as the amount of unnecessary comment data expands,

The following procedure is used to adjust comment data by deleting any thatis no longernec-
essary. The procedure used here is to convert the comment data into a text file, delete all
comment data in the database, and then convert the text file back into database comment
data. Specify the name of the text file to perform the preceding operations automnatically.

1
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Advanced Offline Editing

5.2.3 Cleaning Up Comment Data cont.

1) Select 7. Utilities from the Main Menu.

—_—— = ————— = —————

AL
Ladder Legic hu-hrut Seftware / Main Meau
Unrsisn 2.80 Capyright 1931 YRSIAWA ZLECIRIC CORPOMTION

Database: TEST1 Help: <Rle-H>
Main Meou:
hhce Active PLC
M

1.

2.

3. hn
; Matin
‘ Leader

EIE T
<E> te Exit ta Des

Entar Optiant
—— —— —— mexaun =1

Figure 5.25

2) Select 2. Descriptor Utilities from the Utility Menu.

MEMOCON-SC GLARAR-78
Ladder Legic Develepmant Seftwars ~ Urilitiss

Databass: TEST1 Halp: <ALL-H>

VTILITY Henu:

1. Canfis tisn

1: Tat :cl;n:l-y :il:

<Ex¢> to Tmturn to Previsus MHead
Enter Oprien: H

— ——— IAENAUN =)

Figure 5.26

3) Select 2. Import/Export Yaskawa Database from the Descriptor Utility Options.

—————— ——————————————————"

MEMOGON-EC CLAM 078
Ladder Legic Develepment Seftwarw ~ Descript Utilitiss
Databaze: TESIL Nalp: <Ale—>

BESCAIPT UTILITY Optisms

1. nﬁe Hatwerk Fsinters

CEse? to Moturn te Praviaus Meaw
Encar Opcion: H

= $ALKAMA =

n
n

Figure 5.27
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5.2 Converting Comment Data Files

4) Select 6. Clean up a database using a standard DIF file from the Import/Export Yaskawa
Database Menu for comment data.

MENOCOM—EC CLAD%R-78
L Ladder Leyic Develsyment Seftwars .~ Dazcript Urilitiag ]
Databaze: TESTY Nelp: N1E-R>

Tnpart/Expere YATRAUA Batabass

abazg
rt kata frem a dat ® te a standard BEF file
tandard DIF fils te a databass
ot e 4 Lot D+ T

0 or

<Esc> Metwn ts previsus memu
Enter Optisn: [H

& ———— — — — YRASKAYA J

Figure 5.28

The input screen will appear asking for the name of the text file that will be converted.

| MENOCON-£C CLABS0-70
Ladder Legic Develeprant Loftuare - Duzeript Utilities
Tatabase: TESTL Nelp: <alc-H)

Hane of .DIF fila te expert te:
{Enter> ts bagin <Ezc) te cancel

- —— e — YALXAW J

Figure 5.29

5) Enter the file name and press the Enter Key.

A default database name will be used if a name is not entered. Enter a name to create a
file with ancther name. If there is already another file with the same name when a file is
created, the newer file will overwrite the older file, Refer to 5.2.1 Converting Database
Comment Data to a Text File for more details on text files, such as formatting.

The commerit data will be cleaned up.

1
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Online Editing

This chapter describes network, subroutine, and SFC editing. It also

provides details on communications between Processors and comput-
- ers, starting and stopping the Processor, displaying and editing com-

ments, clearing memory, system configuration, and ASCII editing.

6.1 Preparations for Communications with Processors

..... . ]
6.2 Selecting Remote Operation (frogram and Monitor
Mode) ......... ceseeenenatarananas veee. 6-8
6}.3 Going Online with a Processor ........ veee. 6-11
6.4 Starting and Stopping a Processor .......... 6-13
6.5 Editing Networks ...... carecenans cererenas 6-15
6.6 Editing Subroutines ........... terereaes vo 692
67 SFCEditing .........ccvuvvvinnnnnnn.... 6-95
6.8 Displaying and Editing Comments on the Network/
SFC Screen ...... e, .. 6-140
6.9 Controlling Scanning ........... ceeesaanes 6-144
6.10 Traceback ..... reereaenans sssssuns ceee. 6-148
6.11 Clearing Memory ..... I sesesssnas 6-162
6.12 System Configuration ........ tereesen eeo. 6-165
6.13 Editing for ASCHI Modules ...... crreerans 6-201
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Online Editing
6.1.1 Displaying the Communications Parameters Setup Screen

6.1 Preparations for Communications with Processors

Communications parameters must be set prior to communicating with Processors.

Communications Parameters

Communications parameters are parameters that need to be set in order for a computer to
connect to and communicate with Processors. The parameters are given below.

« Device: Remoie communications devices
Processor front port, YENET-3200, IF71ASCIt Moduie

Processor Front Port or IF71ASCIl Module

¢ Computer serial port:
RS-232C serial port 1 or 2 of a computer (Normally 1)

¢ Port baud rate:150 to 9,600 baud {(Matched t¢ Processor settings)
e Port parity:  Even, odd or none (Matched to Processor settings)

« Port stop bits: Either 1 or 2 (Matched to Processor settings)

+ Timeout: 120 to 200 s (Time iimit to wait for a response from the Processor)

YENET

« Routing Table Editing?:*N” when communicating within the same YENET
“y when communicating with another YENET

Set these parameters prior to communicating with a Processor. Leave the Communications
Mode for the Processor set at RTU.

Note The initial MEMOCAD-PRO settings are the GL factory settings.

Factory Settings
» Port baud rate: 9,600

» Port parity: Even

» Port stop bits: 1

6.1.1 Displaying the Communications Parameters Setup Screen ‘

The following procedure is used to display the Communications Parameters Setup Screen.
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. 1 6.1 Preparations for Communications with Processors

1} Select 3. Online from the Main Menu.

MEMOCON-SC GL48/58-70
Ladder Layic Dovul-ront Seftvars / Nain Menu
Vsrnion 2.00 Capyright 1991 YATXAWR ELECTRIC CORPOMATION

Databess: Healp: <Alt-H>

Main Menu:
1. Salect Metive PLG
2. Offline
- 13
$. List Recive PLC
Leade

6. >
7. Utilivies
<E> te Exit te Dex

Enter Optisn: §J
———— — S —————— YASXAWA

Figure 6.1

2) Select 3. Online Communications Setup from the Menu Options.

]

MENOCON-£C  GLAS S8
Ladder Lagic Develeymant Suftvare / Onling Manu

Datahare: Nelp : <Ale->
Device .: b l:-:.: STOPPED

KD Optiens
1. PH{N- Poda
2. Meniter Mude

<Esc> to Meture te Previeus Meau
Enter Optien:

e — — ——— == YASXAUM =

Figure 6.2

The Device/Communications Parameters Setup Screen will appear.

I DEVICE-COMMINICAT[OMT PARMMETERS SETUP [
Database: Nalp: CAIz-N>

: Bevice: IERENEFTINRTCNTNIN

Conputer Sarial Part: 1

Port Baud Rate: a0
Part Faricy: Even
Pore Stop Bita: 3

Meceiver Tinseut: 128

<=~ => or Tpace’ ts leggls
CALs-E> te Save and Exit CEsc> te Quir
e —

' Figure 6.3

Moving the Cursor

Moving up or down a parameter: Press the Up or Down Cursor Key.
Moving to the next parameter after setting:
‘- Press the Enter Key.
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Online Editing .
6.1.2 Procedure for Setting Communications Parameters

6.1.2 Procedure for Setting Communications Parameters

The following procedure is used to set communications parameters.

1. Processor Front Port or IF71ASCIl Module

1) Display the Device/Communications Parameters Setup Screen.

Refer to 6.1.7 Displaying the Communications Parameters Setup Screen for more de-
tails.

[ BEVICE COMMMICATIONS PAMMNETERS SETUP ]
Batabhsa: $alp: <AIe—N>
Device: [EVEEXNCIRTITIITINE

Camputer Serial Pert: 1

Part Bawd Rate: »m
Part Paricy: Even
Part Sxop Bitaz 1
Receiver Timesut: 128

{{= => o» Space te Teggle
<A1c-E> £s Save and Exiy <Ezc? te Quit
—

Figure 6.4

2) Press the Space Key or press the Left or Right Cursor Key to set either Processor Front
Port or IF71ASCII Module as the device.

The default setting is Processor Front Port. ‘
3) Move the cursor to the parameter that will be set.
4) Press the Space Key or the Left or Right Cursor Key to switch the parameter settings.

5) Afterthe settings are entered, press the Up or Down Cursor Key or press the Enter Keyto
move to the next setting. '

6) Press the Esc Key after all the settings are entered.

Press the Alt + E Keys or move the cursor to Receiver Timeout and press the Enter Key to
save the settings and return to the Online Menu.

[ BEVICE/COMNI CATIONE PAMNETERS SETUP ]
Batabazat Help: <Alt=i>
Sevics: Precesser Freat Pert

Computer Sorial Fort: 1

Part Baud Rate: *e
Part Parity: van
Pert Stap Bits: 1
Macaiver Timasut: =
Enter b in al.

<Alt-E> ta Save and Exit CEzc> ke Quit

Figure 6.5
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6.1 Preparations for Communications with Processors

A confirmation message will appear asking whether to save changes,

[ DEUICL-COMMUNI CATIONS PAMMNETERS SETUP
Batabase: Help: <RIt-W>
Bavice:  Precesssr Preat Pert

Canputar Cerisl Pare: 1

hn
Part o I
Port| - - -
Mecaiver Timmeus: 2m
h <Alt~E> t» Save and Exir CEzc> te Quic
e P

Figure 6.6

7) Make sure that “Y” is entered, and press the Enter Key.
Enter “N” and press the Enter Key if the changes are not to be saved,

The settings will be saved, and the Menu Options will return,

2. YENET-3200

1} Display the Device/Communications Parameters Setup Screen.

Refer to 6.1.7 Displaying the Cornmunications Parameters Setup Screen for more de-
tails. 4

| = DEMICE/CONMINICATIONS PARMMETERY SETUP ]
Patabase: Malp: CAle-H>
Device:, INRIPENNETITENITTE
Conputer Gerial Parc: 1
Part Baud Raca: %w
Port Paricy: Even
Pert Step Bits: 1

Meceiver Timeemt: 120
’ - =D ur Spneed e Tegyls
A2e-E> to Lave and Exic <Esc) te Quit
e YASKNOA

Figure 6.7

2) Press the Space Key or press the Left or Right Cursor Key to set MEMOCON YE-
NET-3200 as the device.
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Online Editing

6.1.2 Procedure for Setting Communications Parameters cont.

3) Press the Enter Key to display Device/Communications Parameters Setup Screen for
YENET.

[ DEVICE/COMMNICATIONS PAMKETERS SETUP

Databaset Halp: <ALe-K>
Dewite: Memscsn YEMET-I288
Receiver Timswut: [ /1]
Edit Reuting Table 7 N

Enter receiver timeeut in zecends
<A1t-E> ve Save and Exit CEscr te Quit
——— — —— YASXAWR

Figure 6.8

4) Set the time for Receiver Timeout. ‘

Move the cursor to Receiver Timeout to enter the desired number. Enter the time in se-
conds.

5) Enter “Y™ to edit the Routing Table.

Enter “N” to edit within the same YENET or “Y” to communicate with another YENET. The ‘
YENET Ailocation Screen will appear when “Y” is entered, Enterthe YENET Numberand

the Bridge Number and then press the Alt + E Keys to save the settings. Refer to 4.5.6
YENET Allocation (Creating a Routing Table) for more details on the allocating proce-
dure.

YEXETS KK1DGER COMMENT

il
:
B
;
y N

THH
THHTHH

PELEE TR
FEEERTTE L

WEEISARWNE

y

<Alt-B) Dulets tar {Esc> Minich

Figure 6.9

6) Press the Esc Key after all the settings are entered.

Press the Alt + E Keys or move the cursor to Receiver Timeoutand press the Enter Keyto ‘
save the settings and return to the Online Menu.
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. 6.1 Preparations for Communications with Processors

A confirmation message will appear asking whether to save changes.

1

L DEVICE-COMUNI CATIONE FAMNETENS SETUP
Database: Help: {Alc-H>
Davice: Mamscen YEMET-1208
Recaivar Timesut: 128
Ed ¢/

Alt~E> to Cave and Exit CExc> to Quit J
— e — YASKAUA

Figure 6.10

7) Make sure that “Y” is entered, and press the Enter Key.
Enter “N” and press the Enter Key if the changes will not be saved.

The settings will be saved, and the Menu Options will retum.

—6-7 —




Online Editing

6.2 Selecting Remote Operation (Program and Monitor
Mode)

The Program and Monitor Modes are two ways to connect to Processors. Program Mode is
used to make changes in the Processor memory, such as programming and entering set-
tings. Monitor Mode is used simply to monitor a Processor or data without making changes
like program editing or data changes to the contents of the Processor memory. Therefore only
one computercan be online with a Processor in Program Mode, butany number of computers
can be online in Monitor Mode. The number of ports available for connecting computers is six
maximum per Processor.

Program Mode

1) Select 3. Online from the Main Menu. ‘

MEHOCON-SC CLAS-/SA- 70
Ladder Leyic Devals it Seftwars 7 Hain Menu
Usrsisn 2.88 Copyrisht 1991 VASKAUA ILICTRIC CORPOMATION
Database: Helpz <Alt-N>

Main Menu:

1. Select Active PLC
2. Offline

. Natisn
2. Lisk Mctive MC

- 3
7. Utilivies
<E> te Exiz to Dus
Entar Optisa:

Figure 6.11

2) Select 1. Program Mode from the Menu Options.

HEMOCON-§C CLAB-S0- M
Ladder Legi: Bavelepmant Seftwars ~# Online Hanu
Databave: Malp = <Alt—H>
Device : D:DO State: STOPPED

HENG Optien:

- niter
3. On-Lime Cemmunications Setup
<Ezc)> te Meturn te Previeus Henu
Eater Optisn: [

Figure 6.12
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6.2 Selecting Remote Operation (Program and Monitor Mode}

+

The Program Mode Attach (Online) Screen will appear.

MEMOCON-SC CLAR/60-78
| Ladder Leyic Duvelapmens Seftwars # Online Nens

]

Databaze: Help : <Alt-H)>
Bovice : D:0M State: EIOFPED

Euter dionor cadees (1-247: [25R

Chateed o Attagh fLac? te Quat

Figure 6.13

Refer.to 6.3 Going Online with a Processor for more details on the procedure,

Monitor Mode

1) Select 3. Online from the Main Menu.

HENOCON-$C CLAMSR/78
Ladder Lei ) hrnt $aftwara / Main Ma
Versien 2--’ f‘:::tlll:.l! 1 YASKAWA ELECTRIC Wlﬂ‘)‘ll‘lﬂl
Database: Nelpi <Mle-W>
fain Meny:

1. Salsct Metive PLC
2. OFfline

- Hetien
5. List Active PLC
6. Mre "
?. Utilicies
<E> ta Exit te Des
Enter Optien: [EI

T ——

Figure 6.14

2) Select 2. Monitor Mode from the Menu Options.

HENGCOM-SC_ CLAB/$-78

I Lodder Legic Develepmant Saftware + Online Menw -|
Dasabas L) s <Alt-H>
Bevics ! p:mes ni ER

NEND Optiens

1. h‘ﬁ Mada
- ~Liaw Pafush lcat ¥ Ty

<Esc> te Batuwn ts Previsus Mees
Enter Optisn: BB

——

Figure 6.15
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Online Editing

The Monitor Mode Attach (Online) Screen wilt appear.

MENOCON-EC CLAS-68/78
Ladder Leyic Develspment Saftware 7 (mlime Henu
Datakess: Help : {Ale-H>
Davice : D:DOB State: SIOPPED

SRERAN =1

[
w
|

Figure 6.16

Refer to NO TAG Going Online with a Processor for more details on the procedure.
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6.3 Going Online with a Processor

6.3 Going Online with a Processor

The following procedure is used to go online from the computer to a Processor in order to
communicate with the Processor.

1) Select 3. Online from the Main Menu.

WEMOCON £ CLAR50-78
Ladder Legic Dewsls: t Softwars / Main Me:
Version 1.80 Capyrieht 1300 PRSI ELbcTRr e R et ton
Databaze: Help: {AZc-N>

Main Meny:

Sslect Active PLC
.

1.
2. OFf1in

. Mt

£. List Nctive PLC
6. Leader

7. Utilicias

<E> %o Exit te Des
Enter Optisn: I

Figure 6.17

2} Set the communications parameters.

Referto 6. 1.2 Procedure for Setting Communications Parameters for more details on the
setting procedure.

3) Select 1. Program Mode from the Menu Options.

HENOCON-IC GLAL68-79
Ladder Lagic Puvelopmant Softwars Oaline Monu

Database: Halp : CAle=H>
Davica : D:bmm State: STOMFED

HEWU Opxisns

. iter

3. On-Lins Communicatisns Setup
<Esc> te Retum ts Previeus Menu
Enter Opcisn: B

Figure 6.18

The input screen will appear for entering the address of the Processor with which to go .
online,

HEROCON-EC CLAR- %879
Iadder Layic Develepment Ewftwars ~ Online Menu l

Database: Nalp : CAle—H)>
[ Device : 3:emm State: STOPPED

Figure 6.19
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Online Editing
' 4) Enter the address and press the Enter Key.

Enterthe device address (1 through 247) of the portto connect. The default settingis 001, ‘
s0 just press the Enter Key to use that address.

The computer will go online with the Processor, and the Edit Options will appear.

MENOCON-£C GLAS-68-79
laddar Leyic Develepment Seftware / Edit Menu
Databaze: Help : <Ale—H>
Device : Dl State: STOPPHD

EDIT Opt lens®

twer
Saguential Pusctien Charts
Trace Back
+ LtartsStep Processer
. Clear Mema:
. Systam Conf’ tiee
B aEu Editer
<Esc? te Maturn t4 Provieus Hewu
Eater Option: EN

= ———— r— — ‘

Figure 6.20

Rl T

Note Once online, the computer will communicate with that Processor until it is taken offline. There-
fore do not turn off the Processor or restart the computer.
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6.4 Starting and Stopping a Processor

6.4 Starting and Stopping a Processor

There are times when editing cannot be performed unless the Processor is started or
stopped. The following procedure is used to start or stop a Processor.

1} Select 3. Online from the Main Menu.

HEMOCON-SC CL4060-79
Laddar Lagic Mohr—nt Eaftware / Main Menx
Yerzien 2.08 Copyright 1991 YASKALA ELECTRIC CORPOMITION
Batabaze: Help: <Hit-H>
Fain Hewu:

1. Salect Sctive PLC
2. OfFline

. Het
5. Lizt fctive ML -
&. Lander
7. Ueilitias
<E> to» Exit te Des
Entar Optisn: B
————— ————— ——— Y AT KA

Figure 6.21

2) Select 1. Program Mode from the Menu Options to go online with a Processor.
A Processor cannot be started or stopped in Monitor Mode.

Referto 6.3 Going Online with a Processorfor more details on the procedure.

HEMOCON-EC GLM/58-79
I Eadder Legic Bevelapment Seftwars ~ Omline Mawe —I

Database: Halp z <Altp>
Pavice : D:0OO Frate: LTOPPED

HENY Opt Lons

. Maniter
7. On=Line Cosmunicatiens Satup
<Esc} te Meturs tu Previsus Menu
Eater Optisn: [N

—

Figure 6.22

3) Select 5. Start/Stop Processor from the Edit Options.

MENOCON—EC GL4nsce. 70
l Ladder Legic Development Goftware Edit Menu j

Datakass: Halp = <ALlt=H>
Devics & b:BEy Stats: STOPMED

1T Optians:

B
1.
g' lmu‘ ﬂt-hl Funciien Chart:
3. Trace Back o *
. Lladr Memsr,

7. Syt w{ﬂlntlnl

4. aﬁn?‘uun

{Esc)> te Maturn te Provieus Menu
Enter Optisn: [

— T ——— =i VAT RAUA

Figure 6.23
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—W

A confirmation message will appear asking whether to proceed.

Figure 6.25

A confirmation message will appear asking whether to start if the Processor is stopped or
to stop if the Processor is started. “N” is already entered in the confirmation message ask-
ing whether to proceed. Press the Enter Key to retumn to the Edit Menu without changing
the Start/Stop status.

4) Enter “Y", and press the Enter Key.

The Processor will start or stop.
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] 6.5 Editing Networks

6.5 Editing Networks

Network editing is used to input and edit ladder elements, to monitor and edit the status of all
references, and to copy, move and find a network.

6.5.1 Network Screen Configuration
The following shows the configuration of the Network Screen.
Network number being displayed

Total number of networks When a database is selected, the name
GL Operate/Stop status of the database will appear here,

Assembly register:
y  Holds keyboard input

’ Logic area

13 ' J

b .

——= Reference Area
o EMET Mimors —— Prompt

E}.ﬁf Efuz- mﬁul'gi aczul.gz Eﬁ? l.ugr mﬁ?)l asgusg uws l.un1 —— Mnen?onic

6.5.2 Displaying Networks

The following proéedures an be used to jump quickly to and display a network from among
several thousand networks via programming.

* Jump to the network display after starting MEMOCAD-PRO or to next or previous network: -
Refer to 1. Displaying Networks on page 6-15.

* Jump to any network:
Refer to 2. Displaying Specified Networks on page 6-17.

» Mark any network, and jump to that network:
Refer to 3. Moving to a Specified Position (Mark) on page 6-19,

1. Displaying Networks

The following procedure is used to display the Network Screen,
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Online Editing
6.5.2 Displaying Networks cont.

1) Select 3. Online from the Main Menu.

%

C
Ladder Layic hﬁhrﬁ! Saftwars / Main Hemu
Veraisn 2.89 Copyright 1991 YATKAUA ELECTRIC CORPOMIION
Database: Halp: <Ale-H>
Rais Menu:
1. Salact Active PIC
2. OFfline

. t
5. Liat fictive HC
&. Londar
7. Usilities
<EY te Exit cte Des
Enter Optisn:
——— —— YASKAUM =1

Figure 6.26

2) Select 1. Program Mode or 2. Monitor Mode from the Menu Options to go online with a
Processor.

Refer to 6.3 Going Online with a Processor for more details on the procedure.

%

Laddar Leyit Mvalspnant Saftware /7 Ouline Weau
Databases Welp ¢ CHlr—>
Puvice : D:ENE $rate: STOPPED ‘
MW Optiens

. Meniter
3. On-lLine Comsunicatisnz Extap

<Ese> to Boturn te Previsus Memu
Eatar Optisn:

——— r—— = fASMAUN =

Figure 6.27 ‘

3) Select 2. Networks from the Edit Options.

MENOCON-EC QLAR SR 78
Ladiar lagic Develepnant Seftwars ~ Edit Hesu
Databaxe Balp @ CAle-l>
Device : D:BMI State: STOPPED
EDIT Optisnat
1. Ealect Batabaszs
i *
4. T:u- Rack N *
5. itart/Stey Precanzer
§. Clsar
7. Sgatan Conf s ien
i, ot nilter

CEze)> to Roturn te Previsus Mesm
Enter Optian: I

Figure 6.28
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The Network Screen will appear,

M
E
3
?

Pt Th. bue oue swe man sm o ape myn
Figure 6.29

¢ Displaying the next network: Press the Page Down Key.
» Displaying the brevious network: Press the Page Up Key.
= Displaying the last network: Press the Ctrl + End Keys.

= Displaying the first network: Press the Ctrl + Home Keys.

When displaying the last network is specified, the cursor will actually jump to a blank network
after the last network.

2. Displaying Specified Networks

The following describes two methods used to display a specified network.

A. Using AR:

AR: (Assembly Register) will appear on the upper right side of the screen.

Enter the network number {Lxx) at AR: and press the Enter Key.

AR: cannot be entered while the Command Submenu (Figure 6.30) is displayed in the
label area at the bottom of the screen. Press the Esc Key to exit the Command Submenu
if it is displayed, and then enter AR:.

B. Using the MOVE Command

The MOVE command can be used to move to screens other than the Network Screen.
The following procedure is used to specify a screen.

Loox: Move to network number xxx.
SNoox:nnn: Move to network number nnn of step number o,
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6.5.2 Displaying Networks cont.
Txo0c: Move to transition number xxx.
Sxo0x: Move to step number xxx.
Gooocnnn:  Move to network number nnn of subroutine number xxx.
SEGx: Move to the first network of segment number x.

1) Press the Slash Key to display the Command Submenu.

E 1.dtabaze Z.ats 3.0Mit 4.Bearch §5.JHew 6.Jeil 7.Grucesser B.slhep

Figure 6.30

2) Press F5 (View).
An alternative method is to enter “V” from the Command Submenu. ‘

The View Submenu will appear.

f View: i.0esc 2.Dindev 3.Durk 4.Dnmark S.0uwp 6.Iete ?.50en S.zeem {nturn

Figure 6.31 ‘

3) Press F6& (Goto).
An alternative method is to enter “G” from the View Submenu.

An input window will appear to enter the address.

Figure 6.32

4) Enter the network or the SFC address (Lxx, SNxx) that will be displayed and press the
Enter Key.

The specified network or SFC will appear.

Shortcuts

a) Enter *VM" at AR: and press the Enter Key, or press the Alt + V Keys, to display the ‘
View Submenu. .
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b) Enter“GOTO”atAR: and press the Enter Key, orpressthe Alt+ N Kéys. to display the
input window. :

3. Jumping to Marks

“Any cursor position marked during network editing can be stored in memory. If an often-

used position is marked, that position can be brought up instantly even while editing
another network.

1) Press the Slash Key to display the Command Submenu.

% 1.dDtabase 2.[ata 2.[Mic 4.Foarch $.Disw 6.J0il 2.frecezzer Lt.sleep

Figure 6.33
2) Press F5 (View).

An altemativé method is to enter “v” from the Command Submenu.

The View Submenu will appear.

E Visws t.Desnc 2.Bindew 3.37ark 4. 0vmark S5.0unp . Jute 7.3sen B.xean Deturm

1

Figure 6.34

3} Move the curéor to the position that will be marked.

4) Press F3 (Mark).
An alternative method is to enter “M” from the View Submenu.
The cursor position will be marked.

Although the mark will not appear on screen, the position of the mark will appear on the
bottom left side of the screen. '

i / Column
Fm 3.3ark 4.Jvmark 5. 5unp €.Zots 7.5een §.200n Beturs

Figure 6.35
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6.5.3 Exiting from Network Editing

5) Press F4 (Unmark) to cancel the mark.

An alternative method is to enter “U” from the View Submenu.
6) Press F5 (Jump) to jump to the mark even if the cursor is in another network.
An alternative method is to enter “J" from the View Submenu.

7) Press F5 (Jump) again to return to the original position.

Itis not poséible to retum to the original position if the cursor is not at the marked position.
The original position is the position of the cursor prior to jumping to the mark, and it will
appear on the left side of the mark position on the lower left side of the screen following a

jump.
Figure 6.36
Shortcuts
a) Enter “VM” at AR: and press the Enter Key, or press the Alt + V Keys to display the
View Submenu. ‘

b) Enter“M”at AR: and press the Enter Key, or press the Alt + M Keys, to mark the cursor
position.

¢} Enter “UMK” at AR: and press the Enter Key to cancel the mark.

d) Enter“J" at AR: and press the Enter Key, or press the Alt + J Keys to jump to the mark.

6.5.3 Exiting from Network Editing

The following procedure is used to exit from network editing.

1) Press the Esc Key.
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A confirmation message asking whether to exit will appear.

i

o IR L S - S

PUE 5. ®uS g e mum oo s opm -

Figure 6.37

If the Function Menu at the bottom of the screen is not atlevel O (menuinitially displayed),
the Function Menu will shift closer to level 0 without a message. Press the Esc Key at
level O to exit.

2) Press the Enter Key.

Enter “N” and press the Enter Key, or press the Esc Key to continue editing.

The Edit Menu will return.

6.5.4 Moving the Cursor on a Network

The following procedure is used to move the cursor on the Network Screen.
i

Moving the Cursor

Moving up, down, left or right; Press the Up, Down, Left or Right Cursor Key.
Moving to the upper left (Home Position): Press the Home Key.
Moving to the lower right (End Position): Press the End Key.
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6.5.5 Entering Elements Using Function Keys

Moving fo the left edge: Press the Cirl + Left Cursor Keys.
Moving to the right edge: Press the Ctrl + Right Cursor Keys.

Home position

{Home)
Keystrokes are
in parentheses.

Left |dmw (CTRL +<-)—-— (CTRL+ —) wamalp| Right

N\

(End)

N\

End position

6.5.5 Entering Eiements Using Function Keys

Display the Element Menu in the label area at the bottom of the screen, and select the function
from the menu using a function key {F1 through F10). All ladder elements are assigned to
function keys.

Refer o Appendix A List of Function Key Menus for more details on elemenits that will be dis-

played.
F1 {DISC): Discrete element
F2 (TC): Timer, counter ‘

F3 (CALC1):  Calcuiation function 1

F4 (CALC2): Calculation function 2

F5 (TRANS): Type of data transfer

F6 (CNVRT): Type of data conversion

F7 (MTRX1): Matrix

F8 (SPEC): Skip, subroutine, stepping switch, ASCII instructions, COMM instructions,
EXPANSION REGISTER instructions
F9 (YENET): YENET
F10 (MOT1): MOTION instructions

To display the next menu, press the Shift Key while a function key menu is displayed.

Example: Entering 00001

1) Move the cursor to where the element will be entered.

—6-22 —




6.5 Editing Networks
m
2) Press F1 (DISC).

The discrete I/O function keys will appear.

wawm%%wum

Figure 6.38
3) Press F1 (NOC).
The element will be entered, and the input field will appear.

|

Iy
Patge s HHHBT By 192 ) aM
HUPLL-Ms 18 ML

Figure 6.39

4) Enter 00001 and press the Enter Key.

Bl MUE M oy moes Tih T8, m

- Figure 6.40

Press the Esc Key to return to the previous menu.

6.5.6 Entering Elements Using Mnemonics

Each element has a unique mnemonic. Enter the mnemonic at AR: to input the element,
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6.5.6 Entering Elements Using Mnemonics cont.

Mnemonics will be displayed with the Element Menu.

- - : 1
Wb Mgr TE T Rn My oegp he 9y W, 3T BemeRl

Figure 6.41

1) Move the cursor to where the element will be entered.

2) Enter the mnemonic of the element at AR:. (Exampie: NOC for NO contact)

BISC (3 LC2 NS OmRT RX1 FEC EXET 1
i oy n“z mﬂl’? n’mq m“s e m{“? Bun rw’ w

Figure 6.42

3) Press the Enter Key.

The element will be entered, and an input field for the address will appear.

Figure 6.43
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4} Enter the address and press the Enter Key.

Figure 6.44

6.5.7 Entering Horizontal and Vertical Shorts

The following procedure is used to enter horizontal and vertical shorts.

Horizontal short

]
l

A

-— Vertical shont
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6.5.7 Entering Horizontal and Vertical Shorts cont.

1) Move the cursor to where the horizontai or vertical short will be entered.

Aol I 4
aa|

C2y

.
kg
<]
M
5
E
?

Pl T b oy b M sy B9, oy

Figure 6.45

W W & W R

ol T S ThE ROR MR L T 34 B

Figure 6.46

2) Press F1 or F2 to display the Ladder Element Function Menu.

An alternative method is to press a function key between F3 and F10 to display the Lad-
der Element Function Menu, and then press F8 (-) or 9 (I} while holding down the Shift
Key.

3) Press F8 (-) or F2 (1).
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The horizontal or vertical short will be entered.

}!‘M‘ e VhE Thb Yon hEy ey v Ay

Figure 6.47

=

=

b S, SR N S

Euoé"f TR M T Yo Yo vap 1) m

1

Figure 6.48

Referto A. Defeting an Efementon page 6-350r B. Deleting Vertical Shorts and Elements on
page 6-37 for more details on deleting horizontal shorts, or C. Deleting a Vertical Short on
page 6-38or B. Deleting Vertical Shorts and Elementson page 6-37for more details on delet-
ing vertical shorts.

Shorteuts

Enter “HS” or“vS” at AR: and press the Enter Key to enter the horizontal or vertical short
directly.

6.5.8 Changing Elements

The following procedure is used to change ladder elements that have already been input.
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6.5.8 Changing Elements conl.

Example: Changing the ADD Instruction to TIMER (T0.1).

1} Move the cursor to the element (ADD) that will be changed.

) E o TICFFEY CL7NT IEREIET  °F: B |

e $g, uo FuC Fme Wgy OOn OO O

Figure 6.49

2) Press F2 (TC).

The timer/counter function keys will appear.

ﬁ;i-‘ ‘.{'gﬁ B'E-(.} a-gg; l’ﬁ; 3 7 ’us ug nm: ‘

Figure 6.50

3) Press F2 (T0.1).

The element (TIMER) will be input, and the input field will appear.

R RO {3003 J - ER-Hic o I - TR

r.Lant
P HURRG -R12 4

Figure 6.51

Press the Esc Key at this point to cancel the change. The original element (ADD) will ap- ‘
pear.
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4) Enter the address and press the Enter Key.

fi

Hat TT0 I YR MR ? @ -3, m -

Figure 6.52

6.5.9 Changing Reference Numbers

The following procedure is used to change the reference number of ladder elements.
1) Move the cursor to the element with the reference number that will be changed.
2) Press the Enter Key.

It a reference number is already entered at AR:, that value will be entered at the address
atthe cursor position when the Enter Key is pressed. If nothing is entered when the Enter
Key is pressed, a range of addresses that can be entered will appear, and a message will
appear asking for the address at the cursor position. Enter the address and press the
Enter Key. The reference number can also be changed by selecting Cell from the Edit
Submenu. Here again, a message will appear asking for the address at the cursor posi-
tion.

A range of addresses that can be entered will appear, and a message will appear asking
for the address.

Figure 6.53
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3) Enter the new address and press the Enter Key.

0L AR | B ) TISFFES - LR IO A I |

1
WM

1%C C LC1 LC2 MRS BOWRT RXL FEC ENET [EWOT1
Lt wwz n?‘!l %1 nws LNé "Iro\l? ,un mun [X1]

Figure 6.54

6.5.10 Inserting

The following procedure is used to insert blank rows, columns, and networks.

Insert a blank network after the
network currently being displayed.
Insert a blank row.

Insert a blank network prior to the
Insert a blank cojumn. network currently being displayed.

Insert: 1.8clunr 2.5ow 3.Jext network 4.3revious network

Figure 6.55 Insert Submenu

1. Inserting a Row

The following procedure is used to insert a blank row in a network. ‘

1) Move the cursor to where the row will be inserted.

L2 o
P FL, TUE TNC The mr YN N OYEY W

Figure 6.56 ‘
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2) Press the Slash Key to display the Command Submenu.

f 1.d0ksbaze 2.Duta F.00it 4, Jeaveh S.0Hew é.Joil 7.Qrecesser 3.:04sp

Figure 6.57
3) Press F3 (Edit).

An altemnative method is to enter “E” from the Command Submenu.

The Edit Submenu will appear.

f Bdie: 1.Jell 2.dscripter .0nsert 4.Qolata S.copll metwerk &.30ve netwerk

Figure 6.58
4) Press F3 (Insert).

An altemati-;re method is to enter “I” from the Edit Submenu.

The Insert Submenu will appear.

f Insert: 1.Jelunn 2.0ew 3.0ext nevwerk 4.Frevisus netuerk

Figure 6.59
5) Press F2 (Row).

An alternative method is to enter “R” from the Insert Supmenu.

A row will be inserted.

Arow cannot be inserteq where an element crosses two rows orwhen thereis no roomto
insert a row pelow the insertion position.

N E LLl i e R —

~+—— |nserted row

18C c LCL LC2 MANS  JOSUNY AL FEC ENET %‘u
a1 ’u: w:l:l ﬂ?ﬂ! FWS 106 m{\l? RWI am L]

Figure 6.60
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6.5.10 Inserting cont.

Shortcuts
a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu. .

b) Enter“IM” at AR: and press the Enter Key, or press the Insert Key to display the Insert
Submenu.

¢) Enter“IR” at AR: and press the Enter Key to insert a row.

2. Insertin olumn

The foliowing procedure is used to insert a blank column in a network.

1) Move the cursor to where the column will be inserted.

8¢ @Wc PorLLy LCZ RANE  JOWRT -+ PEC EMET 1
1 2 w3 mlJII ’1&5 e 'tlIJl? am IH’,

Figure 6.61 ‘

2) Press the Slash Key to display the Command Submenu.

f 1.4abase 2.{ats 3.ic 4.Besrch S Tiew 6.J0i2 7.Dreceszer 1.3lney ‘

Figure 6.62

3) Press F3 (Edit).

An alternative method is 1o enter “E” from the Command Submenu.

The Edit Submenu will appear.

{ Edit: 1.3e1l 2.80ecripter 3.Theere 4.Inlate S.copl netuwwrk 6.Jeve setuerk

Figure 6.63
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4) Press F3 (Insert).
An alternative method is to enter “I” from the Edit Submenu.

The Insert Submenu will appear.

f Ingert: 1.Jolunn 2.0ow 3. 00t notwirk 4.0eevisur netverk

Figure 6.64

5) Press F1 (Column).
An alternative method is to enter “C” from the Insert Submenu.

A column will be inserted.

Inserted column

o AN ST S SN e

OB Pha MUE TUT e M onne B smer mwn

Figure 6.65

A column cannot be inserted if there is no room to the right of the insertion position.

Shortcuts '

a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.

b} Enter“IM” at AR: and press the Enter Key, or press the Insert Key to display the Insert
Submenu. »

¢) Enter “IC” at AR: and press the Enter Key to insert a column directly.

3. Inserting a Network

The following procedure is used to insert a blank network.

— 6-33 —



Online Editing

6.5.10 Inserting cont.

1) Move the cursor to where the network will be inserted.

2) Press the Slash Key to display the Command Submenu.

f 1.d0tabaze 2.Mnta 3.331t 4.Fearch 5.05ev 6.D0il 7.0recanner 3.30sep

Figure 6.66
3) Press F3 (Edit).

An alternative method is to enter “E” from the Command Submeniu.

The Edit Submenu will appear. ‘

f Ediv: 1.3e11 2.dJkcripeer I.0nsert 4.0nlete 5.copl] netwerk i.Jeve netwverk

Figure 6.67

4) Press F3 {Insert). ‘

An alternative method is to enter “I” from the Edit Submenu.

The Insert Submenu will appear.

[ Inssrt: 1.Jolwm 2.Jew 1.Jkxt netwverk 4.0 revisus metwerk ‘

Figure 6.68

5) Press F3 {(Next Network) or F4 (Previous Network).
An alternative method is to enter “N” or “P” from the Insert Submenu.

A network will be inserted immediately before or after the network currently being dis-
played.

Shortcuts

a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu. !
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b) Enter“IM” at AR: and press the Enter Key, or press the Insert Key to display the Insert
Submenu.

¢} Enter “INN” or “IPN” at AR: and press the Enter Key to insert a network immediately
before or after the currently displayed network.

6.5.11 Deleting

The following procedure is used to delete elements cells, blank rows, blank columns and net-
works.

Delete an elerment and cell Delete a blank row

[ Delete an element Delete a blank column Delete a network

‘Delete: 1.@lement 2.cell 3.8olunn 4.Tow 5. etwork

Figure 6.69 Delete Submenu

1. Deleting an Element

The following procedure is used to delete an element from a network,

A. Deleting an Element

1) Move the cursor to the element that will be delsted,

el slel BT
e shale”

3
3
k|-
”

8¢ ¢ Le1 DOALCZ  Braws  BCMURT L IEPEC ENET T2
PHIl wwz n’I.l!:! LU+ FWS Ve "tr.u? ,IMI n'I.Il’ %

Figure 6.70

2) Press the Slash Key to display the Command Submenu.

f l.dltabese 2.0aca 3.(dit 4.Bearch §.THaw 6. Joil 2.(Qrecassor .20sep

Figure 6.71
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6.5.11 Deleting cont.

3) Press F3 (Edit).

An alternative method is to enter “E” from the Command Submenu.

The Edit Submenu will appear.

f Edit: 1.J811 2.&0ecripter 3.0hsert 4.Oelece 5.cenpll network 6. 3ove netwerk

Figure 6.72

4) Press F4 (Delete).

An alternative method is to enter “D” from the Edit Submenu.

The Delete Submenu will appear.

f Delate: 1.Mlement 2.cell 3.Jolumn 4.Jow §.I0twerk

Figure 6.73

5) Press F1 (Element).

An alternative method is to enter “E” from the Delete Submenu, or press the Shift Key to
switch to Function Menus from the Ladder Element Menu for a function key between F1
and F10, and then press F7 (Delete).

The element will be deleted. ‘

18C C LCY LC2 RANE  BONNT AL FEC ENET {DHOT1
| 7Y ’wz n’w: nab!l IWS e n"m Bwt ﬂ'“’ e

Figure 6.74

Shortcuts ‘
a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.
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b) Enter “DM” at AR: and press the Enter Key, or press the Delete Key to display the De-
lete Submenu.

¢) Enter “DE” at AR: and press the Enter Key to delete the element.

B. Deleting Vertical Shorts and Elements

1) Move the cursor to element (with the vertical short) that will be deleted.

RO — ¥ TR AT T R

T

3

4
E:'.%E The TUS TUE THS Far o7 N oo mpn
Figure 6.75

2) Press the Slash Key to display the Command Submenu.

f LodDeabase 2.0t 3.(Bit 4.Bearch 5. Jiew §.J051 7. 0recesser 2.ulnep

Figure 6.76

3) Press F3 (Edit).

An alternative method is to enter “E” from the Command Submenu.

The Edit Submenu will appear.

f Edit: 1.J01l Z.d0ecripter 2.Bnsert 4.Dnlete S.eopll netuerk 6.Jeve natusrk

Figure 6.77

4) Press F4 (Delete).

An alternative method is to enter “D" from the Edit Submenu.
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6.5.11 Deleting cont.

The Delete Submenu will appear. -

{ Delets: 1.erant 2.celll 3.Jeluwm 4.0pw 5.Jxtwerk

Figure 6.78

5) Press F2 {Cell).
An alternative method is to enter “L” from the Delete Submenu.

The element and vertical short will be deleted.

T W W

1SC c foaLcL LC2 MANS  ICMURT  BTTRXL PFEC ENET 0T
i FHI w3 %{ nI-Il5 L¥é w7 ‘Ul' uw’ [X7)

Figure 6.79 ‘

Shortecuts
a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.

b) Enter“DM"at AR: and press the Enter Key, or press the Delete Key to display the De-
lete Submenu.

¢) Enter“DEL” at AR: and press the Enter Key to delete the element and vertical short. ‘

C. Deleting a Vertical Short

1) Move the cursor to the vertical short that will be deleted.

LE S TIPS OCTaR s OF: I |

E‘.ﬁf v, Tup SYe g wpr of W ouw mu

Figure 6.80 ‘
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2} Press F1 or F2 to display the Ladder Element Function Menuy.

An altemative method is to press a function key between F3 and F10to display the Lad-
der Efement Function Menu, and then press F10 (:) while holding down the Shift Key.

tM Tl Gt MOE oy Yoty v 9, my

Figure 6.81

3) Press F10 (:).

The vertical short at the cursor position will be deleted.

ns

o Wb T S e My 30y o

i

Figure 6.82

Shortcuts

Enter “OS” at AR: and press the Enter Key to delete the vertical short at the cursor posi-
tion.

2. Deleting a Row

The following procedure is used to delete a blank row from a network.

1} Move the cursor to the row that will be deleted.

hal ™ L3 Lo L4 j
b

1

P v, e o oy Bir i MR oy mm

=y

Figure 6.83
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6.5.11 Deleting cont.

2) Press the Slash Key to display the Command Submenu.

E t.dDtakass 2.Eata 3.QMit 4.Bearch 5.JHew €.J0il 7.Beucoszer 3.500ep

Figure 6.84

3) Press F3 (Edit).
An altemative method is to enter “E” from the Command Submenu.

The Edit Submenu will appear.

F Edit: 1.Jel1l 2.dJscripter J.0rsert 4.Dnlete S.copll netwerk 6. 0ve metuerk

Figure 6.85

4) Press F4 (Delete).

An alternative methed is to enter “D” from the Edit Submenu.

The Delete Submenu will appear.

f Delete: 1.Jlenent Z.colll 3.2e2unn 4.0ow 5. 0twark

Figure 6.86

5) Press F4 (Row). ‘
An alternative method is to enter “R” from the Delete Submenu.

The row will be deleted.

13+ C LT L2 RNE Dokt XL PEC (YEMET {EMOT1
N1 wuz %3 " 4 'I-US e 'r{!ﬂ El-lll 1y 1A

Figure 6.87
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A row cannot be deleted if there is an element in the row.

Shortcuts
a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.

b) Enter“DM” at AR: and press the Enter Key, or press the Delete Key to display the De-
lete Submenu.

¢) Enter “DR" at AR: and press the Enter Key to delete the row.

| 3. Deleting a Cojumn

The following procedure is used to delete a blank column from a network.

1) Move the cursor to the column that will be deleted.

15C c LC1 Lz AS  BCHURT Ry PEC ENET I}ﬁn
Lut rl-ll! %3 mI-I-H nl-lls e "L? mws a‘l.ll! L]

2) Press the Siash Key to display the Command Submenu,

f 1.dDcabare 3. ata 3,QHic 4. Fearch S.HHew 6.Je1l 7.(racesser t.ulmep

Figure 6.88

3) Press F3 (Edit).
_ An alternative method is to enter “E” from the Command Submenu.

The Edit Submenu will appear.

f Eale: L.Pell 2. dcriptur 3.0hsert 4.Dslote S.copl netwerk G.lsus netuerk

1

Figure 6.89
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6.5.11 Deleting cont,

4) Press F4 (Delete).

An alternative method is to enter “D" from the Edit Submenu.

The Delete Submenu will appear.

f Delete: 1.Menent 2.co1l 1. Jolunn 4.0ew 5.1twerk

Figure 6.90

5) Press F3 (Columny).

An alternative method is to enter “C” from the Delete Submenu.

The column will be deleted.

mr—'—ﬁm—'mm']
T slal B el
e iak sl el

"
E
e
P

e

Prr g, Duo o Mwe gy ooy B PLY WR

Figure 6.91
A column cannot be deleted if there is an element in the column. ‘

Shortcuts

a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.

b) Enter“DM” at AR: and press the Enter Key, or press the Delete Key to display the De-
lete Submenu.

c) Enter “DC" at AR: and press the Enter Key to delete the column.
4. Deleting a Network ‘
The following procedure is used to delete a network that is being displayed.
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1} Move the cursor to the network that will be deleted.

2) Press the Slash Key to display the Command Submenu.

f L.dTeabaze 2. 8ata 3. [Wic 4.Farch 5.[Hav €. 301l 7. Brecesser 2.slney

Figure 6.92
3) Press F3 (Edit).
An alternative method is to enter “E” from the Command Submenu.

The Edit Submenu will appear.

f Eiie: 1.3011 2. decripter .0heart ¢.Delete S.copd netwerk & .Jeve natuark

Figure 6.93
4) Press F4 (Delete).

An alternative method is to enter “D" from the Edit Submenu.

The Delete Submenu will appear.

f Delete: 1.Monent 2.2al] 3.3slwmn 4.Dev 5. Tetuwrk

Figure 6.94

5} Press F5 (Network).

An alternative method is to enter “N” from the Delete Submenu.

A confirmation rmessage asking whether to delete the network will appear.

o S SR . SNNT SN - e -

P %L me mue vme sy e v spw oy

Figure 6.95
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6.5.12 Searching

6) Check to see if the contents of the confirmation message are correct, and if so press “Y”

and the Enter Key to delete the network. “N” is initially entered so the deletion can be
canceled in case the Enter Key is pressed by mistake.

Shortcuts
a) Enter “EM" at AR: and press the Enter Key to display the Edit Submenu.

b) Enter “DM"” at AR: and press the Enter Key, or press the Delete Key to display the De-
lete Submenu.

¢) Enter “DN” at AR: and press the Enter Key to delete the network.

6.5.12 Searching

The following procedure is used to search for specified addresses or instructions (ladder ele-
ments).

1. Searching for Addresses
1) Press the Slash Key 1o display the Command Submenu.

f 1.40abaxe 2.Data 3003t 4.Zearch §.Diav €.J0il 7.ecesser S.alnep

Figure 6.96

2) Press F4 (Search).

An alternative method is to enter “S” from the Command Submenu.

A screen for specifying the address will appear.

SUb Bereeem m e ae—eo— — o [—

” Address - I

CPCUPS- > Pddress<=2Addr & Ine -3ty tiond-3Takble
<Fne? to Quit <lnt
4 .- . .

Figure 6.97

3) Enter the address and press the Enter Key.

<POUPY=2 Addre nutd- e i Search <=<PGDNY
o q u Began

Figure 6.98
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A confirmation message will appear asking whether to execute the search.

RO LT

SPGUPY =3 Adidre: - - 30ddy & Innt<-slnztrer tian
LY o Quat

Figure 6.99

4) Confirm by entering “Y”, and press the Enter Key.
Enter “N" and press the Enter Key, or press the Esc Key to cancel the search.

A search will be executed.

Figure 6.100

The first occurrence will appear, and the cursor will move to that address.

Figure 6.101
) Processing after a Search
Editing the network displayed: Press the Enter Key.
(The search will end at that network.)
Displaying the next occurrence: Press the Down Cursor Key.

Ending the search and retuming to the original network:
Press the Esc Key.

Switching search screens: Press the Page Up or Page Down Key.
Shortcuts
. Enter “S” at AR: and press the Enter Key, or press the Alt + S Keys to display the screen
for specifying the address.
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6.5.12 Searching cont.

2. Searching for Instructions and Addresses
1) Press the Slash Key to display the Command Submenu.

§ 1.iltabase 2.Bata 3.3dit 4.Bearch S.JHew 6.Jpil 7.0recenzer G.20hep

Figure 6.102

2) Press F4 {Search).
An alternative method is to enter “S” from the Command Submenu.

A screen for specifying the address will appear.

LICHPY - Adiderznd Insten
<

L BPAIL D e - e et m——— e 2 e
Adaee oo : IR
Adde 3 Innrdo Search ¢ <PGDHD
Fao ¥ to Quat

Figure 6.103

3) Press the Page Up Key. ‘

A screen for specifying the address or instruction will appear.

<PGUP>-
Skoc

Figure 6.104 ‘

4) Enter the address and press the Enter Key, or press the Down Cursor Key.

Move the cursor down.

5) Enter the instruction (mnemonic) and press the Enter Key.

The element mnemonics will appear together with instructions at the function keys, and
can be selected by pressing a function key.

Figure 6.105

— 646 -




6.5 Editing Networks

A confirmation message will appear asking whether to execute the search.

Figure 6.106

6) Confirm by entering “Y”, and press the Enter Key.

Enter “N” and press the Enter Key, or press the Esc Key to cancel the search.

A search will be executed.

Figure 6.107

The first occurrence will appear, and the cursor will move to that address.

Figure 6.108
Processing after a Search
Editing the network displayed: Press the Enter Key.
. (The search will end at that network.)
Displaying the next occurrence: Press the Down Cursor Key.

Ending the search and retuming to the original network:
Press the Esc Key.

Moving the Cursor

Switching search screens: Press the Page Up or Page Down Key.
Address/mnemonic: Press the Up or Down Cursor Key.
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6.5.12 Searching cont.

Shortcuts

Enter “S" at AR: and press the Enter Key, or press the Alt + S Keys to display the screen
for specifying the address.

3. Searching for Instructions

1) Press the Slash Key to display the Command Submenu.

% 1.4abass 2.fata 3.0ic 4.Jearch 5.JHew 6.Boil 7.Brecescer B.xliep

Figure 6.109

2) Press F4 (Search).

An alternative method is to enter “S” from the Command Submenu.

A screen for specifying the address will appear.

Figure 6.110

3) Press the Page Up Key twice.

An input screen for entering the instruction (mnemonic) will appear.

The element mnemonics will appear together with instructions at the function keys, and
can be selected by pressing a function key.

CIGUEY - Y Rddress<=2Addr & ln.t{->Instru tiond - 3Table Soarch
<kic? ta Quat CEnterd to Broyy

Figure 6.111

4) Enter the instruction (mnemonic) and press the Enter Key.

LE LR e s _——————— e
Taw
CPGUED -2 Aty

Figure 6.112
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A confirmation message will appear asking whether to execute the search.
.
£

| <FCUPZ-> Addrr .o
i

Figure 6.113

5) Confirm by entering “Y™, and press the Enter Key.
Enter “N” and press the Enter Key, or press the Esc Key to cancel the search.

A search will be executed.

Figure 6.114

The first occurrence will appear, and the cursor will move to that address.

Figure 6.115
Processing after a Search
Editing the network displayed: Press the Enter Key.
(The search will end at that network.)
Displaying the next occurrence: Press the Down Cursor Key.

Ending the search and retuming to the original network:
Press the Esc Key.

Switching search screens: Press the Page Up or Page Down Key.

Shortcuts :

Enter “S” at AR: and press the Enter Key, orpress the Alt + S Keys to display the screen
for specifying the address.
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6.5.12 Searching cont.

4. Displaying a List of Found Addresses

The following procedure is used to display a list of networks found with an address (in-
struction) after a search is completed.

1) Press the Slash Key to display the Command Submenu.

E 1.4Dabase 2.Juta 3. it 4. Beavch S.Jisw 6.J0il 7.0recesner S alhep

Figure 6.116

2) Press F4 (Search).

An alternative method is to enter “S” from the Command Submenu.

A screen for specifying the address will appear.

Riitrras

g SPGUPY- 2 Addree.s<- Adde & [nnte=>Innorartase
<Eour tu Guit

Figure 6.117

3) Press the Page Up Key three times. ‘

A screen for specifying a list search will appear.

Figure 6.118 ‘

4) Enter settings needed for the search, and press the Alt + E Keys.

Figure 6.119

A search will be executed.

Figure 6.120
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Occurrences will be displayed as a list after the search is completed.

I Saarch Matches
Patabase: Nelp: <Ale-N>
The felleving matcher were Pound:

piny

I

Network No.

CEsz) te GQuit

e ]

Figure 6.121

5} Move the cursor to the number that will be displayed and press the Enter Key.

The network will appear, and the cursor will move to the occurrence.

Figure 6.122

Processing after a Search

Moving to the previous or next occurrence from the screen displayed:;
Press the Up or Down Cursor Key.

Stopping at the network displayed: Press the Enter Key.

Returning to the original network: Press the Esc Key.

Retuming to the list: Press the Ctrl + Left Cursor Keys.

Settings
A. Network Range

All logic: Search for all networks (including SFC action, transition condition, and
subroutine circuits) in the database.

Current area:  Search only the program area currently displayed.
Block: - Search networks defined as a block.
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From the cursor position:
Search the current area from the present cursor position to the end of the
area.
Specify: Specify a network range to search.

Example: Specifying an Area from Network 1 to Network 10.

Network range: Specify 1 through EFEE (Maximum of 22}

B. Instructions (Specify the Desired Instruction (Ladder Element).)

Specify: Mnemonic items will appear. Specify the desired element using the mnemonic.

The element mnemonics will appear together with instructions at the function ‘
keys, and can be selected by pressing a function key.

Example: N.O. Contact{ )

Instruction:  Specify Mnemonic: [?E

I
Specify with the mnemonic of the element.

Any: Search all elements.

C. Address (Specify the Desired Address.) ‘

Specify: Search items will appear. Enter the desired address or range.

Note A range like that set in Offline Mode for communications cannot be specified in
Online Mode.

Any: Search all addresses.

Moving the Cursor

Switching Search Screens: Press the Page Up or Page Down Key.

Moving to the next or previous item:
Press the Up or Down Cursor Key.

Moving to the nextitem:  Press the Enter Key. ‘
Reversing items: Press the Space Key, or the Left or Right Cursor Key.

— 652 —




_ 6.5 Editing Networks
| T

Shortcuts

Enter “S” at AR: and press the Enter Key, or press the Alt + S Keys to display the screen
for specifying the address.

6.5.13 Editing and Monitoring Registers

Register Editoris used to edit numbers stored at register addresses. Some registers are write
protected, and cannot be edited. The addresses listed below can be edited.

40001 to 40512:  Output registers
40513 to 49999: Holding registers
R00C1 to R1024: Link registers
50001 to 50512: Time registers
A0001 to A7FFF: Expansion registers

Refer to A. Editing Registers on page 6-73 for more details on the procedure for full-page
Register editing.

1. Displaying the Register Editor Screen

There are two ways to display the Register Editor Screen using the cursor.

A. Cursor on an Element with a Register Address

Whenthe cursoris on an element witha Register Address, the contents of the register for
that element will be displayed.

1) Press the Slash Key to display the Command Submenu.

f 1.d]kabase 2.(nta 3.(Mit 4.Barch S.Hew 6.M0il ?.[recanser ¥.50nep
Figure 6.123

2) Press F2 (Data).
An alternative method is to enter “D” from the Command Submenu,

The Data Submenu will appear.

f Bata: 1.0ull page 2.Batch 3.0egiscar

Figure 6.124
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6.5.13 Editing and Monitoring Registers cont.

3) Press F3 (Register).

An alternative method is to enter “R" from the Command Submenu.

The Register Editor Screen will appear.

Description | hey 8 Rinary

e 1el -yl 118
40811 | wieeiili-w1k1eesd

LR -1k b
45813 | S1EIMNL1-BIINLME
H1E1N L -DE1 e

ee b LLEHE

cags3i |8

5152
S

[ 1N
diti

Jisss I!!j
4

HHHE L [

Bisary Edic: 1.3t bit 2.JReay bit 3.eet M1 d.clbar all

Figure 6.125

Moving the Cursor

Moving up or down a screen: Press the Ctrl + Page Up or Page Down Keys.
Moving up or down: Press the Up or Down Cursor Key.
Moving to the next or previous page: Press the Page Down or Page Up Key.

+ When moving to the next or previdus page, 17 addresses continuing from the next or ‘
previous page will appear.

» When moving up from the top row or down from the bottom row, the addresses being
displayed will shift up or down by one.

Shortcuts

Enter “ER” at AR: and press the Enter Key, or press the Alt + R Keys to display the Regis- ‘
ter Editor Screen.

B. Cursor Not on an Element with a Register Address

If the cursor is on an element without a register address or in a position without an ele-
ment, a window will appear to enter the register address that will be edited or displayed.

1) Press the Slash Key to display the Command Submenu.

E 1.43cabase 2.0utn 3. QMit 4. Bearch 5. Diev 6.0l 7.Drecesser V.almep

Figure 6.126 ‘
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2} Press F2 (Data).
An alternative method is to enter “D” from the Command Submenu.

The Data Submenu will appear.

f Dataz 1.[ulI page 2.Baxch 1.Qegistar

3) Press F3 (Register).
An alternatiile method is to enter “R” from the Command Submenu.
The Input Address Window will appear.

The Input Address Window will already have 40001 entered when it first appears. Enter
the address and press the Enter Key t0 change the address in the window.

Figure 6.127

4) Enter the address that will be edited and press the Enter Key.

The first 17 consecutive addresses from the specified address will appear.

yistey €ar H T
Degcription I Moy 8

f

11

TE

a1
».

LTS
HETHHI

L} ettt Lot ih]

Binary Fdis: 1.3t bit 2.Miear bit 3.sat M1 4.cBear ald

Figure 6.128

Moving the Cursor

Moving up oh down: Press the Up or Down Cursor Key.
Moving to the next or previous page: Press the Page Down or Page Up Key.

* When moving to the next or previous page, 17 addresses continuing from the next or
previous page will appear.
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» When moving up from the top row or down from the bottom row, the addresses being
displayed will shift up or down by one.

Shortcuts

Enter “ER” at AR; and press the Enter Key, or press the Alt + R Keys to display the Input
Address Window.

2. Editing Procedure

Register address data will appear in binary, decimal, hexadecimal, and ASCil. Move the
cursor to the respective field and edit the field. Changing one field will automatically
change the other fields.

Moving the Cursor

Moving to the binary, decimal, hexadecimal, or ASCI| areas:
Press the Ctri + Left or Right Cursor Keys
Moving feft or right in the binary area: Press the Left or Right Cursor Key.

A. Editing in Binary

When the cursor is in the binary area, a Binary Edit Menu will appear in the labei area at

the bottom of the screen. Move the cursor to the bit to be edited and set the bit. ‘
1113 Ter H
Dexcription | Moy 8 Dec | Mex |ascII
= FIEE
ry o | towmd e | sees
R — |8 |2
ay Ty | 40087 wnne | 4740 | CN
ng reg | 40008 wwew | 440 | 1J
o rey | 4nOW9 ween | amc | 3
s liing roy ) woun | 5252 | a8
»y rey | 48813 wown | 5354 | £T
rey | ebmid woon | 5520 | U
rog | 401 wwue | 3130 | 18
rey | 48918 e »
ng reg | 417 woue | 3838 | BB
Bisary Edic: 1.3t bit 2 Blear kit 2.zet T11 4.cBear all ‘

Figure 6.129

Changing individual bits to 1 {ON): Press F1 (Set Bit), or entera 1.

Clearing a bit (OFF): Press F2 (Clear Bit), or entera 0.
Changing all bits to 1 {ON}): Press F3 (Set All).
Clearing all bits (OFF): Press F4 (Clear Alf).
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B. Editing in Decimal

Press the Ctrl + Left or Right Cursor Keys to move the cursor to the decimal area. Enter
the number in decimal.

gistar tap H H
Dencriptisn | Rey & Binary Dac Nex  [ascIy
1He1] WELEFAT T M Wisitin bR,
[ g 2 | " ™
Holding vey | 49000 | SONSSCS-SSS0S1 09 s | a4
Welding reg | 40004 | SOOONSE- il | aee
Halding rey | 40005 | G1o08eii-3iseeiee dube ] 4344 | CD
Holding rey | 40066 | G1OOSIE-Si080110 e | 4546 | EF
olding rey | 40087 | KIOSEiLi-8101000 Siew | 4748 | ON
. g ray | 40008 18 Uoan | 4748 | IJ
olding rey | <0887 | wiomte]. 100 R sl XL
elding reg | 40818 | B 118 e ~
Wlding reg | 48811 ] R10S1111-01810008 weun | 4P or
ny rogy [ ABMIZ [ Wy —SLRt A wnas | 152 | QR
Aing rey | 4003 | HEiMLI-SimiELI08 amaw | 5354 | £T
ding ray | 40014 | Bimi ~ 801 S0BE mans | 5528 |V
o 1d. iy | 40R15 | 58110081 80110008 wane ¥ 3128 | LB
. rey | WG | o 10004 mms | 3000 | 08
slding wey | 4017 ] 10008 wene | J20 | W

Figure 6.130

C. Editing in Hexadecimal

Press the Ctrl + Left or Right Cursor Keys to move the cursor to the hexadecimal area.
Enter the number in hexadecimal.

wister tor B
Dascription [ Reg ¥ Binary Deg Wex |ascCIl
THEH | LAy
P AL
alding rey | 40007 | cosnewec-seueeine | sen | aesi
olding rey | 40004 | soeeess-Seeseee oo | sosd
Sliing rey | 400ES | S1000811-81000100 eew | 4344 | CD
ng rog | 4080E - een11e =ewn | 4544 { EP
ng rey [ S0B7 | 51008111-85081008 wane 1 A4S
ng rey | 0008 | WIO6LBELi-SIBEINIE wone | 4940 [ [J
g rey | 400EY | SLORINI1-81001108 oo | ap4C | 1Q,
S rog | 40618 | B1ORIIE-BI081110 wene | ADME | MM
ng rog | 40811 | 1080114 -01 010000 =mew | 458 | OF
#lding reg | 48812 .1 ~B N1 0818 wens | S1C3 [ QR
Slding reg | 4081) | HEOE11-GIHITI00 meue | 5354 | £T
Ay roy | 48E14 | 01006 01-00100000 e | SE39 | y
ny rey I AEBELS | 1006T-08110008 mune | 3139 | 18
ny roy | ABE16 | O0Li000N-08110085 wuue | 3530 | MO
g riy | A7 | SELL000S-00110088 wmns | 3030 | =

Figure 6.131

D. Editing in ASCIHIl

Press the Ctrl + Left or Right Cursor Keys to move the cursor to the ASCli area. Enterthe
ASCII text,

{
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¥
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EEEEEH

{ ey
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:
g

1333333333
! 5!!!!
g ]
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B

FERFREESES
F
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i

4

5

i
HEHI g

 { e fohi

Figure 6,132
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6.5.13 Editing and Monitoring Registers cont.

3. Displaying Registers in the Reference Area

-The Reference Area is located between the Logic Area and the Label Area at the bottom .
of the Network Screen. This is where register data is displayed and edited.

A. Monitoring or Editing Data in a Network

1) Move the cursor 1o the reference number that will be displayed.

2) Press the Slash Key to display the Command Submenu.

% 1,d0tabase 2.0uta 3.034t 4.Jsarch 5.0iew 6. Juil 7.0recaszer 0.skeep

Figure 6.133

3} Press F2 (Data).

An alternative method is to enter “D” from the Command Submenu.

The Data Submenu will appear.

Data: 1.Jull page Z.Datch J3.[0egister

Figure 6.134

4) Press F2 (Watch).

An alternative method is to enter “W" from the Data Submenu.

The specified address and its data will appear in the Reference Area.

o auue Doc

fnal
LPEX  peINAxy Descir 3 b | i F: T ]

Figure 6.135
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Reference Area:

Up to three addresses can be displayed in the Reference Area. A message will appear if
an attempt is made to display more than three addresses. Press the Enter Key to rewrite
the address on the far left side. Refer to 6.5.15 Full-page Editing for more details on the
procedure for displaying more than three addresses.

Figure 6.136

The Discrete or Register Submenu for the addresses disptayed will appear in the Label Area
at the bottom of the screen.

a) Discrete Addresses

@igﬁnw L T T T

Figure 6.137

b) Register Addresses A

= mmes Decimal
@mmu DEINaRY DascIr 3 b | ] L. [ ]

Figure 6.138

B. Monitoring or Editing Addresses Not Displayed in a Network

1) Move the cursor to the Reference Area.

e

Lrd

v 3 3

Figure 6.139

-2} Enter the address that will be monitored or edited at AR:.

AR: El5[55P]

Figure 6.140
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3) Press the Enter Key.

The address at the cursor position will be displayed.

[ECTH = BON2 Dacimal
PECImLINEX —  DidaRy DasCII 3 | [ ] v [: ]

Figure 6.141

The Discrete or Register Submenu for the addresses displayed will appear in the Label Area
at the bottom of the screen.

a) Discrete Addresses

= off
&E:Dlnm rr 2 1 [ v 3 o

Figure 6.142 ‘

b) Register Address

= s Bacinal
%mmn T R o P | : | -] L g )

Figure 6.143

4. Procedure for Editing in the Reference Area

The following procedure is used to edit reference addresses in Decimal, Hexadecimal,
Binary or ACSII.

A. Editing in Decimal

1) Move the cursor to the address in the Reference Area that will be edited.

The Register Submenu will appear.

= wuws Ducinal
%ﬂum atdam Dscit 2 h-| -4 L 3 m

Figure 6.144
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2) Press F1 (Decimal).

3) Enter a decimal number at AR:.

Be sure to enter the number in decimal form. Entering a number other than a decimal
number will' not input properiy.

AR:
Figure 6.145
4) Press the Cirl + Enter Keys.

The number entered at AR: will be entered in the Register.

- 1 Amal
&Mﬁ‘n “Eewascr 3 3 oz o

Figure 6.146

B. Editing in Hexadecimal

1) Move the cursor to the address in the Reference Area that will be edited.
The Register Submenu will appear.

2) Press F2 (HEX).

» BMER Nexadecimgl
@myn DRINARY DMsCIT 3 .| -] : - | iz

Figure 6.147

3) Entera hexadecimal number at AR:.

Be sure to enter the number in hexadecimal form. Entering 2 number other than a hexa-
decimal number will not input properly.

AR: T
Figure 6.148
4) Press the Ctrl + Enter Keys.
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The number entered at AR: will be entered in the Register.

= MAA Hexadecimal
%nw Deiwaky DsCIT 3 -] -] pulL 2

Figure 6.149

C. Editing in Binary
1) Move the cursor to the address in the Reference Area that will be edited.

The Register Submenu will appear.

2} Press F3 (Binary).

= SOIIBIID-SibaNe
%ﬂnwn DeIMakY Ppscil BEDIT B [ oL D m

Figure 6.150

3) Press F5 (Edit).

The Binary Edit Submenu will appear along with a cursor that will move above the bits.

FJM " Pinire Attt 1o Mt 2.Jlear bit J.ast T 4.clear all ;

Figure 6.151 ‘

4) Edit the number.

Refer to A. Editing in Binary on page 6-56 for more details on the procedure for binary
editing.

= 111008t 8- 18181
Binery Rdit: 1.5t bit 2.J0sar kit J.zet T01 4.clear all

Figure 6.152 ‘

5) Press the Esc Key after the number is edited.

The Register Submenu will appear.

—
1

i
1

LA, B

= 111msis-1eLnme
hwn MINARY Drsci1 BEDIT 3 & TroLL m

Figure 6.153 ‘
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6.5.14 Editing Coils and Relays

The following types of editing and displays are available for coils and relays. Refer to B, Edit-
ing Discrete I/O on page 6-76 for more details on the procedure for full-page Coil and Relay
editing.

= Setting disabled and enabled status (Forced ON/OFF)
» Displaying coil use status
» Searching for coils from relays (trace/retrace)

{

1. Setting Disable and Enable (Forced ON/OFF)

Coils can be'disabled so that coils and relays can be forcibly turned ON and OFF, When a
coil is disabled, ON and OFF control from a scan will be ignored, and only forced ON and
OFF control from a computer will be possibie. The Enable/Disable functionis used to sim-

ulate the operations that will be performed when the program is actually written to a Pro-
cessor.

1) Press the Slash Key to display the Command Submenu.

f i.8Dkabass 2.0ata 3.0dit 4.Bvarch §.JHew &.Joll 7.Brecazser S.slmap

Figure 6.154

2) Press F& (Coil).

An alternative method is to enter “C” from the Command Submenu.

The Coil Submenu will appear.

f&il: L.rable 2.0izable 3.T0 4-oF S.edit diadle . Jrace 7.Datrace 8.Jead

Figure 6.155
3) Move the cursor to the coil or relay 1o be disabled.
4) Press F2 (Disable).
An alternative method is to enter “D” from the Coil Submenu.
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The coil or relay at the cursor position will be disabled.

“DF” or “DN" will appear at the Coil with that address if it is disabled.
DF: Disabled and turned OFF
DN: Disabled and tumed ON

B - H- ¥ B
A A e -
' i

Figure 6.156

5} Press F3 (ON} to disable and tum ON the coil or relay.

An alternative method is to enter “O” from the Coil Submenu,

Figure 6.157

6) Press F4 (OFF) to disable and tum OFF the coil or relay. ‘

An alternative method is to enter “F” from the Coil Submenu.

Figure 6.158

7) Press F1 (Enable) to cancel the disable.

An alternative method is to enter “E” from the Coil Submenu. “F/N” or “DF/DN” will disap-
pear when Enable is selected.

When one coil or relay is enabled or disabled, then ali other coils and relays at that same ad-
dress will be enabled or disabled.

Note (1) A coil or relay that is not disabled cannot be tumed ON and OFF.

(2) The Disable/Enable Display only shows coils and not relays.
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Shorteuts

a) Enter “CM” at AR: and press the Enter Key to display the Coil Submenu.

b} Enter “DIS” at AR: and press the Enter Key to disable the coil or relay at the cursor
position.

C} Enter “FN” at AR: and press the Enter Key to disable and turn ON the coil or relay.
d) Enter “FF” at AR: and press the Enter Key to disable and turn OFF the coil or relay.
e) Enter “EN” at AR: and press the Enter Key to cancel the disable.
2. Disable Editing in the Reference Area
Thé following procedure is used to display and disable addresses in the Reference Area.
1) Display the qddress that will be disabled in the Reference Area.

Referto 4. Procedure for Editing in the Reference Areaon page 6-60for more details on
the procedure for editing in the Reference Area.

» OLF
&&'Dlnnm w3 h.| ] Dol P

Figure 6.159

2) Press F2 (Disable).

The address at the cursor position will be disabled.

COECD = Dizablad OFF

[EMALLE ED1SABLETON orr P ;| a a3 m

Figure 6.160

3) Press F3 (ON} to turn Disable ON.
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6.5.14 Editing Coils and Relays cont.

4) Press F4 (OFF} to turn Disable OFF.

5) Press F1 (Enable) to Enable.

3. Disabling from the Disable Table Edit Screen

The following procedure is used to display the Disabled status of a maximum of 510 ad-
dresses on screen for ON, OFF and other types of editing.

1) Press the Slash Key to display the Command Submenu.

E 1.dfcabase 2.Qwta 3.005t 4. Bearch 5.Jiew 6. Joil 7. Brecerser E.almap

Figure 6.161

2) Press F6 (Coil). ‘

An alternative method is to enter “C” from the Command Submenu,

The Coil Submenu will appear.

% Cail: 1.0rable 2.Bisable 3.In 4.o0F S.edit dilable G.jrece 7.Detrace 8.Ised ‘

Figure 6.162

3) Press F5 (Edit Disable).
An alternative method is to enter “S” from the Coil Submenu.
The Coil Disable Table will appear. ‘

A zero (“0") wili appear at reference numbers that are disabled and an “F will appear at
reference numbers that are not disabled.

2345678 ®123456727 2345678y
gx: F—r— |t .2k
MR3x: ==Qm=—Q—= 2 052
BEx: ——P-femen Ry
e -t ——————— Wi ————————
2x= PIx: Widx: —————
] 5 LGy e -l ————
oy ——— DR 9x: —mmmr— -2ix: -———
2l ——— BR22x: -mm— B23x:
m————— 25k ——————— ,Rex: ———————
2T emmmm——— Mg ———— ;2
M ———— |3ix; ————— W22 ————
BEIInE ————— owike: —————— e —
[T o —— it ———— [~ T p A ———
BETYN: me—m——— Az ——— BMLy: mmmmm———
B2 wmmmmmann SBix W
45K ————— | o1t 7
WX Y

—: EMABLE 0 — Coil DPisaklad (Omd> P - Cail Pisabled (OFF)
QUICK SEARCH: E

;) v Fage < Hiaxt Fa
N 1s S.enahle M1

Figure 6.163
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Editing Procedure

F1orE;

Fz2orS:

F3orQ;

F4 or F;

F5 or A:

F6 orC:

Enables the status of the address at the cursor position.
Disables the status of the address at the eursor pbsition.
Turns ON the status of the address at the cursor position.
Turns OFF the status of the address at the cursor position.
Enables the status of all addresses.

Changes the type of address. The type of address changes as shown below
each time the key is pressed.

Coil —» Link Coit -  Input Relay » M, N Code Relay

(From 00001) (From D0001) (From 1 0001} (From N, Mxxox)

Enter an address in the Quick Search field to display the page with that address.

Moving the Cursor

Next or previous page: Press the Page Down or Page Up Key.
First or last page: Press the Ctrl + Page Up or Page Down Keys.

Shortcuts

a) Enter “CM” at AR: and press the Enter Key to display the Coil Submenu.

b) Enter “EDT” at AR: and press the Enter Key to display the Coil Disable Tabie.

4. Displaying Coil Used Status

The following procedure is used to display the Coil Used Table.

1) Press the Slash Key to display the Command Submenu.

E T L.dDtabaze Z.Bata 3.0dic 4. Fearch 5.Diav 6.201) 7.0reconzer .ulnap

Figure 6.164

2) Press F6 (Coil).

An alternative method is to enter “C” from the Command Submenu.
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The Coil Submenu will appear.

} Cail: 1.0nable 2.0Haahls 3.0 4.03F S.edit difadls C.Qvace 7.Decrace §.Jked

Figure 6.165

3) Press F8 (Used).

An alternative method is to enter “U” from the Coil Submenu.

The Coil Used Table will appear.

Coils in use will appear with a “U.”

i [
WA5E7Y w2345y 123454789
Ex: i ] = B2 ——
BEdx: —= i |t S
Gy = 7 =
nx: —mtamnllf e ‘_h: Bl ——
-1:, ﬂi3x ——— -1 e
. Sx: exs ————— L ——————
A= Yz —————e— ez ==
2 — 2axz ——————— R2yxz ——————
2 A —ms—mm— 25N — s mm—— 2 ———
] —————— REx: —————— -|m2yx: —
T — g ———- W3 —
WEIIx: =——— Ay —e—rr—— M35 =————
PIEKT ——smmr—— BRI TK:  ——— 3R =e—————
m’l: . —r——— -“x e ——— -ux  —
2y ——— 43 By i
BMEx: — [ oo B2 ————
PRl : M [ 3
=z Gail Unused U = Geil Used
Ik TEARCH t 4 < >Prev P CPylnddext M
& quit L el age
¢ > sileres Chan
Figure 6.166
Operating Procedure ‘

« C; Address Change
Switches between Coil and Link Coil.

» Quick Search:
Enterthe address that wifl be displayed and press the Enter Key. The page with thataddress
will appear.

Shortcuts

Enter “CM” at AR: and press the Enter Key to display the Coil Submenu.

5. Searching for Coils Using Relays (Trace/Retrace

{

The following procedure is used to find and display coils with the same address as arelay.
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1) Move the cursor to the relay that will be used to find the coil.

- LN SR N - e -

G T ONG SHS e Mem ovm mc aoer mun

Figure 6.167

2) Press the Slash Key to display the Command Submenu.

f L.ddcabane 2.[fata 3.[Mit 4.Fearch $.Disv 6. Jeil 7.[rscessnr t.almey

Figure 6.168
3) Press F6 (Coil).

An alternative method is to enter “C” from the Command Submenu.

The Coil Submenu will appear.

E&ih 1.[bable 2.Sisable 2.In 4ol S.edit diJnble §.Drace 7.Dacrace €. lned

Figure 6.169

4) Press F6 (Trace).

An altemative method is to enter “T” from the Coil Submenu.

Coils with the same address as the relay will appear.

—¢ )
AT

T ]

Figure 6.170
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6.5.15 Full-page Editing

5) Press the Esc Key to cancel the operation.

6) Press the Enter Key to stop the search at the coil position.

7) Press the Home Key or press the Ctrl + Home Keys to retum to the previous coil position.

8) Press F7 (Retrace) after editing is completed in order to retum the cursor to the original
relay.

An alternative method is to enter “R" from the Coil Submenu.

Shortcuts
a) Enter “CM” at AR: and press the Enter Key to display the Coil Submenu.

b) Enter “CT” at AR: and press the Enter Key, or press the Alt + T Keys to display coils
with the same address as the reiay.

¢) Enter “CRT" at AR: and press the Enter Key to retum the cursor to the original relay.

6.5.15 Full-page Editing

Full-page Editing allows 60 addresses listed in 20 rows by 3 columns to be edited and dis-
played all at once. Values are edited with Reference Addresses, and Disable ON/OFF status
is edited with Discrete Addresses {Relays, Coils, etc.)

H

2
11113111311133111

H

AR LIRS IS 8 ] N UL LS

~3
)

AnpANNDODOGRADRANN
11113111
!
L]

s
bec
49058 = BOBA Dec
49057 ~ 00Bd Dec
4B068 =~ POIR Dec

33 | Booumd TILITYILOGIC DMEXT  [EPREY

o]

SARINNAGHNHE

é

Figure 6.171 Full Page Editor Screen

1. Displaying the Full Page Editor Screen

The following procedure is used to display the Full Page Editor Screen.

1) Press the Slash Key to display the Command Submenu.

f 1.dDtabase 2.0eta 3.QHit 4.3earch 5. Qovw 6. Joil 7.0recesner 02000

Figure 6.172 ‘
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2) Press F2 (Data).
An alternative method is to enter “D” from the Command Submenu.

The Data Submenu will appear,

f Dataz 1.[u1) pagpe 2.Daxeh 3.Qegizter

Figure 6.173
3) Press F1 (Full Page).

One alternative method is to enter “F” from the Data Submenu. Another is to move the
cursorto the Reference Area if the address is displayed in the Reference Area, and then

press F8 (Full) from the Discrete or Register Submenu to display the Full Page Editor
Screen.

The Full Page Editor Screen will appear.

E ] ] ] A ool IUTILITYILOGIC 2MEXT PRIV

Figure 6.174

Label Area

* Nothing will appear at 1 through 5 in the Label Area if the cursor is not on an address.

* When the cursor is on an address, discrete 1/O functions will appear if it is a discrete
address or register functions will appear if it is a register address.

Note If a full page is displayed with addresses appearing in the Reference Area of the Network
Screen, those addresses will appear on the full page. If there is no need to dispiay the ad-
dresses, display the Full Page Delete Submenu (See 8. Deleting a Full Page on page 6-81),
or press the Delete Key where the Reference Area is displayed in order to delete the page.

Pull Pagw Belate: 1.Jlemasc 2.3plums 3.0bw 1.Buge
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Shortcuts

Enter “EFP” at AR: and press the Enter Key, or press the Alt + F Keys to display the Full .
Page Editor Screen.

2. Displaying Addresses

The following procedure is used to display addresses on a full page. If an address ap-
pears in the Reference Area, that address wili be displayed.

1) Move the cursor to where the address will be displayed.

ape [tar

L 4 [ | a ACOLEMN WTILITYIOGIC INEXT  (EDPREW

Figure 6.175

2) Enter the address at AR: and press the Enter Key. ‘
fAR:

Figure 6.176

The address will appear at the cursor position, and the Discrete or Register Submenu will
appear in the Label Area at the bottom of the screen.

Ll&! IP1EABLEDON orr | FooLUMM ZUTILITYRLOGIC INEXT  [EPRER ’

Figure 6.177

Lﬁlﬂl& IRINARY DnscIT J§ ACoLUMN DUTILITYIROCIC DMEXT  (EFREY $

Figure 6.178

3. Editing Procedure
The following procedure is used for full-page editing of registers and disabled status.
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A. Editing Registers

The following procedure is used to edit referen

ce addresses in decimal, hexadecimal,
binary or ACSIl.

» Editing in Decimal
1) Move the cursor to the address that will be edited.

The Register Submenu will appear.

Lxmmm Doty Dascir 3 XOLIM RITILITYDLOCIC DMENT  [EPATY

Figure 6.179
2) Press F1 (Decimai).
3) Enter a decimal number at AR:.

Be sure to enter the number in decimal form. Entering a number other than a decimal
number will not input properly.

AR:
Figure 6.180
4) Press the Ctrl + Left Cursor Keys.

The number éntered at AR: will be entered in the register.

" 8811 Desinal

Emm DRTNARY DMSCIT 2 BOOLUMN BITILITYILOGIC IMENT  [DPREV

Figure 6.181
» Editing in Hexadecimal
1) Move the cursor to the address that will be edited.
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The Register Submenu will appear.

Llltl"m ImINARY TascIl R DooLUIM ENTILITYILOCIC DREXT  [OPREM

Figure 6.182

2) Press F2 (HEX).
3) Enter a hexadecimal number at AR:.

Be sure to enter the number in hexadecimal form. Entering a number other than a hexa-
decimal number will not input properly.

AR: I

Figure 6.183

4) Press the Ctrl + Left Cursor Keys.

The number entered at AR: will be entered in the register.

OEI) = GeAa Haxadscimal

Pa:ll‘t’ln TRINARY DNSCII 3 JCOLUMN DITILITYILOGIC INEXT  {IDPREV ‘
Figure 6.184

» Editing in Binary

1) Move the cursor to the address that will be edited.

The Register Submenu will appear.

LRHIIUB DeTaRy ascir 3 ICOLUMH EUTILITYILOGIC DIMEXT  [EOPRED

Figure 6.185
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2) Press F3 (Binary).

E@CIMWE INTMANY DNSCII BEDIT  BCOLiMM WTILITYILOCIC DNEXT  EPREV

Figure 6.186
3) Press F5 (Edit).

The Binary Edit Submenu will appear along with a cursor that will move above the bits,

Mrary Edit: 1.3t hit 2.Jlear bit 3.zet M1 d.clear all

Figure 6.187

4} Edit the number.

Refer to A. Editing in Binary on page 6-56 for more details on the procedure for binary
editing.

3 " cor

~ meiKe-se1ene]

1 Winary Edic: 1.3e¢ bic Z2.Klaar bit 3.set M1 4.efnar all

Figure 6.188
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5) Press the Esc Key after the number is edited.

The Register Submenu will appear.

sz:m‘.’m Deinary IascIl 3 ICOLUM NTILITYROGIC INEXT  {IDPREV

Figure 6.189

B. Editing Disabled Status
1) Display the Full Page Editor Screen.

Refer to 1. Displaying the Full Page Editor Screen on page 6-70 for more details on the
procedure for displaying the screen.

2) Display the addresses that will be edited. - ‘

Referto 2. Displaying Addresses on page 6-72 for more details on the procedure for dis-
playing addresses.

3) Move the cursor to the address that will be disabled.

Boowurm TILITYRLOGIC JMEXT [DPXEV

Figure 6.190

4) Press F2 {Disable).

The address at the cursor position will be disabled.

age ror
= Disahled OFf
OfF

1
288

F-l.: IPISARLEON orr B oL IETILITYIRCGIC JvExt [PREV

Figure 6.191 ‘
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5) Press F3 (ON) to turn Disable ON.
6) Press F4 (OFF) to tumn Disable OFF.

7) Press F1 (Enable) to Enable.

4. Command for Displaying Columns

The following procedure is used to display a series of addresses in a column from the
curser position down.

1) Display the Full Page Editor Screen.

Refer to 1.Displaying the Full Page Editor Screen on page 6-70for more details on the
procedure for displaying the screen.

2) Move the cursor to the address.

TT) - W Decinal

PECI!II@E Deivaxy Dascr1 J ZOOLUMN IITILITYILOGIC DNEXT  (IDFREV

Figure 6.192

3) Press F6 (Column),

A series of addresses will be displayed in a column from the cursor position down.

age tar

1

11311113112113113

L

Eﬁmu DeiwaRy Dascil B OLNS EUTILITYIOGIC DMBXT  [EerEy

Figure 6.193

Note Column Display shows only one column, and cannot continue to the next column.
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5. Displaying the Next/Previous Address

The following procedure is used to display the next or previous address from the cursor
position.

1) Display the Full Page Editor Screen.

Refer to 1. Displaying the Full Page Editor Screen on page 6-70 for more details on the
procedure for displaying the screen.

2) Move the cursor to the address.

age tar

I = 0088 Decimal

Pﬂ:ll".l‘lﬂ Im1vaRy nscII 3 COLUMN TUTILITYDLOGIC [NEXT  ([DOFREV

Figure 6.194

3) Press F2 (NEXT) or F10 (PREV).

The next or previous address will appear.

48018 = BBBS Decimsl
K - o888 Decimal

{The next address)

PEIUI.’(B ImINARY DasCIT R ICOLUMN RUTILITYIROGIC DNEXT  [DFREV

Figure 6.195

‘age cor

m = 8000 Decimal
« §898 Decimal

{The previous address)

LEIMEIB Deivary Degcit 3 BCOLUMN ZHTILITYILOGIC INEXT  [DFREW

Figure 6,196 ‘
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The cursorwill move to the newly displayed address. Ifthe next or previous address is already
being displayed, the cursor will move one down with NEXT or one up with PREV just as with
the Up or Down Cursor Keys. The cursor will not move any farther if it is at the top or bottom.
Simply specify the address at the cursor position as NEXT or PREV to continue moving up or
down one address at a time.

6. Saving a Full Page

Saving atull page not only saves thé status of all addresses, butitalso saves the layout of
the addresses that is displayed. Since a page that is saved can be displayed again by
selecting Load, there is no need to specify a large number of addresses.

1) Display the Full Page Editor Screen.

Refer to 1. Displaying the Full Page Editor Screen on page 6-70for more details on the
procedure for displaying the screen,

2) Press F;l (Utflﬂy).

The Full Page Utility Submenu will appear.

? - poam 1 48837 = BBNN imal 4005 Ducimal
(] “::i.ul mc:ng:nm “l--h:
$ = 8008 Decimai 40037 « B8 Dacimai 48059 = BEBE Decimal
0 = 0088 Perimal 40048 - BOOP Dycimal -

Pull Pagw Ueility: 1.8ave 2.0esd 3.Toists 4.Bindaw snseff

Figure 6.197

3) Press F1 (Save).

An altemnative method is to enter “S” from the Full Page Utility Submenu. The data saved
here is saved to a GL60, TFP file and not in the currently selected database,

A confirmation message will appear asking whether to proceed.

Figure 6.198

4) Make sure that “Y” is entered, and press the Enter Key.
Enter “N” and press the Enter Key to cancel the operation.
The page will be saved,

— 6-79 —




Online Editing

6.5.15 Full-page Editing cont.

The newer pages saved will overwrite the older pages saved fromthe secondtime a page
is saved.

7. Loading a Full Page

The following procedure is used to load a saved full page complete with its layout. Ad-
dresses edited after the full page was saved will appear as edited.

1) Display the Full Page Editor Screen.

Refer to 1. Displaying the Full Page Editor Screen on page 6-70 for more details on the
procedure for displaying the screen.

2) Press F7 (Utility).

The Full Page Utility Submenu will appear.

Pull Page Utility: t.Jave 2.0ead 3.Melets 4.Jindew snceff

Figure 6.199

3) Press F2 (Load).
An alternative method is to enter “L” from the Full Page Utility Submenu. ‘

A confirmation message will appear asking whether to proceed.

Figure 6.200

4) Make sure that “Y” is entered, and press the Enter Key. ‘
Enter “N” and press the Enter Key to cancel the operation.

The page will be loaded.

= 0% Decima 40821 = DUUE Decima -— n
= R Puc 48822 = 9008 Dec S84z - 2008 r Y
= 9088 Dacime 2T = 0000 ma 4BE43 « DOUN ma
= PSS Dacima. 40ki4 - JOOO . 4biid « DOOR P
= S0 Dacima 425 - BESR AR b4 - NS -
= S80S Dacina 4926 = B80S Dec 4004s ~ BBIR £
= BBB8 Dt ina 408927 = BBBE Decime 4047 = BEBE nn
« BOBE Decimk 48623 - GB8 Decima 40048 = S0 ma
= PppiE Decima 4982% = 00 Dacima 40047 = S0

= SR Decima 45818 = 990G Decima 40058 - MONS

= P00 Decima 48831 = §009 Dac 48851 ~ e

= G008 Ducime 48032 = 008 Dacime 48852 = MR -
= 8008 Dec 48833 = PEAE Dacima 48053 - BOBD .
= 9988 Dec 48034 = SRS Dacima. 40054 ~ MR e
= 9008 Dec 49035 = DS Dacima 40055 = 00 va
- e T 4BEGE = BB Decima 4ni54 - DOOE i
= B008 Dacima 4E37 = BBON Decima AME7 - OB .
= B8 Decima 4001 = BBOE Dot ina 45E - 2088 -
= BBBE Dec. 4953y = BMS Decima 40059 - S008 ok
= 8BS Decims 40048 « BA Decima 40060 - PR o

ECTMALIMEX DRINARY RSCII B COLIMN DUTILITYILOGIC JMEXT ey
Figure 6.201
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8. Deleting a Full Page

Full Page Delete not only deletes actual addresses from the database, but items that do
not appear.on screen as well.

A. Deleting the Address at the Cursor Position

The following procedure is used to delete the address at the cursor position from the
page.

1} Display the Full Page Editor Screen.

Referto 1. Displaying the Full Page Editor Screen on page 6-70for more details on the
procedure for displaying the screen.

2) Move the cursor to the address that will be deleted.

I

a8

neafAnNGOnADN

1131113

[(ER NN

0 NRSRAgEe N h
WAEAE N L

...
g
<

Deiwxy ascil g ICOLUMM DITILITYILOGIC BT FREV

Figure 6.202
3} Press F7 {Utility).

The Full Page Utility Submenu will appear.

Figure 6.203

4) Press F3 (Delete).
An alternative method is to enter “D” from the Full Page Utility Submenu.

The Full Page Delete Submenu will appear.

Full Page Delece: 1.Jlesent 2.Jslunn 1.00w 4. Jagw

Figure 6.204
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5) Press F1 (Element).

An alternative method is 1o enter “E” from the Full Page Delete Submenu.

The address at the cursor position will be deleted from the page.

FEEEEEEERE i’i’ﬁ“ﬁiifi

¥ FYIYYEY

Pull Page Dolete: 1.Jlewent 2.Jelumn 3.0ew 4.0kge

Figure 6.205

B. Deleting a Column

The following procedure is used to delete the column at the cursor position from the page.
1) Display the Full Page Editor Screen.

Refer to 1. Displaying the Full Page Editor Screen on page 6-70 for more details on the
procedure for displaying the screen. ‘

2) Move the cursor to the column that will be deleted.

......

i1p2: ¢

¥
FEREEEEERE

B8 0 e
= HHHERINNNEELININE .
&
¥

1]
[

v
i
]
i
2
L]
3

BCOLUMN BUTTLITYDOGIC DNExT  {EPAEU

Figure 6.206

3) Press F7 (Utility).

The Full Page Utility Submenu will appear.

7 = BBBS Decimal 48837 * BOOS Dacimal

4 = DR Decimal 48538 « BBBS Decimal

¥ = B8 Decimel 48833 = GBBE Decimal

= POBP Dwcimal 4948 = 0BMY Decimal
Pull Page Utility: 1.0ewe 2.Qead 3.@nlete 4.Disdew enceff

Figure 6.207
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4) Press F3 (Delete).
An alternative method is to enter “D” from the Fuil Page Utility Submenu.

The Full Page Delete Submenu will appear.

Figure 6.208

5) Press F2 (Column).
An alternative method is to enter “C” from the Full Page Delete Submenu.

The column ‘at the cursor position will be defeted from the page.

[ ] a oL ENTILITYILOGIC DNEXT  [IDeREv

Figure 6.209

C. Deleting a Row

The following procedure is used to delete the row at the cursor position from the page.

1} Display the Full Page Editor Screen.

Referto 1. Dispiaying the Fuli Page Editor Screen on page 6-70for more details on the
procedure for displaying the screen.

2) Move the cursor to the row that will be deleted.

e i SFFET CLR R
= D088 Becima: Az - e ina 45041 = JOBS Ducima
= BBBE Decima. 4872 = B Decima 48842 = 3OO Degima
= 3888 Decin 4BZ3 = S8 Decisa 40843 - o008 o~
- 9908 Decima 424 = BEOS Decina 40844 = 8008 Decima
= 9909 Duc 48025 = BOBR Decimg A5 = BOOS .
= 0908 Dec 4025 - DGR 40046 = MOS Decina
= B8 Dac 4027 - WS ma. 45847 = PR Decina
= SB08 Decing 48028 = BOBE Decina 48044 = 3008 Docima
» 8088 Dac 482 = SR8 Decina 48047 = B8 Decina
UL - N8 4830 = BOEE Decing 400 ~ MOE Decina
iii = G0 Bacima) 4831 = B Decima 48851 = MBS Decima
12 = S8 Becima 48817 - SOAG L~ 4052 = BS Deoima
1] = BOBE Becima. 4bi3) = BOBS Decima 40053 + 808E Decima
He = BOEG . 4534 = 8008 Decima US4 = S08d reY
HS = BB Decima 3% = N8 o 48055 = BEMA k.
16 = b 406 « BBBR Decimg 40856 = MO Decine
17 = S900 Ducima 4537 = BB Dac 4BNS7 = BPOE Duc ina,
:‘" cina 1-3!--& “’-— .
Yy = cina - cina - Py
28 = B9 Decina 40048 - B0OP Decina A0NEE - MOOS .
|
BCIMRLINEY ImINaRY DAsCIT 3 ZCOLUMN BNTILITYILOGIC ZNEXT rrey

Figure 6.210
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3) Press F7 (Utility).

The Full Page Utility Submenu will appear.

¥
3
L
|
1
i

- =
= MO8 Decimal 48060 = 0O8R Decimal
Pull Page Utilicy: 2. Jawe 2.0wad 3.Twlrte 4.Dindew enseff

Figure 6.211

4) Press F3 (Delete).
An alternative method is to enter “D” from the Full Page Utility Submenu.

The Full Page Delete Submenu will appear.

? = 388 Decimal 4837 = BB Decimal 4007 = BBAE Decinal

8 = 8899 Decimsl ABKI8 = BB Bacimal 48058 = S Derinal

3 = 8000 Decimal 4By = BBBR Pecimal 40055 = ShBA

@ = 888 Decimal 45048 = BBES Decimal 48868 = SBB8 Decimal
Full Page Delate: 1.JRenent 2.Jelusn 3.0av 4.Jage

Figure 6.212

5) Press F3 (Row).
An alternative method is to enter “R” from the Full Page Delete Submenu.

The row at the cursor position will be deleted from the page.

Fditer T STS ok 1IRAN T
= 48821 = G Dacima 48841 = BB8A Dacima.
= e 48822 - M00A ima; 48042 = G Dacima
= #0080 Dac 48023 - S00R L 4B43 = GBI Ducima
= BBS Dec 4024 = ODOS T 4004 = GBI Puc ima
= BBBS Decina 4BRZS =~ OIS Decima 48045 = SB0E Dac ims.
= SUB8 Decima 4802¢ = BOES Ducima 4B46 » 0BBE Decima
= B80S Decima 40027 = BOOS Ducina 48047 v 9908 Dacims
= B80S Decima 40828 = BOO Bacima AB84% = 9008 Decins
- S80 Docina 40029 = 0008 Ducima a4t - 008 ™
= DA dma 40001 -~ D008 . 40051 = OB i
= 8888 Dacima 49002 = 0088 ~a -y

- mudd ma. 4983 - GNNS 48053 = 0008 Becima
- gl ma, 44 = G008 43854 = 0088 Dec
= 398N Becima 4R35 = 8080 Dec 48855 » 0088 Dec
= PPN Decima 488545 = B008 Dac 48856 = B Dacina
= 800 Dwcime .. 48837 - 8888 Dec. 48857 = #00E Dacima
- 9998 Decime 48018 - 8880 Decime ™
~ B8O Dacima 40839 = BEBN Dec S5 = BB Dec
- GBS Dacine 49048 « B80S Decims AB0GE = $O88 Decina

Pull Page Delete: 1.Mensnt 2.301umn 2.0ew 4.[ese

Figure 6.213

D. Deleting a Full Page

The following procedure is used to delete all addresses displayed on the page from the
screen.

1) Display the Full Page Editor Screen.
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Refer to 1. Displaying the Full Page Editor Screen on page 6-

70 for more details on the
procedure for displaying the screen.

2) Press F7 (QtiliW).

The Full Page Utility Submenu will appear.

7 = B0 Decimal 48837 « GBI Decima] 4057 = BBOE Decinal

0 = G888 Decimal 48818 = SO0 Decimal 40950 = SO Decinal

¥ = BO0S Decimal 483t ~ BOOE Dacimal A005% = DOl Decimal

S = B0 Decimal 48k - 3008 Decimal SPRGE «~ 00O Decimal
Pull Page Utility: 1.8ave 2.[Jhad Aelete 4.Dindsw en‘eff

Figure 6.214
3) Press F3 (Delete).

An altemative method is to enter “D” from the Full Page Utility Submenu.

The Fuli Page Delete Submenu will appear.

? = BB Decimal 48437 = G888 Decimal 9857 = S0 Decimal
1 - ti::} a0 - veee :§m§ e - e i
b 12037 - Beas D pr el
S - GOOE Dacinel AB04E - 0080 Ducimal 496D - 998 Ducimal
Fall Page Balete: 1.[lement 2.3 lumn 3. Dew 4. Foge

Figure 6.215
4) Press F4 (Page).

An alternative method is to enter “P” from the Full Page Delete Submenu.

All addresses will be deleted from the screen.

'l ] B H] F ] oL WTILITYDOGIC ZGXT  DRWRy

Figure 6.216

9. Displaying the Comment Window

The following brocedure is used to display the Comment Window on a fuil page.
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6.5.15 Full-page Editing cont.

1) Display the Full Page Editor Screen.

Refer to 1. Displaying the Full Page Editor Screen on page 6-70 for more details on the ‘
procedure for displaying the screen.

2) Press F7 (Utility).

The Full Page Utility Submenu will appear.

Full Page Utility: 1.Jave 2.0oad 3.[nlste 4.Rindew sn-eff

Figure 6.217

3) Press F4 (Window ON/OFF)}.

The signal descriptor of the address where the cursor is positioned will appear in the
Comment Window. Addresses will not appear in the window under the following circum-
stances.

a) Cursor not on an address

b) Database not selected (because the signal descriptor is used for reference from the ‘
database on the computer)

An alternative method for displaying the window is to enter “W” from the Full Page Utility
Submenu.

The Comment Window will appear.

- — Nl ——

KELAy
FOk TEST

BLE Jo]TARLEDON &orr | oL RITILITYOGIC DOXT  [IPRER

Figure 6.218

The function labels displayed on screen will switch from the Full Page Utility Submenuto
the Full Page Editor Menu each time Window is selected. Select Window once more from
the Full Page Utility Submenu to cancel the dispfay.
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Press the Tab Key to edit comments for the address.

6.5.16 Copying Networks

The following procedure is used to copy currently displayed networks to a specified location.
Transition networks cannot be copied.

1) Display the network that will be copied.

18 C L1 ILC2 MNE  ICWURT 1) FEC ENET
L2T]Y tlﬂlz n}ll; B?JM lws g ml'raﬂ? nl.lll uw’

%1

Figure 6.219

2) Press the Slash Key to display the Command Submenu.

f 1.ddkabere 2.Quta 3.[Mit 4. Farch §.Diew 6.0l 7 Beacesser 3.sTewp

Figure 6.220

3) Press F3 (Edit).

An alternative method is to enter “E” from the Command Submenu.

The Edit Sub}nenu will appear.

H

f Hait: 1.3l Z.dfkcriptor Y.0hzert 4.Delate S.copl natwerk 6.Jevs netwerk

, Figure 6.221

4) Press F5 (Copy Network).

|
An alternative method is to enter “Y” from the Edit Submenu.
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6.5.16 Copying Networks cont.

A temporary network will appear.

LRI 7777 |= - == xe - mseesmnnmnnan o bt s e e — Y—
i ucrn Ll

-4 s o AL LR TR TPV TP T PP LELELELELES S W—
Ed e

O.Initial Metusrk B.Dalete Element §.Dalste Shunt J.irite Netwerk

Figure 6.222

A temporary network is an exact duplicate of the currently displayed network that is
created temporarily on the computer screen and is not a network in the program of the
Processor. Enter the correct reference number at the question marks and specify where
to copy the network in order to copy the temporary network on the computer into the Pro-
cessor program.

5) Move the cursor to reference number {7?77?7?).

Figure 6.223

6) Enter the reference number at AR: and press the Enter Key.

AR:

Figure 6.224

The reference number at the cursor position will switch to the number entered at the
question marks.

Figure 6.225
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7) Repeat the same steps to enter all reference numbers.

- Initial Metwerk §.Delate Elesent D.Delste Chunt §.Write Netwark

Figure 6.226

8) Press F2 (Delete Element) orF3

{Delete Shunt) to delete elements or shunts that do not
need to be copied.

9) Press F1 (Initial Network) to return to the ori

ginal status priorto entering a reference num-
ber or deleting an element.

10) Press F4 (Writé Network) after all the changes are completed.

The input screen for entering the destination network number will appear.

Figure 6.227

11) Enter the destination network number and press the Enter Key.

The network that is copied will be inserted prior to the specified network number, and the
network numbers will automatically shift down by one.

A confirmation message wil appear asking whether to proceed.

Couy Metuork te WHu1® 1) ”

Figure 6.228

12) Check the details and press “Y” and the Enter Key. “N”is initially entered so deletion will
not be executed in case the Enter Key is pressed by mistake.

Figure 6.229
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6.5.17 Moving Networks

The network will be copied.

Shortcuts
Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.

6.5.17 Moving Networks

The following procedure is used to move networks. Networks cannot be moved while a Pro-
cessor is operating. If the Processor is operating, exit from network editing, return to the Edit
Menu, and stop the Processor. Refer to 6.4 Starting and Stopping a Processorfor more de-
tails on the procedure for stopping a Processor.

1) Display the network that will be moved.

2) Press the Slash Key to display the Command Submenu.

E 1.d%tabeas 2.Oata 3.04ic 4. Bearch 5.Jisw 6. Joil 7.0racesvar d.albep

Figure 6.230

3) Press F3 (Edit). ‘
An alternative method is to enter “E” from the Command Submenu.

The Edit Submenu will appear.

% Edic: 1.Je11 2.4kcripter 3.0heert 4.Drlate 5. copd metwerk G&.Jove Ratwerk ‘

Figure 6.231

4) Press F6 (Move Network).

An alternative method is to enter “M” from the Edit Submenu.

The input screen will appear for entering the source network number that will be moved.

Figure 6.232
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5) Enter the source network number that will be moved and press the Enter Key.

A confirmation message will appear asking whether to proceed.

I
fluvr Network WK to wini? ) ”

Figure 6.233

6) Check the details and press “Y” and the Enter Key. “N" is initially entered so deletion will
not be executed in case the Enter Key is pressed by mistake.

Figure 6.234

i

The network will be moved.

Shortcuts

Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.
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6.6.1 Entering the GOSUB Instruction

6.6 Editing Subroutines

When the same circuit is written often in a ladder program, storing the circuits as subroutines
enables the circuit to be accessed from the ladder program at any time, and the circuit only
needs to be built once. The subroutine circuit will be executed when the GOSUB instruction is
ON. Memory must be alocated to subroutines before editing. Refer to 1. Allocating Memory
on page 6-167 for more details on allocating memory to subroutines prior to editing.

6.6.1 Entering the GOSUB Instruction

1)} Display the Network Edit Screen.
2) Move the cursor to where the element will be entered. ‘

The GOSUB instruction must be executed at the very end of the network. Entries cannot
be input in the area (slashed line area) after the GOSUB instruction.

V
%

In the above situation, the coil is actually entered above the GOSUB instruction so that it
will not interfere with the instruction.

b -+ - - - - - - ]-

R e b

3) Press F8 (SPEC). ‘
An alternative method is to enter “GOSUB” at AR: and press the Enter Key.

A Function Menu like Skip or Subroutine will appear.

Lg A TR TEm YRR *Am Y 2
Figure 6.235
4) Press F2 (GOSUB).

5) Enter the subroutine number and press the Enter Key.
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The range of subroutine numbers is GO0 to G99.

6.6.2 Displaying Subroutine Networks

1) Move the cursor to the GOSUB element.

o L S S e

Figure 6.236

2) Press the Slash Key to display the Command Submenu.

% 1.ilkabase 2. Date 3.0Hit 4.Fearch §.THew £.301) 7 .Brocesser 8.z0sup

Figure 6.237

3) Press F5 (View).

An alternative method is to enter “v” from the Command Submenu.

The View Submenu will appear.

% I‘hﬂ 1.Desc 2.Dindev J.Jark t.Drmark 5.0usp 6.Jote 7.50em B.300n [etumn
|

Figure 6.238

4) Press F7 (Zodm).
An alternative method is to enter “Z" from the View Submenu.

The Subroutine Edit Screen will appear.
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w
6.6.2 Displaying Subroutine Networks cont. ]
5) Press F8 (Zoom Return) from the View Submenu after editing is completed'in order to
return to the original network.

An alternative method is to enter “R” from the View Submenu.

Shortcuts
a) Enter “VM" at AR: and press the Enter Key to display the View Submenu.
b) Enter“Z” at AR: and press the Enter Key, or press the Alt + Z Keys to display the Edit

Subroutine Screen. {Enter “ZR" and press the Enter Key, or press the Alt + X Keys to
return to the Network Screen.)
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6.7 SFC Editing

SFC stands for Sequential Function Chart. SFC is a new PLC language that takes conven-
tional serial sequence control system items written in ladder language and expresses them
as a block diagram similar to a flowchart so that the entire structure can be grasped at a
glance, and so that programming will be easier. Refer to MEMOCON-SC GL60S Design and
Maintenance Manual (manual No. SIE-C815-14. 1)for more details on SFC. This manual can
be obtained at your GL60 sales outlet or business office.

6.7.1 SFC Screen Configuration

The following describes the SFC Screen configuration.

8

Eéw&%ﬂwﬂ LI = |7

Figure 6.239

1) SFC number currently displayed:
The SFC number S000 is used for the currently displayed SFC flowchart and numbers
S001 and on are used for steps.

2) Column and row display for the current cursor position
3) GL60 Operate/Stop Status

4) Database Name:
Displays when a database is selected.

5) Assembly Register:
The assembly register stores input (text and numbers) from the keyboard.
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6.7.2 Displaying the SFC Screen

6) Logic Area

7) Label Area:
Function key menus corresponding to function keys F1 to F10 will appear in the label
area. Various menus can be displayed depending on the operation.

8) Prompt

9) Mnemonic;
The SFC input field is comprised of 10 rows by 8 columns numbered 0 through 8. Since
row 0 and row 9 are used exclusively for From and To, steps and transitions are entered in
the 8 x 8 area from row 1 to row 8.
Rows 1 through 8 are divided into upper {step) and lower (transition) rows. Since all fields
in the vertical direction cannot be monitored on the display at the same time, use the Up
and Down Cursor Keys to scroll through and view other rows.

Actual field size

1 2 3 4 5 6 7 8Ceolumn

_________ 0 Row (From row)
T T-3--4-4-49-41 1Row
F-t-f-1-41-41-1-1- 1 2Row

-1t -1-1-{-1-1-1 8Row ‘

9 Row (To row}

Figure 6.240

6.7.2 Displaying the SFC Screen ‘

The following procedure is used to display the SFC Screen.

1) Select 3. Online from the Main Menu.

HEMOCON-EC GLAL-S0-78
lalisr Lagic hnh'ﬂnt Seftware / Main Manu
Vorsien Z.08 Capyright 1991 YASKAWA FLECTRIC CORFOMITION
Database: Help: <Alt-N)
PMain Menu:
1. Sslect Active PIC
2. OFfline

. Mt

2. Lisc fctive MO
. »
7. Yeilicien

<E> ts Exit te Des
Enter Opcisa: M1
—— ae—— T4 KA

Figure 6.241
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2) Select 1. Program Mode or 2. Monitor Mode from the Online Menu to go online with a
Processor.

Refer to 6.3 Going Online with a Processor for more details on the procedure.

: MENOCON-£C GL48-68-78
Ladder Legic Develepmant faftuers ~ Online Menu
Databany: Help @ <ALe=NH>
evica : D:0M State: STOPPED
NENU Optians

- T
3. On—Line Communicatisns Setup
<Esc? te Retwrn te Pravieus Menu
Enter Optien: i

— X — — ~— = YALKADA =

Figure 6.242

3) Select 3. Sequential Function Charts from the Edit Options.

NEMOCOM-EC CL40/58-78
I Ladder Lagic Dewalspment Seftwire ~ Edit Mewu I
Batabase: W 2 CRLt-H>
Davice .= Dimt E:}:-: STOPPED
EDIY Optiens:

1. Zalact Databaze
2. Networks

. Trace
5. Start/Stop Precessor
. Claar Meme.

7. Cyatam Canf tion
. IEII Edizer -

{Ezc> to Meturs te Frevieus Heny
Enter Optien: W

—— — —

Figure 6.243

The SFC Screen will appear.

NETH NCH P O/TR f
SFC1 'n'n:z nﬁ(‘.‘.} msm 3 2 & 1 a

Figure 6.244
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6.7.2 Displaying the SFC Screen cont.

Moving the Cursor

Moving up, down, left or right: Press the Up, Down, Left or Right Cursor Key.
Moving to the upper left (Home Position): Press the Home Key.

Moving to the lower right (End Position): Press the End Key.

Moving to the left edge: Press the Cirl + Left Curscr Keys.

Moving to the right edge: Press the Ctrl + Right Cursor Keys.

1. Displaying the SFC Expanded-screen

The following procedure is used to display step, action and transition condition circuits,
and to move to the expanded-screen used for macro steps.

1) Move the cursor to element to be zoomed.

"
shar
™
82
Py smosgr myma ) 8 1 3w

Figure 6.245 ‘

2) Press the Slash Key to display the Command Submenu.

1 %i_'g.;.,

1.dfkabaze Z.afc ede 3.[Mit 4.Jsarch 5.Hew 6.Beacerser

Figure 6.246

3) Press F7 (View).

The View Submenu will appear.

] .7
Tone
Uisw: t.0esc 2.Dindew 3.3avk 4.Jamark 5.0unp 6.Jote 7.5eem .zean Detura

Figure 6.247

4) Press F5 (Zoom).
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The screen will shift to a Macrostep expanded—screen.

e

1.d0cabase 2.sfc fede 3.(Mit 4.Bearch 5.]Hev 6. Bracosser

Figure 6.248

If the cursor is at a step, the screen shifts to an action circuit. fitis ata transition, the
screen shifts to the transition condition circuit.

Press F8 (Zoom Retum) from the View Submenu or enter “R" to retumn to the original screen
from the top of the zoom.

Note  Although Zoom Return can be usedto return to the original screen from the location moved to
using the ZOOM command, Zoom Return cannot be used to return to the SFC from the loca-
tion moved to using the GOTO command. Use the GOTO command again in that case.

Shortcuts
a) Enter “VM" at AR: and press the Enter Key to display the View Submenu.

b} Enter“Z” at AR: and press the Enter Key, or press the Alt + Z Keys to move the cursor
to the action circuit.

¢) Zoom return
Enter “ZR" at AR: and press the Enter Key, or press the Alt + X Keys.

~

2. Displaying a Specified SFC

The following procedure is used to move quickly to a specified Edit Screen (Network,
SFC, Subrogtine) by setting an address. .

1) Press the Slash Key to display the Command Submenu.

B |

1.dlcabage 2.afc Toda 3.0Mit 4.Bearch 5.1Hew &.Bracessar

Figure 6.249

2) Press F5 (View).

The View Submenu will appear.

T

b 087
Visw: 1.0ese 2.0indew 3.30rk 4.Dwmark 5.0unp 6.Bers 7. 5pen S.20em Daturn

Figure 6.250
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6.7.2 Displaying the SFC Screen cont.

3) Press F6 (Goto).

The address input window will appear.

Figure 6.251

4) Enter the address and press the Enter Key.

Coil and element addresses are not valid entries. Be sure to enter Lxx, SEGx, Gyx:nn,
SNxx:nn, Sxx, or Txx.

Shortcuts

a) Enter “VM" at AR: and press the Enter Key to display the View Submenu.

b) Enter “GOTO" at AR: and press the Enter Key, or press the Alt + N Keys.

3. Jumping to Marks

The foliowing procedure is used to mark a position in order to retum quickly to the marked ‘
position while editing another location.

1) Move the cursor to the position to be marked.
2) Press the Slash Key to display the Command Submenu.

e a7
TN

‘ 1.d0tabass 2.3f¢ Fede 1.0Hit 4.Jvarch 5. Biew 6.Jrocesser

Figure 6.252

3) Press F5 (View).

The View Submenu will appear.

Pom e

Visw: 1.Dwsc 2.Dindew 3.Jurk 4.Innark 5.Junp C.Jete 7.5een 8.z00m Decurn

Figure 6.253
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4) Press F3 (Mark).
The cursor position will be marked.

The mark position will appear at the lower-left side of the screen when a mark is set.

Marked column number

SFC number with mark arked line number
\\ sonc [ spur
Tons
wi 1.[fesc 2. 3.Zark 4.Jhmark 5.0ump 6.Jote 7. 5een B.zeam Meturm

Figure 6.254

Press F4 (Unmark) from the View Submenu to cancel the mark.

5} Press F5 (Jump) to jump to the mark.

Shortcuts

a) Enter “VM" at AR: and press the Enter Key, or press the Alt + V Keys to display the
View Submenu.

b) Enter“M”at AR: and press the Enter Key, or press the Alt + M Keys to create a mark at
the cursor position.

¢) Enter“J”at AR: and press the Enter Key, orpress the Alt + J Keys to jump to the mark,

6.7.3 Exiting from SFC Editing

The following procedure is used to exit from SFC editing.

1} Press the Esc Key.

A confirmation message asking whether to exit will appear.

Figure 6.255

Ifthe Function Menu at the bottom of the screen is not atlevel 0 (menu initially displayed),

the Function Menu will shift closer to level 0 without a message. Press the Esc Key at
level 0 to operate the Exit function.
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6.7.4 Moving the Cursor on the SFC Screen

2) Press the Enter Key.

Enter “N” and press the Enter Key, or press the Esc Key to continue editing.

The Edit Menu will return.

6.7.4 Moving the Cursor on the SFC Screen

The following procedure is used to move the cursor on the SFC Screen.

Moving the Cursor

Moving up, down, left or right: Press the Up, Down, Left or Right Cursor Key.
Moving to the upper left (Home Position): Press the Home Key.
Moving to the lower right (End Position): Press the End Key.

Moving to the left edge: Press the Ctrl + Left Cursor Keys.
Moving to the right edge: Press the Ctrl + Right Cursor Keys.
Home position

N

(Home)
Keystrokes are
in parentheses.

Left | (CHl+ ) —-— (Ctl« ») wmmmlp! Right

N\

(End)

End position

Figure 6.256

6.7.5 Entering Elements Using Function Keys

Display the Element Menuinthe label area at the bottom of the screen, and selectthe function
from the menu using a function key (F1 through F10). All SFC elements are assigned to func-
tion keys.

F1 (INSTR):  Steps and transitions
F2 (BRANCH): Branches and intersections
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F3 (LOOP): Loops
F4 (TO/FR):  To and From

Example: Entering S001

1) Move the cursor to where the element will be entered.

Figure 6.257
2) Press F1 (INSTR).

The function keys for steps and transitions will appear.

ISTEP  MITEP

fISIEr [emTER ”t " i gr—t“ a

Figure 6.258

Referto Appendix A List of Function Key Menus for more details on elements that will be
displayed.

3) Press F1 (STEP).
Press the Esc Key to retumn to the previous menu.

The element at the cursor position will appear along with a message asking for the ad-
dress.

Figure 6.259
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6.7.6 Entering Elements Using Mnemonics

4) Enter the address and press the Enter Key.

6.7.6 Entering Elements Using Mnemonics

Each element has a unigue mnemonic. Enter the mnemonic at AR: to enter the elemeni.

1) Move the cursor to where the element will be entered.

I'H
w i

S Smober Dyma 1 1 ®©

Figure 6.260

Entries cannot be input or an error may occur at some positions. For more details on the
SFC, referto tems 5and 6 Write Protected ltems in SFC Programming provided in ME-
MOCON-SC GL60S Design and Maintenance Manual (manual No. SIE-C815-14.1).

2} Enterthe mnemonic of the element at AR: (Example: STEP for a step) and press the En- ‘
ter Key.

AR: 3V

Figure 6.261

Refer to Appendix A List of Function Key Menus for more details on elements and mne- ‘
monics that will be displayed.

The element at the cursor position will appear along with a message asking for the ad-
dress.

Figure 6.262 ‘

— 6-104 —




6.7 SFC Editing

m

3) Enter the address and press the Enter Key.

Do not use the same step or transition number twice.

6.7.7 Changing Step and Transition Numbers

The following procedure is used to change step and transition numbers. ’

1) Move the cursor to the step or transition number that will be changed and press the Enter
Key.

A message asking for the reference number will appear.

Figure 6.263

Press the Esc Key to cancel the change and return to the original reference number.
2) Enter the step or transition number that will be changed and press the Enter Key.

The step or transition number will change.

NETR INCH CR
SPC1 -Pm % msm 2 B i 3 a o

Figure 6.264

6.7.8 Insertion

The following procedure is used for a variety of insertions during SFC editing.
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6.7.8 Insertion cont.

Row Insertion: Inserts a row on the SFC Screen.
Column Insertion: Inserts a column on the SFC Screen.

1. Inserting a Row

The following procedure is used to insert a blank row on the SFC Screen.
1} Move the cursor to where the row will be inserted.

A row cannot be inserted if there is no room to insert a row below the insertion position.
Room for at least two rows is needed because two rows are inserted at the same time
with Row Insertion.

Figure 6.265

2) Press the Slash Key to display the Command Submenu.

-

1.dDtabase 2.ufc Fode 3.(Hir t.Fearch S.JHew 6.Drecesser

Figure 6.266 ‘

3) Press F3 (Edit),
The Edit Submenu will appear.

e

Edit: 1.Ja1l 2. d3kcripcors J.edchangs 4.0nsere 5.0nlete

Figure 6.267

4) Press F4 (Insert). ‘
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The Insert Submenu will appear.

Toeg

Lo o7
Inzort: 1. Jeolumn 2.0ow

Figure 6.268
5) Press F2 (Row).

A row will be inserted at the cursor position.

3

=

T
S ES‘
T4 T
L 11 HCH P 0/TR
s ,?rcz "gnm wsm 2 1 3 I a =

Figure 6.269

Shortcuts
a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.

b} Enter“IM”at AR: and press the Enter Key, or press the Insert Key to display the Insert
Submenu.

¢) Enter “IR” at AR: and press the Enter Key to insert a row at the cursor position.

2. Inserting a Column
The following procedure is used to insert a blank column.

1) Move the cursor to where the column will be inserted.,

A column cannot be insérted if there is no room to the right of the insertion position.

Figure 6.270
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6.7.8 Insertion cont.

2) Press the Slash Key to display the Command Submenu.

s

1.d%abase 2.3fc Drde 1.5t 4. Jearch 5. Jiev C.0recossor

Figure 6.271

3) Press F3 (Edit).
The Edit Submenu will appear.

s

Edit: 1.Je1l Z.dJecriptere 3.olkhange 4.[hsere S.Dnlete

Figure 6.272

4) Press F4 (Insert).

The Insert Submenu will appear.

ToEé

bl .7
Inzere: 1.0nlumn 2.0ew

Figure 6.273

5} Press F1 (Column).

A column will be inserted at the cursor position.

E,“’g Isﬂmi?'n-"’o? Eml i a 4 a

Figure 6.274
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Shorteuts
a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.

b} Enter“IM” at AR: and press the Enter Key, or press the Insert Key to display the Insert
Submenu.

c} Enter “iC”" at AR: and press the Enter Key to insert a column at the cursor position.

6.7.9 Deleting

There are several commands available here depending on the type of deletion. Be sure to
select and use the appropriate command.

Delete Element: Deletes elements on SFC and Network Screens.
Delete Column/Row:  Deletes blank rows and columns.
Delete SFC: Deletes the SFC Screen currently displayed.

1. Deleting an Elemeht

The following procedure is used to delete an element or cell.

A. Deleting an Element

1) Move the cursor to the element that will be deleted.

Figure 6.275

2) Press the Slash Key to display the Command Submenu.

L.dlkabaze 2.8fc Jode 3.0d1t 4.Bearch 5,.Jaw 6.Jrecesssr

Figure 6.276
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6.7.9 Deleting cont.

3) Press F3 (Edit).

The Edit Submenu will appear.

s

Edit: 1.Jell 2. dkcripters J.odkhange 4.[nsarc 5.0elete

Figure 6.277

4) Press F5 (Delete).

The Delete Submenu will appear.

006

S0N% a7
Delate: 1.0lemens 2.c01 3.J0lumm €.[bw 5.[age

Figure 6.278

5) Press F1 (Element).

The element will be deleted.

&Grg ,:-rg% ﬂg”a] 1 a 1 a m

Figure 6.279

Shortcuts

a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.

b) Enter“DM" at AR: and press the Enter Key, or press the Delete Key to display the De-
lete Submenu.

c) Enter “SDE” at AR: and press the Enter Key to delete the element.
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B. Deleting an Element with a Branch or Loop

1) Move the cursor to the element with the branch or loop to be deleted.

HE MHEMER A Y e O T O, B0

Figure 6.280

2) Press the Slash Key to display the Command Submenu.

ToNE

) [ soe?
L.dlkabazs 2.3fc Dods 3.[lit 4.Bsarch §.Disw C.Brecesser

Figure 6.281
3} Press F3 (Edit).
The Edit Submenu will appear.

| s

Edit: 1,301l 2.dlkcristore 3.alkhangs 4.0hsart §.Delete

Figure 6.282
4} Press F5 (Delete).

The Delete Submenu will appear,

B

Delete: i.[Hement 2.colll 3.Jolunn 4.[Dow 5. Bage

Figure 6.283
5) Press F2 (Cell).
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6.7.9 Deleting cont,

The element and its branch or loop will be deleted.

Shortcuts

a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.

b) Enter“DM"at AR: and press the Enter Key, or press the Delete Key to display the De-
jete Submenu.

¢) Enter“DEL” at AR: and press the Enter Key o delete the element and its branch or
loop.

C. Deleting a Branch or Loop

1) Move the cursor to the element with the branch or loop to be deleted.

roE M et Y Yuha O Doie Tl Tl

Figure 6.284

2) Press any key between F1 and F4.
The Element Menu will appear. ‘
3) Press F9 if the branch or loop moves up from the transition.

4) Press F10 if the branch or loop moves down from the transition.

Only the branch or loop will be deleted.

Shortcuts

a) Enter “DTB" at AR: and press the Enter Key if the branch or ioop moves up from the
transition.

b) Enter“DBB"atAR:and préss the Enter Key if the branch orloop moves down fromthe ‘
transition.
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2. Deleting Rows and Columns

The following procedure is used to delete blank rows or columns.

1) Move the cursor to the row or column that will be deleted,

Figure 6.285

2) Press the Slash Key to display the Command Submenu.

ji it

1.dDcabese 2,3fc Dode 3.003t 4. Jearch 5.Diew &.[recassar

Figure 6.286
3} Press F3 (Edit).
The Edit Submenu will appear.

g

Edic: 1.0011 Z.dlecriptere 3.eZchange A.0nasrt 5.0 1nte

Figure 6.287

4) Press F5 (Delete).
The Delete Submenu will appear.

L

Belete: 1.Mement 2.colll 3.3olumn 4.0ew 5.[nge

Figure 6.288
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6.7.9 Deleting cont.

5) Press F3 (Column) or F4 (Row).

The row or column will be deleted.

&Tﬁ%%ﬂml 1 ] 3 [} : |

Figure 6.289

Note A row or column cannot be deleted if there is an element in the row or column. Be sure to
delete two rows when deleting a row because the SFC Screen sets a row aside to enable step
and transition input for each row.

Shortcuts

a) Enter “EM” at AR: and press the Enter Key to display the Edit Submenu.

b) Enter “DM” at AR: and press the Enter Key, or press the Delete Key 1o display the De- ‘
lete Submenu.

¢) Enter "DC” (delete column) or “DR” (delete row) at AR: and press the Enter Key to
delete the row or column.

3. Deleting an SFC Screen ‘

The following procedure is used to delete the currently displayed SFC Screen.

1) Display the SFC Screen to be deleted.

NETR INCH O/FR
Pun owoer Bym2 3 4 3 31 0w

Figure 6.290
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2) Press the Slash Key to display the Command Submenu.

=

L.dBeadarn 2.2fc Jede 3.0Wit 4.Bvarch 5.Dew 6.Drecosuar

Figure 6.291

3) Press F3 (Edit).
The Edit Submenu will appear.

s

Edit: 1.3e11 2.dJecripters 3.0Xhangs +.fhaert S.[eleta

Figure 6.292

4) Press F5 (Delate).

The Delete Submenu will appear.

.~

Dalete: i.Mament 2.ce1l 3.Jelunn 4.0ew 5.0age

Figure 6.293

5) Press F5 (Page).

A confirmation message will appear asking whether to proceed with the deletion.

Figure 6.294
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8) Check to see if the contents of the confirmation message are correct, and if so press “Y”

and the Enter Key to delete the screen. “N” is initially entered so deletion will not be
executed in case the Enter Key is pressed by mistake.

The SFC Screen will be deleted.

Shortcuts
a) Enter “EM" at AR: and press the Enter Key to display the Edit Subment.

b) Enter“DM" at AR: and press the Enter Key, or press the Delete Key to display the De-
lete Submenu.

c) Enter“DP"at AR: and press the Enter Key to display the execution confirmation mes-
sage.

6.7.10 Searching

The following procedure is used to search for specified instructions (elements) or addresses.

1. Searching for Addresses

1) Press the Slash Key to display the Command Submenu.

| e

1.d0tabazs 2.zfc Iade 3.JHit 4.Fearch 5.JHev G.Jrecezser

Figure 6.295

2) Press F4 {Search).

A screen for specifying the address will appear. ‘

CPGUP2=2 Addrez:{-3ddr & Inned->ln_truct 1ol Table Search <-<PGDN>
{E.¢) tu Quat Stute e 1n
Sy L.

Figure 6.296

3) Enter the address and press the Enter Key.

Figure 6.297
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M

A confirmation message will appear asking whether to proceed with the search.

() eareh - Fa—
Bitelres. :

CPGUPY-> Adidee < s
¢ty te G

Figure 6.298

4) Confirm by entering “Y”, and press the Enter Key.
Enter “N” and press the Enter Key, or press the Esc Key to cancel the search.

A search will be executed.

Searel 1n Progeess

Hotvarh: SHHH:L

Figure 6.299

The first occurrence will appear, and the cursor will move to that address.

Figure 6.300
Processing after a Search
Editing the network displayed: Press the Enter Key.
(The search will end at that SFC or network.)
Displaying the next occurrence: Press the Down Cursor Key.

- Exiting the search and retumning to the original SFC:
Press the Esc Key.

Switching search screens: Press the Page Up or Page Down Key.

Shortcuts

Enter “S” at AR: and press the Enter Key, or press the Alt + S Keys to display the screen
for specifying the address. '
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6.7.10 Searching cont.

2. Searching for Instructions and Addresses

1) Press the Slash Key to display the Command Submenu.

S0l .7
TN
i.dfkabasa 2.xfc Fede 3.[Bit 4.3earch 5.JHew 6.Jrecessar

Figure 6.301

2} Press F4 (Search).

A screen for specifying the address will appear.

CPGUPY=> Addpenc¢=DRddr B In.t{-3lastra taond=2Eable Sy
<hao > to Quat <hotery Lo Hegan

Figure 6.302

3) Press the Page Up Key.

A screen for specifying the address or instruction will appear. ‘

Ad
I

ctiun

LRGUP: -3 Addrr s ¢-3Add= & Inot<-21n troction<->Iable Search <-<PGDHX
b : {F Crreii> Mo

.
<kser to Quit {knter) to Beran Rove of Cursor

PR

Figure 6.303

4) Enter the address and press the Enter Key.
Move the cursor down.
5) Enter the instruction (mnemonic) and press the Enter Key.

The element mnemonics wifl appear together with instructions at the function keys, and
can be selected by pressing a function key.

CPULED>- > A zL
<E.cd> to guat’

Figure 6.304 ‘
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A confirmation message will appear asking whether to proceed with the search.

Figure 6.305

6} Confirm by entering “y”, and press the Enter Key.
Enter “N” and press the Enter Key, or press the Esc Key to cancel the search.

A search will be executed.

Figure 6.306

The first occurrence will appear, and the cursor will move to that address.

Figure 6.307
Processing after a Search
Editing the network displayed: Press the Enter Key.
‘ (The search will end at that SFC or network.)
Displaying the next occurrence: Press the Down Cursor Key.
Exiting the search and returning to the original SFC:
Press the Esc Key.

Moving the Cursor

Switching search screens: Press the Page Up or Page Down Key.
Address/mnemonic: Press the Up or Down Cursor Key.
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6.7.10 Searching cont.

Shortcuts

Enter “S” at AR: and press the Enter Key, or press the Alt + S Keys to display the screen
for specifying the address.

3. Searching for Instructions

1) Press the Slash Key to display the Command Submenu.

T

Sl o7
1.ixeadase 2-sfc Inde 3.[it 4.Bearch S..B,u . [Jrecezser

Figure 6.308

2) Press F4 (Search).

A screen for specifying the address will appear.

Figure 6.309 ‘

3) Press the Page Up Key twice.
An input screen for entering the instruction (mnemonic) will appear.

The element mnemonics will appear together with instructions at the function keys, and
can be selected by pressing a function key.

CPGUP> > Adin

Figure 6.310

4) Enter the instruction {mnemonic) and press the Enter Key.

Figure 6.311
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A confirmation message will appear asking whether to proceed with the search.

Figure 6.312

5) Confirm by entering “Y”, and press the Enter Key.
Enter “N” and press the Enter Key, or press the Esc Key to cancel the search.

A search will be executed.

Figure 6.313

The first occurrence will appear, and the cursor will move to that address.

Figure 6.314
Processing after a Search
Editing the network displayed: Press the Enter Key.
(The search will end at that SFC or network.)
Displaying the next occurrence: Press the Down Cursor Key.

Exiting the search and returning to the original SFC:
Press the Esc Key.

Switching search screens; Press the Page Up or Page Down Key.

Shortcuts

Enter “S” at AR: and press the Enter Key, or press the Alt+ S Keys to display the screen
for specifying the address.
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4. Displaying a Table of Found Addresses

The following procedure is used to display a table of addresses (instructions) found after ‘
a search is completed.

1) Press the Slash Key to display the Command Submenu.

T 2087
TG
1.iltabase Z.3fc Feda 3.0Mit 4.Fearch 5.JHev 6.0escosser

Figure 6.2315

2) Press F4 (Search).

A screen for specifying the address will appear.

BRI - — J—
Milidre: o : ‘ .
eh <-<PGDN>

<reulty-» addee oo 2Addy B Inged=2lastpec taun
<} .0 tu Quat <EnLae

1

Figure 6.316

3) Press the Page Up Key three times.

A screen for specifying a table search will appear.

Figure 6.317

4) Enter the settings needed for the search, and press the Alt + £ Keys.

e T AL SECL
Ltion  f Specity

o Lpecatw Sesa h - 1
Ar & Turt<=2Instruct tond-3Tahle ararch Cibubsy
<Alt b¥ tu Began

Figure 6.318

A search will be executed.

Srarchoan Progrons

Hetuork: SHdMst

Figure 6.319 ‘
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Occurrences will be displayed in a table after the search is completed.

L . Search Matchar f
Databpse: TESTL Halp: <Alx=H)>
The fsllewing matches wera Fownd:

<{Ese> te Quit

Quick Find: NN J
— T rr— = YATNALA

Figure 6.320

5) Move the cursor to the number that will be displayed and press the Enter Key.
The SFC Screen will appear, and the cursor will move to the occurrence.

Processing after a Search

Moving to the previous or next occurrence from the screen displayed:
' Press the Up or Down Cursor Key.

Stopping at the network displayed: Press the Enter Key.

Retuming to the original network: Press the Esc Key.

Returning to the table: Press the Home Key.

Settings
~ 1) SFC Range
All SFCs: Searches for all SFCs in the database.
Current SFC: Searches only the SFC area currently displayed.

From the cursor position:
. Searches from the present cursor position to the end of the current area.

2) Instructions: Specifying the Element to Find

Specify: The mnemonic will appear. Specify the element to find using the mnemonic.

Example: A Step (H 1)

Instruction:  Specify Mnemonic:

Any: Searches all elements.

3) Addresses: Specifying the Address to Find

Specify: Specifies the address to find.
Any: Searches all addresses.
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6.7.11 SFC Mode Submenu

Moving the Cursor

Moving to the next or previous item: )
Press the Up or Down Cursor Key.
Moving to the next item: Press the Enter Key.
Reversing items: Press the Space Key, or the Left or Right Cursor Key.

Shortcuts

Enter “S™ at AR: and press the Enter Key, or press the Alt + S Keys to display the screen
for specifying the address.

6.7.11 SFC Mode Submenu

The SFC Mode Submenu is a special Command Menu for SFC editing.

PC Mode: 1.Jondition settiny 2.Fimulation 3.Jbed dizplay 4.Jlapsed active time

Figure 6.321 SFC Mode Submenu

F1: Starting Up the Condition Setting Menu.
The F1 function sets conditions for initializing (starting), resetting, and presetting the
SFC. ‘

F2: Starting Up the Simulation Submenu
The F2 function sets simulation status, such as active, disabled and hold, useful for de-
bugging and other operations.

F3: Starting Up the Used Display Menu
The F3 function displays a list of step and transition numbers as well as program use sta-

tus. ‘

F4: Display Time Requirement Chart
Displays the amount of time required for a Step operation.

1. SFC Initialization

The following procedure is used to set startup settings used for initializing and starting up
the SFC program. The SFC will start up when the conditions that are set go into effect.

1) Press the Slash Key to display the Command Submenu.

|t

1.40cabaze 2.sfc Jade 3.[Bir 4.Bearch 5.D0sw 6.Brecesser

Figure 6.322 '
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2) Press F2 (SFC Mode).

The SFC Mode Submenu will appeat.

Pim O

FC Meda: 1. Jenditien weteing 2.Mimulatise 3.Deed dirplay 4.Mapeed active time

Figure 6.323

3) Press F1 (Condition Setting).

The Condition Setting Submenu will appear.

1L

] a7
Condition Setcing: 1.0nitialize 2.0waet 3.Drexet

Figure 6.324
4) Press F1 {Initialize).

A screen for SFC Mode Initialize will appear.

' N REP S riaTUS
I

<AIt=E> tw Save and Exic
i-%st RefE J.Ctatus O [.Ecatus OFF f.Claar Paramsrer

Figure 6.325

5) Enter the reference number that will be the start condition at AR:.

6) Press F1 (Set Reference Number). '
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6.7.11 SFC Mode Submenu cont.

The reference number can also be set by pressing the Enter Key aiter entering the refer-
ence number at AR:.

N AEF & ETATUS
1

<A1t-E> te $ave ani Exit
D.Set Raft H.tratur On T.Srates OFF {.Claar Parametar

Figure 6.326

7) Press F2 (Status ON) or F3 (Status OFF} to select initialize condition ON or OFF.

8) Press the Alt + E Keys to save the settings.

An altemnative method is to press the Esc Key and enter “Y” or “N” when the confirmation
message appears asking whether to save changes.

Note A network that is not SFC must be created in order to turn a specified reference ON or OFF.

Shortcuts ‘
a) Enter “SMM” at AR: and press the Enter Key to display the SFC Mode Submenu.

b) Enter“SCM”at AR: and press the Enter Key to display the Condition Setting Subme-
nu.

¢) Enter“INIT” at AR: and press the EnterKeyto display the SFC Mode Initialize Screen.

2. Reset Setting ‘

Reset Setting inactivates steps in SFC processing (no processing). Multiple settings can
be used for reset conditions.

1) Press the Slash Key to display the Command Submenu.

2) Press F2 (SFC Mode).
The SFC Mode Submenu will appear.

L

Mede: 1.Jenditien setting 2.Bimulatien 3.Iewd dizplay 4.[Elapeed active tinme

Figure 6.327
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3) Press F1 (Condition Setting).

The Condition Setting Submenu will appear.

T 907
) ™
Casdicien Setting: 1.[Qnitialize 2.0ezet I.Dresat

Figure 6.328

4) Press F2 (Reset).

The SFC Mode Reset Screen will appear.

;

STEF WO ~ REGISTER WG

wegnnawnsEF

I

<A1E-E> te Save amd Exit
O-Tex Mors P.Scacus On [.Ceatus OFF T.Clear Paramstor

HUTTHHTH

Figure 6.329

A maximum of 8 steps can be reset per condition, and 64 conditions can be set in total.
5) Enter the reference number at AR:.
6) Press F1 (Set Reference Number).

Press the Page Up or Page Down Key to switch input screens after the 16th reference
number.

Resetting ail condition settings (setting to ALL) initializes conditions and resets all pro-
grammed steps.

7} Press F2 (Status ON) or F3 (Status OFF) to select reset condition ON or OFF.

STEF WO -/ REGISTER MO

H
H

<Alt-E> te Save amd Exic
U-Set Beff J.Itatus On D-fratuz OfF §.Clear Paramster

T
I

Figure 6.330 "
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8) Move the cursor to the setting area for step numbers.

9) Enter the step number at AR:.

If an Input Register (30001 or higher) is setinstead of a step, the step with the register data will
be reset. :

Register Data
[ o001 ! 20 | sozoisset

10} Press F1 (Set Step).

An alternative method is to enter the reference number at AR: and press the Enter Key.

#

STEP W0 - RECIETER NO

{1 -REARERIN > |

i

LTHHTEE RIS

T

<Alt=-E> te Save and Exit
J-$at ftey J.Claar Step 0 3.Clear Paranster

Figure 6.331 ‘
11) Press the Alt + E Keys to save the settings.
Shortecuts
a) Enter “SMM" at AR: and press the Enter Key to display the SFC Mode Submenu.

b) Enter“SCM" at AR: and press the Enter Key to display the Condition Setting Subme-

1

¢) Enter “RESET" at AR: and press the Enter Key to display the SFC Mode Reset
Screen.

3. Preset Settings

The following procedure is used to activate (process) a step where SFC processing was
terminated.

1) Press the Slash Key to display the Command Submenu.

L

1.dfabase 2.sfc Dede 3.J0ic 4. Jearch 5. Biav 6.Qrocusser

Figure 6.332
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2) Press F2 (SFC Mode).

The SFC Mode Submenu will appear.

S w7
e 9
PC Made: 1. Jonditien wetting 2.Jiaulatisn 3.Deed display 4. Napesd active tina

Figure 6.333

3) Press F1 (Condition Setting).

The Condition Setting Submenu will appear.

|t

Condition Swtting: 1. Dhivialize 2.(kset 3.Qreset

* Figure 6.334

4) Press F3 (Preset).

The SFC Mode Preset Screen will appear.

STEP M0 ~ REGISTER WO

El
I'
”
-
»
=1
]

'Y WA

——— m—— —— ——— e e e ——

T
T

<Alt-E> te fava smd Exit
.54t Bot® Tobracus On  J-Sratus OFF 0-Claar Paramster

Figure 6.335

A maximum of 8 steps can be reset per condition, and 64 conditions can be set in total.
5) Enter the reference number at AR:.

Press the Page Up or Page Down Key to switch input screens after the 16th reference
number. i

6) Press F1 (Set Reference Number).
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6.7.11 SFC Mode Submenu cont.

7) Press F2 (Status ON) or F3 (Status OFF) to select preset condition ON or OFF.

ke — - — — — — -

el
k
E

THERLTRERREN

o F%:
[T FERTAT =

HHITHTHI

<ALt-E> te Save and Exic
B.Sat Rafd F.Status On B.Status OFFf 0.Clear Farssetar

Figure 6.336

8) Move the cursor to the setting area for step numbers.

9) Enter the step number at AR:.

If an input register (30001 or higher) is set instead of a step, the step with the register data
will be reset.

Register Data
[ sooot | 20 | S020isset.

10) Press F1 (Set Step).

Ne REF 8 SINTUS STEF WO ~ RECISTER MO

g inlli ON e B — — - — —— —— —e
? e - e ——— ———
4 ——— T e —— et i
- — e —— e ——
- ———— e L e — —— e —
|- S, e ———
§ —emm —— e e —————— ——— e
|- — e ——————
N — e e —————— ——
P — = oS ‘
12— — e o — e ———
13 — e e e —
14 — o T e —— —
15  mm— — —— i — e —— — e —
16 —eem e e i —— — — ——

<alt-E> te Save and Exit
0.tat Sxep J.Clear Stap O D.Clear Paramster
.
Figure 6.337

11) Press the Alt + E Keys to save the settings.

Shortcuts
a) Enter “SMM" at AR: and press the Enter Key to display the SFC Mode Submenu.

b) Enter“SCM" at AR: and press the Enter Key to display the Condition Setting Subme- ‘
nu.
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m

¢} Enter“PRE" at AR: and press the Enter Key to display the SFC Mode Preset Screen.

4. Simulation Setftings

Simulation Settings are useful for debugging programs with SFC simulation operation.

A. Active Function

The Active function activates steps which are out of processing order. Processing auto-
matically moves to the next step.

1) Press the Slash Key to display the Command Submenu.

ke

1.d0kabase 2.2fc Dode 3.0Mic ¢.Bearch 5.Diev 6.0rwcenzar

Figure 6.338

2) Press F2 (SFC Mode).

The SFC Mode Submenu will appear.

i_%_:}- -

IC Mede: 1. Jeadition setting Z.3Hmulatien 3.Dsed display 4.0Mapead active time

' Figure 6.339

3) Press F2 (Simulation).

The Simulation Submenu will appear.

086 087
13
Simulation: 1.Tctive 2.[isable 3.J0)d 4.0vset 5.Haar all 6.0Hic status

Figure 6.340

4) Move the cursor to the desired step.
5) Press F1 (Active).

1

Processing will begin from the step at the cursor position.
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6.7.11 SFC Mode Submenu cont.

Original processing that was in progress will continue unchanged.

Shortcuts ‘

a) Enter “SMM” at AR: and press the Enter Key to display the SFC Mode Submenu.
b} Enter “SSM” at AR: and press the Enter Key to display the Simulation Submenu.

¢) Enter “ACT” at AR: and press the Enter Key to start processing from the step at the
cursor position.

B. Disable Function

A disabled step will not become active even when its turn to execute comes around. The
Disable function disables steps so they will not execute during program editing or other

operations. ‘

1) Press the Slash Key to display the Command Submenu.

S a7
TG
1.d0zakase 2.sfc Dede 3.[Mic 4.Fearch 5.Diew E.[Jreceszer

Figure 6.341

2) Press F2 (SFC Mode).

The SFC Mode Submenu wil! appear.

SO06 a7
TG

P Mode: 1.Benditien setting 2.JHmulatisn 3.Dsed display 4.Hlapsed activa time

Figure 6.342

3) Press F2 (Simulation}.

The Simulation Submenu will appear.

Pom 9o

Simulation: 1,3ctive 2.0Hzable 3.J0ld 4.Jeset S.Feer all 6.[Mic status

Figure 6.343 ‘
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4) Move the cursor to the desired step.
5) Press F2 (Disable).
Press F4 (Reset) to cancel the Disable function.

The step at the cursor position will be disabled.

Shortcuts
a) Enter “SMM” at AR: and press the Enter Key to display the SFC Mode Submenu.

b) Enter “SSM” at AR: and press the Enter Key to display the Simulation Submenu.

c) Enter“DA” at AR: and press the Enter Key to disable the step at the cursor position.

C. Hold Function

If a step on hold becomes active when its turn to execute comes around, active status will
be maintained and processing will not continue untit the hold is canceled.

1) Press the Slash Key to display the Command Submenu.

| s

1.dlabase 2.¢fc Jede 3.0Mit 4.Bearch 5.Jiew 6. Brecaxsor

Figure 6.344

2) Press F2 (SFC Mode).

The SFC Mode Submenu will appear.

S0is 087
TG
TC Meda: 1.Jendicien setcing 2. FHauletion 3.Thed dizplay 4.[lapewd active time

Figure 6.345

3) Press F2 (Simulation).
The Simulation Submenu will appear.

P Do

Simlation: 1.Tetive Z.Bizable 3.Ie1d 4.Deaec S.Blear all 4.54it avatus

Figure 6.346

- 6-133 —



Online Editing
- - -

6.7.11 SFC Mode Submenu cont.

4) Move the cursor to the desired step.

5) Press F3 (Hold).

Press F4 (Reset) to cancel the Hold function.

The step at the cursor position will be on hold.

Shortcuts
a) Enter “SMM” at AR: and press the Enter Key to display the SFC Mode Submenu.

b) Enter “SSM” at AR: and press the Enter Key to display the Simulation Submenu.

c) Enter“HLD" at AR: and press the Enter Key to put the step at the cursor position on
hold.

5. Sinale-screen Editing for Simulations ‘

The following procedure is used to execute the three simuiation operations described in
Simulation Settings, based on a list from the Edit Screen.

1) Press the Slash Key to display the Command Submenu.

Sl an?
by
1.80cabase 2.sfc ikeda 3.0Mic 4.Jearch S.Diew & .Brecenser

Figure 6.347

2) Press F2 (SFC Mode).

The SFC Mode Submenu will appear.

S 5087
T
PC Mede: 1.Menditien setting Z.Bimulatisn 3.Jesd display 4.Hlapsed active tine

Figure 6.348

3) Press F2 (Simulation).
The Simulation Submenu will appear.

e

Simulation: 1.Tctive 2. [iwable 3.0s1d 4.[Jesat S.Ziear all 6.[dit statuy

Figure 6.349 ‘
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4) Press F6 (Edit Status).

The Step Status Display will appear.

8123456799
iu: --

LEsc) te Quit

T-active D~ dirabls ¥ -~ held I - active & hald
1.Jctive 2.[ivable 3.Jald 4.feset 5. lear all

Figure 6.350

5) Select a simulation function from the Function Menu.

The Status Display for all references will appear as follows after settings are entered.

Active Status: A
Hold Status: H
Disabied Status: D

Active and Hold Status: Reversed H

6) Press the Alt + E Keys to save the settings.

Shortcuts
a) Enter “SMM” at AR: and press the Enter Key to display the SFC Mode Submenu.

b) Enter “SSM” at AR: and press the Enter Key fo display the Simulation Submenu.

c) Enter “FORED” at AR: and press the Enter Key to display the Step Status Display.

6.7.12 Displaying SFC Use Status

The following describes the list display for SFG step and transition numbers in use.

tep Ute > H s Ip:<hlc
L2II56TY
ARAAPAN - -

A =~ Nermal Btep (Actisn Circuits) " -~ Macre step (Expanded Uiswd
<Esc) te Betern

Figure 6.351 SFC Use Status Display

- 6-135 —



Online Editing
6.7.12 Displaying SFC Use Status cont.

S001 to S512 are all displayed.

®123456797
= AAAAMRA - -

A - Mermal ttap (Actisn Clrcwits) B - Macre atep CExpanded Ulewd
CEsc) te Beturn R

Figure 6.352

In the above example, steps S001 to S007 will be used in the program. Steps S004 and S007
are macro steps. ‘

Operations cannot be applied to items on the list because the list is strictly for display pur-
poses only. The same is true for the transitions list display.

Transition Use Status

A - Narmal Step (Actiem Gh-m(lé:tg N - Macre step {Expanded View)
&
—

e Peturw
r— VALY —=

Figure 6.353 ‘
“T" will appear at transitions in use.
Displaying Steps and Transitions

The following procedure is used to display a list of all step (S001 to $512) and transition (T001
to T512) numbers and also indicates whether they are in use in a program.

1} Press the Slash Key to display the Command Submenu.

TG

S ae?
i.dtebaze 2.afc Tede 3.[Qdit 4.Bearch S.Dew 6.Qrecenver

Figure 6.354 ‘

— 6-136 —




: 6.7 SFC Editing

2) Press F2 (SFC Mode).
The SFC Mode Submenu will appear.

P 5

BC Mede: 1 Benditinn setting 2.Binulation 3.Meed diaplay 4.Jlapead active time

Figure 6.355

3) Press F3 (Used Display).

The Used Display Submenu will appear.

b

TIN6 L )
Uzed Pisplay: 1.Bkeye used 2.0canzitions used

Figure 6.356

4) Press F1 (Steps Used) or F2 (Transitions Used) to display the respective Use Display
Screen. .

tey Uis Blaylay LE 3 STOFFES CCART (IIENL YEST, — Welp:ZATe—HY

®123456709 W IIMSETEY
T ARARIAN - - 2 wivs el

A - Nermal Step Chctien Clreouits) " - Hacre step CExpanded Uind
* :E-:) te Maturn »

Figure 6.357

<Eac> t» Meturn

Figure 6.358
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6.7.13 Displaying the Active Time Reguirement

Since the Steps Used and Transitions Used are simply displays, individual elements dis-
played here cannot be changed.

Shortcuts

a) Enter “SMM” at AR: and press the Enter Key to display the SFC Mode Submenu.
b) Enter “SUM" at AR: and press the Enter Key to display the Used Display Submenu.

c) Enter“STEPU” for Steps or “TRANU" for Transitions at AR: and press the EnterKey to
display the respective Use Display screen.

6.7.13 Displaying the Active Time Requirement

The following procedure is used to display the time required for a step to become inactive
after it becomes active. :

1) Press the Slash Key to display the Command Submenu.

T

Shhe 07
1.dltabase 2.3fc Iede 3.0Mic 4.Fearch 5. Jiew 6. Jrecerner

Figure 6.359

2) Press F2 (SFC Mode).

The SFC Mode Submenu will appear. ‘

i%d:..,

PC Meds: 1.Jonditien seccing 2.Bimslatisn 3.Teed dizplay 4.Mlapeed sctive vine

Figure 6.360

3) Press F4 (Elapsed Active Time).
The time chart will appear.

A Step is active as long as A is displayed. | indicates inactive status. ‘
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Initially 32 steps ranging from S001 to S032 are displayed. Enter a step number in the
assembly register and press the Enter Key to display 32 steps starting from the number
that was entered.

STEP Al TINECEEC> STEF as1 TIRECSECY
kL 4 1 a.e 2?7 1 .. 0]
02 I .0 pi ot ] I .8
by ] i .0 imy I [N
S 1 "e.a a2 I "a.8
1] I -, 621 1 .e.
Sl I .8 £n22 1 .3
s H [N} 023 1 "t
Sl 1 " s 624 I [N}
o 1 [ K] fwzs 1 N
b o ] 1 040 926 1 [ N]
sl I e.8 R27 1 [ N]
82 I [ N e 1 [ . X ]
L1 k] I [ X} sy I [N
R4 1 -l s 1 X}
hs I [N} a1 1 8.8
= 13 1 LN | $132 1 -h.p
A - fActive Ite I - Inactive Stap
(!u) te Meturn

Figure 6.361

Shortcuts

a) Enter “SMM" at AR: and press the Enter Key to display the SFC Mode Submenu.

b) Enter “EAT” at AR: and press the Enter Key to display the Time Chart.
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W

6.8.1 Displaying the Comment Window

6.8 Displaying and Editing Comments on the Network/SFC
Screen

The foliowing procedure is used to display or edit any instructions or network comments in
Online editing. Comment data is read from databases created in Offline mode rather than
from the memory of the GL60 CPU.

6.8.1 Displaying the Comment Window

1) Open Select Database from the Main Menu or the Online Edit Menu to select the data-
base with comments that will be displayed.

Referto 3.1.3 Selecting a Database for more details on the procedure for selecting a da-
tabase.

2) Press the Slash Key from the Network or SFC Screen.

R B! TTOPIED LT R TESTT AR I |
e
w .............................................................. —r

R
<]
4
E
3
P

El:c C LG 102 MANS  JCMURT N1 FEC ENET {DOT1L
Lua n1'-!]2 m‘I.Ii:l ml“.!i mIJJS 16 .‘Ll'.’ Ewc F“, LOA

Figure 6.362

3) Press F5 (View).

1.d%cabase 2.Jaca 3.[Mic 4.Fesrch S.THew 6.Jeil 7.0recenzer 0.sleep

Figure 6.363
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4) Press F2 (Window) to display the Comment Window on screen,

—
|y .
]

%

3

E

2

Visu: 1.Dasc 2.Dindew 3.Davk 4.Domark 5.Tunp 6.Jeto 7.Zaan 0.zeen Deturn

Figure 6.364

o A B - N e

Visw: 1.Jesc 2.Bndev 3.Turk 4.Dnmark 5.0unp 6.Intc 7.5eem B.zeen [wturs

Figure 6.365

6.8.2 Displaying Descriptors on the Screen

1} Press the Slash Key from the Network or SFC Screen,

)£ C 1 wRT ML PEC EMET W
WE mwa n‘w’? m:ul.‘ﬂ mw'ss | 2T m:'.u? ,m mw! .1

Figure 6.366
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6.8.2 Displaying Descriptors on the Screen cont.

2) Press F5 (View).

1.dkakaze Z.0aca 3.[Mit 4.Jearch 5.JHev 6. Joil 7.Brecezser S.slnep

Figure 6.367

3) Press F1 (Desc) to display the signal descriptors of all addresses on the screen.

When signal descriptors are displayed, that part of the screen is enlarged so the entire
screen cannot be seen. Use the cursor to scroll through the screen.

Press F1 (Desc) again to return to the original screen.

Ulew: 1.Deac Z.Dindew 3.3nrk 4.Inmark 5.0uy 6.Jote 7.30en §.2sem Dnturn

Figure 6.368 ‘

Visw: 1.Desc 2.Dindsw 3.Jark 4.Demack 5.0uny 6.Jove ?.5eam 8 z0em (eturn

Figure 6.369

Refer to 4.4 Editing Comments for more details on the procedure for editing comments. ‘
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Note

(1) The comment data that will be displayed is read from the database created on the hard
disk of the computer. Therefore the database with the target comments must be se-
lected prior to opening the Network or SFC Screen.

{2} Processors with Comment Memory
Comment operations in MEMOCAD-PRO are carried out using all database data,
Therefore even if a Processor has comments, those comments cannot be displayed or
edited.
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6.9.1 Execufing One Scan: Single Sweep

6.9 Controlling Scanning

Briefly, internal processing in a Processor is a matter of executing a program, processing /O,
and then repeating the cycle as shown in the figure below.

Executing a program & Exscuting the SFC
» Executing network 1 to the
maximuem number of networks
[y
IO processing

One cycle of program execution and I/O processing occurs in a single scan.
One scan normally takes about 5 to 10 ms, but it varies with the size of the program.

The following sections describe two functions refated to scans.

1) Single Sweep
Executes just one scan for simulation.

2) Constant Sweep
Sets the time it takes for a single sweep and fixes the scan time.

6.9.1 Executing One Scan: Single Sweep ‘

The following procedure is used to execute a program for one scan, and can be used to simu-
late network operations and calculations. Make sure that the Processor is stopped when
executing a Single Sweep.

1) Display the network or reference (Reference Area) that will be scanned.

2) Press the Slash Key to display the Command Submenu.

f 1.iIcabase 2.Oate 3.0Mit 4.3eerch S.THew 6.Jeil ?.Jescezver D.alinep

Figure 6.370
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m

3) Press F8 (Sweep).

An glternative method is to enter “W” from the Command Submenu.

The Sweep Submenu will appear.

Figure 6.371
4) Press F1 {Single).
An alternative method is to enter “S” from the Sweep Submenu.

A confirmation message will appear asking whether to proceed.

Figure 6.372

5) Make sure that “Y” is entered, and press the Enter Key.
Enter “N” and press the Enter Key to cancel the operation.
A single scan will be executed.

Note (1) I/O Module are not serviced during a single sweep.

(2) Certain measures have to be taken when conducting an actual simulation, such as dis-
abling input relays.

6.9.2 Setting the Scan Time: Constant Sweep

The following procedure is used to set and fix the scan time for a Processor. Scan time is fixed

to minimize fluctuations at times such as during simple positioning control. The following reg-
isters are used while the Constant Sweep function is in use.

» 49998: The target value is entered here.

» 49999: This is the time required for an actual scan.
(in ms, but changes in 10-ms increments)
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6.9.2 Setting the Scan Time: Constant Sweep cont.

These registers are available as long as the Constant Sweep function is not in use.

1) Press the Slash Key to display the Command Submenu.

2) Press F8 (Sweep).
An alternative method is to enter “W” from the Command Submenu.

The Sweep Submenu will appear.

% Swanp: 1.Jngle 2.Jenstant J.calkel

-~

Figure 6.373

3) Press F1 (Constant).
An alterative method is to enter “C” from the Sweep Submenu.

The input screen for setting scan time will appear.

Figure 6.374

4} Enter the scan time and press the Enter Key.

Scan time is set between 10 and 200 ms (10-ms increments). Any input value that is low- ‘
er than the actual scan time will be ignored.

A confirmation message will appear asking whether to proceed.

5) Make sure that “Y” is entered, and press the Enter Key.

Figure 6.375

Enter “N” and press the Enter Key t¢ cancel the operation.

Scan time wil! be set to constant.
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6.9.3 Canceling a Constant Sweep
The following procedure is used to cancel a constant sweep.
1) Press the Slésh Key to display the Command Submenu.
2) Press F8 (Sweep).
An alternative method is to enter “W” from the Command Submenu.

The Sweep Submenu will appear.

f B Sweep: 1. Hingle 2.Jomatant 3.calkel

Figure 6.376
3) Press F3 {Cancel).
An alternative method is to enter “N” from the Sweep Submenu,

A confirmation message will appear asking whether to proceed.

4) Make sure that “Y" is entered, and press the Enter Key.

Figure 6.377

Enter “N” and press the Enter Key to cancel the operation.

5) Constant Sweep will be canceled.
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6.10.1 Displaying the Setup Screen

6.10 Traceback

The Traceback function displays coil ON/OFF status and register values in time-series wave-
forms on screen. It can be used to sample discrete status up to a maximum of 8 points as well

as a set of register values.

= DISLEETE D:B01 TIHNING CL7EH1 FROGRAM Help KALL-H.

REF 8 TRIGGER PMOINT: @ %: 512 ZOOW : X1

T —— —————

A I T Y N A

g!gu

1.ZoonX1l 2.ZooaX4 3.ZoonX1E

Figure 6.378 Example of Discrete VO Sampling

- ISTER [E_J} RBNING GLTBH1 Heip (<A LE-HY

REF & 43818 TRIGGER TOINT: @ X: 512 ¥:0 To0M: X1 = YiBd
o [}

1.ZoowXl 2.ZoonX4 3.ZoanXlE 4.ZoonYl S.2conYLEE &.ZoonTSEd

Figure 6.379 Example of Register Sampling

6.10.1 Displaying the Setup Screen ‘

The following procedure is used to display the Traceback Setup Screen.

1) Select 3. Online from the Main Menu.

ENOCON-SC_CLAB/60.78
Leddar Leyic Develepment Seftwire ~ Main Menu
Gorsier 2.0 Capyright 1331 FASKAWA ELECTRIC CORFOMTION

Database: Nelp: CAle-N>
Main Henur
Sulsct Active PLC
Offlina

1.
2.
. Wt
E. List fctive PLC
- td

7. Urilizias

<E> te Exit ts Dos
Enter Optien:

—— YTASKMM =4 ‘

Figure 6.380
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2) Select 1. Program Mode from the Menu Options to go online with a Processor,

Refer to 6.3 Going Online with a Processor for more details on the procedure,

HEROCON-2C CLAS/60-78
Ladder Legic Devalspment Coftwars ~ Online Menu

Datakaze: Halp & <AIz-H>
Mvice : D:0EN State: LICPPED

MENU Optiens

. niter
3. Go~Line Communicatisn: Setuy

<Esc) te Katurn te Previsus Menu
Enter Optian: IR

Figure 6.381

3) Select 4. Trace Back from the Edjt Options.

I. MEMCCON-EC  GLAR-S0-78
Ladder Lagic Develepment Leftwars ~ Edit Menu ]

Batabase: Halp = <ALt-N>
Device : Dilin State: STOPPED

EDIT Optiens:
1. Eelect Dutadase
Z. Natwerks

6. Claar {
7. Eystam Conf tinn
3. QEI;.HI.:"

. v
3 hﬁnehl Funceiun Charts
+ Start/Akep cCazsayr
Pener:

<Ezc) te Maturn te Frevieus Nemu
Enter Optien: EJ
——— ey — ———— Y E XA

Figure 6.382

The Traceback Setup Screen will appear.

SARMPLING: DISAILE

SAMPLING CYCLE: 8 scans/peine
TRIGCER POITNT: 1 weine

DISCRETE REGISTER
REF 3 L REF 3 TRIGGER

111§

[T

L IVL LN NTYTY B

0-at Comditisn P.Display Discrete L.Display Register

Figure 6.383

6.10.2 Setting Conditions

The following settings must be entered prior to sampling.
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6.10.2 Setting Conditions cont.

+ Reference Number: Sets the reference number to be sampled.

s Trigger Condition: Sets the condition for starting sampling.
« Sampling Cycle: Sets the number of scans per sampling.
» Trigger Point:’ Sets the sampling range.

The following procedure is used to enter the settings above.

1) Display the Traceback Setup Screen.

Refer to 6.10.1 Displaying the Setup Screen for more details on the procedure for dis-
playing the screen.

RECISTER
] REF 8 TRIGCER

CIURSFI S B

0.5t Canditisn J.Disslay Discrots [.Bisplay Fegizter ‘

Figure 6.384

2} Press F1 {Set Condition).

The Traceback Set Condition Menu will appear along with a cursor. ‘

DISCRETE RECISTER
1 3 XEF 8 TRIGGER 3 XEF ® TRIGGER
1

I
1T

§.Senpling 8-Cycls O.Point J.0n B.0Ff A.» §.Clear

Figure 6.385

Moving the Cursor ‘
Moving up, down, left or right: Press the Up, Down, Left or Right Cursor Key.

— 6-150 —



6.10 Traceback

3) Refer to the following items to set conditions.

1. Setting the Reference Number and Trigger Condition

The following procedure is used to set the reference number and trigger condition for 2
coil or register that will be traced back. The trigger condition is the condition for starting a
traceback, and sampling will begin when these conditions are met. Be sure to set whena
certain coil will be ON or OFF or when a register value will be used for the setting. The
setting procedure is described below using an actual example.

The ON/OFF status of coils 00001, 00002, 00003 and 00004 as well asthevalue at regis-
ter 40010 are sampled when coil 00001 is ON set as the trigger condition.

1) Display the Traceback Setup Screen.

Refer to 6.10.1 Displaying the Setup Screen for more details on the procedure for dis-
playing the screen,

mm___rm—-}mmg L THL
- SAMPLING: DISAJLE
SANFLING CYCLE: 8 acans/paint
TRICGER POINY: 1 puine

DISCRETE MCISTER
KEF 8 TRIGGER 2 [ TRICCER

Bynasue |

I
[T

B-Set Cenditien J.Dirplay Discrete D.Display Regizter

Figure 6.386

2) Press F1 (Set Condition).

The Traceback Set Condition Menu will appear along with a cursor,

SAMPLING: DISABLE
EANTLING CYCLE: B scans/paint
TRICCER POTNT: 1 peint

DBISCRETE RECISTER
TRIGGER l s NF3 TRIGGER

e R

-
S
L]

I
il

- tanpling B-Cycle B-Paint 0.0n A.0FF B.w J.Clvar

* Figure 6.387

Moving the Cursor
Moving up, down, left or right: Press the Up, Down, Left or Right Cursor Key.
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6.10.2 Setting Conditions cont.

3) Move the cursor to the first discrete /O position.

RECISTER
L) REF & TRIGGER
1

DISCRETE
L TRIC

1)
o

mymthwar- | 8

I
I

Figure 6.388

4) Enter the discrete address at AR: and press the Enter Key.
AR:

Figure 6.389

The value at AR: will be entered at the reference number at the cursor position.

o] e Fhen | P B
) [—————[ | —
= =
: p— p—
| = =
Figure 6.390 ‘

5) Press F4 (ON) with the cursor at the above position.

ON will be entered at the trigger position, and the trigger condition will be set.

1 . —

DISCRETE RECISTER
] KEF 3 TRIGEER 2 REF 3 IRIGGER ‘
1

Figure 6.391

6) Move the cursor down one line.

DISCRELE KEGISTER
REF B TRIGGER ] REF 3 TRIGGER
oty o 1 pre— ——
I

L LU NI ¥

[HH
1k

Figure 6.392 ‘
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7) Enter the reference numbers for 00002, 00003 and 00004 the same way as was done

with 00001,
) REF g"m'l'il L] BEF F‘u“glﬁl
1 ...} oN 1 r—r— —
- .
; %
(] - pum—
K — —

Figure 6.393

8) Move the cursor to the register figld.

9) Enter 40010 again as was done with 00001.

o| xS o | e EEE

% l% o LR

2 [ ] -

I

3 —— ——

i| — — ’ ’
Figure 6.394

The reference numbers will be set.

2, Clearing Settings

The following procedure is used to change or delete a set reference number or trigger
condition.

1) Display the Traceback Setup Screen.

Refer to 6.10.1 Displaying the Setup Screen for more details on the procedure for dis-
playing the screen.

SANPLING: PISARLE
SAMPLING CYCLE: 8 scane peint
TRIGGER POINT: 1 puint

DISCRETE REGISTER
REF # TRIGGER 2 KEF & TRIGCER
aalin -] 1 a1 -
b :
et -

lend e | o

D-Set Conditien D.Pisplay Blscrete D.¥isplay Megister

Figure 6.395
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6.10.2 Setting Conditions cont.

2) Press F1 (Set Condition).
The Traceback Set Condition Menu will appear along with a cursor.

SANFLING: DISABLE
SAMPLING CYCLE: 8 scans/mint
TRIGGER TOINT: 1 peint

PISCRETE REGISTER
[ H TRIGCER . REFE TRICCER
1 w 1 “eis -
2 -
3 e -
) 1 -
s —_—
H pa— p—
7 - p—
t pm—— p—

O-Swoling §.Cycle B.Peint .00 B0ff B.= §.Clear

Figure 6.396

Moving the Cursor
Moving up, down, left or right: Press the Up, Down, Left or Right Cursor Key.

3) Move the cursor to the reference number that will be cleared.

L] RET 3““:};:@ 3 EEGIHEIW
; [ . :§ D: 1 L1 -
= =

Figure 6.397

4) Press F7 (Clear).

The contents at the cursor position will be cleared.

DISCRETE FEGISTER
3 REF 2 TRIGGER 3 REF B TRIGGER
é SO0 OH 1 40018 A
W
: a4 -
s s, —
1| =
| = =
| = =
Figure 6.398

3. Setting the Sampling Cycle

The following procedure is used to set the sampling cycle (the number of scans per cycle)
within a range of 1 through 65535.

1) Display the Traceback Setup Screen.
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Refer to 6.10.1 Displaying the Setup Screen for more details on the procedure for dis-
playing the screen.

m—_‘ﬁlﬂ_m“———m

SANPLING: DISAMLE
SRMPLING CYCLE: § scanz/puint
TRIQCER POINT: 1 peint

PISCRETE RECISTER
L RET ¥ TRIGCER L] REF & TR1CCER
1 S, o 1 L L) -
2 L] -
3 L] -
; a4 -
H — ———
7 — —
3 PR —

@.5st Conditien 4.Display Discrete f.Pisplay Megisver

Figure 6.399

2) Press F1 (Set Condition).

The Traceback Set Condition Menu wili appear along with a cursor,

SAMPLING: DISABLE
SANPLING CYCLE: § scans/peint
' TRIGGEN POINT: 1 meint

DICCRETE RECISTER
] REF 2 TRIGGER , [ REF & TRICGER
S w 1 ous -
2 -
3 28087 -
4 I -
5 —
. ———
7 ———— —
[ ] e —

D-Sanpling B-Cycle D-Peint 2.0n B.0FF B.» O.Clear

Figure 6.400

Moving the Cursor
Moving up, down, left or right: Press the Up, Down, Left or Right Cursor Key.

3} Press F2 (Cycle).

The input window for entering the sampling cycle will appear.

nnnnnnnn

WARAL W

Figure 6.401
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6.10.2 Setting Conditions cont.

4) Enter the cycle and press the Enter Key.

C I R R

Figure 6.402

The cycle will be set.

SAMPLING: BISARLE
SAMPLING CYCLE: 1 scanz/peint
TRIGGER POINT: 1 peint

Figure 6.403

4. Setting the Trigger Point

The following procedure is used to set the number of points to between 1 and 1,024 when ‘
sampling will occur after the Trigger Condition is met.

1) Display the Traceback Setup Screen.

Refer to 6.70.7 Displaying the Setup Screen for more details on the procedure for dis-
playing the screen. ‘

SANFLING CYCLE: 1 zcanas/paint
TRIGCGER POINT: 1 peiat

DISCREIE RECISTER
REF 3 TRIGCER L) L TRICGER
a1 oN 1 48E18 -
[ ] -
[ -
[ -

LT U FYNEaN ]

.ot Conditisen §.Display bizcrets L[.Dizplay Regyister

Figure 6.404

2) Press F1 (Set Condition).
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The Traceback Set Condition Menu will appear along with a cursor,

SANPLING: DISARLE
LARPLING CYCLE: 1 scans/paint
TNIGGER POIMT: 1 paint

Bt REGISTER
L I REF 3 ‘m{'}lm I ] REF % TRICGER
1 w i e -
i ; :
g L1 -
H —— —_—
? — —
H — ——

D-Sampling B-Cyole f.Peint T.on D.0Ff Y= Z.Clear

Figure 6.405

Moving the Cursor
Moving up, down, left or right: Press the Up, Down, Left or Right Cursor Key.

3) Press F3 (Point).

The input winddw for entering the trigger point will appear.

LICL T FARTNTTS

Figure 6.406

' 4) Enter the trigger point and press the Enter Key.

DISCRETE RECISTER
TRICCER

I

Figure 6.407

The trigger point will be set.

SRNPLING: DITANLE
SMMPLING CYCLE: 1 acans/peint
TRIGCER POINT: 1824 peint

Figure 6.408
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6.10.3 Executing a Traceback

6.10.3 Executing a Traceback

The following procedure is used to execute a traceback to conduct a sampling.
1) Display the Traceback Setup Screen.

Refer to 6.10.1 Displaying the Setup Screen for more details on the procedure for dis-
playing the screen.

e lp: %
SAMPLING: DIGANLE
SAMPLING CYCLE: 1 scans/paint
TRIGGER POIHT: 1024 paise
BISCNETE REGISTER

E ] REF B TRIOCER L REF 3 TRIGCER
1 S o 1 40810 -
2 . -
3 | ] -
4 ] L]
: it -
H p—
H po— _—
7 f— _—

08¢t Gonditien B.Display B [-Piepley Rex

Figure 6.409

2) Press F1 (Set Condition).

The Set Conditions Menu will appear along with a cursor.

CAMPLING: DISABLE
SARMPLING CYCLE:= 1 acans/peint
TRIGGER POINT: 1824 peiat

t] o e o] wer P B
-W

l

\1 1] -

WIPAR W

-Sanpling .Cycle B.Peint 0.0n J.06¢F J.+ J-Clear

Figure 6.410

Moving the Cursor
Moving up, down, left or right: Press the Up, Down, Left or Right Cursor Key.

3) Press F1 (Sampling).

A confirmation message will appear asking whether to proceed.

WIRR N

Figure 6.411
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4) Make sure that “Y" is entered, and press the Enter Key.
Sampling will begin.
When sampling is enabled, the system is ready for a traceback and will wait for conditions
to be met. Once the conditions are met, traceback will be executed and sampling will be-

gin.

A message will appear after sampling is corﬁpleted.

2
i
2
3
s
[
?

H-Fampling §.Cycls P.Peinr T.0n 5.0FF B.» Z.Clear

Figure 6.412

A message will not appear if the Set Conditions Menu is not displayed at the bottom of the
screen. '

5) Press any key to cancel the message.

Note  Sampling will not take place if the Processor is stopped. In that case, return to the Edit Menu
and start the Processor before trying again. Refer to 6.4 Starting and Stopping a Processor
for more details on the procedure for starting a Processor.

6.10.4 Displaying Sémpling Results for Discrete Addresses

The following procedure is used to display the sampling results for discrete addresses.

1) Display the Traceback Setup Screen.

Refer to 6.70.7 Displaying the Setup Screen for more detaiis on the procedure for dis-
playing the screen. .

N CERY -1, COLTTEY  CL7ENT TR Halp=AAIc— N
SAMPLING: DISANLE
SAMPLING CYCLE: 1 scans/peint
TRIGGER POTNT: 1824 peiat
DISCRETE REGISTER

(] REF 8 TRIGZER ® REF & TRIGGER
1 o) o 1 [T -
2 [ -
3 [ -
4 . -
] e —_
i p— —
? — —
. — —

B-tat Conditisn F.Display Bi O.Bisplay Pegister

Figure 6.413

- 6-159 —



S

Online Editing
M

6.10.5 Displaying Sampling Results for Register Addresses

2) Press F2 (Display Discrete).

lf the Set Conditions Menu is displayed, press the Esc Key to return to the previous func- ‘
tions menu (Figure 6.413).

The discrete sampling results will appear.

= DISCRETE D1 RUNNING CLTBH1 FROGRAM Halp XA Lt—H;

Y 8 TRICGEE FOINT: B x=¥512 Z00M: X1
s

I O T T 1 T T O

lggn

1.ZoonX1 Z.ZecnXs 3.ZoomX1E

Figure 6.414

The display of X axis can be enlarged from the function menu.
F1 (ZoomX1): Enlarges 1 time.
F2 (ZoomX4): Eniarges 4 times.
F3 (ZoomX16): Enlarges 16 times.

The enlarged display is much easier to see, such as when changing the ON/OFF status '
every scan.

6.10.5 Displaying Sampling Results for Register Addresses

The following procedure is used to display the sampling results for register addresses.
1) Display the Traceback Setup Screen. ‘

Refer to 6.10.7 Displaying the Setup Screen for more details on the procedure for dis-

playing the screen.
SAMPLING: DISANLE
EAMPLING CYCLE: 1 scans/peint

TRIGGER POINT: 1624 peint

DISCRETE REGISTER
L] REF & TRIGCER 12 L] TRICCER
hea: N L L] -
[ ] -
[ ] -
] -

|RALNE

3.8st Conditisn H.Display Biscrats [.Display Begister

Figure 6.415 ‘
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2) Press F3 (Display Register).

if the Set Conditions Menu is displayed, press the Esc Key to return to the previous func-
tions menu (Figure 6.415).

The registef sampling results will appear.

- ISTER [H.3 RUNMING GL7@H1 FROGRAN Help XA Lt—H>
REF p 40018 TRIGGER POINT: 8 X: §12 ¥: 8 Z00M: X1 = Y188

f

1.2oosX1 2.ZooaX4 3.ZoanX16 4.ZoonYl S.Zoont 108 6. ZoanYSES

Figure 6.416

The display of X and Y axes can both be enlarged from the function menu.
F1(ZoomX1):  Enlarges X 1 time.
F2 (ZoomX4):  Enlarges X 4 times.
F3 {ZoomX16): Enlarges X 16 times.
F4 (ZoomY1):  Enlarges Y 1 time.
F5 (ZoomY100): Enlarges Y 100 times.
F6 (ZoomY500): Enlarges Y 500 times.

1

The Y axis direction does not change appreciably at register values below 100 unless the
display is enlarged.
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6.11.I Executing Clear Memory

6.11 Clearing Memory

The User Memory in the Processor is composed of Program Memory, Register Memory, Al-
location Memory, and Comment Memory for Networks and SFCs. When the data in memory
are not needed, or an error occurs, the memory can be cleared. Please note however that
memory cannot be restored once it is cleared.

The following memory partitions can be selected.

+ Mode Memory

¢ SFC Memory: SFC Screen
Action
Transition
All SFCs

¢ Ladder Memory

+ Subroutine Memory

= |/O Allocation Memory:  1/O Allocation
Link Allocation
ASCII Allocation
High-speed Station Allocation
All Allocations

= Register Memory: Holding Register
Constant Register
Expansion Memory Register
All Registers

= Comment Memory: SFC Comments
Extension Comments
Extension Symbols
All Comments

» All Memory

6.11.1 Executing Clear Memory

The following procedure is used 1o clear memory.
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1) Select 3. Online from the Main Menu.

FEMOCON-£C Wlm
Laddar Legic I-v-hr. Seftwars / Main
Uszzion 2.08 Copyright 1991 YATKAUA ELECTRIC eomlmau I
Databave: TEETL Help: <Mlt-H>
Hain Menu:

1. Eelect le!h-.m
2. Offlina

5. I.in Retive PLC
K. Laadsr
7. Utilivies
<E> ta Exit te Dos
Enter Oyptien: E
— e —— —— Te— YALIAUA J

Figure 6.417

2) Select 1. Program Mode from the Menu Options to go online with a Processor.

Refer to 6.3 Going Online with a Processor for more details on the procedure.

HEMOCON-SC CLAL/S8-78
Ladder Lagic Develagment Eaftwars ~ Osline Memu
Datakaze: TESTL Halyp = <Ale—3>
Device : D:DOS trate: STOFPED
MENU Optisns
niter

3 On-Line Communicatisns $etuy
<Exc> te Return ts Previsuzs Menu
Entar Optiaa: TN

Pu— — —- —————m— YALKAYA =

Figure 6.418

3) Select 6. Clear Memory from the Egit Options,

MEHOCON-SC GLAB/ER-7
[ Ladder Legic Develapment Seftwars ~ Edit Heny
batabaze: TEST1 He <l1t—ll>
vice .: bzl St}’ STOPPED

EPIT Optisns:

; f.:hct Batabiie

3 Eequential Punctien Charts
g Trace Back "

ltu—!/!n Precaszer

[N IEII Editer
<Ezc)> te Moturn te Previsus Menu
Enter Optian: R

— — YASKAVA =

Figure 6.419
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6.11.1 Executing Clear Memory cont.

The Clear Processor Memory Menu will appear.

» Tahls Errer ® TCOF Tebls Evrer
® Actisn Takle Errer ] uuu—.ruasc: I/Pert Errer
8 Tremzitisn Tabla Errer 8 PC Link Allscat
H h:n:-rﬂ " = & 1::';:'9-’ Timar Erve:
» {4 4 i
B User Status Tahls Errer ® Neal Time Clsck
@ User Mewary Confiy Errer 8 ALY Errer

O.%eds B-Flew [-Ladder I -Subreutins B.Traffic Cop B-Data ¥ Comnnent D.A11

Figure 6.420

4) Select the memory that will be cleared from the Clear Processor Memory Menu.

A confirmation message will appear asking whether to proceed.

Erre!
n‘m ‘[lbl: Errer L3
or Howary Canfig Errer # #lll Errer

B.Mede D-Plew [.Ladder LSubreutise J.Traffic Cep B.Data H.Commant J.211

Figure 6.421

5) Enter “Y” and press the Enter Key.
The operation will be executed, and the memory that was selected will be cleared.

Memory cannot be restored once it is cleared.
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6.12 System Configuration

The following procedure is used to define the Processor configuration, I/O Module allocation,
PC Link allocation, ASCIl Module, High-speed Station aliocation and YENET,

1} Select 3. Online from the Main Menu.

TEMOCON SC GLARSB78
Ladder Lagic Develupment Seftwars ~ Hain Memu
Usraien 2.8 Copuright 1301 PASKROM ELECTRIG CORPORATION
Batabass: TEET1 Nalp: <Ale-H>
Main Menu:

1. Selsct Rorive FLG
2. OFfline

. tlan
5. List Retive MO
&, Leadsy
7. Utilicies
<E> te Exit te Dan
Enter Optien: T

v— v—— e YARKAUM

Figure 6.422

2) Select 1. Program Mode from the Menu Options.

| REOCON-SC CLAM/ 6078
Ladier Legic Davalspawnt Seftware ~ Online Haay

Databaze: TESTL Malp : <Alt-H>
Pevica : D:DOO State: STOPPED

MENU Optiens

- nitar
3. On=Line Communicatisns Setup
<Esc> te Meturn te Mrevisus Menu
Enter Optisn: IB

e —— CR— e — YASKAUA =

Figure 6.423

3) Enter the address of the device with which to go online.

MEMOCON-£C Gl4b4n-78
l Ladder Leyic Develspment Safcunre ~ Online Menu |

Databagy: TEET1 Halp = <ALt—H>
Duvice :z D:0OW State: STOPPED

Figure 6.424
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6.12.1 Processor Configuration

4) Select 7. System Configuration from the Edit Options.

MEMOCON-SC CLARER/ 78
Ladder Lagic Develspmant Seftware # Edit Memu
Batabase: TEST1 Halp : <Ale—i>
Device i D:BL $tate: STOPFED
EPIT Optians:

1. Salact Batabase
2. Metuorks
3 Seymaatial Fusctise Chares
4. Tracy Back
§. Start/Step Precesser
6. Clear HNama
tor
<Esc)> to Raturs te Previeus Heau
Enter Optisa: H
= YASXAW =

Figure 6.425

The System Configuration Menu will appear.

Note (1) Retumn to the Edit Menu and stop the Processor before entering or changing settings ‘
from this menu.

(2) Only referencing is available while the Processor is operating.

6.12.1 Processor Configuration ‘

The following procedure is used to set memory, segment allocation and communications port
parameters in the Processor.

Select 1. Processor Configuration from the System Configuration Options.

%’#—"__

HEROGOW-5C CLAR-60-7R
Ladder Legic Devalspmant Saftuvars / Eyeten Configuratien
Database: TEST1 Nalyp = <AN1t-N>
Device = DL State: STOPPED

SYSTER COMPIGUMTION Optiens:

1

4.

5. N Hr'd $tation

[ Pé'l-i.l

7. YENET

(E2¢? te Meturn to Provisus Hemu
Entay Optien:

s —— YASKAUM =

Figure 6.426
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The Processor Configuration Menu will appear

HEHOCON-£C QLAB- 8-
' Ladder Legic Duvelepment Seftware ~ Precezser Configuratisn

Databaze: TEFTL Holp = <ALe-#>
Device : Dx:BBL Stata: STOPPED

FROCELSOR COMFICUMATION Optisns:

!. EO"NCI

3, Pert Faramsturs
4. $yetem Scatuz Allscacien

<Esc) to Roturn te Previeus Menu

Enter Optien: B

Figure 6.427

1. Allocating Memory

The following procedure is used to allocate user memory to action, transition condition,
and subroutine circuits.

1) Select 1. Memory Allocation from the Processor Configuration Menu.

A screen for allocating memory will appear,

Nemary Uzad fvailable Tetal
Ladada; CHT?
Rt h: i w
Iranzitien ] -
Subrsutine -
@

Tetals

IFC Displays
Stape
Transiciens

<Ese)> te quix

Figure 6.428

2) Setthe ladder memory allocation, as well as the action, transition condition, and subrou-
tine circuit memory allocations so they equal the total memory that is available,

[RERSRY SLLSORTTOR D TTOFFEF L7 (ORI WaIp=CATeHS

Bensry Uned Avallable Tetal
Laddar .7 L4585
Actien [ . ] y
Tranzitisn "o .. [
Cubreut ine L] L] =
Tetala L} 4506 R XW
$PC Diapla; L] 63 o]
Stape T 7T i 511 512
Trangitisne L 512 $12

<Esc) ¢t guic

Figure 6.429
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6.12.1 Processor Configuration cont.

Moving the Cursor
Moving up or down: Press the Up or Down Cursor Key.

3) Press the Esc Key after all the settings are entered.

4) A confirmation message will appear asking whether to save the settings. Enter “Y” or “N”
and press the Enter Key.

<Exc’ ta quit

Figure 6.430

The total memory that was set cannot be saved if it is different from the total that is dis-
played. Also action, Transition and Subroutine Memory are a maximum of 16 Kwords.

2. Setting the 2-Level Scans

All networks are divided into a maximum of eight segments. The scan level is setin order
to reduce scan time by setting one segment as a high-speed segment (executed every
scan) and the rest as low-speed segments (number of segments - executed once per
scan).

Set the following in order to execute the 2-level scan. ‘
1) Scan level settings

2) Segment allocation

A. Setting the Scan Level

The following procedure is used to set the scan level. Usually the scan level is setto 1 but
set the level to 2 for 2-level scans.

1) Select 2. Segments from the Processor Configuration Menu.

The Segment Assignment Screen will appear.
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2) Press F1 (Scan Level).

$can Level: 1 Total Netwsrka: 2
Segnent # Ftart End Size
1 1 L4 s

.Ccan Lavel B Delete Segmant [ Add Segmant

Figure 6.431

The Scan Level Settings switch between 1 and 2.

This processing shortens the scan time in 2-level scanning. Refer to MEMOCON-SC
GL60S Design and Maintenance Manual (manual No. SIE-C815-14.1 )} for more details.
Segments can be allocated if the scan level is set to 2.

Note Segments cannot be allocated with GL40S1 , GL4082 or GL40S3 Processors because these
Processors cannot be set to scan level 2.

B. Adding Segments

The following procedure is used to allocate segments.

1} Select 2. Se‘gments from the Processor Configuration Menu.
The Segment Assignment Screen will appear.

2) Press F1 (Scan Level) to set the Scan Level to 2.

3) Press F3 (Add Segment_) to add segment (up to segment #8_).

EEONT TR TR ETOIFED CIwT TR TESTT LD PO s

Scan lavel: 2 Total Netwerka: 2

Zegment ¥ Start End fize
i [ __ 1 [ s
2 -l et
i ) & =

1.Scan Lovel J.Belete Sagwant P.4dd Soymunt

Figure 6.432
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6.12.1 Processor Configuration cont.

Examples of entries when adding segments are given beiow.

Example: Allocating the Following 30 Networks

1 through 10 — Segment 1
11 through 20 — Segment 2
21 through 30 — Segment 3

Operating Procedure

1) Select 2. Segments from the Processor Configuration Menu.

2) Fromthe Segment Assignment Screen, press F3 (Add Segment) once for each segment
added. .

3) Move the cursor to segment 2.

4) Enter the first network number for segment 2.
5) Move the cursor tq segment 3.

6) Enter the first network number for segment 3.
7) Press the Enter Key.

8) Press the Esc Key to save the settings. ‘

Note A segmentthatwas added will be deleted if the Scan Level is changed after the segment was
added.

C. Deleting Segments

The following procedure is used to reduce the number of segments. Be sure to returnthe
number of segments to 1 when exiting the 2-level scan. ‘

1) Select 2. Segments from the Processor Configuration Menu.

The Segment:  gnment Screen will appear.

Scan Level: 2 Tetal Netwerka: 2
Sogmant 8 Start End Size
1
2

a2 BORI5

BaR1

2 3 Bae1
4 ] S0EL

N-Scan Level J.balace Segmant [j.4dd Sepment

Figure 6.433
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2) Press F2 (Delete Segment) to begin deleting segments starting from the largest Seg-
ment Number.

Soan lawel: 2 Tetal Netwerks: 2
Segmant & Start Ead Size

% % [ .. ] a3y
H ) o= =

Scan Level J.Dulete ts. it J.ndd nt

Figure 6.434

3. Setting Port Parameters

The following procedure is used to set port parameters.
1) Select 3. Port Parameters from the Processor Configuration Menu.

The MEMOBUS Port Configuration Screen will appear.

wlp: £
MEMOBUS Pert Made Parity Stop Boud Rddr Delay
1 Even 1 %o [..¥ ..}
2 Even 1 bil. ] [ .] -l
3 1] Even i 7% [} e
4 my Even i 7 (.1 L]
SEst? ¥n gquit
Figure 6.435

2) Move the cursor to the item that will be set, and press the Space Key or press the Left or
Right Cursor Key to switch settings.

| MEMORUS Port Hade Parity Stop Baud Al Delay
| 1 A$CII Even 1 %0 3 "
-
ne
4 LH=H Even i ] [
1
1
CExc)> ta uit
i+
Figure 6.436

-—6-171 —




Online Editing

m
6.12.1 Processor Configuration cont.

3) Move the cursor to Addr (Address) and Delay, and enter these values.

4) Press the Esc Key after all settings are entered.

5) Aconfirmation message will appear asking whether to save the changes. Enter “y” or “N”
and press the Enter Key.

SEscy te guit

Figure 6.437

Parameter settings are given below.

e Mode: ASCIlorRTU

¢ Parity:  None, odd and even ‘
e Stop bits:1 or 2

« Baud rate:150, 300, 600, 1,200, 2,400, 4,800, 9,600 or 19,200 baud

» Address: 1 through 247 (Device Address)
« Delay:  Time from sending to receiving an instruction (10-ms increments)

GL60 Series factory settings for port parameters are given below.

e Mode: RTU

= Parity:  Even

« Stop bits: 1

« Baud rate:9,600

* Address: 1 ‘
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eDelay: 0O

4. Setting System Status Allocation

The following procedure is used for system status allocation to enable CPU error status
as well as the status of all Modules to be monitored even with the CPU stopped.

1} Select 4. System Status Allocation from the Processor Configuration Menu.

SYSTEN EIATUS I

Halp: <Ale—H>

€Exc> co Beturs ts Menu
h1t-E> te Save amd Exit

Figure 6.438

2} Enter the reference number, number of registers, and status table number from the key-
board. :

Reference number setting range:  4xxxx or Rxoo
Number of registers setting range: 1 through 106
Status table number setting range: 1 through 106

| SYSTEN STATUS — ]

fetiva PLEC: Welp: CRle-¥)

REFEXENCE 481 |
$12E ne
TARLE L

+ <Ezc>_  te Return to Manu
<hlt-E) te Save and Exit
e ——

Figure 6.439

3} After the settings are entered, press the Alt + E Keys to save them.,

Note System Status cannot be set unless the Processoris stopped, and System Status Allocation
is only available when GL60H, GL60HT, GL70H or GL70HT is selected.

6.12.2 I/O Allocation

I/O Allocation is used to specify channels, stations, and racks, and to allocate /O status to
each slot. The GL60 and GL70 I/O Sections use a fully independent free location system that
allows any I/O Module to be placed in any slot. Therefore I/O numbers corresponding to the
type of Module mounted in a slot must be allocated to the slot in advance. Referto Appendix D
I/0 Configurations of GL Series for more details on the procedure for configuring I/0 sections
like channels and racks.
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1. Displaying the /O Allocation Screen

The following procedure is used to display the /O Allocation Screen.

1) Select 3. Online from the Main Menu.

C GLARGA- 0
ll nt Seftwars ~ Main Menu
Yerzion 2 - Gomulu l’r!l‘l‘.ﬂ ELECTRIC oum-ﬂm

Databaze: TEST1 Help: <Alt-H>

Main Menu:
1. Select Active FLC
2. Offline

- 3
5. List Active PLC
&. Leadar
7. Btilitier
<E} te Exit te Des
Enter Optien: B
| e — e e— Y ASKAUA

Figure 6.440

2) Select 1. Program'Mode from the Menu Options to go online with a Processor.

HENOCON-SC CIAR G- TR
Ladder Legic Devsleyment Esftwars 7 Online Henu
Database: TEET1 Nelp : CAlt=-H>
Davice : D:0WR Stats: STOPPED
MENU Opcisn:

. tor
3. On=Line Communicatisns Setup
{Ezc> ko Baturn te Previeus Femu
Enter Option: KB

YASKAUA =

Figure 6.441 ‘

3) Select 7. System Configuration from the Edit Options.

== ——————————— e 1

AENOCOM-SC CLALER/78
Ladder Lagic Develayment Ssftwers / Edit Mesw

Database: TESTL Halp = {Plt->
Device 3 DL Scate: STOFFED

EDIT Optisns:

1. Solut Database

2. Matwe

a ;-mnthl Tunctien Charts

5. Start/Stap Frecesver

6. Clear Hemar

i. EE!H mnr

<Esc)> te Betwm te Previeus Menu
Entar Optien: W

Figure 6.442
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4) Select 2. I/0 Allocation from the System Configuration Options.

WENOCON—£C CL48%0-7
L Lidder Lagiz Davalepment Seftwars Syaten Canfiguratisn

Databass: TESTL L] 3 LAdE=M>
Devica i Diewl e NS

SYSTEN CONPICURBATION Optisna:
1. Pracarser Canfiguratisn
. t
4. 85CI1 Heduls Allacatien
5. lt'h—cr-d Statien
6. FC Lin
7. YENET
<Eze> to Rotwrw to Frevieus Mesy
Enter Optien: B

N——— — —_— YASKAUA o

Figure 6.443

The I/O Allocation Screen will appear.

= INPUTE s CHAMKEL: 1 meK: 2
DISCRETES RECISTERS

sLOT REF 3 POINTE  CAXD XEM 3 SIZE | oamD

1 ] . — — » —

4 e . —_— — 8 —_—

s — . —_— — 8 o

H —_— 5 — — » _—

{Ese> te quit

Figure 6.444

2. Setting Channels

Channels and stations must be specified for remote station I/Q allocation. Channels can
be specified from 1 to 3 (2 and 3 are remote stations). The following procedure is used to

display stations on screen when channel 2 orhigher is set. (There is no station at Channel
1)

1) Press F4 (Channel) from the I/O Allocation Screen.

== [NPUTE wn CHANKEL: 1

DILCRETES
MEF 3 NI=I'8 nkp

<Esc> te quit

140 Cards §.Bescripters 0 Belsre J.Channel J.Stacisn J.Rack . $tatun J). Oukpnts)

Figure 6.445
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6.12.2 1/0 Allocation cont.

2) Enter a channel number (2 or 3) and press the Enter Key.

o JHPUTE e CHANMEL: 1 mex: 3

Figure 6.446

The screen will switch to the channel number that was selected.

DT H €
sa INFOIS == CHRMMEL: 2 SIATION: 1 RACK: 1
DISCRETES REGISTERS
$LOT REF 8 POINIE CARD REF 83 SIZE ARy
. | - [ S — . —
] — H —_— — 8 —
3 — H —_— Ju— 1 —
4 —— ] — —— . —
5 —— . — — N -
& ——— » — —_— ] —
] —_— . — —— . —
[ — " — ——— . —_—
<Esc) te quit
[.1/0 Cards §.Descriptars J|.Delets J.Channal J).Stacion J.Rack J.3tatus J).Outputsl ‘
Figure 6.447

A rack must be specified if muitiple racks are used.

Refer to Appendix D I/O Configurations of GL Series for more details on the procedure for
configuring remote l/O.

Channels cannot be set for the GL40.

3. Setting Stations

Channels and stations must be specified for remote station I/O allocation. A maximum of
31 stations can be specified per channel. The following procedure is used to display sta-
tions on screen when channel 2 or higher is set. (There is no station at channel 1.)
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1) Press F5 (Station) from the 1/Q Aliocation Screen.

H H{13

we [NFUTE we CHANNEL: 2 STATION: 1 MACN: 1
DITCRETER REGISTERS

til&'.l’ REF B Nl=‘l’3 =1 Lk ] I=ZE Calp

2 Jp—

2

4

L]

& -

7 ——

] ——

<Ese) ta yuit

170 Cards 3.Descripeers [.Delete J.Chanasl J.Station 3.

Figure 6.448

2) Enter a station number (1 through 31) and press the Enter Key.

ws IMNIS = CHAWNEL: 2 EIATION: 11 mcx: 1
BISCRETES REGISTERS
sLoT REF & MOINIE  CARD REF B SI12E CARD
1 | ] ' — —_ —_—
2 p—— . —— —— 1] —r—
i ———— " — —_— . ———
4 — . —— —_— [ —
5 — ] — — ] —
H — s — —— . —
? —— . — —_— . ——
] — s — ——— H ———
CEzc) te quit

-Channel J.Sxatien J.

Figure 6.449

A rack must be specified if multiple racks are used.

Refer to Appendix D I/O Configurations of GL Series for more details on the procedure for
configuring remote I/Q,

r

Stations cannot be set in the GL40.
I

4. Setting Racks

The following procedure is used to specify up to five racks for channel 1, and up to four
racks for channels 2 or 3. The GL40 does not have channels 2 and 3, so only up to four
racks are specified.

1) Press F& (F{aék) from the I/O Allocation Screen.

+
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W
6.12.2 I/'0 Allocation cont.

Press the Page Up or Page Down Key to change racks. Rack numbers increase or de-
crease by one each time the key is pressed.

we INFUTE wu CHAMNEL: 2 STATION: 11 mcK: 1

"
-qnmnuuhg

{Esc> te quit

1/0 Cards J.Descripters [l.Delete f-Channel J.Stavien J.Rack § States ]I Owtputsy

Figure 6.450

2) Enter a rack number (1 through 4).

o INPUTE o= CHANMNEL: 2 SIATION: 11 MACK: 1
DISCRETER RECISTERS

Sll&'l' KEF 3 POI!II cakb [ S{ﬂ CARD

2 PRy ——— S — T p———

3

g “ . Entey Rark Munbuer to Edit

e

?

1

<Ezc> to guit ‘

I1/0 Cavds §.Descripters fl.Pelste Jl.Channel J.Stacien J.Back § Statur J.Outputs:

Figure 6.451
3) Press the Enter Key.
we THMITIE wu CHANMEL: 2 STATION: 11 MCK: 3
SLOT XEF & ngﬁgn CAKD KEF 2 usﬂgm GARD
i - T - ! i
a —_— . —_— —_— ———
H fa— ! = _— )
] p— ! = -—_— _
H _= Y = - 3 ==

<Exc? te wuit

1,0 Cards J.Dwscripters f.Delsts J).Channel J.Ztatism J Rack J.Status J.Outputs|

Figure 6.452

5. Switching between Input and Output Screens

The foliowing procedure is used to switch between Input and Output Screens.
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1) Display the I/0 Allocation Screen.

2) The screen switches between input settings and output settings each time F8 is pressed.

i

6. /O Allocation

I/O Allocation describes various aflocation procedures.
Allocation items are described in the following order.

1) Setting reference numbers for registers

2) Setting number of registers

3) Entering /O card descriptions for registers

4) Setting reference numbers for discrete I/O

5) Setting number of discrete /O

6) Entering I/O! card descriptions for discrete I/O

7) Displaying the allocation status list

7. Setting Reference Numbers for Registers

The following procedure is used to set reference numbers for registers,

1) Move the cursor to the register setting for Slot 1,

Moving the Cursor
Moving up or down: Press the Up or Down Cursor Key.
Moving left or right: Press the Tab Key or the Shift + Tab Keys.

2) Enter the address and press the Enter Key to move the cursor automatically to Size,

we INPUTE we CMANNEL: 1 MCK: 1

BISCRETER REGISTERS
sLoT REF 8 POINTE CARD REF R LIZE CRRD

1 — s — [
2 — ] — '3 ——
3 — . —— — . —

4 — ] ———— — . —
s —— 1] —— ——— . rr——
3 r— 1] —— ——— H —r——

<Esc)> ta quit

H.170 Cawds E-Pescriptere §].Balste J).Channal B:.Station J. Rack B-1tares D Outputel

Figure 6.453
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m

6.12.2 I/0 Allocation cont.

8. Setting the Number of Registers
The following procedure is used to set the number of registers.

Enter the number of registers and press the Enter Key.

The cursor will move automatically to Card.

A RILSCRTTo Bl STOPFED GL7OWT JRUBEL TESTL  Welp=<Ale—W]
=e JNPUTE CHANMEL: 1 MCK: 1
PISCRETES REGISLERS
SLOT & POINIE OARD XEF & EIIE CARD
1 —m ¥ —_ k% w ——
2 —_— . — —_— ——
3 [ » —— — E] ———
4 —_— » — — ] ————
5 —_— » — — ] ————
& —_— » ——— — H] ——
<Esc> te Quit
140 Caxds J.bescriptere J.Deiets Jl.Channel J.Statisn J.Rack §.Status J.Owtputs]

Figure 6.454

9. Entering I/Q Card Descriptions for Registers

The following procedure is used to enter names for I/O Modules mounted in siots. Be sure
to select a target database first since Module data is stored in a database.

1} Press F1 (/O Cards) from the function label.

an INPUIS e CHAMMEL: 1 MACK: 1
DISCRETES RECISTERE
$LoT REP B MOINIS  CAKD REF 8 SIZE CARD
i — [ — L) s
3 e a — —— . p—
4 m—— 2 —_— —_— . —
5 — 1 —_— —— a JE—
& ——— ) —— —m—— ] —_—

Description: JAMGC-I2701 Begister input:iéhics x §

<Eze> tw quit

.50 Cards §.Buscwiptsrs [J.Dulete J.Channel J.Etacisn J}.-Rack § Statua Jl.Outputs] ‘

Figure 6.455

2) A list of /O Cards will appear. Move the cursor to the desired card and press the Enter
Key.

1/0 CARD DESCRIFTIONS

22 JANSC-B2INZ hhy 32~paint ulgt: 240DC. L1R220UAC
2384 JAl 984 Bestact re (Ihlnl 1“/’ uwwzztnc
Jﬂm—n!:l.l Io:t-:t. r.h BUDC/F2M0AC

AR T
T
- ' 3 n-m-enr type
G—l! g utput I.ihits x
n7ie JAREC-E2T10 Rey autput:1bhits x l(nnn-el e Sypad
JAREC-B2783 #naley inputiA/D): to w184, 4]
n73 JAREC-] naleg laput<A/BY:~10U ta +10U 8 circuits
JRAEC-| inaleg iaput<A/Dd: 4 to 20mh, 3
n JARRC-R2' bnaley sutput(DAY: B to «IM), 2
nn: JANSC-E2712 Amaley sutput<DBA>: @ te *5U. 2 ¢
JAREC-§2 lag sutput<D/R>: -5 to *5¥. 2 ¢
272 JANEC-B2732 Analey sutput{D/Nd:-iB te +«1M.Z c
M2 JAMEC-] lsg ntplt(M) 4 ta 20mh.2 ¢
{Pglp> Prav (PyDnd> Next
CEntar> ta Select an 170 Card <Ese? za quit
n:[/ —T— utputs ‘
Figure 6.456
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Al VO Cards are stored in the list, and can be selected from the list.

Card descriptions will be printed as slot data when allocation is printed using the printing func-
tion,

10.Setting Reference Numbers for Discrete i/0

The following procedure is used to set reference numbers for discrete I/O.
1) Move the cursor to the discrete 1/O for slot 1.
2) Enter the address and press the Enter Key to move the cursor automatically to Points.

The xxxx paﬁ of the address (1x00¢0r 0xxxx) must be in the form of (8xn+1).(n=0,1,2,
etc.)

s INPMUTE we CHANMEL: 1 mcx: 1
BISCRETES REGISTERS
sLOT REF & POINTE CARD REF &SI CARD
é — = — et = na
3 Ky | — —_ [——
i — . —_— — s —_—
s _— H e — —] J—
6 J— . pu— —_— r—

CEmc> te quit

.Delste {l.Channel J.Statien J.Rack f.Stal

Figure 6.457

11.Setting Discrete /0 Points

The following procedure is used to set discrete /O points.

Enter the point and press the Enter Key.

Discrete /O points must be multiples of 8.

The cursor will move automatically to Card.

mipt +

= INPUTE ws  CHAMMEL: 1 mACK: 1

DIsexETES RECISTERS
sL0T KEF 3 CPOINTS  Canb MEFs SIZE Gamp
1 —_— $ e S
AEEC N -
4 —— F — — . —_—
5 —_— - _— 1 —
‘ — . — — s —

<Esc> te quit

Figure 6.458
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#

6.12.2 1/0 Allocation cont.

12.Entering /O Card Descrip_tions for Discrete 1/Q

The following procedure is used to enter descriptions for IO Cards mounted in slots. Be
sure to select a target database first since /O Card data is stored in a database.

1) Press F1 (I/O Cards) from the function Jabel.

A list of 1/O Cards will appear.

=
1,0 CARD DESCRIFTIONG

<Pgbn> Mext
<Entar> te Exlect s 1,0 Card <Exc> te yuix

A ———

tputs|

Figure 6.459

2) Move the cursor to the desired Card and press the Enter Key.

The I/O card description will be entered at the siot that was selected. ‘

- [NMUTE w= CHAMNEL: 1
DISCRETES

REF & POINTS

1 16

B
¥
8
B
M

L1111 U
- it
i

wnauuhg
-

<Ezc> te wuit

L.IN Cards §.Devcripters f.Delete J.Channsl J.Statisn J-Rack ). Seatus . Outputs

Description: JAMGC-EZ5N) 288 UAC 16-paint input ‘

Figure 6.460

All VO Cards are stored in the list, and can be selected from the list.

Card descriptions wil! be printed together with the allocation when the allocation is printed
using the printing function.

13.Displaying the Allocation Status List

The following procedure is used to display a list of points used, maximum addresses, and ‘
other information for discrete /O and registers.
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1) Display the IO Aliocation Screen.

Referto 1. Displaying the Allocate /0 Screenon page 6-174 for more details on the pro-
cedure for displaying the I/O Allocation Screen.

2) Press F7 (Status) to display the Aliocation Status List.

Figure 6.461

6.12.3 Individual PC Link Allocations

Individual PC Links are allocated in the Online Mode. individual allocation is for PC Link Sta-
tions connected to a computer, and it can also be used for a standalone station that is not
connected to another station through PC Link. Referto 4.5.3 PC Link Allocation in the Offline
Mode for more details on PC Links.

The cable from the computer may be connected to either the IOP or Link (iF64) port on the
Processor. Allocation is also possible even without an IF64 Link Module connected to the sta-
tion (Processor). Be sure to stop the CPU.

1} Go online with the Processor,
Refer to 6.3 Going Online with a Processor for more details on the procedure.

2) Select 7. System Configuration from the Edit Options,

EE_—E_—'_'T—-——?_—'M’—?

MEMOCON-EC  GLALS 078
L Ladder Leyic Davelopment $aftware ~ Edit feny ]
Databasze: TESTE e = <Ale—d>
Bevice ¢ D:BEL b =
EDIT Oytiens:

+ Salact Database
Fo o rlcn
Sequantial Functien Charky
race Back
« $tart/itep Precesser
Clear Mensp

MLl

ol
(Esc> to Meturn te Previews Hesw
Enter Optien: B

E; — — — YATEAM J

Figure 6.462
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M
6.12.3 Individual PC Link Allocations cont.

3) Select 3. Link Allocation from the System Configuration Options.

KEMOCON-5C GLALS8-78
Ladder» Legic Develspmant Seftwars / System Configuratiss

Databsse: TESI1 Muly : CAlc-N>
Device : D:mil State: STOPPED

SYETEM CONFIGURATION Optiens:

1. Pracezzer Configwravisn
2. 1A Allecatisn

3. Mih-apeed Sratisn
N It
g 1 "

$: 7
CEzc) te Matwrn te Previews Menc
- Enter Optien:
—_— e sm— YA KA =
Figure 6.463

The Allocate PC Link Screen will appear.

BDISCRETE AECISTER BISCRETE REGISTER
s | mPx rolwrs MEME  SIZE » | mrm PolNt XEFR SIZE
3 = — RS 17 — — —
F] — — —_—— m—— 19 —_— —— e
3 — — — — 19 — —— —
4 — — e — 20 —_— — —
5 — — — — 21 — m———— — ——
& — — e —— 22 —_— — —— —
7 — . — 23 — — ——
] —_—— — —— 74 —_— — ————
'] — a— — — % — — —— —
1| — m— —— — % — — —_— -
¥l — =— — =T |l = = =
12| —em——— —_— 28 — — —_—
13 —— — — — 2% — —— — amma
14] —— — — 38 —_— —mam _—
IS} mmm—— —_— n —_—— — —
# - —— —— T Bl == = =

<Alt-D> Delete paramster <Esc) Piaish ‘
Figure 6.464

The allocation process will be described here using the following items.

1. Reference Numbers for Discrete I/O

The following procedure is used to allocate discrete reference numbers for all stations. ‘

1) Move the cursor to the discrete 1/O of the station that will be aliocated.

f—COF LIRK Sil TTOPFES 7M1 GIDRAL YESTi  Relp:tAlt—+]
DISCRETE REGISTER DISCRETE REGISTER
] REFE POINIS EREFE  S1ZE L2 REFE POINTE SI1ZE
1 [ — m— 17 — —— —— ——
2 — — — 18 —_— m— —
3 — —— — — 1% —— — —_—
4 m— — —_—— m — — —— m—
5 — — — — 21 — — — m——
& — — — — 22 ——— —— —_—
? —_— — —— — 23 — —— —_—
] —— —— — 24 — — —_—
] — s —— — 25 —— — —_—
18 —— == — —— 26 —— — —_—
W — = = | Bl = ==
12 — — — —— 29 —— ———— — ——
13 ——— —— — 29 — — — —
14 — — —— r—— E ] mm— — — —
15} —m — mm— ——— k1 ——— — —_— —
16 —_— —mm— — 2 —— — —_—
<A1t-D> Delste paranster <Euc) Finish
Figure 6.465
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2} Enter the reference number and press the Enter Key to move the cursor automatically to
Points,

The first address at all stations must be in the form of (16xn+1).(n=0,1, 2, etc.)

F=5F LIRY — R IYOFFED [HA, mm TEETT Fe Iy R IT—N )

MECRITE XEGISTER BISCRETE REGISTER
3 REPR PFOINIS NXEPE CIZE £ ] REFE FOINTS KEPR  SIZ2E
1 DO —_— —— 1?7 — — — —
el — - | = — == —
] —— m—— —— m— 19 — —— —— ——
4 —— r—— — n — — — r—
13 r— — —— Fh — —— — —
& — — 22 — — ——
? — — —— — 23 —_— —— — —
. — —— —— —— 24 — — .
’ _ e —— 2| e e c— —
18] ———  —— —_— — 3 r— — — —
11f ———— ——— —_— — 7 — —— — —
Bl — = — = || = — —
1} ——— m— —_— ——— 29 — — —_— ——
== == |3l == —= =
15| ——— —— — — 1 — —— —_—— —
B =" == | = = =

<Ple=B> Dalaze Paranscer {Ezc) Finish
Figure 6.466

2. Discrete I/O Points

The following procedure is used to allocate discrete /O points for all stations.
1} Move the cursor to the point that will be changed.

The discrete I/0 points used with PC Link are D000 to D1024. Enter the number of
points (multiple of 16) for each station so it falls within the above range.

2) Enter the reference number and press the Enter Key to move the cursor automatically to
“Ref #" (reference number).

mw—_—'?m—nmﬂ'ﬂu_—m
DISCRETE RECIETER DISCRETE RECISTER
* XEPS POINTS REFE EIZX [ REFS POINTE REM §IZE
. ; Desel M2 EEEEN —— i: — — —— —
3 —— — — 19 —_— m—— —_—
4 —— —— — Y —_— — —_— —
5 —_— —— 24 — — —_— m—
5 — —— — — 22 —_— R —
7 — — —— ———— 23 —_— —_—
+ — e D T | — — —
[ R i — 5| — — = =
W —— —_— —— —— 26 — —
1] —— —— —_—. 27 | m—— —— e T
12| ——— e —_—— | — — e 2
NI — — - 29 | ———— e
14 ——— —— —. | — — .
18] —— - — —— 31 —_— — ———
W — — o 2| — — = =
<Rle=D> Dalate parangter CEzc) Fimizh
Figure 6.467

3. Setting Reference Numbers for Registers

The following procedure is used to allocate register reference numbers for all stations.
1) Move the cursor to Register at slot 1.
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e e e
6.12.4 Batch PC Link Allocations

2) Enter the address and press the Enter Key to move the cursor automatically to Size.

DISCRETE KRECISTER DESCRETE REGISTER
E ] REFR MINIE SI1ZE L ] POINTE XEFS $I1ZE
1| vewn ez —_ | = =— — —
3 —_— - —— ——— 19 — — —
| === 0=m= |8| == — =
5 ——— - —_— —— 21 —— —— — m—
& it — ———— 22 —— — — s
? —_— e — —— 23 — —— — mm——
Il —_— — — 24 —— —— —
. —_— — — 25 —— — m—
8 — e — —— 26 — — —_— m—
1| — —— — — 27 — — —— —
12| —— - —_— Fil —— — — m—
13| e m— —_— — 29 —— — . —
14 i —— —_—— n —— — —— —
15 —=— —_— 3 ——— — — —
16] —— —— —— 3z — — —
<Alt=B> Dalats TP <Exc> Finizh
Figure 6.468

4. Setting the Number of Registers

The following procedure is used to set the number of registers.

Enter the number of registers and press the Enter Key.

The cursor will move automatically to “Module”.

F—COF LIRK LE ] TTOPPFES  CLPWT RN YESTE e Ip=<A oW
DISCRETE TEGISTER DISCREIE RECISTER
3 REPS POINIS NEFR SIZE L] REFE POINTE REFE  STIZE
é DO 8832 mesi TIVER i'.} — — mm— ——
k] ——— —— —_— —— 1% —_— mm—— — —
4 —_— —_— F 3 —_— —— — —
== == | 8| == = =
& —_— — — — 22 —_—— — —
] — — —_— — 23 —_— — —— —
[ —— —— —— — 24 — — s —
] — —— —_— e 25 —_ e — —
| —— - —_—— 24 — — —— —
11 —— —— — — 27 —_— — —_— -
12] — — —_— 21 —— — —
13 — — —_— 29 — —_—
14] —= — ——— 38 —_— — —_
15 — ——— —— 1 — — ——
18] i —— —_— 2 —_— - ——
<R1t-B> Delets parimater {Ezc) Pinizh
Figure 6.469

Changing settings: Press the Tab Key to move to where a change will be made, and enterthe
change. ‘

Deleting an entry: Move the cursor to the reference number or number of registers to delete,
and press the Alt + D Keys.

After entering the settings, press the Esc Key to save changes and exit.

The register range used with PC Link is R0001 to R1024.

6.12.4 Batch PC Link Allocations

PC Links are allocated in batches in Online Mode. Batch allocation is when all stations on a

PC Link Network are allocated using one computer, and it allows specified stations or all sta-
tions to be aliocated at once. The cable from the computer must be connected to the IF64 Link
Module port on the Processor, and the station that will be allocated must be connected by Link
Cable to the local station. Allocation cannot be performed if other Programming Panels are ‘
online with the stations that will be allocated.
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“ﬁ
Refer to 4.5.3 PC Link Affocation in the Offline Mode for more details on PC Links.
1) Select 2. Program Mode from the Main Menu to go online with a Processor.

Refer to 6.3 Going Online with a Processortor more details on the procedure. Here any
Station Number on the PC Link can be specified as the address.

2) Select 7. System Configuration from the Edit Options.

PMENOCON-£C GLAL G879
| Laddar Legic Develepment $eftware ~ Edit Mesy —l

Patakaze: TEST1 Haly = CAlt-N>
Devics : DML State: STOFFED

EBIT Optisnz:

+ Salack lutnhn
+» Hatwarks
..mml Punctian Charty

t.rtlt:o) Preacessor
Clesr Mo

. fadal TN
N

ter
<Esc?> te Mmtwen te Previsus Heny
Entar Optien: -]
e—— T— — TRIKAWA

Figure 6.470

3) Select 6. PC Link from the System Configuration Options.

NENOCON-SC CLAB G078
. I Ladder Lagic Develepmant Leftuare Ewvetan Configuratisn —I

Batabasa: TERT1 delp 1 CALE-M>
Device : D:bld State: STOFPED
SYSTEN COMPIGURBMTION Optiens:
- Frocasser G-nfimtiln
g Ilohllht: 't im h
4. ALCII Ih&ll.l f1llecatise

5, Iiil-—-sn‘ $tatien

<Esc> te Return ts Previsus Menu
Enter Optism:

— —— F YASKAUN J

Figure 6.471

4) Press F4 (Ed‘it Station) to display the input screen.

I

STATION: 1

KEAD MAP WRITE MAT
REFE POINTS REFS POINTE L

=
T

INTE

8
3

NTE

:“ 3-

-
-

HHIHIHIHT
I

i Ll Y

i1

[
T
I

IJ.ttap Link §.Stert Link J.Lead JL.Edit Etatisn P Cveats Link B,

{4
Fe
-
H

Figure 6.472
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6.12.4 Batch PC Link Allocations cont.

5) Enter the station number that will be edited and press the Enter Key.

3 13
SIATION: 2
READ MAF WRITE P READ AP URITE MAP
1 2 POINIE POINTS L REFS POINIT REFR MOINTE
1 (- . 17 — —— —_—
2 —_— —_— e 1 —_—— —_—
3 —_— — — iea 19 —_—— _—
+ —_— —_— 20 — — —_—
5 —_—— —_— 21 — — —_—
' —_— —_— —— 72 — —— — —
7 —_— —_— 23 — —— — —
] —_— — —_— 24 — — —— —
] RS — _— 25 — — —_—
18] — — —_— 7% — —
11| — — —— 2? — — —_—
2] — — — — 2% — ——— —_—
13| — — — — 2% — — —_—
14f ——— — —_— aw» — — — —
18] —— — — — 31 —_— — —_— —
18] ———— — _— 22 Y ———
.£tep Link J.Start Link [ Lead J.Edit Statien J.Create Lisk J).Begister

Figure 6.473

6) Enter the reference number that will be allocated and press the Enter Key.

SIATION:

-

VRITE MapP

T

=
]
g

P

FHTHI T E

HIHITIHTHT |
I E]
RIS
WIS

[T
|8
I

.Step Link H.Starr Link [].laad §l.Edic Station J Crsate Lisk J.

v
3
§

F Y

Figure 6.474

7) Enter the points and press the Enter Key.

FC LTRK DITURETE TR TICPFES QLA m H;Iy:uh:ﬂs
STATION: 1
KEAD WP MRITE MAF READ MA|
] REFS TOINIS INTS s PO

e LU TS ¥ T

N

HTEEEERTTTTNTT L S

T 3
TS

[ |

TS
HTTHITITE

"y

Bugus

15
16 —

J-Step Link §.Sterc Link [ Lead J)Edit Starisn J.Create Link 3. Reyiztar

My

Figure 6.475

8) Press the Esc Key.

Press F5 (Create Link) to clear the Allocation Screen for a new allocation. Entera new alioca- ‘
tion when the screen is cleared. '
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Note

If Load is not executed after allocation, the allocation prior to clearing the screen will remain.

When executing PC Links, be sure to connect the cable from the computer to the Program-
ming Panel (PP port in diagram below) port of the PC Link Module before going online with a
Processor.

Connectingtoa PC

Link Module A ————
(Example)

Computer

Coaxial cable

Reset after setting the

Station Address.

Coaxial cable model:
=i oy

PC Link Modules (IF64)

» Features

» Allow high-speed data transfers between GL Processors.

» Require no communications program because the Modules have special references
for linking. '

» Transmit up to one kilometer at 4 Mbps depending on the coaxial cable that is selected.

« Connect to ACGCs, computers, and other device through a built-in MEMOBUS port.
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6.12.4 Baich PC Link Allocations cont.

« Switch Settings

Memory Protect Switch

Switch Position Function

ON ® Prohibits changes in CPU programming and other areas from the
Programming Panel port.

# Prohibits access to local and remote CPUs.

OFF Permits changes in CPU programming and other areas from the
Programming Pane| port.

» DIP Switch (1sw)

Pin No. Setting
1 Must be OFF.
2 ON Hold Mode

Holds Link Data from a down station that was present
immediately prior to the station going down.

OFF Clear Mode
Sets Link Data for a down station to OFF or Zero.

3,4 3 4 Baud rate (See note)
ON ON 4 Mbps
ON OFF 2 Mbps ‘
OFF ON 1 Mbps
OFF OFF 0.5 Mbps

Note Make sure the baud rate of all stations in the system is the same.

1. Loading Allocation ‘

The following procedure is used to load allocation into the PC Link Modules of all stations.

1) Press F3 (Load) from the Station Edit Menu.

TR BISOREYE Dl CTOFFED CLAW MG Walp=dAle Ay

STATION: 1
READ MAF
REFR POINTS

5
-
=]

23
5"
§
I

WRITE MAP
REFE POINIE

17
14
1%
Fi
21
2
3
24

LT

HITTTHIH
T

LI

TSI

T
PEHTHTTTEHE

REESEYRN

LIS

e o ab R
[ ot ahaithtie

fl-Statien 3.821

Figure 6.476
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2) Press F1 (Select Station) or F2 (All Stations).

J

STATION: 1

READ maP URTTE MAP
REFE  FOINIS REFR POINTS L

M6 17

o
5
-

1TE

¥

4
NI§

3
15

LTI
IR

T
i

THTTTT]

I

HI
T
i

{J-Scacion BP.A21

Figure 6.477

3) A confirmation message will appear asking whether to proceed. Enter “Y” or “N” and
press the Enter Key.

p={AIE
STATION: 1
READ MAP VRITE MaP READ P VRITE_MAP

L) REFS POINTS REM  POINs s REFE POINIS NP3 POINTS
1 DESEL i 1?7 | —— — —_—— —
3 r—— —— — —— 18 — —
3 — —— —
1| — = —_— —
5 — — —— r—
6 —_— —— —
7 — —— —
& — — —— — —— — —
b —_— — — —— 25 —_— — —_—
18| —— —_— 2% — — R
Hl — — — 27 | —— — ——
| 12— —— —— r— 28 — —_—
13— — — | — e ——
M —— e —— | — e -
15— m—— v — 3 —— —
] et i — 2| — — =0

f-tracisn J.a11

.

Figure 6.478

i

STATION: 1

EEAD AP URITE MAP READ WP VRITE MAP
POINIT JEPS POINTE L REFE PFOINTS
bbb smié 1? e

-
o LU TN
ot o i

[T |8

LTI

HHHTHITHAT

|
111
T [

[HITI
T - |
IR

H-Statien J.012

Figure 6.479

Load only operates for the specified station and only the part of Station #1 on the Allocation
Screen will be loaded. Therefore Station #2 allocation cannot be changed.

2. Starting and Stopping Link Communications

The following procedure is used to temporarily stop link communications in order to pre-
vent faulty operation in situations such as changing allocations.
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6.12.4 Batch PC Link Allocations cont.

For Stopping
1) Press F1 (PC Link Stop) from the Station Edit Menu.

2} A confirmation message will appear asking whether to proceed. Enter “Y” or “N” and
press the Enter Key.

STATION: 1

READ mAF VRITE TP REAR MAP
REFS TOINIT EKEFR MOINTE 2 REFE MINTS

T3

I

ol O o 0 T SR
H

M

o

NI
NN
s

FCLIRK BISCRETE . Ll TTOFPES  GLAN G L RO R
SIATION: 1

L]
-
m
[
»
E
¥
4
8
-
=]

|
|
|

CT T Y FNRIIT

HITHTHTHIE (%
.

[T
TR
I8

T

LT
I

f-Statien §.A11

Figure 6.481

We recommend stopping link communications during ailocation.

For Starting

1) Press F1 (PC Link Start) from the Station Edit Menu.
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2) A confirmation message will appear asking whether to proceed. Enter “Y” or “N” and
press the Enter Key.

KEAD mr WRITE Map REAE nap WRITE ma
KE] REFS POINTS L REFE POINIE REFE PO3

-
g
3
g
a-

TN
[T
HTHIT]

HITTTT

Figure 6.482

-~ FELTMCDBIICREIE -l STOPPep O i Wl rah e

ETATION: 1

READ MAP WRITE AP READ MA
NS POINTE REFE  POINTE b NT!

EHEE ) (38

L]
b-l--vn. U1 G

T
T 5

HHTEHTTTH

[THT

J.txacien J 411

Figure 6.483

6.12.5 ASCII Module Allocation

Up to 8 ASCil Modules (16 ports) can be connected to a remote line at one time. ASCII Mod-
ule allocation specifies the channel used by each Module.

1. Displaying the ASCIl Modules Allocation Screen

The following procedure is usedto display the ASCII Allocation Screen. Allocation cannot
be performed unless the Processor is stopped.

1) Go online with a Processor.

Refer to 6.3 Going Online with a Processor for more details on the procedure.
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6.12.5 ASCIH Module Allocation cont.

2) Select 7. System Configuration from the Edit Options.

HEMOCOM-EC CLARG8-78
Laddar Layic Davelepment Seftwere / Edit Menu

Datakaze: TEFTL Walyp = <A ND>
Davice : D:BEL State: STOPPED

EDIT Optisams:
. Selsct Databaze
Netwerks
faguantial Pesction Charts
wace Back
- $tart/Stap Precezser
_ Cluar Heme
tar
{Esc> ts Futurn ts Frevisxa Hemu
Entar Optisa: El

Figure 6.484

3) Select 4. ASCII Module Allocation from the System Configuration Options.

HEMOCON-SC GLAB/EI- 79
Laddar Legic Bevelspment Seftuars / Sywtes Configuratisa
Batabasa: TEST1 Nelp ¢ <Ale-WD>
Pevice : Dl EFtate: $TOFPED

SYSTEN CONFIGUMIION Optlenc:
1. Pracesssr Caafigcration
2. 1/0 Mllacatism
3. Link Allscatisn
- od Stat
e. FC ld-l!r
7. VYENET
<Ezc)> te Beturn ts Pravisus Menu
Eatar Optisn:

Figure 6.485

The ASCH Allocation Screen will appear.

1

LI LU F YT =

LAlt=D> Delste paramster L{Eazc) Finizh

Figure 6.486

2. Allocating ASCIl Modules

The following procedure is used to specify the channels used for all ASCII Modules con-
nected to the remote line.

— 6-194 —




] 6.12 System Configuration

Be sure to stop the GL60 or GL70 prior to changing ASCII allocations.
1) Move the cursor to the Module to which a channel is to be allocated.

2) Enter the channel number (2 or 3) and press the Enter Key.

MODULE WO CHANKEL HO

(AR -]

LIS FYRTETS

£Ale—D> Bwlste paramater LEac> Finish

Figure 6.487

3) Press the Alt + E Keys or press the Esc Key after the settings are entered.

6.12.6 High-speed Station Allocation

High- and low-speed IO processing is executed by station, and high-speed station allocation
is used to select the stations and the channels that will process I/O at high speed. This opera-
tion is necessary when 2-level scanning is selected. it is not necessary 1-level scanning be-
cause all channels and stations are selected for high-speed I/0 processing automatically. 1/O
references allocated to each high-speed station must be continuous to enable higher speed
I/0 processing. This is why the first address and number of registers are entered at the same
time.

i

Refer to 2-Level Scans or High-speed Stations in the MEMOCON-SC GLE0S Design and
Maintenance Manual (manual No. SIE-C815-14. 1) for more details on high-speed stations.

1. Displaying the High-speed Station Allocation Screen

The followind procedure is used to display the Online High-speed Station Allocation
Screen. |

1) Go online with a Processor.

Referto 6.3 Going Online with a Processor for more details on the procedure.

— 6-195 —



Online Editing
6.12.6 High-speed Station Allocation cont.

2) Select 7. System Configuration from the Edit Options.

@

HEMOCOMN-SC GLAS/E0-29
Ladder Lagic Devslopment Seftware / Edit Henu
Batakase: TESTY Nalp = CAlt-N>
Davice : DT State: SICPPED
IT Optisne:
Select Databazs
Netweris

1.

2.

3 Swqueatial Functies Charts
4. Trace Back

5. Start/Step Frecesser

. Clear Memar

. Ter
<{Ezc)> te Retwrn ta Froviews Meeu !I
Il Enter Optisn: B
—— YASIALA

Figure 6.488

3) Select 5. High-speed Station from the System Configuration Options.

MENOCOM-SC CLAR/48/78
Ladder Legic Develepmant Saftwars - Systen Confipration
Batadesn: TEST1 Nalp 1 <hle=it>
Tewice : Db Stata: STOPPED
SYSTEN CONFICUMATION Optiens:
1. Frec Conf igurat lon
170 Aliacatien

. Link Allscatian
4. ASCI] Maduls Nllacatien

wN

7. ¥BET
{Ezc? te Return t» Fravisus Menu
Enter Optien: W

T—r——— TATKRUR =i ‘

Figure 6.489

The High-speed Station Allocation Screen will appear.

1

DISCRETE REGISTER
[

:i
E
4

-
3
]

TR

I

I

I

LI PN

Figure 6.490

Note Allocation cannot be performed unless the Processor is stopped.

2. Allocating High-speed Stations

The following procedure is used to specify the stations and the channels for which to per- ‘
form high-speed I/O processing in a 2-level scan.
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1) Select 3. Online from the Main Menu.
2) Select 6. Processor Configuration from the Online Edit Men.

3) Select 8. High-speed Station from the Processor Configuration Options.

e
PISCRETE REGISTER

INMT oUTPUT T UTMIT

3 CHE £T%| REFE FOINIE REFR POINIE REFR SIZE XEFR SIZE
1 8 — | =—— e T D —— .
2 = | me— e e — — —— —
2= = —— = e —— —— o
4]~ = — —— —_— — — r— — -
s - — —— — E— — — ——— —— —
‘ - - — —— —— r— — —— — —
P = — e— — —_ — — —
T =mEs =2 l= = = =

<Esc? Finish
Figure 6.491

4) Move the cursor to the reference number that will be set.

nlp: .t
DISCRETE REGISTEN

THMIT QUTPUT TNPUT WTHNT

‘# JCME STH| KEFS POINTE REFR  POIKTS NEFR SIZE REPS SI1ZE
i 2 [ -9 107 "3l 7 32 InLM el 4808 e
F3 2 E 1ML ei4  EBE1 eq IMM e 4288 WG
ITel=E=EE= ===
61~ = | ——— e e —_— e — —
2]l = — e —_— —_— e ——
Bl — | — s e e —_— e —— —

<Kzc)> finish

Figure 6.492

5) Press the Alt + E Keys to save the data.
Allocation is not necessary in a one-level scan.
A maximum of 8 stations can be specified as high-speed stations,
Note Input restrictions related to high-speed allocation
(1) Channel number: Remote channel 2 or 3
(2) Station number: 1 through 31

(3) Discrete Address: 00001 through 04098 or 10001 through 14096
Addresses must be entered in muttiples of 16 plus 1. (nx 16 + 1)
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6.12.7 YENET Alocations: Creating a Routing Table

(4) The number of points entered for discrete addresses must be a multiple of 16. The ref-
erence addresses plus the number of input points cannot exceed the address range
given above.

(5) The same address cannot be defined twice in high-speed allocation. If an address is
already used in the allocation table, a warning message will appear asking to check
that entry.

6. 12 7 YENET Allocations: Creating a Routing Table

Allocations are requured for the YENET-3200 optical communications systern to set YENET
numbers, Bridge numbers, and Processor names.

1. Displaying the YENET Configuration Screen
The following procedure is used to display the Online YENET Allocation Screen. ‘

1) Go online with a Processor.
Refer to 6.3 Going Online with a Processor for more details on the procedure.

2) Select 7. System Configuration from the Edit Options.

—_——————— == —————————————— |
MEROCON-EC GLAR/AE/78
Ladday Lagic Devalepment Leftwere ~ Edit Mewu

Databaze: TERTL Welp * CAle=N)>
Dewite : D:0E§ State: STOPFED

Soqueatial Punctisn Charts
Back

Al
. Starc/Step Precesser
. Claar Mane

<Ezc?> te Meturn ts Previsus fesu

Enter Optian: H
E ——— e ———————x YASMAMR =

Figure 6.493

3) Select 7. YENET frorn the System Configuration Options.

—— =

MEMOICON=3C GLAB68,79
Ladder Legic Duvelapment Seftuare / Systam Configuratien

Database: TERT1 Nelp 3 <Alc—N>
Device : DiBlL Ttate: STOPFED

SYETEM CONFICOMTION Optiens:

Frecazzer Coni l.unt Lan
- llhc-

Allecat
- :cu hlnb llll:lthn
K iyh—crod Statisa

(LY SRTETH

{Esc)> te Metwra te Previsus Mesu
Entar Optisn: W

Figure 6.494 ‘
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The Edit YENET Routing Table Screen will appear.

;

j
5
§
:
i
8
§
;

g

L
HH

BB IPA WM

Je

{Alz-D> Delets parasmster LEsc)> Finish

Figure 6.495

Note Allocation cannot be performed unless the Processor is stopped.

2. Creating a Routing Table

The following procedure is used to create a routing table.

1) Press the Up Cursor Key to move the cursor to the name location. Enter the name.

YEMETS ERIDCER 'COMRENT I

3
-
-}
g

COMMENT

FHTET
T
THATH
FELETT T

BERYRNS N

I3

£Alx-D) Dalets tar SEac) Finizh

Figure 6.496

2) Enter the network number.

:
5
§

:
L}
-}
§

ANPGRS

HHHTHE

HTTH
T
LT

=

| <A1t-D) Balsts paranster LEsc> Finisgh

Figure 6.497
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6.12.7 YENET Allocations: Creating a Routing Table cont.

3) Enter the bridge number.

FEEEETTTER

g
HITH
FHEHL

[T ERT AT PRI

)

<hlt=D> Dalsts parametsr SEzc> Finixh |

Figure 6.498

4) Enter the comment {Up to 16 characters can be entered).

YEMEIR ER1DCER COMMENT

é
%
:

ANRRERHIL
THETT
RRRERENN

=L L BT PRI

rmy

{h1t=D) Delsts paramster {Ezc> Finish ‘

Figure 6.499

5) Press the Alt + E Keys after aliocation is completed.

Note The name and routing tabie will be deleted if the 3200IF Module is reset. Reload the data if
that happens. ‘
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6.13 Editing for ASC!l Modules

Special data processing instructions are used to transfer data between an ASC!I Module and
ASCll devices. These instructions needs messages that stipulate data I/O format. Each mes-
sage is given a number (message number) that is stored in the memory of the ASCII Module.

Preparations

Itis possible to program with a GL60S ASCII Module by connecting a computer to an ASCI|
Module through a GLE0S or by connecting a computer directly to an ASCIl Module. Referto
MEMOCON-SC GL60S ASCI Modules User's Manual (manual No. SIE-C815-14.4) for fur-
ther details.

1) Connecting to an ASCIi Module through a Computer and Processor (such as the
GL60S)

a) Connectthe RS-232C portofthe computer to the IOP or COMM port of the Processor.
b) Connect an RIOD Module to the ASCII Module with a coaxial cable,
¢} Turn ON the power.

Note Be sure to allocate the ASCII Module prior to connecting.

T r— Connection (1)

Do not forget the |
settings! 1

Figure €6.500
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2) Connecting a Computer Directly to an ASCH Module
a) Set the Memory Protect Switch on the ASCII Module to 1 or 2.
b) Connect the RS-232C port of the computer to a port on the ASCII Module.

¢) Turn ON the power.

Connection (2)

RS-232C
porl

Memory Protect
Switch

Port1or
Port 2

Figure 6.501
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Computer ASCIl Moduie

Cable model:
JIMSZ W1015-T

Connector
(25 pin}

Terminator

m

=i
*,/L

Connector
(9 pin)

/____)

" ASCIt Module or ~.> -
M
N._RIOD,RIOR __ C__ASCli Module

Figure 6.502

6.13.1 Procedure for Starting the ASCII Editing

The following procedure is used to start up ASCII editing.

1. 10P or COMM Modules

1) Select 3. Online from the Main Menu.

Ladder Legic Davels; cnt Seftuars / Main Wenu
Varsien .08 Capyright 1’;!!5““ ELEGTRIC COXPORATION
Databaze: TESTL Holp: <Adt-N>
Main Manu:

Selsct Aexive PLC
Offline

1.
2.
5.
6.

3
List #ctive PFLC
Leadar
7. Urilitiss
<E> te Exit te Das
Enter Optien: W

Figure 6.503

2) Set the communications parameters.
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6.13.1 Procedure for Starting the ASCII Editing cont.

Set the device communications parameters as follows:

With an IOP or COMM Module: Processor front port
Referto 6. 1.2 Procedure for Setting Cormmunications Parameters for more details onthe ‘
setting procedure.

3) Select 1. Program Mode (editing possible) or 2. Monitor Mode (editing not possible) from
the Menu Options.

e me——————— |

MEMOCOH-EC GLAS/CR-78
Leddar Lagic Develspment Seftware / Online Mesu

Database: TESTL Nalyp = <Ale=i>
Davics : D:0OM State: SIOFFED

HENU Optisns

+ Maniter

3. Gn=Lime Communicatisaz Satup

<Exc) ¢ Maturn te Frevisus Hesu

Entar Optien: B

YACKAUA =

Figure 6.504

4) Enter the address of the device with which to go online and press the Enter Key.

HEMOCON-SC CLASA420
I Laddsr Legic Develepment Saftware 7 Online MHenu I

Databaze: TESTL Help : CAle=N>
Dewice : P:EEE Skata: STOFPED

DLLACH m— Tm e o e e

T Eoter devsee wddeess €1-247): [TTR "

ALoter> to Attarh

Figure 6.505 ‘

5) Select 8. ASCI| Editor from the Edit Options.

m

MEMOCOH-SC CLARSR-78
Ladder Legic Develupment Seftuars / Edit Menu

Databass: TEST1 Helyp ¢ <Ale=H>
Dewice : Digll State: SIOFFED

EDIT Optiewa:
1. Sslect Databaze
5" Seeeeniial Puactien Chart
3 14 £ 3
4. Trace Back
5. Start/Step Precesser
&. Claar Meme:
2. sﬁen c.naﬁntm
{Exc} te Boturs to Proviaus Menu
Tatar Optisn: T

Figure 6.506 ‘
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2. ASCIl Modules

1) Select 3. Online from the Main Menu.
2) Set the communications parameters.

Set the device communications parameters as follows:

With an ASCIi Module: IF71 ASCIl Module
Referto 6.1.2 Procedure for Setting Comrnunications Parametersfor more details on the
setting procedure.

3) Select 1. Program Mode {editing possibie) or 2. Monitor Mode {editing not possible) from
the Menu Options.

4) Enter the number of the device with which to go online and press the Enter Key,

The ASCH Edit Menu will appear.

MEMOCOM-SC GLAB/CR 78
Ladder Loyic Develepment Seftware ~ RECI1 Edicsr
Batabase: TEST1 Malp 1 <Alt-H>
Device .= bzl uch: [HunN ]

RLCIE Edic Optisan:

{Esc) te Metwrn te Previsus Menu
Estar Optien: [B

— ——— — e ————— YALRAVA =

Figure 6.507

6.13.2 Selecting an ASCIl Module

The following procedure is used to select an ASCII Module. This function can only be
executed when multiple ASCII Modules are connected.

1) Select 1. Select ASCII Module from the ASCI| Edit Options. .

HEHDCON-EC CL4B-5078
I_ Laddsr Legic Develepmant Saftware ~ AECII Edfter I
Database: TEXTL Help : <Alt—H>
Device 1 Digil ntch: T
lb:.uh 1

ASCIT Edic Optisns:

{Esc? te Meturn te Provieur Heny
Intar Option: Ej

— — e — Yasrawm =

Figure 6.508
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6.13.3 Editing ASCIHI Messages

2) Enter the number of the Moduie that will be edited and press the Enter Key.

HENOCON-EC CLAM/6R"78
Ladder Logic bevealapment Seftwars / AECIT Editar

Databaze: SATO Halp @ {Alt—H3>
Degice : preR aict:
Hoduls = 1

S2ar oot ALCHD Hodele e

s b 7

<Exc)> to Beturn s Previsus Mewu
Enter Oprisn: KN

Figure 6.509

6.13.3 Editing ASCIl Messages

This section describes the procedure for editing ASCIl messages using the functions dis-
played at the bottom of the screen.

The following function keys can be used:
Moving the cursor: Press the Left, Right, Up or Down Cursor Key.
Selecting the message number that will be edited:
Press the Enter Key.
Moving to the next or previous page (from message number 1 through 1,024):
Press the Page Down or Page Up Key. ‘
All functions are represented by keys F1 through F6

1. Displaying the ASCIl Message Editor Screen
The following procedure is used to display the ASCHl Message Editor Screen.
1) Move the cursor to the number of the message that will be edited. ‘
2) Press F1 (Edit) from the ASCIl Message Editor Screen.

The Edit Messages Screen will appear.

zage Tor T TCRIE

Meduls Munbar: 1 Mezzages svailable: 1822 Werds available: 32M7
Husher Werds Muaber Uards Nusber Werds Wunber Verds Number Words

aas?

|

L3 |34 . -3 » ]

L] [ =] " L ar] ] 5E ]
] . | 1%d ] [ =} . s ] [ H ]
;e . | 1 . [ 3] . _e L] il [
] ] ki [ ] 3 . 4?7 . [ L]
[ o] . 29 . "t a [ ] [] .52 ]
- L] .21 . m3as [ | . "3 .
.. » |22 L] aE ] s [] 4 | ]
e s 2y . [ <rd L] [ .23 [ o5 1]
"-ie 11 e 2 [ 1] . .52 [ et .
[ 2] [] [ 1] » [ =] . "5 » 7 L]
[ F] . mze » [ d ) G4 . i L ]
[ k] . .27 » [ . [ 3] ] - [
i [} [ -3 . [+ L] se [ ] - [}

B-Edic §.Copy D.Dedets D.Plavback J-Medule J.Quit

Figure 6.510 ‘
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6.13 Editing for ASCII Modules

2. Creating Messages

The following describes the procedures for creating ASCIl messages using the functions
displayed at the bottom of the screen.

A. Next/Previous (Menu Switching)

The next/previous functions defined at F1. The function switches function menus for edit-
ing ASCIl messages.

The function menu switches each time F1 is pressed.

Figure 6.511

B. Text

The foliowing describes the Text function defined at F2 that is used to enter or change
text.

1) Press F1 from the Edit Messages Screen to switch to the next functions.

2) Press F2 (Text) from the Edit Messages Screen.

Figure 6.512

3) Enter text in the Text Edit Screen that appears.
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6.13.3 Editing ASCII Messages cont.

4) After the text is entered, press the Alt + E Keys to save the text.

. Next J.Text [.Integer §.Zarwss J.ASCI! N.fpaca F.<CR> J.Playback J.Write

Figure 6.513

5) Press the Esc Key after all editing is completed.

8) A confirmation message will appear asking whether to save changes. Enter “Y” or “N”
and press the Enter Key. ‘

Figure 6.514

C. Integer Data

The following describes the integer function defined at F3 that is used to enter or change
integer data of n digits of m units.

1) Press F1 from the Edit Messages Screen to switch to the next functions.

2) Press F3 (Integer) from the Edit Messages Screen.

e €4-99) 1M 1 EY Lengih-<1-8)

Figure 6.515 ‘
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3) Enter the display prefix in the input screen that appears.

4) Press the Enter Key after the prefix is entered, and enter the length (number of digits).

Figure 6.516

5) Ifthe wrong prefix was entered the first time, press the Enter Key once more to re-enter it.
6) After the text is entered, press the Alt + E Keys to save the text.
7) Press the Esc Key after all editing is completed.

8) A confirmation message will appear asking whether to save changes. Enter “Y” or “N”
and press the Enter Key.

Figure 6.517

D. Integer Data (Zeroes)

The following describes the zeroes function defined at F4 that is used to enter or change
integer data of n digits of m units.

1) Press F1 from the Edit Messages Screen to switch to the next functions.

2) Press F4 (Zeroes) from the Edit Messages Screen.
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6.13.3 Editing ASCII Messages cont.

3) Enter the display prefix in the input screen that appears.

lary =——--

e ax K1 -2 1 J EY  Lenyth <1-82

Figure 6.518

4) Press the Enter Key after the prefix is entered, and enter the length (number of digits).

Figure 6.519

5) Ifthe wrong prefix was entered the first time, press the Enter Key once maore to re-enter t.

8) After the text is entered, press the Alt + E Keys 1o save the text.

7) Press the Esc Key after all editing is completed. ‘

8) A confirmation message will appear asking whether to save changes. Enter *Y” or “N”
and press the Enter Key.

Figure 6.520 ‘
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Difference Between Integer ‘min’ and Zeroes ‘mJdn’

« min prints spaces at the leftmost digits if the specified length is not filled.

* mJn prints zeros at the leftmost digits if the specified length is not filled.

E. ASCIl Data

The following describes the ASCII function defined at F5 that is used to enter or change
ASCI text.

1) Press F1 from the Edit Messages Screen to switch to the next functions,

2) Press F5 (ASCIHI) from the Edit Messages Screen.

3) Enter the display prefix in the input screen that appears.

Figure 6.521

4) After the text is entered, press the Alt + E Keys to save the text.

Figure 6.522

5) Press the Esc Key after all editing is completed.
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6.13.3 Editing ASCII Messages cont.

6) A confirmation message will appear asking whether to save changes. Enter “Y" or “N"
and press the Enter Key.

Figure 6.523

F. Spaces
The following describes the space function defined at F6 that is used to enter or change ‘
spaces.

1) Press F1 from the Edit Messages Screen to switch to the next functions.

2) Press F6 (Space) from the Edit Messages Screen.

sage: 15 H H T
[ heccen -

Figure 6.524

3) Enter the display prefix in the input screen that appears.

Figure 6.525
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4} After the text is entered, press the Alt + E Keys to save the text.

5) Press the Esc Key after all editing is completed.

8) A confirmation message will appear asking whether to save changes. Enter “Y” or “N"
and press the Enter Key. ’

Figure 6.526

G. Carriage Returns

The following describes the carriage return function defined at F7 that is used to enter
carriage retumns.

1) Press F1 from the Edit Messages Screen to switch to the next functions.

2) Press F7 (CR) from the Edit Messages Screen.

Figure 6.527

3) Press the Esc Key after all editing is completed,
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6.13.3 Editing ASCII Messages cont.

4) A confirmation message will appear asking whether to save changes. Enter “Y™ or “N”
and press the Enter Key. ‘

Figure 6.528

H. Binary Data

The following describes the binary function defined at F2 that is used to enter or change
Binary Data of n digits of m units.

1) Press F1 from the Edit Messages Screen to switch to the previous functions.

2) Press F2 (Binary) frc;m the Edit Messages Screen.

3) Enter the display prefix in the input screen that appears.

[ hotton -

Prefin C1-%97 EUX B BH Length €1-16)

Figure 6.529

4) Press the Enter Key after the prefix is entered, and enter the length.

5) Ifthe wrong prefix was entered the first time, press the Enter Key once more to re-enterit.
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6) After the text is entered, press the Alt + E Keys to save the text.

Figure 6.530
7) Press the Esc Key after all editing is completed.

8) A confirmati'on message will appear asking whether to save changes. Enter “Y” or “N”
and press the Enter Key.

Figure 6.531

. Hexadecimal Data

The following describes the hexadecimal function defined at F3 that is used to enter or
change hexadecimal data of n digits of m units.

1) Press F1 from the Edit Messages Screen to switch to the previous functions.

2) Press F3 (Hex) from the Edit Messages Screen.

3) Enter the display prefix in the input screen that appears.

[~ batten =

bl = mm e T

ax LY I8 H O EL Leagth <1-42

— DOEENCRCETERY

Figure 6.532
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6.13.3 Editing ASCII Messages cont.

4) Press the Enter Key after the prefix is entered, and enter the length.
5) Ifthe wrong Prefix was entered the firsttime, press the Enter Key once more to re-enterit. ‘

6) After the text is entered, press the Alt + E Keys to save the text.

J.-Previsus J Winary §).Hex I Octal Jj. Repeat J.Contrel §-Calsndar IPlayhack

Figure 6.533

7) Press the Esc Key after all editing is completed.

8) A confirmation message will appear asking whether to save changes. Enter “Y” or “N”
and press the Enter Key. ‘

J.Proviens § Binsry §)-Hex JJ.Octal §. Reprac J.Contrel g-Calendar J| Playback

Figure 6.534

J. Octal Data

The following describes the octal function defined at F4 that is used to enter or change
octal data of n digits of m units.

1) Press F1 from the Edit Messages Screen to switch to the previous functions.

2) Press F4 (Octal) from the Edit Messages Screen.

— 6-216 —




6.13 Editing for ASCII Modules

3) Enter the display prefix in the input screen that appears.

rebas (1-99) 18 0 El  Leoyth <i-4)

Figure 6.535

4) Press the Enter Key after the prefix is entered, and enter the length.

5) lfthe wrong prefix was entered the first time, press the Enter Key once more to re-enterit,

6) After the text is entered, press the Alt + E Keys to save the text.

Figure 6.536

7) Press the Esc Key after all editing is completed.

8) A confirmation message will appear asking whether to save changes. Enter “Y” or “N”
and press the Enter Key,

Figure 6.537
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6.13.3 Editing ASCII Messages cont.

K. Repeat

The foliowing describes the repeat function defined at F5 that is used to a repeat speci- ‘
fied message a set number of times.

1) Press F1 from the Edit Messages Screen to switch to the previous functions.

2) From the Edit Messages Screen, move the cursor to the beginning of the message that
will be repeated.

Figure 6.538

3) Press F5 (Repeat) from the Edit Messages Screen.

4) Enter the prefix that will be repeated when the input screen appears. ‘

You cannot repeat more than once.
5) Press the Alt + E Keys after all settings are entered.
6) Move the cursor to the end of the message that will be repeated. .

Be sure to add a closing parenthesis “).”
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L. Control Codes

‘ ::cu oRit'd,
Stom =

6.13 Editing for ASCII Modules

Figure 6.540

The following describes the control function defined at F6 that is used 1o set control codes

for ASCII devices.

1) Press F1 from the Edit Messages Screen to switch to the previous functions.

2) Press F6 (Control) from the Edit Messages Screen.

3) Enter the control code using decimal numbers in the input screen that appears.

Fascage: 1000

 tep ~
[ battan -

Longth: G000 Nagisters: W fuallabls: 30097 TiKERT )

Figure 6.541
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4) After the text is entered, press the Alt + E Keys to save the text.

Previeus §.Binary Jl.Nex J.Octal J.Repeat J.Contrel J Calandar J.Pla k

Figure 6.542

5) Press the Esc Key after ali editing is completed.

6) A confirmation message will appear asking whether to save changes. Enter “Y" or *N”

and press the Enter Key. ‘
R332,

Figure 6.543

M. Calendar

The following describes the calendar function defined at F7 that is used to set formats
used when a calendar is output.

1) Press F1 from the Edit Messages Screen to switch to the previous functions. ‘
2) Press F7 (Calendar) from the Edit Messages Screen.

3) Enter the register data (1 through 8) in the input screen that appears.

Figure 6.544
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Register Data
Symbol Meanings Number of registers
reguired

1C Year 1

2C Month 1

3C : Day 1

4aC Day of the week 1

5C Hour 1

6C Minute 1

7C Second 1

8C : Year 10 second 7
Output Format
» When 1C,":",2C,"" 3C,"" 4C is specified: 93:01:11:MON
» When 8C is specified: 93:01:11:MON:10:09:07

4) After the text is entered, press the Alt + E Keys to save the text.

Figure 6.545

5) Press the Esc Key after all editing is completed.

6) A confirmation message will appear asking whether to save changes. Enter “Y™ or “N”
and press the Enter Key.

H.Previsus H.-Binury J.nex BD.octal J.Bepoat J.Contrel §-Calendar J.Playhack
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N. Playback

The following describes the playback function defined at F8 that is used to display edited
ASCII messages in output format. The function is used to set formats used when a calen-
dar is output.

Press F8 (Playback) from the Edit Messages Screen.

Figure 6.546
e tatn ELECIRLC COTTOMIION oo &

Presz any hay te centinue

Figure 6.547

3. Copying

The following describes the copy function defined at F2 that is used to copy the contents ‘
of one message to another message.

1) Press F2 (Copy) from the ASCIl Message Editor Screen.

Medule Nombar: 1 Hessapes available: 1017 WHerdsr avallahle: 32461
Munber Yords MHunber Verds Hunber Words MNusbar Uerds Nusber Wenis

w s [} -2y L] "4l L] .57 | ]
-ie [} 538 EH . L] ) ]
el [ -7 . 3. [ ] a4 L] 1] 1]
| <] 3] [ 33 . ;32 . aa4e . "o .
e . ",y [ ] a3 [ ] "4? . -1 .
[ . "m2s $1 4 [ ] "4 [ ] [ 3 .
-7 51 .21 [ IS [] .4y . 1] 1 3
... ] L] .22 ] |, = [ ] 050 . e .
4 [] [ E] [] .17 ] .51 L] 05 L]
e . aze . L= ] -2 . [t .
i » [ 3] ] L] | ] |- X] [ 067 L
|z » .ezé a L a2 4 a aneE L]
[ k] ) we? a 1 34 -5 . .y ]
[ L] | ] L) L] .2 | ] L~ » L ] a
et von et e NIETEN RS [IEET

Figure 6.548 ‘
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4

2) Move the cursor to the number of the source message to be copied and press the Enter
Key.

3) Move the cursor to the number of the message to receive the copy and press the Enter
Key. '

saage tor g s Ip:=<AIv

Pedule Humber: 1 Messages availahle: IMI? Verds availahle: 32461

(1]

"

L
] swsssasass

Figure 6.549

4) Enter “Y” as prompted by the confirmation message that appears.

ZU A ter H wlpi<h]t

Meduls Number: 1 Mescages available: 1816  Werds available: 32412
Humbar Merds Nusher Verdse Nunber Uords Munber Verds Nuaber Verds

el 29 ey [} 43 . -s? .
L] 4“2 | u [ K] [] S »
L. =] [} -7 [ [ [] o] . nmsy ]
it (13 iy [ "2 . i . [ 1] 1]
-as a iy 8 [ =] ] a7 ] [ 1} »
] . ez 51 34 [ [ et [ ] 2 .
a7 s1 21 L] "|as . [ 14 L] [ k] .
e 1] -2 L] [ ] ] -se . e [
anby 1] 823 . »,37 [] .51 . |t .
e » o4 . 38 [] .52 . [ ) [
i1 L] -y . |3y [ ] ;|53 . "7 []
-.z L] e ] a4 (] st » - ed [
-3 . |27 1 Bi41 4 .s5s L] [ 3] 4
-4 L] ..z [ ] .2 [} -se 1] L1 ] '

3. Edit J.Copy O.Delste T.Plaghack B.Hedule B-Quit

Figure 6.550

4. Deleting

The following describes the delete function defined at F3 thatis used to delete messages
stored in the ASCII Module.

1} Move the cursor to the number of the message to delete.

1
H

cTage tar B #IpiARIt

Modile Wender: 1 Messages avaflable: 1816  Verds available: 32432

;4 29 s . 7 1]

& -
o 6y s ] e .
s [ .y 2 1 .
] . -ce . "2 L}
"a? 51 "t L4 ] .
-h . .2 ] | ] [}
oy 1 [ 5] ] 3 [
-.ie ] "es L] | ] 1
..l a1 .25 ] . 967 1
| H] [ .|ze L] ] L .
i3 . "e? . [ ] L .
a4 . "2 L] L] Lo, ] | ]

3.Edit J.Capy B.Dolete D.Playhack J.fmdule B.Quic

Figure 6.551
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2) Press F3 (Delete).

LAy Eor 3] alp-3NIc
Medule Hunber: 1 MHezzages avallabla: 1@17 Werds availahla: J24M
Hunker Vords Hunber Usrds Nusber Worda Munber Verds Huabar Usrdz

2% [ 1] Fd 2y [ ] .2 L] -5 L]

[ 1 a E [ | ] [ ] [ |

-7 | [ =2 [ ] [ ] 3 [ ]

"e4 [ 3] [ 1] [} 2z [] [ ] B mes a
.7 [ ] [ 1] [ ] [ =x] . "|47 » el ]
[ [ ] -ce 51 "4 ] a4 ] -2 1
.7 51 21 . [ =] . .47 1] -3 1
el [ ] a2z L [ =] . s ] [ 13 »
[ g [] |23 ] ".3? [ ] 51 [ ] [ ] !
[ 1) ] g4 [ ] L= [ ] 2 1] 13 [ ]
[+ [ ] RS [ ] "3y ] "5 ] e7 [ ]
-,z ] [ 3 [] -4l ] 54 [] et [
3 [ ] [ rd [ [t 34 ! [ ] -y 1]
"’ [ ] L] L+ . | . wh L]

B-Edit B.Copy B.Balate T.Playheck J.Medule B.quit

Figure 6.552

3) Enter keys as prompted by the confirmation message that appears.

5. Playback

The following describes playback function defined at F4 that is used to display edited
ASCIl messages in output format.

1) Move the cursor to the number of the message to delete.

RTIT Maasage Hiter | 5 EIENICTE  #2CTT (AL TESIL Telp:CALt-5

Medale HWunber: 1 Messages availahle: 1017 Werds aveilable: 32421 ‘
Mumiser Gords Number Uerds Husker Verds HNusbar Vords Henber Wunis
W? -.is 22 -z L] 4 . .57 []
13 | . i ] ] MGE ]
5] ] [ %4 5 a3y [] [+ [] sy a
- (14 " [ ] 32 a [ 1 2 _ed .
] [] -y . .23 ] .7 [ ] [ L}
- [ ] 51 34 . ] [ ] 2 [ ]
a7 51 [} [ ] m3s [] iy [ ] e [ ]
[ ] L ] [ ] =13 [ .se . .ol .
ey ] [ ] [ ] ",a? [] "1 . 5 [}
e [ ] "4 . [ 1] [ .52 [ ee ]
"1 [] E25 [] [ 1] [ ] [ ] "7 []
miz » [ . el [ ] 54 [] [ ] []
13 [ ] -e? L] [ et 34 [+ . [ 34 [ ]
4 [ ] .2 [ ] 42 [ ] [ [ ] "7 ]

3.Edic 3.Copy [.Pelete D.Playback J.Heduls D.Quic

Figure 6.553 ‘

2) Press F4 (Playback) from the ASCII Message Editor Screen.

RREREEEEEEEEIRRSERRAEREERERERRERTASRRERLSNE
g YASKAW ELECTRIC CORPOMATION
SREEESRERARSEERLESEEE IR RENRTAT TS ERESRLEND

Figure 6.554 ‘
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6. Quitting

The following describes the quit function defined at F& that returns to the ASCII Edit
Menu.

Press F6 (Quit) from the ASCI| Message Editor Screen.

The ASCII Edit Menu will retum.

6.13.4 Clearing Memory

The following procedure is used to clear ASCII memory.

1) Select 3. Clear ASCII Memory from the ASCII Edit Options.

L Laddar Lagic Develepment Saftusre ~ ASCII diter 1
Batabase: TELT1 Help @ <N1le=N>
Puvice : D ncrl: FIECIETR
Meduls : 1

- Set AR I-!l
{Esc? t» Matare to Previeus Meau
Enter Opcisn: B

YASIAUS =

Figure 6.555

2} A confirmation message will appear asking whether to save changes. Enter “Y” or “N”
and press the Enter Key.

6.13.5 Calendar

The following describes ASCII calendar operation.

1) Select 4. Set ASCII Calendar from the Edit ASCII Menu.

2) Change data based on the data currently displayed on screen.

I MENOCON-SC CLen/6e-78

! Laddsr lagic Divelepmant Seftware + ASCII Editer
Databaye: TESTL Nelp = CAle—)>
Devica : P01 133]: KITNKN L hr
fgdes 2 B RICCIT

P ML B 14 Mt
I T

wyottedd s b inn. Lo,

<heed te Quat

Figure 6.556
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6.13.6 Setting Port Parameiers

3) Press the Alt + E Keys or press the Esc Key.

6.13.6 Setting Port Parameters

The following procedure is used to set ASCII port parameters.
1) Select 5. Set ASC!I Ports from the ASCII Edit Menu.

2) Move the cursor to each item and press the Space Key or enter a number.

| Laddar Legic Development Seftwars / A3CII Editer ]
l-lr 3 CAle—M)>
ascli:

- wrt ALl

FrROAAIOD C ®OW/kOGFF  PAKIIY SIOF RBOUD DATA  KHD

= LImArTL keen P 8 N

La-mbluad Even b Yo 8 N

nODE  PARITY  S10F  BAUD  DLLAY

RIu luen 1 YhHM uan
kU Luen 1 i K

- ol Exat (Fzer to Guat

Figure 6.557

3) Press the Alt + E Keys or press the Esc Key.
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Motion Editting

This chapter describes how to select motion files, create and edit mo-
tion programs, and set motion parameters. Information is also pro-
vided on these parameters.

7.1 Procedures for Selecting Motion Files ....... 7-2
7.2 Procedures for Creating Motion Programs ... 7-6
7.3 Procedures for Setting Motion Parameters ... 7-9

7.4 Motion Selection Screen Configuration ...... 7-11

7.5 Program Editing .......... eesreesrsseses T-12
7.6 Setting Parameters ........... ceenne veeees 7120

7.7 Monitoring .......... ceesea veseen R B X,

— 71—



Motion Edit

7.1 Procedures for Selecting Motion Files

The following procedure is used to select motion files {programs, parameters, etc.).

1) Select 4. Motion from the Main Menu.

e ——— e e

cz.m
r Legic hl t Seftwars ~ Main Menw
U-rlhn 2.8 Copyright l’! 1 YASKAW ELECTRIC CORPORMTION

batabase: TERT1 Help: <alt-H)
Hain Henw:
1. Salsct Rctive FLC
2. OFfline
3. Online

tive PLC

<E> te Exit ts Desx
Enter Optien: EB

§° Lander
|| . 72 Beilities

Figure 7.1

2) Select 2. Select Program/Parameters from the Motion Options.

HEMOCON-EC CLAR%8/78
Ladder Logic Developaeat Saftware / Edic Metien
Datainse: TEST1 Help: <ALc—N>

HOTION Optisns:
1. Sslect Datalass

w

i Plr‘-t-n

I iy i o

<Exc)> te Matura te Hain Hemu
Extar Optien: W

Figure 7.2 ‘

The Select Motion Screen will appear.

NENOCON-SC CLAR/EB- 79
Ladder Legic Develapment Ceftwvare - Cxlact Metien
Databaze: TEST1 Help: <Alc-H>

- ﬂullur thu an

<Enter> te Eiis <Esc) te Quit
I-Edie 0. Exic
v —

— |

Figure 7.3 ‘
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3) Press F1 (Edit).

4) Selectthe IF66 Servo Module using the Right and Left Cursor Keys, then press the Enter
Key.

Set the Module number (1 to 4) of the target IFE6 Servo Module.

5) Select the Programming Panel using the Right and Left Cursor Keys, then press the En-
ter Key.

The buffer number specifies the work memory space inside the Programming Panel. This
space is used as temporary memory for motion programs. It is possible to set the buffer
from 1 to 8 (2 kilobytes per buffer).

6) Enter the file name of the motion program, then press the Enter Key.
Up to 8 characters can be entered as the motion file name.
7) Enter the title and date of editing of the motion program,then press the Enter Key.

This is used as a comment field. It is attached to the motion file when the motion file is
saved.

8) Select the servo axes to be used, then press the Enter Key.
This indicates which servo axes will be used for the motion file.

9} After all the selections for the program file have been completed, press the Enter Key to
comptete the settings.

MEMOCON-SC CLABAAL~78 |
L Ladier Legic Develepment Seftuars ~ Selsct Hetisa
Databaze: TEST1 Halp: <Alc—H>

oN

-1

Matian Paramsters mop:1  PPi1
Filanume:
Titla:
[ Pataz Mxig? _l
<Entur> t» Edit {Eac) ts Quit
Edit i
———— -u-'—=‘—m'b‘-‘—-= = PASKAYA =
Figure 7.4

—_7-3 —



Motion Edit

10) Move the cursor from the motion program setting position to the motion parameters set-
ting position using the Down Cursor Key.

NEMOCON-EC CLARSAL T8
Lidder Legic Duvelopmont Seftward 7/ Sslect Metise
Database: TEST1 Nalp: <Alt-H>
Metisn h‘ﬁ. LoD S o
Filoname: OPRO
Title: HOTION FROCEAN
Date: #3-20-1%%7 Rxisg: 1= == - - — -

<Enter> te Edic <Ezc) to Quit

. Edic . Exix
—

TRSXRWA =i

Figure 7.5

11) Press the Enter Key to place the cursor in the Servo Module setting position.

12) Selectto set the IF66 Servo Module using the Right and Left Cursor Keys, then press the
Enter Key.

Set the Module number (1 to 4) of the target IF66 Servo Module.

13) Select the Programming Panel using the Right and Left Cursor Keys, then press the En-

ter Key. ‘

The buffer number specifies the work memory space inside the Programming Panel. This
space is used as temporary memory for motion programs. It is possible to set the buffer
from 1 to 8 (2 kilobytes per buffer).

14) Enter the file name and press the Enter Key.

Up to 8 characters can be entered as the motion file name. ‘

15) Enter the title and press the Enter Key.

This is used as a comment field. It is attached to the motion file when the motion file is
saved.

16) Enter the date and press the Enter Key.

This is used as a comment field. It is attached to the motion file when the motion file is
saved.

17} Enter the axis numbers and press the Enter Key.
Indicates which servo axes will be used for the motion file. ‘
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18) Afterallthe selections for the parameter file have been completed, press the Enter Key to
complete the settings.

HENOCON-£C  CLAB-CR70
L Ladder Legic Develapment Saftuare 7 Salect Metien —I
Database: TESTL Healp: <AHlt-u>

Mot in: MOD:t My
Filename: BOTOPNO
T%:%:E HOTION PROGRAN

3-28-1997

et ) — Hus.y PRl —
rOLGIRR
HOT10N FAKAMLIER
HY 28 1997

{Enter> te Edjc {Est> te Quit
-Edic M. Exit

——

Figure 7.6

19) Press F10 (Exit) to return to the Menu Screen.
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7.2 Procedures for Creating Motion Programs

The following procedure is used to create and edit motion programs.
For details on editing, refer to 7.5 Program Editing.

The following program example will be created.

NOO1 GO1 X350, Y346, 2342, F15000;
N002 M30;
NOO3

Figure 7.7

1) Select a program file.

Refer to 7.1 Procedures for Selecting Motion Files.

2) After a selection is made, the screen will retumn to the Motion Options.

3) Select 3. Program.

HENOCOMN-SC GLAB/GR-70
Ladder Legic Devalspment Seftwars ~ Edit Metien
Database: TEET1 Halp: <Alt-w>

MOTION Optiens:

1. Selett Database
2. Swlect Pre: arametere

. Farensters
5. Pre Hemiter
6. Pexitisn Hemiter
<Eze> teo Meture te Hain Hemu
Entar Option: [

YASKAVE =

Figure 7.8 ‘

4) Press the Slash Key to display the Motion Command Submenu.

EBTT FSTTOR FROCRAH TEETL  Walp=<hLiWY
mob:1 PPo1 0:BL  FILE:WOTOFM Axirik- -
AUAIL:2B45  USED:BEND Lime 1 Cal 1 INSERT

Figure 7.9 ‘
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5) Press F5 (Axis names).

The screen for selecting the axis names will appear.

soordinates =

Select axis nanes:

Nave: 1: EX

Nang 2
Nane J3:

Figure 7.10

6) Enter the axis names (X-Y-Z) and press the Enter Key.
7) Create line NOO1.

8) Press the Slash Key, then select F1 (Gxx) to display the G code list.

@ - EEcu- !ntcmﬂt!n

G4 ~ Dwell

By - Wait uwneil nnlti—ttoguspud
Q28 - Return to homs go-it n

G62 - Multi-stsp spew

Gi2 - tait for pazsage

Gh6 = Notch signal

G99 - fbsolute ceordinates

G691 - Incremental coordinates

Figure 7.11

9) Move the cursor to G01, and press the Enter Key.

10} Select F2 (X-Y-2) to display the axis variable list.

K
g

CGGD-IH'{

Figure 7.12
11) Move the cursor to X and press the Enter Key.
12) Enter the numeric value 350.
13) Execute the same procedure as X for Y and Z.

14) Press F3 (Fnnn) to display the F variable list.

Figure 7.13

— 77—




Motion Edit
m

15) Move the cursor to F and press the Enter Key.

16} Enter the numeric value 15000.
17} Press the Enter Key to end the line.
18) Create line NOO2.

19) Press F4 (Mxx) to display the M code list.

- 2t
M1 — Netch s!::d. sutput Frevent

Figure 7.14

20) Move the cursor to M30 and press the Enter Key, then enter “".
21) After editing has been completed, press F10 to save and retum to the Motion Edit Mode.

By pressing F9 during editing, it is possible to save the program and continue editing. If

the Esc Key is pressed, a confirmation message asking whether to exit will appear. it “Y”

is entered and the Enter Key is pressed, the user will exit the current mode after saving ‘
the data. If “N” is entered, the user will exit without saving the data.
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7.3 Procedures for Setting Motion Parameters

This following pfocedure is used to set up the Servopack.
The following example describes how to set the position command mode.
1) Select a parameter file.
Refer to 7.1 Procedures for Selecting Motion Files.

2) Select 4. Parameters from the Motion Options.

HEMOCON-SC CL4B-E08-79
L Ladder Leyic Devalspmant Softumre + Edit Mot len I

Database: TESTL Help: <Ale-N>

MOTION Optimns:

1. Celect Bacabase
2. Sulact 'aranetere
1. Pre

. Tran £

§. Peritien n.",x::.-

{Exc)y te Meturm te Main Meanu

Entar Oprisn: B J
— re— — —— e—— YA S XANA

Figure 7.15

3} Press the Page Down Key to go to the next page.

4) Move the cursor to the position command mode selection.

ECTT ROYTON FARARETEE TEXTT Welpich =R
MODULE: & PROGRMMNING PAMEL: 1 FILE: WOTOMAR
Metsr retatismal dirsctien

3 Forvard
s Finite
¢ Linear

Postion command wade
! Fasitisn data type

<Epaced te togwle mede
3-Select Metien D.Detailed U.3ave MD-Exit

Figure 7.16

5) Press the Space Key to change between absolute and increment.
6) Select either of the two settings and press the Enter Key.
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Other parameters are set in the same manner.
For details on parameters and contents of parameters, refer to 7.6 Setting Parameters.

7) Press F10 (Exit) to return to thé Edit Motion Parameters Screen.
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' 7.4 Motion Selection Screen Configuration

7.4 Motion Selection Screen Configuration

The following screen shows the Motion Program/Motion Parameters Selection Screen.

%

HEMOCON-£C GLAL %S08 I
L Ladder Legic Develapmant Seftwars ~ Selact Metien
Databaze: TESTL Halp: <Rlt-W>

CEnter) te Rdit <Esc> to Quit

l .21 Q. Exit
T — — ——— ———— A XA =

Figure 7.17

1} Module Numbers
Set the Module number (1 to 4) of the target IF66 Servo Module.
2) Program Numbers

The buffer number specifies the work memory space inside the Programming Panel. This
space is used as temporary memory for motion programs. It is possible to set the buffer
from 1 to 8 (2 kilobytes per buffer).

3) File Names
Up to 8 characters can be entered as a motion file name.
4) Title and Dafe Information

This is used és a comment field. It is attached to the motion file when the motion file is
saved.

5) Axis

Specifies which servo axes will be used for the motion file. The information contained on
this list can be used only by the Loader.
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7.5.1 Selecting O Number

7.5 Program Editing

The following procedures are used to edit motion programs.

Selecting O number.  Selects a motion program O number.

Line Deletion: Deletes a part of the motion program.
Selecting Axis Names: Selects the axis names of the servo.
Block: Executes block editing.

7.5.1 Selecting O Number

The foliowing procedure is used to select a motion program O number.

1) Display the Edit Motion Program Screen.

2) Press the Slash Key to display the Motion Command Submenu.

[EBTT ROTION FROGRAH TESTH HelprtAIt-H3]
Hob:i PP:1 O:lr FILE:MOTOPRO AxiziX- ~
AUAIL:ZIMS  USED: D3 Line 1 Cel 1 INSERT

Figure 7.18

3) Press F2 (Select O#). ‘

The screen for selecting O number will appear.

[ETT ROTTON PROCHRH TESIT e lp: AW
nopy FF:: 0:@2 FILE:WOTOFRC hxiz¥- —
H 0:12
0:83 0:13
0z 0:14
085 0:15
0:e 0:16
o:87 0:17
o:88 0:18
o 0:19
0:18 Q=29
Selece 08: IEDNIR
e —
AVATL:2845 UTED:08ED Lise 1 Col 1 INSERT
.Select Metien §.Lelect OF ].Bleck Jl.Delete J.Axis names J.Farssster: J.

Figure 7.19 ‘
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j 7.5 Program Editing

4) Move the cursor to the O number to be selected.

5) Press the Enter Key.

The screen of the selected O number will appear.

7.5.2 Line Deletion

Deletes one iine of the motion program.
1) Display the Edit Motion Program Screen.

2) Press the Siash Key to display the Motion Command Submenu.

ESTT TOTTON FITN TETTT _ Relp: ALY
MOD:L FP:i 0:81  FILE:MOTOPRG Rxiazd— =
NBEL OB X150, 346. 2. miSeEN;
NG OB x330. 480. 208. F5PeN;

L T

AVAIL:1996 USED:8@52 ‘ Line 2 Cal 1 IMEERT
-Salect Metien J.Select 08 P.Bleck J.Dulste J.Mxis namas . Paranetars ] Cavs

Figure 7.20

3) Move the cursor to the line to be deleted.

4) Press F4 (Delete).

The line where the cursor is positioned will be deleted.

ESTT ROTTON PRGN TESTT LOrROS )
HOD:1 PP:1 O:BL  FILE:WOIOPMO i k- -
N1 OB X350, 34, 342. FL5008;
R '
AUVATL:ZB1R UEED: 8830 Line 2 Cal 1 INCEXT
;8elect Metisn §-Select O D.Bleck I Delete P.Axis nanes Parameters J.Save

Figure 7.21

7.5.3 Selecting Axi§ Names

|
Selects the axis names for the Servopack.

1) Display the Edit Motion Program Screen.
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o et
7.5.4 Blocks

2) Press the Slash Key to display the Motion Command Submenu.

ESTT HOTIGH PRGN TESTT  Welp-<RIE-a)]
HOD:1 PP:1 O:@i FILE:MOIOFIC Axis¥- —

AUAIL:2845 UCED:0883 Line 1 Cal 1 INSERT

J.felact Hotiss J.felect OB P Rlack 2.Delete J.Axiz name: J|.Paremsters . Save

Figure 7.22

3) Press F5 {Axis names).

The screen for selecting the axis names will appear.

ESIT TOTTSH FIRCIH e Ip=iNIT
HOD:1 PP:i O:B1i FILE:MOTOPRO AxiziX- -

AUATL: 2845 UCED: B3 Line 1 Csl 1 IMCERT ‘

Figure 7.23

4) Enter the axis names.
5) Press the Enter Key. ‘

The axis names will be selected.

7.5.4 Blocks

A group of program lines can be defined as a block in motion programming. This provides
various ways to edit a motion program.

Block: Defines a block in 2 motion program.

Unbilock: Ungroups a block.

Block Copy:  Copies a block.

Block Move:  Moves a block.

Block Jump:  Jumps to a block. ‘
Block Delete: Deletes a block.
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7.5 Program Editing

1. Block

The following procedure is used to define a block in a motion program,

1) Press the Slash Key to display the Motion Command Submenu,

EETT WOTION PGS IR Wl
MOD:1 PP:t O:B1  PILE:MOTOPRO Axisd= —
MNBEL Gl KISH. J46. 142, FIS00;
NORZ  H3E:

AUATL:ZE1E  USED:0@30 Line 2 Ce) 1 INSENT
-Select Metisn J.talsct O §l.Bleck Jl.Pulete J.Axiz nanes . Parsmeters 3 Save

Figure 7.24

2) Press F3 (Block).

The Block Sﬁbmenu will appear.

AVAIL:ZBL  UCED:eE3e Line 1 Col 4 INSENT
Block: ).

Figure 7.25

8) Move the cursor to the program line to be defined as a block.
4) Press F1 (Block).

The line will be defined as a block.

MOD:1 PPiL 0zl PILE:MOTOSRO fxip iKX= —

WAIL:ZHE USED:BG sl k] Lina 1 Cel 4 INCERT
Mock: {].Blsck J.Unbleck Ii.Co - Reve JI. Ji |- Da laxw
Figure 7.26
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7.5.4 Blocks cont.

It is possible to specify the size of a block by selecting more than one line.

To create a block containing more than one fine, use the previous procedure to selectboth the
first line and the tast line of the area to be defined as a block. The text within the area between

these two lines will form one block.

2. Unblock

The following procedure is used to ungroup a block.

1) Press the Slash Key to display the Motion Command Submenu.

[EBSIT FOTTON FROGRAN TEETT HalpiTWIcH3
MOP:1 PP:1 0:81 FILE:MOTGPMM) Axis:X- -
L gmm
(=] :
AVAIL:2H13 USED:ON30 Lins 1 Cal 4 INSERT
[).-Sulect Hetien §.Selece 08 [.Bleck ]| Belste D-fxiz name: J).Paramsters Q-Seve

Figure 7.27

2) Press F3 (Block). ‘

The Block Submenu will appear.

Line : Cal 4 IMSERT

AUAIL:20Li8 USED:MGe
Black: .

Figure 7.28 '
3) Press F2 (Unblock).
The block will be ungrouped.
EFIT MOTTOR FROCIAH TEIT  Relp: (At
HoD:1 PPl O:81  FILE=MOTOFRO iz - ~

NGBl GEBL XIS8. 6. 342, F15000;
L - H

AVALL:28{E USED:BE38 Line 1 Col 4 INSERT
Black: [).Bleck § Unklsck P.Co Yeve J.J1 . De lste

Figure 7.29
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M

Note Onlyone biock can be defined at a time. Complete one block operation and ungroup the block
before defining the next block.

3. Copy
The following procedure is used to copy a block.

1) Define the block to be copied.

For details on defining blocks, refer to 1. Block on page 7-15.

MOM:: PP:i 0:f1  FILE:MOTOPMO Axin:¥- -

AUAILIZEIE USED:9838 Line 1 Cal 4 INSERT
Bleck: .Black 3.Unblack fJ.Ca: Fave J.Ji - Delste
Figure 7.30

2) Move the cursor to where the block will be copied to.
3) Press F3 (Copy).

The block will be copied.

EBTY WOTTOR PNOGNAN TETT W lp:ALAY
MOD:1 FPi1 0:81 FILE:HOTOPRO Axis k= =
et

N2 B
W3 GB: X3ISE. 3.“' 2. F15008;

WRIL:119S USED:B52 .00 k] Line 3 Col 4 IMGEWY

Figure 7.31

4. Move

The following procedure is used to move a block.

1) Define the block to be moved.
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7.5.4 Blocks cont.

For details on defining blocks, refer to 1. Block on page 7-15.

EETT FOTTON PROCRAR TESTT W lpiekiE—wy
#oD:4 PPii 0:81 FILE:MOTOPRO Axis K- =
My GB1 KIS8. 346. 342. FIS0NN;
N3 50. 346. 342, FL5008;

RUATL:19S  USED:0NS3 itk Line 2 Cel 4 IMSEMT
Bleck: {].Black_H.unblock J.Copy f.Move Delete
.
Figure 7.32

2) Move the cursor to where the block will be moved.

3) Press F4 (Move).

The block will be moved to the position specified.

BT TOTION FRGCWMH TR Relp: ALY
mop:1 PP:i O:81  FILE:MOTOPRO AxfsiX- -

NORL Gt X3ISE. J4é. 342, MIS008:
MEE? CB1 X358, 346. J42. FIS0NE;
NG M3E;

MAIL:1YYS USED:MEG3 Line 4 Col 4 INGERT

Figure 7.33

5. Jump ‘ ‘

The following procedure is used to jump to a block.
1) Define a block.

For details on defining blocks, refer to 1. Block on page 7-15.
2) Press F5 {Jump).

The cursor will jump to the first line of block.

6. Delete
1

The following procedure is used to delete a block.
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7.5 Program Editing
1) Define the block to be deleted.

For details on defining biocks, refer to 7. Block on page 7-15.

TESTT LD TR )
MOD:1 PP:1 O:81 FILE:MOTOPRO Mxiz:Xu -

!-1 GEL X3CH. 346. 42, PI.S-

AVAIL:17YS URED:@ES3 i K Line 2 Csl 4 INSERT
Black: Ihch .Unblack f].Ca .Feve J.Jusp J.Delets

Figure 7.34
2) Press F6 (Delete).

A confirmation message asking whether to delete the block will appear.

Figure 7.35

3) Enter “Y” to delete and “N” to not delete the block.

The block will be deleted.

[ESTT BOTION FROCRAH

o Tpz <RIt
MOD:1 PP:1 O:81 FILE:MOTOMWO Axlz )= =
NBR1 GE! X358. 346. 342. FiSems:
L F
AUAIL:2Bi8 USED:B8IN Line 1 Col 4 INSERT

Figure 7.36
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7.6.1 Setting Detailed Parameters

7.6 Setting Parameters

This section explains methods for setting motion parameters, in particular detailed parame-
ters and their contents.

For general information on parameter setting methods, refer to 7.3 Procedures for Setting

Motion Parameters.
Detailed parameters: Sets the detailed parameters.
Detailed parameter contents: Sets the contents of the detailed parameters.

7.6.1 Setting Detailed Parameters

A detailed menu of the parameter settings is provided.

The following example describes how to specify the position loop gain setting.

1) Display the Edit Motion Parameters Screen.

[EETY ROTION FAKAFETIRS TESTE — Relp:<Alc-H3|
MOBULE: 1 PROCRANRING PAMEL: 1 FILE: MOTOPAR
Feudrate (1) : BEED  (Gatunit/win]
Linsar accrleratison time (13 H L [mal . ‘
In-pesitisen ranyge H 1
Hetsr selectisn H ]
Encader ypulis par revelutisn B 3z (pmlsw<X42]
Foud par revelutisn H z27en
Gear ratis (woter zids? H 1 {ryeul
Gaar ratis (machine zide) ] 1 Lrreu)
Entar fovdrate {1-240.000)
{.5alact Motien J-Detailed O.%ave M.Exit
Figure 7.37 ‘

2) Press F2 (Detailed).

3) Move the cursor to position loop gain.

ESTT FROTTON PRMAHETERE TISTT  Halyp:<ATeH)|
MODULE: 1 PROCRAMMING PANEL: 1 FILE: MOTOMEK

Pesitisn lesp pain B [ v ] (181
Vslecity lesp gain H 15
Intagral gain B i8 [£4°-4 "0 |
Enceder salectisn H [ ]
Abeslute anceder admizsible errer: 2N Tpulse)
Pewdrats <27 H 1 [ ldwnic mind
Feadrats 1) z 1 [{xiBBl)unit mind
Fendrate (8 H 1 LA unis nin)

Enter gain (8200

{1.5elect Mation J.Genwral F-Save T Exic
Figure 7.38 ‘
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7.6 Setting Parameters

4) Enter an appropriate value (0 to 200).
5) Press the Enter Key.

Specify other detailed parameter settings in the same manner.

7.6.2 Setting Detailed Parameter Contents

The foltowing prbcedure is used to set the contents of the detailed parameters.
The example describes how to set the S-curve acceleration/deceleration.

1) Display the Edit Motion Parameter Screen.

ESIT ROTTON MGREYER TR e Ly GATEH]
MODULE: 1 PROGRAMMING PANEL: 1 PILE: MOTOPAR
Pesdrats (1) : MEEED  (<ASMDunit/min)
Linsar acceleration time €13 H i {oal
In—peaitisn ranye H i
Hater zelectien H »
Enceder wulss per revslutisn H 3TN [pulsecids)
Tesd per revelutien H 32°%9
Coar racie (neter zide? H 1 Lrrev]
Gear ratis <(sachine side> T 1 Trravl
Enter Fesdrate C1-148,.000)
I-Seluct Metisn J.Dwtailed O-Save HI-Poeit
Figure 7.39

2) Press F2 (Detailed).
3) Press the Pége Down Key.

4) Move the cursor to the S-curve acceleration/deceleration.

ESIT FOTTON ORRETER — TBIT - Relp:<hic-HY
MODULE: 1  PROGRAMAING PANEL: 1  FILE: HOTOPMAR
Dacisal places ER |
§ curwn accelridscel = xm
Curraat limit T OFF
Pasdferuard : OfF
2=atep sccolrdacel 3 1-xtep
Feedrate limic : OFf
ficcwLdacel pactarn = OFF
Suftusre travel limit : OFf
<Epaca}> o tegglas On OFF
B.8elect Mevien §.Caneral D.Contents D.Save WI.Eicit

Figure 7.40

5) Press F3 (Contents).
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7.6.2 Setting Detailed Porameter Contents cont,

6) Enter an appropriate value for S-curve acceleration/deceleration constant (2 to 126).

EBTT WOTTON FRARETEE w {p:AIE:
MODULE: 1  FROCRBAMMING PANEL: 1  FILE: HOTOMR
Decimal places H 3
£ curvs accel/dscel : Om

hccal-decel pattem : OfF
Seftwars cravel limit : OFf

<Epacs te tegyls O Off
H-Sslect Metien J.Ganeral I.Cantents J.5ave [ Exit

Figure 7.41

7) Press the Enter Key to return to the screen for setting detailed parameters.
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7.7 Monitoring

7.7 Monitoring

The monitoring functions display the motion program that is currently running or the current
positions of its motor axes.

Moenitoring programs: With this operation the block of the motion programthatis current-
ly running can be displayed.

Monitoring the current positions of motor axes:
The current values of the motor axes being used can be displayed

on the screen.

Both monitor functions are online functions and cannot be used when offline.

7.7.1 Monitoring Programs

The block of the motion program that is currently running can be displayed using the following
process. .

1) Select 4. Motion from the Main Menu.

NEROCOM-5C CL4844-79
Ladder legic Mohrnt Caftuare / Main Hemu
Verzian 2.88 Copyright 1991 YACKAUA ELECTRIC CORPOMTION
Batabaze: TEST1 Nelpz <Alt-H>
Hain Menu:

1. Select fctive FLC
2. Offline
3. OnIine

. t Mctive FLC
6. T

7. Uzilicies

<E> ta Exit t» Dos
Enter Optisn: EB

—— . ——— T — e YASKAUA =

Figure 7.42

2) Select a Motion File.
For details on motion file selection, refer to 7.1 Procedures for Selecting Motion Files.
3) Select 5. Program Monitor from the Motion Options.

Program Monitor is an online function; you must have a communications link with the Pro-
cessor. Before selecting 5. Program Monitor, make sure that the computer and Proces-
sor are connected so that the computer can go online with the Processor.
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7.7.1 Monitoring Programs conl.

When monitoring programs, select a motion program before selecting the monitor func-
tion.

——

MEMOCON-E£C GLAR/60-78
ladder Legic Develepmant Seftwars ~ Edic Hetisn
Datakase: TEETL Holp: <ALt-H>

HOTION Optisns:

1. falact Databass
2. Sslact Preyran/Paramsters
3. Pragram

4. Faramsters

i. ElﬁEn En!eu-

<Eac> te Meturn te Main Manu
Enter Optien: N

—————eit - == FASIRVA =

Figure 7.43

The screen for entering the device address is displayed to allow the user to go online be-
tween a device to the Processor. '

MEMOCON-6C GlAS/60/78
Laddar Legic Davelepment Seftware / Edit Metisa
Database: TESTL Help: <ALE-H>

Enter device addreess

, CEnter? 1o Attach <E<e> to @it ‘

Figure 7.44

4) Enter an address, then press the Enter Key.

The screen for selecting the Servo Module will appear. ‘

HEMOCON-SC GLARAA-M
Ladder Legic Devaleyment Seftwars / Edit Metisn
Databasze: TESTD Help: <Ale—H>

{Enter? to Confirn <Fuc? tu Return 1o Moo I

Tr—— ——————— YASXAUA =

Figure 7.45

5) Enter a Servo Module number and the desired axis, then press the Enter Key.
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m

The Monitor Program Screen will appear.

TR LR
MnoD=1 FP:i O:lt  PILE:MOTPRMO Axis:X-¥-Z

m Wllﬂ. YH2 TN3:
Lt H

<Est) t» Quit

Figure 7.46

7.7.2 Monitoring the Current Positions of Motor Axes

The current positions of the motor axes used can be seen on the screen.

1) Select 4. Motion from the Main Menu.

ladder Lagic be hxthfl # Main He
13 1]} 1 AT IRLL
Versian 2.88 Cepyright 19T TAEINUR ELECTR G CORPORNTION
Database: TEST1 Help: <R1e—H>
MHain Menu:
1. Ealact Acties PLC
2. Offline
3. Online

- t Active PLC
6. Leadar
7. Utilities
<E> te Exit te Dex
Enter Optisa: B J
— a— — —— AT XA =
Figure 7.47

2) Select a Motion File.
For details on motion file selection, refer to 7.1 Procedures for Selecting Motion Files.
3) Select 6. Position Monitor from the Motion Options.

Program Monitor is an online function; you must have acommunications link with the Pro-
cessor. Before selecting 6. Position Monitor, make sure that the computerand Processor
are connected so that the computer can go online with the Processor.
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7.7.2 Monitoring the Current Positions of Motor Axes conl.

When monitoring a position, always select a motion program before selecting the monitor
function.

e e ————— = —— ==

MEMOCON-SC CLAM68" 78
Ladder Legic Devslspaent Seftwars / Edit Metien
Database: TESTL Help: <Alt—H>

MOTION Optisne:

1. Salect Databass
alsct FrogranParsseters

2.

3. gran
4. Faransters

5. Fro Meniter

<{Ezse> te Npture te Muin Fenu
Eater Optisn: T

Figure 7.48

The screen for entering the address of the device to go online with the Processor will ap-
pear. ‘

HEMOCON-SC CLAG/GB78
Laddsr Legic Develapment $eftuare ~ Edit Metien
Databaza: TEXT1 Halps <Rlt-H>

B

Figure 7.49

4) Enter an address and press the Enter Key.

The screen for selecting the Servo Module will appear. ‘

C
| Laddsr Legic Develspment Seftwurs - Edit Mazien |
Databazs: SAIO Nuly: CAIt-H>

Suleet 1Rut scrwo Module <1-42: Ed

© <Enter? ta Confarn <Fzc? 1o Return ta Mrnog

L — == ae— ——— —wrwm YASKAWM =
Figure 7.50
5) Enter a Servo Module number and press the Enter Key. ‘
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' ' 7.7 Monitoring

The Monitor Position Screen will appear.

. EL0(] I-IERIIFIIF
MOD:1 PP:I O:@1  PILE:NOTPRO

Axis Hang Fesitien
1 X +48_B57
2 ¥ ~197_565
3 z +300. 008
4 ] +100. 00
5 ¥ el B ]
[ " +759 .06
7 -

[ ] -

<Eac> te Quir
Figure 7.51
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Printing

This chapter describes the lists that can be printed with the MEMO-
CAD-PRO Lister, as well as cross-reference data, list settings and
printer parameters.

8.1 Sample of Lists ..... ceveeseesan cetesenaan 8-2
3.2 Cross References ........... terecaasas eee. 811
8.3 List Settings ............... teerereenes eee 8-13
8.4 Printing ............ et ssccransas 8-36
8.5 Cancelling Printing ......... ceserennes ceen 8-38
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Printing

8.1 Sample of Lists

The following shows a sample of lists which can be output using the print function. The print-
ing style can be changed by modifying the function.

MEMOCAD-PRO Lister Sample List
» Ladder Lists

1) Ladder without comments

2) Ladder with comments (with short comments below the ladder diagram)

Note If a short comment cannot be contained in one line because of the type of printer
or size of paper used, it will be printed befow the ladder diagram.

3) Ladder with comments, page title, page number and cross references
{with short commenits to the right of the ladder diagram)

¢ SFC Lists

4) SFC without comments
5) SFC with comments
= List of Allocation Tables
6) System configuration
7) /O Modules
8) /O allocations
9} PC Link, high-speed station allocation
10) ASCIl and YENET allocation
¢ List of Discrete /O Tables
11} Used tables
12) Disable tables ‘
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) _ 8.1 Sample of Lists
M
» List of Register Tables
13) Used tables
14} Contents
» List of SFC Status Tables

15) Mode tables

16) Simuilation tables

17} Used tables

o List of Commént Tables

18) Printing commgnts

19) Network comments

20) Mismatch comments (unreferenced)
21) Mismatch comments (undefined)
* ASCli Message List

22) ASCII messa:ges (message list)
23) ASCIl messages (used status list)
» Motion List

24) Motion prograjlms

25) Motion parameters
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Printing

L.adder Lists

1) Ladder without Comments

2) Ladder with Comments

LE - FETHORK COPMENT SAMPLEL

s ]

NI

3 -E? M )
5 B
2% ; ERROLNE ;

3) Ladder with Comments, Page Title, Page Number and Cross References

i
it ot
5 ﬂﬁw

= A

SFC Lists
4) SFC without Comments

5000 : 2 1
1 st 02 5006
oL ) Took
01 000
o Toor
004 s
To4 Too8
Sous oo
4 - Tooy

1 1
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‘ 8.1 Sampie of Lists

5) SFC with Comments

SAWLE L7 DATARASE

SFC S0DD continued an mext page ...

List of Allocation Tables

6) System Configuration

PLC CORFIGURAT 00
———t a5

Active FLC: SAPLE

Procassor: SLbOH
User Wamory  ; 012%word Scan 1ol 2
Mwory mu!!ﬂc # Alocated . Sequinrt Start m-_-_:_
T
P Mii i i
NENDRUS . o

ta "vuts
i ra’ x
Ition ui'ls
7) /O Modules

1/ CAND QESCRIPTIONS

e i 1’\‘!{ TS DESCRIPTION

FEFLFE EEEE]

1

8) /O Allocations

1

SURY o T-CoF 170 ALLOCATION

mll

"""'H"i:?‘! ot need RTEE O !ﬂ"i-&"mh nere BT RlN,

;mriﬁaﬁﬁin@ ---- =gl o
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g) PC Link, High-speed Station Allocations

SUSULY OF TRAFFIC COF

LEMK ALLOCATION

HIGH SPEED STATION ALLOCATTON

Pow o opm oW Wh o B

HUHE

10) ASCIl and YENET Allocations

SUMARY GF TRAFFIC COP
ama.

ASCIT ALLOCATION

[ ——
Filtiiis
i

List of Discrete Tables

11) Used Tables
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8.1 Sample of Lists
M
12) Disable Tables

MEFEKEMCE Mo. 1 D001 - 0asolt SRETE DISABLE TARLL
————inieee:

S1234967%
=F-- -

T ENABLL O:DISAME O FiGISAMLE DFF
0a50K : -

List of Register Tables

13) Used Tables

. RERISTER WSEG TARLE
REFERENCE Mo, : 40001 - A0SOC

SEHIEY

TR I TR IY)

14) Contents

PEFERENCE Moz 40001 . aopg o oS OF MEGISTER
IEFEAENCE N o)

= BEX an ASCIT
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List of SFC Status Tables

15) Mode Tables

SUMMALY OF SFC STATUS - COMDTTION SEYTING

INITIALIZE
e Mt S

PRESET

3 % Slgg—;s w

_Stq Bo. | Register

16) Simulation Tahles

SUMMARY OF SFC STATUS - SIMULATION
A: Active D: Disasle N: Wld *: hetiveldela

et

17) Used Tables

SURMARY OF SFC STATHS - YSEAGE
e

o Uused A Actien B Mcrs 1 Traksitien
L]




81 Sample of Lists

List of Comment Tables

18) Printing Comments

REFEROICE No. : 00001 - bonyg  COVENT TARLE
i 1 200
00001 : | Le|
illea WL AN NTERTRRIR]
o002 1 0 ] 1)
.ten e,
00003 : biEtets 1 L
al
. Rk TETRS
00004 : | | L)
oW
00008, 1 iy 1) 1]
00006 17 o 1 Lel
00207 T Lt}
[
00000 - 1 b =)
i ARLE
00809 : v L
s, TRANE
obd1e : T ey
s TAABLE
ooa1L 1 T 1)
o
00012 - | e ] i
wa3 -] e 1 el
[ oy SO 1 LE)

19) Network Comments

20) Mismatch Comments: Unreferenced

21) Mismatch Comments: Undefined

ASCIl Message List

22) ASCIl Messages {Message List)

Nodule i1 ASCIT MESSAZES

MeATagt nsher :00D] Hesiage used mmwry 0020 Rendad regs mem ;003
Weduba: ‘ASCIT MESSAGE TEST BATA', [1. 1,14, IX,

Netsage mEber ;0002 Messhge wiod memory (0017 Noacded Fags nam DB
Module: *ASCIL NESSAE TEST paTa’,lp,

Meisage mmber 0001 Message used mmcry 0006 Readad regs mm ;043
Aadute; 811.1M1,50,

Mt ragn tusher 0804 Meisige uind mmery 0012 Nosiod rogt e ;000
Hodule: "SNPLE SHPLE SNWLE', 'TEST TEST THST',

23) ASCII Messages (Used Status List)

Hodule mmber ;| ASCIT MESSEs
————————
All massages arsa 112264 Miisages wiad 10004
All mussages M. L0 Misiages svallable ;1028
Max maysage %o, 10004 Mampry utad 00088
R
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Motion Lists

24) Motion Programs

WOTION PROGRAM
SR e some
[N W Aafs Names:xe -

o:a)

25) Motion Parameters

MITION PARNETERS
S : e v
W00:2 PPk Asitile - v e v -

Fasdrats {1} 0 [(x1000)vnit/nin]
Linsar acexloration time (1) 100 [ms]
In-pagition range 1
otor selectisn "
Enceder pulse por revelvtion 218 [pulxe(¥s))
Fond par relution w2
Gaar ratie {meter sige} 1 Lirw)
Gosr Tatin {mackine side} 1 [re]
Motor Totatienal direction F t

) -
Postion command mode Absalete
Pasitinm data tyve Mnary
Positicn 1eep guin W [5-1)
Yelocity lesp cain 15
Intagral pin 10 [(x2}ma]
Encaler stiaction 8 [putss])
sitalute wnceler awissible errar 2%
Fowtrate (2] 1 [{x1000)wmit/min]
Fosdrute {3) 1 [{x1000)unbt/min]
Fesdrate (4) b [{x1000)uniz/min]
Decimal places 3

MOTION

5 purve accel/decal ofr
Currect 1imit oft
Fosdtonurd of
2-stop sccal/dece] 1-step
Fesirate |imit off
Acos/dece] patters off
Softwere traval Vit off
Backiash compancatish ofr
Moy ratyrn eft
Entermal svar travel sipml ot
Extermal SHOP sigaal off
Wraky caneallation signel off
Pulsa $ighe] inpet orf
Fasdback pulse sigeal or
Marlgrborhosd 51pnal ot
Dver travel sigal chande Normal
Others
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8.2 Cross References

8.2 Cross References

Cross-reference data is necessary to perform printing. Cross-reference data is the data that
is printed together with ladder lists and table lists and it is used to indicate which network an
address is in and where a coil's address is used for a relay.

The following procedure is used to calculate a cross reference. The cross reference files are
created when calculation has been completed.
Cross reference files; ?7?.XR1

?7?.XR2

7?7?2.XR3

???.XRD ???: Name of database

1) Select 2. Offline from the Main Menu.

MENQCON-EC WIM
Ladder Lagic Dsvale runr Seftvare / Nain Benu
Verzisn 2.8 Copyright 1931 YASKAWS FLECTRIC CORPOMTION

Databape: TESTI1 Halp: <ALe-H>
Mals Memu:

1. Select #ctive PLC
-

Hetian

List Active PLC

Loadar

Ueilicies

<E> te Exit te Dea

Encur Optisn: HI

— ——— - TASAWA =

NI ILFY
Pt ot

_Figure 8.1

2) Select 8. Cross Reference Disposition from the Offline Edit Menu.

NEMOCON-SC GLARS0/78
I Ladder Legic Develepment Seftwara ~ Edit Menu |
Databaze: TEST1 Help: <ALe-H>
OfFline Edit Menu:

lsgt Netive PLC
- T -

Bequentisl Pusctien Charce
macriptars

‘anhu- Daué tie
SET8F I mﬂ L]
nsc?l Hetea

WIS W
Lt

|

<Esc> te Feture te Frevisus Mens
Entur Optisn:

r— — c— Yatinpn -

Figure 8.2

3) A message will appear to confirm the contents. Enter “Y” or “N” as appropriate.

The calculation is executed.

Note (1) ifacross-reference does notexist, it cannot be printed. In addition, if a cross-reference
is not current, the correct program data wili not be printed.

—8-11 —




Printing

(2) After editing a network, always perform the cross-reference calculation and update the
data.

(3) Depending on the program, cross-reference data can be a substantial size. Always
check that there is enough free space available on the hard disk of the computer, as the
size of the cross-reference data may reach two to three times the size of the database
in a program where the same address is used for many purposes.

— 812 —
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8.3 List Settings

m

8.3 List Settings

The foliowing settings are possible for lists.
o Printer Parameters Settings

Sets the model of the connected printer, as well paper size, dates and page numbers.

» Printing Mode Settings

Sets what type of list will be created. Also, the type of ladder or table lists and range of
data to be printed can be specified.

Registering a New Printer

Itis possible to change the printer control codes of the models supported by MEMOCAD-
PRO. The changed code system can be registered in any name,

Note Aftereach parameter has been set, press the Alt + E Keys to save the set contents. Or, press
the “3” key from the Print Menu (the Main Menu of the list) to move the cursor to Save List
Settings, then press the Enter Key to save.

8.3.1 Printer Parameters Settings

Sets the model of the connected printer, as well paper size, dates and page numbers.

—_— = ————— ————————
| PRINTER PARRMET S

Molp: CAlt=H>
Pristar type: TR T Tz Vi o

Priater commectian: Farallsl - LPFT1
Form size: 11™ wide by §.5" leng

4= -+ or Spaced = Change Sutting

Figure 8.3
Printer type: Set this to match the printer connected.
Printer connection: Select either serial communications or paraliel communications.
Form size: " Sats the size of the paper to be used for printing.
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Printing
e e s _ ]
8.3.1 Printer Parameters Settings coni.

1} Select 7. Utilities from the Main Menu.

HEMOCON-EC AN 20
Ladder Legic hulmu: Softwars 7 Main Metu
Version 2.00 Copyright 1 THEKAW ELECTRIC CORPORRTION

Database: TEST1 Help: <Alt—H>
Hain Reous

Select Active PLC

Offline

Online

Natian

Lizt Retive PLC

Laader

1.
2.
a.
4.
5.
€.
i

YR
CE> ta Exit te Des
Entar Optisn:

YASKAUA

Figure 8.4

if a database has not been selected, the screen for selecting a database will appear. Se-
lect a database using the procedures described in 3.1.3 Selecting a Database. f the da-
tabase selected is being changed, select 1. Select Database from the Printer Menu.

2} Move the cursorto 1. Configuration from the Utility Menu and press the Enter Key to dis-
play the Printer Parameters Setting Screen.

MEQCON-EC GLAR-E8-78
Ladder Leyic Develspasnt Seftuars / Cenfiguratien

Database: Help: <ALt=X>
Canfigwratisn Optians: ‘

1. Screen Paramatars
b T
<Eac)> ts Feturn ts Main Menu
Eatey Opcian Wumber: B

YALRAUA =q

Figure 8.5

3) Move the cursor to 2. Printer Parameters and press the Enter Key.

4) Move the cursor to Printer type.

[ PRINTER PAMMKETERS ]
reinter types [TERIIT 2
Printar cemnsctisn:  Parallsl - LITL
Ferm nize: 11" wide by B.5 lang

L= 4 ar Space’ - Change Batting

— e ——— YATKMM_ =1

Figure 8.6
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8.3 List Settings

5) Press the Space Key to select the type of printer to be connected.

8) Move the cursor to Printer connection.

Help: CALc-H>
Printer type: KP Lazerjet 11 (Lu-thL)

Printer conmsctien: IO
Forn sixe: 11" wids by 3.5% leng

<4+ = or Space> - Changs Satting

Figure 8.7

7) Use the Space Key to choose the appropriate type of connection for the printer.

8) Move the cursor to Form size.

PRINTER PAMINETERS ]

Help: <ALt->
Printer type: HF Lazerjet II <LandSingle)

Printer connectisn: Farallel - LPTL

Parm sixze: TR Ty

{4 =+ or Space> - Change Catting

Figure 8.8

9) Use the Space Key to select the appropriate paper size.

Instead of using the Space Key, itis possible to select the form size by pressing the Right
and Left CursorKeys. To alter pages or dates, press the Enter Key while “Y” is selected to
display the input field. Enter the appropriate numeric values and press the Enter Key.

10) Press the Alt + E Keys to save the setting and return to the Print Menu,
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8.3.2 Network/SFC Print Settings

8.3.2 Network/SFC Print Settings

The following procedures are used to specify print settings for a ladder list or SFC list.

H Print Nevwrk # SPC |

Databazs: TEET1 delp: <Ale-d>
ickisn Metwar Al
Transicien Netwerks : All
Netwarks : Specify -1
Suwweuting Netwerka lﬁﬂ
Print A11 Mews 7
1nclude ln:rigon Yos Lline 3 line
3 Reference: Yes
Meltipls Net L

{— / ==> ar space Change $attiny <ENTER) Sat up ranpe
<Alt-E> Sava and Quit <Exc) Done <Homn> Lave and Quit
l— —eee

YACKAUA =

Figure 8.9

SFC’s, Action Networks, Transition Networks, Networks, Subroutine Networks:
Selects either the ladder list or SFC list to be printed.

Print All Rows?:

If Fixed is specified, seven blank lines are printed when a program ends. If this function is set
to Variable, it is possibie to move to the next network without printing the remaining empty
lines.

Variable: Include Descriptors:
Sets whether or not the ladder list should include descriptors (comments). The signal names
can be set for 1 to 3 lines of print.

Inciude Cross Reference:
The cross reference for a coil is normally printed beside the coil or, depending on the size of
paper used, under the network.

Multiple Networks/Page:
Sets the number of networks printed on one page to either one network or as many networks
as can be contained.

Print Page Title:
This function will print the page title created on the network descriptions at the top of the page
of the ladder list.

Print Power Rail:
Sets whether or not to print the power rail on the right end of the form. (The power rail is nor-
mally printed on the left end.)
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M

1) Select 5. List Active PLC from the Main menu.

'ich. rlntll'uu-/lh
v af e
1

Ladder
Versisn 2.88 Capyright 1 YAEXAUR ELECTRIC oomnnm
Datadaze: TESTL Help: <Alt-H>
Main Mena:
1. Sulact Rctive FLC
2. Offline
3. Online
4. Hatisn

Ly er i
<E> te Exit te Des
Enter Opcien: B

wva— —— or—— YALKAM =

Figure 8.10

2) Move the cursor to 2. Print Network/SFC and press the Enter Key.

The Print Network/SFC Screen will appear.

o Print Netwirk ¢ SPC

Databaze: TESTL Help: <Ale-H)>

3 CWer]
Transitien Netwerks

Natus: :
t-h"utinl Natverks t  Nene
Print lll L] T Fixed
nE

B

=

Fhlti'l. l.lt\-r

Print Page T 3 Yas

Prist Pever llﬂ : Yes

€= 7 =3 or space Change Sstting <ENTER)> Lot up Fange

CALt-E> Save and Quit <Esc> Dene CHoma)> Save and Quit

——— ac—— = ————

Figure 8.1

3) Move the cursor to SFC’s and press the Space Key to select from All, None or Specify.

| Print Natusrk - $PC ]
Butabase: TESY1 Holp: <Alr-H>
Specify sl - £512
2 Mane

cisn twe
Transicion Metuerks : Nane

Figure 8.12

4) If Specify is selected, press the Enter Key and the area input field will appear.
5) Enter the first address to be printed and press the Enter Key.

6) Enter the last address to be printed.

Enter $PC Address Rangw
ttart Address : COBL

End Addrews - ENTTRENENN

Valid Mange: T8 - SMAX

Figure 8.13
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8.3.2 Network/SFC Print Settings cont.

7) Press the Enter Key to save the area setting.

| Print Metwerk ~ $PC . |
Database: TESTL Help: <N1t—W>
tien ok B m”, o - il
Tranzitien Netwerks : Mene
Figure 8.14

8) Use the same procedure for the setting of the action networks, transition networks, net-
works and subroutine networks.

9) Move the cursor to Printall Rows? and press the Space Key to select either from Fixed or
Variabie.

Netwpria = Al
Subreuking Netusris 2 Nenw

IIIW Fived
"o scriptare s Yes lina 1 3 Lline

Include Creps Mafsrence: Yes
tultipls Netwerks/Page : Ha
Print Paga Title :
Print Pawar Rail z Ye3

(= s —7 ar spaca Change S$atting <(EWTER> Setr up range

<Ale~E> Save and Quit {Ezc> Dens Ciome> Lave and Quit
—— ———r——=me——ar— YASKAVA

Figure 8.15

10) Move the cursor to Include Descriptors and press the Space Key to set either Yes or No. ‘

Netusris : Al

Sulesutine Wetwirks T Hene
Print All Bewe 7 3 Flxced
Yas line = 3 lins
Multiple ih:‘ h:;.“.: l!h.-
W] H
Print Pags Title e : Yes
Print Power Rail Yoz

(== 7 —> ar spats Chamge Letting <ENTER)> Set up range
CA1t-E> Save and Quit <Esc> Dens (Home? Save amd Quit
—E—— S

YaLkatm ‘

Figure 8.16

11) If Yes is set and the Enter Key is pressed, the input field to set the number of lines to be
printed for the signal name will appear.

Use the above step only when the number of lines to be printed needs to be changed.

Pleass entar line nunaber sf conmant synlwl
Line number of Synbel: B

Figure 8.17

12) Enter the number of lines to be printed and press the Enter Key.
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8.3 List Settings

13) Move the cursorto Include Cross Reference and press the Space Key to select either Yes
or No.

14) Move the cursorto Multiple Networks/Page and press the Space Key to select either Yes
or No.

15) Move the cursor to Print Page Title and press the Space Key to select either Yes or No.
16) Move the cursor to Print Power Rail and press the Space Key to select either Yes or No.

17) Press the Alt + E Keys to save the setting and return to the List Menu.

i
8.3.3 Print Tables/Reports Settings

The following kinds of table lists are possible.

I Print Tables 7 Raperts }

Davabase: TESTL Balp: <ALlt-H)>
IR IR Specify

Print Biscrets Tables : Spacify

Print Megister Takles : Spacify

PFrint $FC Stactus : Epecify

Print Descriptors Tablea : Spacify

Print ASCIT Messaye : Specify

. {— 7 ==> or space Changs Latting
ALC=E> Save and Quit {Exc)> Bane CHoma)> Cave and Quit
—_— — —

Yasuaun =

Figure 8.18

Print Allocation Tables:
Prints lists of /O, program memory, and other allocations.

Print Discrete Tables: _
Prints tables which indicate the disabled status and used status of relays and coils.

. Print Register Tables:
Prints tables which indicate the used status and contents of each register.

Print SFC Status:
Prints the tables for SFC mode, simulation, and used status.

Print Descriptors Tables:
Outputs lists of the descriptors created. If the cross reference settings are also output this can
be used as a cross reference list.

Print ASCIl Message:
Outputs lists of ASCIl messages.
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M
8.3.3 Print Tables/Reports Settings cont.

1. Print Allocation Tables Settings

The following procedure is used to print various kinds of allocations performedin 4.5 Set-
ting the System Configuration.

{ Print Wilocatisn Tables ]
Databaszs: TESTL Hulp: <Alv-3>

SR oo
1/0 Hadule Descriptisn = Yox
Print I/0 Allscatisns = All

e foacs Trations ~ T
L t ]
peLial

MBCLE
YENET

{— 7 —=) oy space Changs Tetting <ENTER> St up renge

<ALt=E> Soww and Quit {Esc> Dame <Hons> Save and Quit
—— == YREKAUA =

Figure 8.19

System Configurations:
Prints details such as the type of the GL processor targeted and program memory allocation.

/O Module Description:
" Prints the names of Modules on the /O allocation list.

Print YO Allocations:
Prints the 1/0 allocation for each rack and slot.

. High-speed Stations: ‘

Prints the high speed stations allocations.

PC Link:
Prints the PC link allocations.

ASCII:
Prints the ASCI| allocations.

YENET: ‘
Prints the YENET routine tables.

1) Select 5. List Active PLC from the Main menu.

cLaeh-7e
> Lagic I-U-I. n: Seftwars 7 Hain Meou
H by

lloni.u 2. - Capyright YASKAUA ELECTRIC CORPOMYION
Database: TEETL Help: <Ale—H>
Main Henu:
1. Selsce Aceive FLC
2. OFEline
3. Oalina
4. Matisn

- 4

7. Btilities
<E> o Exit to Das
Enter Optisa: @

— v YAEMAM

Figure 8.20 ‘
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““

2) Move the cursor to 3. Print Tables/Reports from the Print Menu and press the Enter Key.

Whenthe Enter Key is pressed, the default is Specify. Press the Space Keyto setto either
None or All. When Al is selected, all table/reports will be printed.

The Print Tables/Reports Menu will appear.

L Print Tablas + Raports ]
Database: TEST1 Halp: <Ale-d}
T TN PTICEME Nens
Print Mzcrats Tables : Mang
Print Regizter Tables i Mana
Print LPC Status 2 Hene

Print Dascriptera Tahles : Nems
Frint ASCII Pessagm 3 Heas

{— 7/ —> sr upats Change Setting
CALt—E> Save amd Quit CEzc) Done (Kenw> Zave and Quit
— v

Figure 8.21

3) Move the cursor to Print Allocation Tables and press the Enter Key.

The Print Allocation Tables Screen will appear.

L Print Allecaties Takies ]
Ratabaza: TESTL Melp: <Alt-N>

170 Madule Descriptien :

Print 170 Allecacisns
Other Allecatisnz
High

Nieh Epond Ftatisms )
#scr1

{«= /7 —» or spacy Change Setting <ENTER) Set wy range
<A)t<E> Save and Guit {Esc> Dems {Nema> Tave and Quit
I e

YASKALM

Figure 8.22

4) Press the Space Key to select either Yes or No for Systermn Configuration.

L Print Allecatien Tables ]

Dutabaze: TESTL Halp: <Alc-H)>

EYEIREIIETTTS TR Yo

Figure 8.23

5) Move the curéor to IO Module Description and press the Space Key to select either Yes
or No.
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6) Move the cursor to Print I/O Allocations and press the Space Key to select either All,
None or Specify.

] Print Allecatisn Tables 1

Databaga: TESTL Halp: <Ale—H>
System Configurations :© Yes
I/0 Module Description © Mo
- - Specify OCH1:STE1-CN3:§TI2

Figure 8.24

7) If Specify is selected, press the Enter Key to display the area input field and enter the
areas for the channel and station.

Priat rasge of 1) Allscatiens

Start chanmel: 1 Statien L -
End channel: 3 Statien 1 I

Ualid Range Chesssl : $1-83 Stactien : &1-22

Figure 8.25

8) Press the Enter Key to save the set areas.

[ Priac Allecstisn Takles
Database: TETT1 Malp: <Ale-d>

Syaten Configuratisns s Yes

I/0 Nodule Pascriptieon : e
- - Bl Specify OHL:STEI-CN3:$T32

Figure 8.26

9) Move the cursor to Other Aliocations and press the Space Key to select either Yes or No.
10) Press the Alt + E Keys to save the settings.

Note The printer will omit unallocated portions within the range specified by All or Specify.
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2. Print Discrete Tables Settings

The followihg procedure is used to print tables which indicate used or disabled status of
relays and coils.

| Print Diacrete Tshle (12> ]
Datahaze: TESTL Welp: <ALE~d>
.m_ Spacify
®oco: 3 Spaciiy  IGET - G192
Locex ¢ Specify 10081 - 1489
BIXXY : Specify DaeSl - Dikz4
FELK | fmcify ML) -
: fpec -
WOBKX 1 Specify NGSl1 - eeds

= 7 = sr apace Changs Satting <Pglp2>.<Pyln> fot op Contrall Code
(A3e-E> Sawn and Quit KEsc> Done SHemad Cave and Quic
—— ——— c——— ———

| Print Discrate Tables <2/2)
Batabase: IESTL Nelp: <Ale-N>

XAK = Specify  GIOEL - GE192
: fpec

®2:

Specify ML - MSB44

HE1xx Spcify  MS111 - MS14
Specify HBELL - NBB4Y

<= 7 —> or zpace Chanpe Sutting  <PgUp>.<PgDn> fot up Cantrell Cods

CAle-E> Save and Quit {Esc> bens . (Hews> fave and Quit
—— = r— = YASKAUA =
Figure 8.27
Print Used Tables: Prints a list of the used status of coils and relay programs.

Print Disabled Tables:  Prints a list of the disabled status of coils and relays, as well as the
OFF or ON status if Disabled is selected.

1/2 Used Tables — 2/2 Disabled Tables:
Can be switched using the Page Up and Page down Keys.

1) Select 5. List Active PLC from the Main menu.

%
HEMOCON-SC GLAB/S0-78
lltrlhnh:f.-’ g::iﬂc"gﬁ'ﬁsaﬁélﬁi&mnu
Datapase: TESTL Nelp: <Ale-4>
Main Menu:
Salsct fctive MC

1.
2. Offline
z. Online

70 Urilities
{E> te Exit te Dex
. Entsr Owtien:
—r—— e — YREKAUA =

Figure 8.28
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8.3.3 Print Tables/Reports Settings cont.

2) Move the cursor to 3. Print Tables/Reports from the Print Menu and press the Enter Key.

The Print Tables/Reports Menu will appear.

[ Print Tehles < Reperts }

Batabase: TEST1 Walp: <Ale=H>
Print Allecatien Taklea : Spacify
IR P ITCEE None
Print Ragizter Tahlss I Nens
Print SPC States = Nema
Princ Descriptors Tahle: :  Nean
Priat ASCII Massapw I Hene

L= 7 —> or tpate Change Setting

<A1lt-E> Save and Quit CEsc> Dane CHama) Save and Quic
I& —r— e rw—— YASKAVA =
Figure 8.29

3) Move the cursor to Print Discrete Tables and press the Enter Key.

When the the Enter Key is pressed, the default is Specify. Press the Space Key to setto
either None or All. When All is selected, all reference numbers will be printed.

The Print Discrete Table (1/2) will appear.

I Prist Discrete Table <i/2) ]

Patadase: TEET1 Help: <Alt—H>
T FUITTE. £pecif ¢
oot : Epecify SEBEL - SESES
Looo ¢ Hane
:  Nens
nEERK : All
MS1iXX = Nene
ROEXK =  MNens

(= + =5 sr space Change Setting <Fgiip>.{(Pgbn> Sac up Centrell Cede

<A1t-E> Save and Quit {Ezc> Dans <Homn) Lava and Quit
— — YASKALA

Figure 8.30

4) Press the Space Key to select either All, None or Specify.

5) When Specify is selected, the cursor will automatically move to 0x00x.

[ Print Diccrats Tebls <i/2) 1
Dutabuses TESTL Help: <Alt—H>
Prist Used Tables

- hsee

190w - 1486
DessL - D24
se1L - e

Yy MSL11 - PSLM
HOS1L - MBSt

Figure 8.31
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m

6} Press the Space Key to select either All, None or Specify.

7) When Specify is selected, press the Enter Key to display the area input field, and enter
the reference numbers of the area to be printed.

Refarence Range ta Print eut

$tart Beforence MNunber: SOOEL
End Meforence Hunker: ELZEN

Yalid Range: GEOEL - BS1YZ

Figure 8.32

8) Press the Enter Key to save the set areas.

| Print Discrete Table <127 ]
Databane: TESTL Nelp: CAlt-H>
Print Uzad Tables : Spmcif
Iﬁ Specify BOEL - BELEG
xoocc & Fpecify 10081 - 14896
BXXXX : Specify DB - DiBZ24

" = MSELL - MSede

MSIXX ¢ Specify MS1ll - #5148

NXX NBBi1 - NBSAR
Figure 8.33

9) Use the procedure described above to set the remaining relays {coils).

10) Press the Page Down Key to display the Print Discrete Tables (2/2).

Print Discrete Tables €2/2)>
Databaze: TESTL Help: C(RLt-ity
AT PPN $psc1f

o

IRAXX
DHAAN :  Mens

GEXX : A
514X = Nens
MBBXE :  Ne

== # =D or space Change Setting <SPyUp).<Pgin)> Set up Contrell Code
{A1c-E> Save aad Quin {Ezc}> Dana Skama> Save snd Quit

YASKAUS =

Figure 8.34

11} Use the procedure described above for setting the Print Used Tables.

12) Press the Alt + E Keys to save the settings.

3. Print Register Tables Settings

I Print Bagiscer Tables I
Databare: TERT1 Kelp: <Alt-N>

JeNEL - 18512

pecify JiBE1 - J1d9
H 4608 - 419033

XXX ¢ Specify DMEBNL - MMID

SKXNX : Epecify SOMEL - 58400

Print Bagigter Contenta : SR;;‘.I,I
E; ¢ Specify 1M1 - 31208

H 40081 - 48028

kodil - X0
t Epecify SHEL - sEECE
RINL -~ ABS2F

{~— # ==> or space Change Sutting <ENTER> Set up rangs
<0it—E> fove and Quit CExc) Dene CMeme? Save and Quit J
— YALRNUS

Figure 8.35
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8.3.3 Print Tables/Reports Settings cont.

1) Select 5. List Active PLC from the Main menu.

Y

¢
Laddsr Legic D-v-hr-ne Ssftwars / Hain Menu
Usrsion 2.88 Cepyright 1%%1 YASKAUA ELECTAIC CORPORATION

Rain Menu:
1. Sslact dictive PLC
2. Offline

3. Onl.

4. Matisn

- r

7. Usilicies

<E> te Exit te Des
Enter Optien: HE

Databazs: TEST1 Help: <ale-i>

YRSXAUn =

Figure 8.36

The Print Tables/Reports Menu will appear.

2} Move the cursor to 3. Print Tables/Reports from the Print Menu and press the Enter Key.

{ Princ Tables / Mporte

J

£ 7 —> or spate Change Detting

Figure 8.37

The Print Register Tables Menu will appear.

Database: TEST1 Help: <AlE-H>
Print Allscatien Tablses : Specify
Print Dizcrets Takles t Spacify
Print £PC Status : Hema
Print Descripters Tables t Hens
Print ASCII Meszage :  Neww

<Alr=E> fawe and Quit <{Esc> Dene <Hame) Save and Quit
e e

YASKAUA =

3) Move the cursor to the Print Register Tables and press the Enter Key.

| Print Megister Takles

XXX = Nenw

RXXXX = Mane

Regis e z!ﬂif: Nane

Priat gister ntents H L]

00K 7 Hene

XXX : Mane

LXK :  Nens

XXX :  Wene

AXXXX Hene

{— ¢/ =) or spac¢ Changa Sstting <{ENTER) Set ump vange
<A1t-E> fava and Quix {Esc> Done <Home)> Save and Quit

Database: TEET! Heip: <ale-m>

T Specify 38801 - 2208
HNene

YREKAWA =

Figure 8.38
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When the the Enter Key is pressed, the default is Specify. Press the Space Key to set ‘
either to None or All. When All is selected, all reference numbers will be printed.



8.3 List Setiings
.

4) Use the Space Key to select from the Print Used Tables either of the All, None or Specify.

5) If Specify is selected, the cursor will automatically move to 30XXX.

L Frint Bagister Tables ]
batabass: TESTL Halp: <ALt-H>

Frint Used Tahles : _Specif
.th-eu’ I - I
H ne

Figure 8.39

6} Press the Space Key to select either All, None or Specify.

7) When Specify is selected, press the Enter Key to display the area input field, and enter
the reference numbers of the area to be printed.

Raference Range te Print sut

Seart Refarence Nusber: 38881
Erd Raference Nunker: HTIRZN

Ualid Range: 38881 - 38512

Figure 8.40

8) Press the Enter Key to save the area.

L Print Rayister Tables ]
Bavabare: TESTL Help: <Ale—h>

Priat Used Tables

Figure 8.41

9) Set remaining registers in the same manner.

10) Usethe same procedure described above for setting the Print Register Contents, and the
the Print Used Tables.

11) Press the Alt + E Keys to save the settings.

4. Print SFC Status Tables Settings

| Print $PC Status Tabls ]

Databaze: TESTE Nalp: <Ale-i>
IO KT P T Y« s

Print EPC Simuratisn Tabls s Yo

Print SPC Uswd Table : You

==/ ==> sr spats Changs Satting
<hlt=E> Save and Quit <Est)> Dwhm {lems)> Save and Quit
e— ———

Yatkaun =

Figure 8.42
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8.3.3 Print Tables/Reports Settings cont.

1) Select 5. List Active PLC from the Main menu.

NEMOCON-EC GLAB/%8- 78
hgd.lr Loyic Devals t Seftwars / Hain Henu

Uarsisn 2.08 Copyright 1931 YasXwum ELECTRIC CORPORATION
Batahass: TESTL Halp: CRlt=H>
Wain Memu:
1. Eelact Retive PFLC
2. Offline
3. Online
4. Motisn
- Ll
7. Utilitiex

<E> to Exit te bes
Eater Option: @

Figure 8.43

2) Move the cursor to 3. Print Tables/Reports from the Print Menhu and press the Enter Key.

The Print Tables/Reports Menu will appear.

L. Print Tables / Beperts 1
Databaze: TEET1 Neip: CAle-H>
Print #llecatisn Taklez z Epecify
Print Blacrete Tables : Specify
Print Pegistar Tables : Epecify
NI SR ETTTN tone
Print Descripters Taklss :  Nems
Print A$CI1 Mecsage : Hens

{— # ==> ar zpace Changs Lattiny ‘

<Alt—E> Save and Quit {Esc> Denw <Rems) Tave and Quic
— —== ¥ASKAUR =

Figure 8.44

3) Move the cursor to Print SFC Status and press the Enter Key.

When the the Enter Key is pressed, the default is Specify. Press the Space Key to set ‘
either 1o None or All. When All is selected, all the SFC table/reports will be printed.

The Print SFC Status Table Menu will appear.

| Print $PC Status Table |

Datadase: TESTL Welp: (ALE-W>
TN E Ve«

Frint EPC Eimuration Table : Yer

Print SFC Used Table t Yag

Lo+ 4 == ar zspace Change Bstting

<Ale-E> Lave and Quit {Ezc)> Dans ' (Name) Save and Quit
faskam =

Figure 8.45 ‘
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et ————e—————
4) Press the Space Key to set either Yes or No to set the Print SFC Mode Table,
5) Press the Down Cursor Key to move the cursor to the Print SFC Simulation Table.
6) Press the Space Key to set either Yes or No.
7) Set the the Print SFC Used Table in the same manner described above.

8) Press the Alt + E Keys to save the settings.

5. Print Descriptors Tables Settings

| Print Descriptars Tables <1.2) ]
Patabass: TESTI Nelp: <A)e=H>
pacify include Crezs Reference
IW_: pacify  BEEEL - SOSN8
100 = pecify 10081 - 148%
Fhoox 3 pocify - 12
IREXX P JimEi - 3589
AR P - 49993
SXARX pacif Sl - 58512
B0 pacif POREL - Die24
XXX H pacify FEL - RiG24
SXXA : pacify £MBL - £512
20X B pecify 2810 - 23299
HEEXK : pacify - M5B8
MELXR H pacifiy NS111 - 5148
. L} H pecify NEG11 - NEBAS
(== # —> er space  Changw Sscting <{Pyptp>.<PgDn) St up Contrall Cade
CAIt-E> Save and Guit CEsc) Bene {Nors)> Save and Quit
—— —— ———— PARKAUN =)

[ Priat Dukcripters Tadles €2.2 ]
Databass: TEST1 Walp: <AIt-H>

Spacify LOGEL - LSoGR
g canment T Spacify 1 - 999
Print Mirs Macch Table : Yax

— 7 ==} or spain Change Settiny <PyUp>.<PyBn> Swt up Centrall Cade
<ale-EY Save and Quit SEsc> Dene <Hame> Save and Quit
e rr— —

VASXAUA =

Figure 8.46

Page 1/2 — 2/2: Can be switched using the Page Up /Page Down Keys.

1) Select 5. List Active PLC from the Main Menu,

MENOCON-SC CL4A/68-79
Ladisr Legyic hu.llr.n: LEaftware / Main Menu
Usrsian 2.08 Cepyright 1391 YASKAUA ELECTRIC CORPORATION

Datebass: TEIT1 Help:r <Rlt-H>
Hain Hanu:
1, Select Acsive PLC
2. Offline

- T

7. Utilicies

<E> te Exit te Des
Enter Optisn:

— ——— YASXAWR =

I

Figure 8.47
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8.3.3 Print Tables/Reports Settings cont.

2) Move the cursor to 3. Print Tables/Reports from the Print Menu and press the Enter Key.

The Print Tables/Reports Menu will appear.

| Frint Tadles ~ Raperts ]
Database: TEST1 NHelp: <Alt-d>

Frimt Allecatisa Tables . Speacify
Print Discrete Tables T Specify
Print Register Tables T Specify
Print SFC States -1 Specify

11 Nans

Frins ASCII Message i bone

£— 7 =) ar space Change Satting
<Alt=E> Save aad Quit <Esc> Done {Hoan> Save and Quit
T ————e————c—x. FRSKANN

Figure 8.48

3) Move the cursor to the the Print Descriptors Tables and press the Enter Key.

When the the Enter Key is pressed, the default is Specify. Press the Space Key to set
either to None or All. When All is selected, all tables/reports will be printed.

The Print Descriptors Tables (1/2) Screen will appear.

| Print Descripters Tables (1/2) | ‘
Databaze: TEST1 Ralp: <Alt=H>
Spocify imcleds Cress Mefarence
T
130000 s Hane
Fhboos T Mane
3XAXK 3 Hene
AXXRY 3 Mens
SNXXX 2 Nane
DAXXR 3  HNens
XXX Mane
SIAX Mune
2T Hane
MERXX Honw
B1KX Mana
B Hana
{— 7 ==> ax apace Change Setting <Pstiy>.<(Psbu> Set wp Coentrall Cade
<Ale—E> Save and Quit {Ezc)> Dane {ipnad Save and Quit
—— YASXAUM = ‘

Figure 8.49

4) Press the Space Key to select either All, None or Specify.

5) When Specify is selected, the cursor will automaticaily move to doacx.

| Print Descripters Taklew <1/27 ]
Datsbase: TESTL Welp: <ALe~-R>

Print Descriptors :  tpecify include Cress Tefarence
Hiy
000k E]
3o ]

Figure 8.50 ‘
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. 8.3 List Settings
‘
6) Press the Space Key to select either All, None or Specify.

7) When Specify is selected, press the Enter Key to display the area input field, and enter
the reference numbers of the area to be printed.

Mafarence Range te Frint eut

Start Rafarence Wuabar: SOSEL
End Refarence Muaber:

Ualid Ranys: SOOI - B9192

Figure 8.51

8) Press the Enter Key to save the area.

| Print Descriptere Tables (12> ]
Databaxe: TELT2 Malp: <Alt-H>
Print Descriptars ;. Specify fnclude Cress Reference
Cnd—— £l e e

IO E] Hena

3o i Hena

JXxAR z Mans

AAXRXX 2 MNens

Saxxx 2 Nenp

Figure 8.52

9) Set the remaining tables using the same procedure.

10) Press the Page Down Key to display the Print Descriptors Tables (2/2) Screen.

| Print Descristers Tables <223 ] Ii

Databaze: TESTL Help: <ALt-M>
Hany
ng conmpnt E) Nang
Print Niss Match Tables : Mo

= # = er zpace Chanys Satting <Pglp>.(Pgin> Sut up Centrell Cods
<Alt-E> Save and Quit CEzc> Dute SHomed Bave and Quit J
————— ——— = YATRAWM

Figure 8.53

11} Use the same procedure described above for specifying the Network Descriptor and the
Long Comment settings.

12) Press the Space Key to set Yes or No to select the Print Miss Match Table.

13) Press the Alt + E Keys to save the settings.
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8.3.3 Print Tables/Reports Settings cont.

6. Print ASCIl Message Settings

1 Print #5CII Message i
Databaze: TESTL Help: <AIT-H>
DN Specify 1 - 1824
Hodule 2 s Specify 1 = 124
Module 3 :  Speciiy 1 - 1m24
Meduls 4 = Spacify 1 - 124
Moduls :  Speeify 1 - 1me4
Weduls & s Spwcify 1 - 1m24
Fadule 7 : Spmcify 1 - 124
Maduls 4 : Spacify 1 - 1K24
Eattiay CENTER: §
LD Save and it T e Tem ne) Save and Quit
TASXAUA =
.
Figure 8.54
1) Select 5. List Active PLC from the Main menu.
Gl
Ladder Legic Mhr-n Saftuare 7 Hain Me
nrsien 2.80 Capsright 1391 YASKAM ELECTRIC COXPOMATION
Databaze: TEFTL Nelyp: <Alg-l>
Kain Menu:
1. Salsct Acxiva PLC
27 OFfline
3 Online
42 fetien

7. Utilicies
CE) to Exit te Dex
Entar Opcion: N

— YASKAWN =

Figure 8.55

2) Move the cursor to 3. Print Tables/Reports from the Print Menu and press the Enter Key.

The Print Tables/Reports Menu will appear.

Priat Tablez 7 Keparts ‘

Patabase: TEST1 Halp: <R1lt-d>
PFrint Allscatien Tables : Spacify
Print Discrete Tables 2 Spacify
Print Register Table: i Specify
Prist S$FC Status : Specify
Print Dezcripters Tahlax z Epacify

K== s ==} pr spaxe Change Setting
<Alt=E> Save amd Quit {Esc) Deas CHomy)> Save and Quit

Figure 8.56

3) Move the cursor to Print ASCIHl Message and press the Enter Key.

When the the Enter Key is pressed, the default is Specify. Press the Space Key to set ‘
either to None or All. When Ali is selected, all tables/reports will be printed.
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The Print ASCII Message Screen will appear.

I Print RSCIL Meszage —l
Databaze: TEST1 Nalp: <Alt-H>

ISR A1)

Heduls 2 I }$1
Moduls 3 A1l
Haduls 4 @ All
Medule 5 LI 35
Medule & : Al
Module 7 LI} ¢ §
Hoduls 8 = All

<l1§;}’$-‘:: :l.m! %i::h;ln(m %:‘:?Sm and Quit
— YASKAWA
Figure 8.57

4) Move the cursor to the Module to be to printed.
5} Press the Space Key to select All or Specify.

6) When Specify is selected, press the Enter Key to display the input field for Specify and
enter the range to be printed.

ALICII Meszage Rengs to Print sut

Start ASCI]1 Mamaaps Humdar : B991
End ASCI! Massape MWunber : EZEEN

Valid Range: BOE1-1024

Figure 8.58

7) Press the Er;ter Key to save the range.

I Print ASCII Mexzage I
Batabnze: TB'! Heolp:z <Ale-H>
m_ Spucify 1- 1
Meduls 2 Al
MWedule 3 : Al

fedule ¢ LI ) §

Heduls 5 Al
Maduls & H A1l
Hodule 7 = All
Madule 8 Al

{— 7 —> ar space Chings Eattin <Mﬂ) Lot rang;
<Alt~Z> Eave and mt - <{Esc> Ln n‘)"Sul and Quit
—

YASKA

Figure 8.59

8) Set other Modules to None.

9) Press the Alt + E Keys to save the settings.
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8.3.4 Print Motion Lists Settings

8.3.4 Print Motion Lists Settings

_——————————— = |

I Print Motien Lists ]

Databaze: TEST1 Help: <Ale—H>
TN TEL TN Specify MOTI:PPL-HOT4:FPY
2. Print Fetien Faremsters 1 Specify MOTL:PPL-MOT4:MP¥

{== 7 —> ar space Change Satting <ENTER> 5ot up range
<Alt-E> Save and Quit {Ezc> Dene <Howa) Save and Quit
—— me—

Figure 8.60

1) Select 5. List Active PLC from the Main Menu.

=== —————

KENOCON-SC CLARSO/78
Ladder Leyic Devals t Saftuare / Bain Menu
Vercise .88 Cogyright LY91 SAGKAW ELECTRIC CORFOMTION

Dactabase: TEST1 Halp:s <Ale=H>
Pain Henu:
i. $slact Retive FLC
. OFfline

- 4

7. #eilities
<E> te Exit te Desz
Enter Option:

Figure 8.61

2) Move the cursor to 4. Print Motion List on the Print Menu, and press the Enter Key.

When the the Enter Key is pressed, the default is Specify. Press the Space Key to set
either to None or All. When All is selected, ali the programs and parameters will be
printed.

The Print Motion Lists Menu will appear.

| - Print Metisn Listx |

Databaze: TEETL Help: <Als-H>

AT TN T TR 411
2. Prist Metisn Paramsters s ALl

{== / =<3 ar rpace Change Sstting <ENTER> ot wp range
{Alt=E> fave and Quit <Esc> Dens <Nema? Eave and Quit
e ——— e ———— e r——ne— VALK =
Figure 8.62 ‘
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8.3 List Settings

3) Press the Space Key to select either All, None or Specify,

4) When Speciy is selected, press the Enter Key to display the input field for Specify and
enter the range.

| Print Metisn Lists B
Detabass: TESTL Belp: <ALt—H>
TGRS Specify MOT1IPPL-MOT4:PPE

2. Print Metien Parenstere ¢ ALl

Prist range sf Motisn yreyman

Start MOD Numbar: I  Ecave PP Husbar: 81
End HOD Mumber: 4 End PP Wunber: I

Ualid Ranges MOD : 1-¢ PP : 1-§

{=— 7 =3 sr spaca  Change Sstting <ENTER> fst up rangs

<O1t~E> $ave and Guit <Ezt) Dwos <Hems> Cave and Quit
| 5 —— —— m—e se—a— YATKAUN

Figure 8.63

5) Press the Enter Key to save the range.

L Print Metian Lista
Datakaze: TESTL Help: <Alt—H>
NIRRT ST TR Srecify MOT1:FPI-MOT4:PPA

2. Prink Metisn Parsnsters = All

€=/ =) or space Changs Satting <ENTERD Sat up rangs
CAIt~E> Lave and Quic <Ese¢> Dana <Hema> Save and Quic
e — YASKAUN =i

Figure 8.64

6) Use the same procedure described above for setting the Print Monitor Parameters.

7) Press the Alt + E Keys to save the setting.
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8.4 Printing

The following procedure is used to print out the specified list. Check the list settings and the
connection to the printer.

1) Select 5. List Active PLC from the Main menu.

HEMOCON-SC CLARSS- 79
Ladder Legic Develepment Saftware - Main Hean
Uersisn 288 Capyright 1331 FASKAUM ELECIRIC CORPOMTION
Dasabase: TEET1 Help: <Alt-N>

Main Menu:

1. Select Mctive FLC

2. Offline

3. Onl.

4. Matien

7. Gtilities
<E> to Exit ¥» Doz
Entur Optisn: BN

co— m— YATKAUR —

Figure 8.65

2) Carry out the settings necessary for printing.

Setthe necessary items {the model of printer, print type, etc.) according to the information
listed in 8.3 List Settings. :

3) Move the cursor to <P> to Print to Printer.
— | ‘
| List senu ]
Database: TESTL Nelp: CAle-N>

1. Select Data Base

2.+ Prist Netwerk ~ SPC Spacify

3. Print Takbles / Baperts Hana

4. Priat Hetisn lize Hene

<37 te Save Lizt Satup

<Alt-E> fave and Guit CEsc> Dane

{== s =3 ar zpace Change Setting ‘

Figure 8.66

4) When the Enter Key is pressed, a message will appear confirming execution of printing.

I List sanu I

Database: TEST1 Help: <Alt-N>
1. Selecs Daca Bass
2. Priat Netwerk / SFC fpacify

<8> te Eawe List Setup

{w= 7 —) ar space Change Setting
<Alt-E> Save and Quit <Esc? Dowe
e —

Figure 8.67
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5) Enter “Y” and press the Enter Key.

Printing will start.

When the printing has been completed, the printing time will appear. Press any key to return
to the List Menu.

Note After completing network editing but before printing, recalculate the cross references, ac-
cording to the information contained in 2. Cross Reference Process, to upgrade the cross
reference data. If the cross reference data is not current, correct data cannot be printed.
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8.5 Cancelling Printing

The procedure below is used to cancel printing.

1) Press the Esc Key.

it may take a littie while after the Esc Key has been pressed before the screen responds.
However, if the Esc Key is pressed again, this will constitute the Esc Key being pressed
for the second time to cancel the first operation. So make sure to press the key only once
and wait for the screen to respond.

| Ladder Lowic Develepaant Seftwars < Listisy ]
Databess: CFRO

<Est)> te Stey
YASKAUA =

Figure 8.68

A message will appear confirming the cancellation.
While the message is being displayed, the operation is being suspended.
2) Enter “N" and press the Enter Key.
Enter “Y” to continue the printing. ‘

The print out will be cancelled and the printing time will appear.

—8-38 —




The Loader

This chapter describes the loading and saving of data between a speci-
fied device and a computer and connection methods between these de-
vices and a computer. As well it describes the procedure for selecting
motion programs and parameters, how to set device and communica-
tions parameters, and starting and stopping the processor.

9.1 Loader Memu........ Cereenn Cerenas verese 92

9.2 Connection Methods between Device and
Computer ..... veersaes fereretatinanes e 93

9.3 Motion Program/Parameters Selection ...... 9.6

9.4 Device and Communications Parameters
SEttingS ------- * 0 e v 0 eE R 4t ¥ s s ra PP RN ESS S . 9‘8

9.5 Starting and Stopping the Processor......... 9-10

9.6 Writing to EEPROM (MM41)....... ceevene 9-11
9.7 Loading and Saving to the Processor ........ 9-12
9.8 Converting P150 Disk Data ............ cees 922
9.9 Data Communications with P150 .......... . 929
9.10 Loading viaYENET ......... creredna eees 938
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9.1 Loader Menu

Loads and saves data between the specified device and files on the hard disk of the comput-

er.
Computer<—s> GLxoox (CPU)
Computer<—> P150 data
Computer<—s> P150
Computer<—> IF71 (ASCII Module)
=
| Saddar optc Tttt AT, Lestar tene
Batabaze: TESTI Nelp: <Ale-H>
LOADER Optisna:
3] urlts 1o Device.
b Pevitertohmnicatiany Sotup
6. Writs te EEFNOMCHNML)
<Exc> te Return ts Main Mewu
Enker Optian: I}
Yatknun
Figure 9.1 Loader Menu
1) Select Database ‘

Selects a file on the computer’'s hard disk to load and save data to.
2) Read from Device
Reads from a device, selected under 5. Device/Communications Setup, to the computer.
3) Write to Device ‘
Writes from the computer to a device selected under 5. Device/Communications Setup.
4) Start/Stop Processor
Starts and Stops the Processor.
5) Device/Communications Setup
Selects the device and sets its communications parameters.
6) Write to EEPROM (MM41)

Wirites the program to the EEPROM (JAMSC-MM41} of the Processor. Applies only ‘
when the MM41 is connected to the GL40.
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9.2 Connection Methods between Device and Computer

9.2 Connection Methods between Device and Computer

The devices that can be connected to a computer for loading are described below. This sec-
tion explains the procedure for setting and operation with each of the possible devices.

e Processor (the Communications port of the GL40, GL60, GL70)
s P150

» ASCII Module (IF71)

9.2.1 Connection between Processor and Computer

Connect the RS-232C port at the rear of the computer and the RS-232C port of either an IOP
or a Communication Moduie with a cable.

Use the following models of connection cables.
* JEPMC-W5311-03 (2.5 m) (D-SUB 9-pin)

* JEPMC-W5311-15 (15 m) (D-SUB 9-pin)

Computer IOP or
N Communication
Module

Cable model:
JEPMC-W5311-03 (2.5 m)
JEPMC-W5311-15 (15 m)

Port 1 or Port 2):

RS-232C port
VA

Connector (9-pin)

Figure 9.2 Connection Diagram of Processor and Computer
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The Loader
9.2.2 Connection between P150 and Computer

9.2.2 Connection between P150 and Computer

Connects the RS-232C port of the computer and the RS-232C port of the P150 with a cable. ‘
Connect the cable connectors according to the cable wiring diagram illustrated below.

—
Cable Wiring Diagram —

1 1 P150 Programming

|
2 3

71 2|
3 | 5|
5] 7]
€] 6]
3] 8]
(4] 20

2-paired shislded
cable

[

Hood cover
‘ D-SUB 25-pin plug
{male)

Figure 9.3 Connection Diagram between P150 and Computer ‘

D-8UB 8-pin plug
{male)

9.2.3 Connection between ASCIl Module and Computer

Connect the RS-232C port behind the computer and either of the RS-232C ports of the ASCI
Module with a cable. ‘

Use the foliowing models for the connection cables.
¢ JEPMC-W5311-03 (2.5 m) (D-SUB 9-pin)

« JEPMC-W5311-15 (15 m) (D-SUB 9-pin)
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9.2 Connection Methods between Device and Computer

%

Computer

Cable model: ASCII Module

JEPMC-W5311-03 (2.5 m)
JEPMC-W5311-15 (15 m)

Port 1 or Port

RS-232C port

Connector (9-pin) Connector

(9-pin)

Figure 9.4 Connection Diagram between ASCIl Module and Computer
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9.3 Motion Program/Parameters Selection

The following procedure is used to select the motion program and parameters to be loaded
and saved. When loading a motion program and parameters, select the program using the
Module number and program number of a program registered in the database. When saving
a motion program and parameters, first create a new file, register it in the database using the
Module number and program number and select this file.

When Selecting an Existing File
1} Press F1 (Edit) or the Enter Key.

2) Set the Module number {(MOD).

Use the Up or Down Cursor Key to move to the items to be set.

3) Set the program number (PP).

Usethe Right or Left Cursor Key to move the cursor to the Module number (MOD} and the
program number (PP).

MOD: Module number setting (1 - 4)
PP: Program number (1 - 8)

File name; Name of the motion program or the parameter file name registered on the ‘

database
Title: Title of the file selected
Date: Date when the selected file was created
Axis: Specify the axis number of the Servopack for loading and saving. This ap-

plies only when loading or saving to the Servopack. By specifying more than
one axis, it is possible to load to more than one Servopack. ‘

When Creating a New File
1) Press F1 (Directory).

Select 10%é morva wedule (143,
Aibirectery TExit

Figure 9.5
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9.3 Motion Program/Parameters Selection
“ﬁ
2) Specify the directory in which the file is to be created.
3) Press F5 (New File).
4) Enter the file name in the input field.

5) Press the Alt + E Keys.
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9.4 Device and Communications Parameters Settings

The following procedure is used to select a device and specify its parameters.

-

1} Select 6. Loader from the Main Menu.

2) Select 5. Device/Communications Setup from the Loader Menu.

3) Use the Space Key or the Right and Left Cursor Keys to select the device.

I BEUICH/COMNICATIONG PARMMETERS SETUP ]

Databazs: TEETL

Nelp: <Rlr=d>
Device: HRTEENTEINTTYINE
Computsr Serial Peys: I
Fort Baud Rate: %N
Fort Pardty: Evea
Part Sxep Bite: i

¢~ <> ar Spaae? te Togyle
<Ale-E> te Bave and Exit <Esc)> e Quit
— —r————— Y RERAN

4) Press the Enter Key.

Figure 9.6

The parameters of the selected device will appear.

Parameters Settings

Devices: Processor Front Port
Memocon YENET-3200
P150 Prograrmming Panel

P150 Disk File

[F71 ASCII Module

» Processor Front Port Parameters

Computer serial port:
Port baud rate:

Port parity:

Port stop bits:
Device address:

1 or 2 {(normally 1)

300, 600, 1200, 2400, 4800 or 9600 baud
Even, odd, or none

for2

1 to 247

» Memocon YENET-3200 Parameters

Edit Routine Tables ?:
Target YENET#:
Target node#:

YorN
1to 126
1to 126
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9.4 Device and Communications Parameters Settings

* P150 Programming Panel Parameters
Computer serial port: 1 or 2 (normally 1)

Port baud rate: 300, 600, 1200, 2400, 4800 or 9600 baud
Port parity: Even, odd, or none
Port stop bits: 1or2
« P150 Disk File
Drive: A, B,.....(connection drive)

= IF71 ASCII Module
Computer serial port: 1 or 2 (normally 1)

Port baud rate: 300, 600, 1200, 2400, 4800 or 9600 baud
Port parity: Even, odd, or none

Port stop bits: lor2

Unit number: 1 to 247

Module number: 110 247

5) Use the Up and Down Cursor Keys to move the cursor to the parameter input field.

i DEVICE-COFPINTCATIONS PAMNETERS GETUP ]
Databaze: TEST1 Welp: <Ale-4>
Pavice:  Preceaser Freat Port

Canputer Sarial Fert: 1

Pert Baxd Rate:
Faxt Parity: Evan
Part Step Bits: 1
£<= =3 ar Spaze? te Tegyls
<Ale-E> to Save and Exit {Es¢) to Quit
rar— — YASKAWM =4
Figure 9.7

6) Set the parameters,

7) Press the Alt + E Keys to save the changes and complete the settings.

The Loader Menu will retumn.
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The Loader

9.5 Starting and Stopping the Processor

The following procedure is used to start and stop the Processor. The same operation will start
the Processor if it is not activated and stop the Processor if it has been started.

1) Select 6. Loader from the Main Menu.
2) Select 5. Device/Communications Setup from the Loader Menu.
3) Set the device to the Processor Front Port.

4) Select 4. Start/Stop Processor from the Loader menu.

5) Enter the device address and press the Enter Key.

HEMOCON-EC GLARA 78
Ladder Loyic Buvalapment Teftvarw / Laadar Manu
Database: TEST1 Help: <Alt-H>

FASKAWA

Figure 9.8

6) Check the operations described above and enter “Y”, then press the Enter Key.
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9.6 Writing to EEPROM (MM41)

m

9.6 Writing to EEPROM (MM41)

The following procedure is used to write a program to EEPROM (JAMSC-MMA41),
Applies only when GL40 is connected to the MM41.

1) Select 6. Loader from the Main Menu.
2) Select 5. Device/Communications Setup from the Loader Menu.
3) Set the device to the Processor Front Port.

4) Select 6. Write to EEPROM (MM41) from the Loader Menu.

5) Enter the device address and press the Enter Key.
6) Check the operations described above and enter “¥”, then press the Enter Key.

|-

‘ Vrate 1EPROMCHMAL )™ KR “

Figure 9.9

“Successful WRITE operation” will appear.

7) Press any kéy.
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The Loader
w

9.7.1 Loading Programs, Comments and Extended Memory

9.7 Loading and Saving to the Processor

This function executes the loading and saving of data to the Processor. The kinds of data
available are listed below.

» Programs {ladder, SFC, reference data, etc.)

» Comments (applicable only for those models with comment memory)

«» Extended memory (applicable only for those models with extended memory)
» Motion programs

» Motion parameters

« ASCIl messages (connection to an ASCII Module is necessary.)

9.7.1 Loading Programs, Comments and Extended Memory

The following procedure is used to ioad program and comment data created by the computer
to the Processor. Before starting this program, tum off the Processor. (Refer to 9.5 Starting

and Stopping the Processor.)

1) Select 6. Loader from the Main Menu.
2) Select 5. Device/Communications Setup from the Loader Menu.
3) Set the device to the Processor Front Port.

4) Select the database. (Refer to 3.1.3 Selecting a Database.)

5) Select 3. Write to Device from the Loader Menu.

6) Select 1. Ladder Program.

NENOCON-EC GLAM68-78
Ladder Legic Devels At Softuare / Leader Menu
Varaian 2.88 Capyright 1791 YRACXAUA ELECTRIC CORPOMATION

Database: TEXT1 Help: <Alt-N>
LOADER Select Area:

- Hetlan
3. Matien Pamor
CESC) Maturn te Frevisus Menu

Enter Optisn: [H

Figure 9.10 ‘

—9-12 —




9.7 Loading and Saving to the Processor

m

7) Enter the device address and press the Enter Key.

| Ladder Legic Develeyment Seftuars ~ WRITE TO CPU PORT ]
Databaye: TEST1

Figure 9.11

8) Select the memory area and the press Enter Key.

Memory Areas

Select from the areas below using the Space Key or Right and Left Cursor Keys.

CPU and data memory: Ladder program

Comment memory: Available only to GL60S3, GL60H and GL70H

Extended memory: Available only to GL60S3, GL60H and GL70H

All Processors: CPU and data memory, comment memory, extended memory

Selsct precessser ares: [HIENTICEGIEE
€= <> o Spaced to Togyle <Enter) te Sslack

Figure 9.12

8) Check the operations described above and press the Enter Key.

UHITE Chu
PEOM: C:

Figure 9.13
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9.7.2 Saving Programs, Comments and Extended Memory

The current processing status will appear.

Cancelling Processing
By pressing the Esc Key, the loading process can be cancelled. When loading is can-
celled, the data and program inside the CPU will be initialized.

“Successful WRITE Operation” will appear.
10) Press any key.

Note When the type of the CPU connected and the type of CPU set by the database are different,
the following message will appear, “Different CPU Type of Processor and Database. Load to
Processor?”. If “Y” is input and the Enter Key is pressed, the execution will proceed. However,
a command may be sent to the CPU that cannot be used by that particular CPU or the
memory will run out causing an error to be generated. If this occurs, the program which has
been stored in the CPU will be cleared.

9.7.2 Saving Programs, Comments and Extended Memory

The following procedure is used to save the program and comment data stored inside the
Processor to the hard disk of the computer.

1) Select 6. Loader from the Main Menu.

2) Select 5. Device/Communicatioﬁs Setup from the Loader Menu.
38) Set the device to the Processor Front Port. ‘

4) Select the database. (Refer to 3.1.3 Selecting a Database.)

5) Select 2. Read from Device from the Loader Menu.

6) Select 1. Ladder Program..

7) Enter the device address and press the Enter Key.

{ Leddar Lagic Develepaant Seftware - READ FAOM GV PORT 1

Databazs: YEST1

Figure 9,14 ‘
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‘ 9.7 Loading and Saving to the Processor

8) Select the memory area and the press Enter Key.

Memory Areas

Select from the areas below using the Space Key or Right and Left Cursor Keys.
CPU and data memory: Ladder program

Comment memory: Available only to GL60S3, GL60H and GL70H

Extended memory: Available only to GL60S3, GL60H and GL70H

All Processors: CPU and data memory, comment memory, extended memory

JEERD TR CPY TONT DT TTOFFED DT RORTTON TR

Select processer arvs: [NIRMENINESTIENN

€<= =) or Spacad te Toggle <Enter> te Salsct

Figure 9.15

9} Check the operations described above and press the Enter Key.

v e |

HLRD CIY & DATR Mennry

I FROM® Froge..or Front Port

TO: CinGLOWSNDBATESTY KA J

Figure 9.16

- The current processing status will appear.

Cancelling Processing
By pressing the Esc Key, the saving process can be cancelled. When saving is cancelled,
the data and program inside the CPU will be initialized.

“Successful READ operation” will appear.

10) Press any ke;y.

9.7.3 Loading Motion Program/Parameters

The following procedure is used to load motion programs and parameters from the computer
viathe IF66 to the Servopack . When loading motion programs and parameters, the IF66 and
the Servopack must be correctly connected. When the ERR LED of the IF66 is lit, this indi-
cates that acommunications error has occurred, When the TX/RX LED of the IF66 is flashing,
this indicates that communications are taking place correctly.
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The Loader
9.7.3 Loading Motion Program/Parameters cont.

Before starting this program, turn off the Processor. {Refer to 9.5 Starting and Stopping the
Processor) This function is available only for the GL60H, GL70H and GL40S.

1) Select 6. Loader from the Main Menu.

2) Select 5. Device/Communications Setup from the Loader Menu.
3) Set the device to the Processor Front Port.

4) Select the database. (Referto 3.1.3 Selecting a Database.)

5) Select 3. Write to Device from the Loader Menu.

6) Select 2. Motion Program (or 3. Motion Parameters).

7) Enter the device address and press the Enter Key.

The screen for selecting the motion programs/parameters will appear.

Metie mzr.l nob:1  FP:l
N.hn:nl: \GLABEDINPACL
Ticla:z MOTION PROGRAN
Data: €3-28-1997 Pxigs 1= - ~ = = = =
Select arealz) of precesser te WAITE.
Edic [CRWRITE
Figure 9.17

8) Select the motion programs/parameters.

For selecting motion programs and parameters, refer to 9.3 Motion Program/Parameters
Selection.

9) Press F10 (WRITE).

10} Enter “Y” and press the Enter Key.

talect arvats? of pracezser ¥ VRITE.
Edic [CFVAITE

Figure 9.18
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9.7 Loading and Saving to the Processor

1

i

The current processing status will appear.
“Successful WRITE operation” will appear.

11) Press any key.

9.7.4 Saving Motion Programs/Parameters

The following procedure is used to save motion programs and parameters from the Servo-
pack to the computer. When saving motion programs and parameters, the IF66 and the Ser-
vopack must be correctly connected. When the ERRLED of the IF66 is lit, this indicates that a
communications error has occurred. When the TX/RX LED of the IF66 is flashing, this indi-
cates that communications are taking place correctly.

This function is avéilable only to GL60H, GL70H and GL40S,
1) Seiect 6. Loader from the Main Menu.
2) Select 5. Device/Communications Setup from the Loader Menu.
3) Set the device to the Processor Front Port.
4} Select the d‘atabase. (Refer to 3.1.3 Selecting a Database.)
5) Select 2. Read from Device from the Loader Menu.
8) Select 2. Motion Program (or 3. Motion Parameters).

7) Enter the device address and press the Enter Key.

[ Ladder Leyic Development Saftwars ~ READ FEOR CPU PORT

Databaze: TERT1

Figure 9.19
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9.7.5 Loading ASCII Messages

The screen to select the motion programs/parameters will appear.

NEAE PRE O ROR——DTRE— ITOPMS WL MBI TR |
Hetien Pre mob:i PRIL
Filaname: fiuGLAMENDINPAGL

Title: MOTION PROCRAN
l_ Data: §3-20-1397 Mxlez 1= = - - - = = —I
Select areats) of precezser Co RERD.
OmEd1e [[INREAD
Figure 9.20

8) Select the motion programs/parameters.

For selecting the motion programs and parameters, refer to 9.3 Motion Program/Param- ‘
eters Selection.

9) Press F10 (READ).

10) Enter “¥" and press the Enter Key.

Hetisn

Filename: C:NGLESSDINFRGL
Titls: MOTION PROCRAN

Date: §3-29-199[EEEE s

Select arsals) of precezzer te READ.

BEdic [KREAD

Figure 9.21

The current processing status will appear.
“Successful READ cperation” will appear.

11) Press any key.

9.7.5 Loading ASCIl Messages

The following procedure is used to load ASCIl messages from the computer to the ASCHl ‘
Module.
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! 9.7 Loading and Saving to the Processor

1) Connect to the ASCII Module.

2) Select 6. Loader from the Main Menu.

3) Select 5. Device/Communications Setup from the Loader Menu.
4) Set the device to IF71 ASCI| Module.

5) Set the Module number to the number of the Module connected.

L PIVICE/ CATIONE PAMKETERS SETOP
Database: TESTL Halpz <ALT-N>
Device: I[F71 RECII Medule
Computor Serial Pert: 1

Part Baud Rate: %N
Fart Parity: Even
Port Step Biex: 1
Unit Musber: -
Feduls Number: [ 1v1.: ]
Eater Medule Number (1-8>
<ALlt~E> te Save and Exit {Eac? te Quit J
——— ——— —— SASKAWA =
Figure 9.22

The data from the Modute number set in the communications parameters is loaded to the
ASCII Module,

6) Select the database. (Referto 3.7.3 Selecting a Database.)
7) Select 3. Write to Device from the Loader Menu.,

Loading will start and its current processing status will appear.

Urite to TE7L ASCIT Madule 1

r gy A%CIIL 2M:WILE

Figure 9.23

By pressing the Esc Key, the process can be cancelled.
“Successful WRITE Operation” will appear.
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#

9.7.6 Saving ASCH Messages

8) Press any key.

9.7.6 Saving ASCIl Messages

The following procedure is used to save ASCIl messages from the ASCil Module to the com-
puter.

1) Connect to the ASCII Module.

2) Select 6. Loader from the Main Menu.

3) Select 5. Device/Communications Setup from the Loader Menu.
4) Set the device to IF71 ASClI Module.

. 5) Set the Module number to the number of the Module connected.

[ DEVICE COMMUNICAT 10NE PAMNETERS SETUP 1

Databuse: TEETL Halp: <Ale-H>

Davice: 1F?1 ASC11 Medule
Conputer Serial Pert: 1

Part Boud Rate: %N
Part Parity: Even
Part Step Bita: 1

Unit Numbar: [}
Peduls Musbar: [ ]

Entar Meduls Nunber (1-82
4£A1t-E> tw Save and Exie {Exc> te Quit
—— —c———m—

Figure 9.24

The ASCII messages are saved to the Module with the number set in the communica-
tions parameters.

8) Select the database. (Refer to 3.1.3 Selecting a Database.) ‘
7) Select 2. Read from Device from the Loader Menu.

The load wil! start and its current processing status will appear.

Read frun 1F?7L ASCI] Hoade

Readang:  ASCLI 21°4FFn

Figure 9.25 ‘
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9.7 Loading and Saving to the Processor
m

By pressing the Esc Key, the process can be cancelled.
“Successful READ operation” will appear.

8) Press any key.

-921 —




The Loader
w

9.8.IWritingPrograms,CommentsandExtendedMemorytoaP150Disk

9.8 Converting P150 Disk Data

This function allows the user to create or read files which can be used by a P150 disk. The
communication target device can be a floppy disk inserted into the computer or the hard disk
of the computer. The kinds of data available are listed below.

« Programs {ladder, SFC, reference data, etc.)
« Comments

s Extended memory

+ Motion programs

+ Motion parameters

9.8.1 Writing Programs, Comments and Extended Memory to a
P150 Disk

The following procedure is used to write programs, comments and extended memory to a
P150 disk.

1) Select 6. Loader from the Main Menu.

2) Select 5. Device/Communications Setup from the Loader Menu.

3) Set the device to “P150 Disk File”. ‘
4) Specify the drive in which the P150 disk will be inserted.

5) Select the database. (Refer to 3.1.3 Selecting a Database.)

6) Select 3. Write to Device from the Loader Menu.

7) Select 1. Ladder Program. ‘

8) Enter the file name and press the Enter Key.

FRITE TU FI50 BISK TEIT Walp:Ale—1Y

Halp: <A1c-H>

File Hane: [T ——

Enter PIS8 disk filename. <PL> Diractery
<A1t-E> te Eave and Exit {Ezc> t4 Quic
Figure 9.26

Press F1 to display the screen for selecting P150 disk files. With this screen, files can be ‘
selected or created using the same procedure as the database selection screen.
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9.8 Converting PI150 Disk Data

b e

9) Seiect the memory area and press the Enter Key.

Memory Areas

Select from the areas below using the Space Key or Right and Left Cursor Keys.
CPU and data memory

Comment memory: Avalilable only to GL60S3, GL60H and GL70H
Extended memory:; Available only to GL.60S3, GL60H and GL70H

[FRITE T FISH BI0Y TEXTT  Welp:CRTE-HY

Help: <Ale—H>

Fila Name: W:TEST1.P1S

Fils Type: I

<= =2 ar Space> ts Togyls
<A1t=E> ta Save and Exit <Exe} te Quit

Figure 9.27

10) Enter the title and press the Enter Key.

11) Enter the date and press the Enter Key.

12) Enter the order number and press the Enter Key.
13) “Continue? Y" will appear. Press the Enter Key.

14) Check the operations described above and press the Enter Key.

TEEY L TRLEL
Help: <AXe=H>
Tils Hame: #:PROCRAM
File Typa: CPO
Chu & Dn
Title:
1 GanGLbMS
Date: -3
TO: PLRB Da-h
Orderit:
Continug 7 ¥
<Alt-E> ts Save and Exit <Esc? te Quit
Figure 9.28

The writing will start and the current processing status will appear.

Cancelling Process
By pressing the Esc Key, the loading process can be cancelied. When loading is can-
celled, the data and program inside the CPU wili be initialized.
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9.8.2 Reeding Programs, Commnents and Extended Memory from a P150 Disk

“Successful WRITE Operation” will appear.

15) Press any key. ‘

9.8.2 Reading Programs, Comments and Extended Memory from a
P150 Disk

The following procedure is used to read programs, comments and extended memory froma
P150 disk.

1) Select 6. Loader from the Main Menu.
2) Select 5. Device/Communications Setup from the Loader Menu.
3) Set the device to “P150 Disk File".

4) Select the database. (Refer to 3.1.3 Selecting a Database.)

5) Select 2. Read from Device from the Loader Menu.
6) Select1. Ladder Program.

7) Enter the file name to be read and press the Enter Key.

FEAT PRON P58 DITN TEETL — Relp:{RIc-R3
Halp: <Ale—H>
File Mame: £:TEETY.PIS
Flils Typez CM & DATA Memary
Tivle=
Data: §3-20-1997
Ordork:
Continue T T
<Alt-E> te Save and Exit <Eec> te Quit

Figure 9.29

Press F1 to display the screen for selecting P150 disk files. With this screen, files can be ‘
selected or created using the same procedure as the database selection screen.

8) “Continue? Y” will appear. Press the Enter Key.

9) Check the operations described above and press the Enter Key.

JEAD FRN PIST TIIX T DTS

Melp: <ALt-N>

Continwe 7 ¥

Figure 9.30 ‘
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9.8 Converting PI150 Disk Data

The current processing status will appear.

To Cancel Processing
By pressing the Esc Key, the loading process can be cancelied. When loading is can-
celled, the data and program inside the CPU will be initialized.

“Successful READ operation” will appear.

10) Press any key.

9.8.3 Writing Motion Programs/Parameters to a P150 Disk

The following procedure is used to write motion programs/parameters to a P150 disk. This
function is available only to GL60H, GL70H and GL40S.

1) Select 6. Loader from the Main Menu.

2) Select 5. Device/Communications Setup from the Loader Menu.
3) Set the device to “P150 Disk File”.

4) Select the database. (Referto 3.1.3 Selecting a Database.)

5) Select 3. Write to Device from the Loader Menu.

6) Select 2. Motion Program (or 3. Motion Parameters).

The screen for selecting the motion programs/parameters will appear.

[ Loddsr Lagic Davalepment Seftuers + VRITE T0 P1S8 DISK ]
Database: TESTL

Title: MOTION
Date: §3-28-1%97 Axig: $- - - - = = —

mb:1 Ml
,_'r‘ﬁ.":"-. !:mu\nl\r:u ‘l

Select PI5S® flle ferwat ts WRITE.
MF4ic MEAWRITE

Figure 9.31

7) Select the motion programs/parameters.

For information on selecting motion programs and parameters, refer to 9.3 Motion Pro-
gram/Parameters Selection.
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9.8.4 Reading Motion Programs/Parameters from a P150 Disk

8) Press F10 (WRITE).

9) Enter the file name and press the Enter Key.

tabate: TEET1 URTTE HOTTON FAGGRAN FILE — Walp: ARy |

BOURCE

Pilename: C: G
Title: HOTION FROCRAN
Bate: 3-20-1%97

DESTINRT]OM:

Filanune: W
Title:

Bate: F-Z9-1997

Eantar filename of F150 Fils.
Pirectary

Figure 9.32

Press F1 to display the screen for selecting P150 disk files. With this screen, files can be ‘
selected or created using the same procedure as the database selection screen.

10) Enter the title and press the Enter Key.
11) Enter the date and press the Enter Key.

12) Enter “Y” and press the Enter Key. ‘

Bate: M3-28-1997

DESTIMATION:

mame: A\PRCL
i HOTTOM PRCCRR
Date: #3-28-19%7

CenFirw URITE 7 K1 ‘

Figure 9.33

“Successful WRITE operation” will appear.

13) Press any key.

9.8.4 Reading Motion Programs/Parameters from a P150 Disk

The following procedure is used to read motion programs/parameters from a P150 disk to the ‘
computer. This function is available only to GL60H, GL70H and GL40S.
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' 9.8 Converting P150 Disk Data

1) Select 6. Loader from the Main Menu.

2) Select 5. Device/Communications Setup from the Loader Menu.
3) Set the device to “P150 Disk File”.

4) Select the database. (Referto 3.1.3 Selecting a Database.)

5) Select 2. Rgad from Device from the Loader Menu.

6) Select 2. Motion Program (or 3. Motion Parameters).

The screen for selecting the motion programs/parameters will appear.

[ tedder Teyic Develepment Eaftvare - READ FROH FiS® BiSK |
Database: TESTL

Hatisn '"E". mop:1 PPl
Filsname: C:\CLAEC\DIPRG1

Title: MOTION PROCRAN

Date: 83-28-1997 Axfg: Ir = = = = = =

Select PISH File farwat te READ.

MEEdix EEREAD
— -“—:— — PALIRYS =

Figure 9.34

7) Select the motion programs/parameters.

For information on selecting motion programs and parameters, refer to 9.3 Motion Pro-
gram/Parameters Selection.

8) Press F10 (READ).

9) Enter name of the file to be read and press the Enter Key.

it Z X3 olpt 3

FMilsname:
Ticle:
Bate:

DESTINATION:

mang: G CLERS\DINFRGL
Titls: NOTTON PROCRAN
Date: E)-Z5-1997

Entar Filewans of Pi58 file.
MPirectery

Figure 9.35

Press F1 to display the screen for selecting P150 disk files. With this screen, files can be
selected or created using the same procedure as the database selection screen.

—9-27 —



The Loader
iR e S ]
9.8.4 Reading Motion Programs/Parameters from a P150 Disk cont. :

10) Enter the title and press the Enter Key.

11) Enter the date and press the Enter Key.

12) Enter “Y” and press the Enter Key.

The current processing status will appear.

“Successful READ operation” will appear.

13) Press any key.
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9.9 Data Communications with P150

9.9 Data Communications with P150

This function allows the user to create or read files which can be used by the P150. Although
this procedure is the same as that described in 9.8 Converting P150 Disk Data, this function
will also enable connection to the P150 Programming Panel and allow reading from orwriting
to a floppy disk inserted into the P150. Use this function for creating P150 data when a 3.5
inch floppy disk drive is not connected to the computer.

The kinds of data available are listed below.
» Programs (ladder, SFC, reference data, etc.)

+« Comments

» Extended memory
¢ Motion programs

» Motion parameters

9.9.1 Writing Programs, Comments and Extended Memory to a
P150 Disk

The following procedure is used to write programs, comments and extended memory to a
disk inserted into the drive of the P150 Programming Panel.

1) Select 6. Loader from the Main Menu.

2) Select 5. Device/Communications Setup from the Loader Menu.

3) Set the device to “P150 Programming Panel”,

4} Match the communications parameters to the setting of the P150 port.
5) Select the database. (Referto 3.1.3 Selecting a Database.)

6) Select 3. Wri;re to Device from the Loader Menu.

7) Select 1. Ladder Program.

. 8) Check the operations described above and press the Enter Key.
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9.9.1 Writing Programs, Comments and Extended Memory to a P150 Disk cont.

9) Following the instructions on the screen, go online from the P150.

{Ezc> to Quit
Figure 9.36
10) Following the instructions on the screen, press the Supervisory Key on the P150. ‘
PEITE 15 FISE PICIARATRS FAREL L L S

i CEUPRRULLOKY > o Pihe

CEsc> te Quit ‘

Figure 9.37

11) Following the instructions on the screen, operate the P150. ‘

g LTRSS

Perfarn SAUE spsratisn az ususl...

€1 LORDPER <F7>

<2> SAVE <>

€3> CMU <FM1>. COMMENT <F25, EXMMD <F3)
(4> Enter Fllenans

<S> COMFIRM <{F1>

Figure 9.38

The current processing status will appear.
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9.9 Data Communications with P150

m

Note

12) Following the instruction on the screen, end operation of the P150.

i

(1.4 l-I;=z‘]=QS

RBetuyn te IMITIAL BISPLAY te complate lesad

1) END <F2)
<2> PREVIOUE MEWNY <IF7>
€3> INITIAL DISPLAY <F?7) or <PE>

Figure 9.39

“Successful WRITE operation” will appear.

13) Press any key.

The P150 should be operated according to the instructions displayed on the screen. if the
P150 is operated incorrectly or if processing is stopped, the P150 will hang up. If this occurs,
reset the P150.

9.9.2 Reading Programs, Comments and Extended Memory from a
P150 Disk

The following procedure is used to read programs, comments and extended memory from
the disk inserted into the drive of the P150 Programming Panel.

1) Select 6. Loader from the Main Menu.

2) Select 5. Device/Communications Setup from the Loader Menu.

3) Set the device to “P150 Programming Panel".

4) Match the communications parameters to the setting of the P150 port.
5) Select the database. (Refer to 3.1.3 Selecting a Database.)

6) Select 2. Read from Device from the Loader Menu.

7) Select 1. La&der Program.

8) Check the operations described above and press the Enter Key.
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O

9.9.2 Reading Programs, Comments and Extended Memory from a P150 Disk cont.

9) Following the instructions on the screen, go online from the P150.

Helect PHOGHAR MODE nd ATTACH fron PLOWL

Statu.: ..oviting for FlW9

<Esc?> ts Quit

Figure 9.40

10) Following the instructions on the screen, press the Supervisory Key on the P150.

<Esc> te Quic ‘

Figure 9.41

11) Following the instructions on the screen, operate the P150.

WERD YS0H IS0 FIRCORARTRC TRREL WY DO

Perform LOAD speratisn a3 usual...

1> LOADER <F7>

€2> LOAD <>

<37 CPU <Pi>, COMNENT <F2>, EXPAND {F3>
<4) Entar filename

<5) CONFIMN <Fi>

Figure 9.42

Reading will start and the current processing status will appear. ‘
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12) Following the instructions on the screen, end operation of the P150.

Raturn to INITIAL PISFLAY te complets laad

1> END <P2>
2> FRIVIOUS MBNU <F7)>
€3> INITIAL DISPLAY <F7> er <F3>

Figure 9.43

“Successful READ operation” will appear.

13) Press any key.

Note The P150 shoutd be operated according to the instructions displayed on the screen. If the

P150 is operated incorrectly or if processing is stopped, the P150 will hang up. If this occurs,
reset the P150.

9.9.3 Writing Motion Programs/Parameters to a P150 Disk

The following procedure is used to write motion programs/parameters to a disk inserted into

the drive of the P150 Programming Panel. This function is only available to GL60H, GL70H
and GL40S.

1) Select 6. Loader from the Main Menu.

2) Select 5. Device/fCommunications Setup from the Loader Menu.

3) Set the device to “P150 Programming Panel”.

4) Match the coammunications parameters to the setting of the P150 port.
5) Select the database. (Refer to 3.1.3 Selecting a Database.)

6) Select 3. Write to Device from the Loader Menu.

7) Select 2. Motion Program (or 3. Motion Parameters).
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9.9.3 Writing Motion Programs/Parameters (o a P150 Disk cont.

The screen for selecting the motion programs/parameters will appear.

| Laddar Legic Development faftware ~ VAITE TO P58 BISK |
Databass: TEETL

Hetien mD:i  FP:1

Filename: C:VCLESS\DINFA

Title: HOTION PROGRAN
Date: 83-28-1%97 Mxip! 1= = - = = =~ =

Salect area te WRITE te the F150 Fregramsing Panel.
MEdic BERVRITE

YASKAUR =

Figure 9.44

8) Select the motion programs/parameters to be written.

For information on selecting motion programs and parameters, refer to 8.3 Motion Pro-
gram/Parameters Selection.

9) Press F10 (WRITE).
10) Enter “Y” and press the Enter Key.
11) Check the operations described above and press the Enter Key.

12) Following the instructions on the screen, go online from the P150. ‘

SNITE TS FISH PRGCRAMATRC FRREL TThIE

Select PROGRAN MODE and ATIACK {rom Pi5M.

<Esc)> te Quit ‘

Figure 9.45

13) Following the instructions on the screen, operate the P150.

EWTTE T FIS0 FROGREMNTRE TRHEL Y TeTp:NItW3

Perforn SAUE eperatisn as usual...

€1 Pleass talsct PARAMETER LOADER.
<2> SME SU-OPICPI>

€33 Plaaze set paranster.msduls.avxis auaber
<4> COMFIM <F1>

Figure 9.46
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Writing will start and the current processing status will appear.

14} Following the instructions on the screen, end operation of the P150.

PRTTE IO FiSh PRSCRANHTRG FAREL — WK LD EHO =

Meturn te INITIAL DISPLAY te cemplute lead

1> ENp <F2>
€25 FREVIONS WENU <F7)>
€37 INITIAL DISPLAY <F?> or <(P3>

Figure 9.47

“Successtul WRITE operation” will appear.
15) Press any key.

Note The P150 should be operated according to the instructions displayed on the screen. If the
P150 is operated incorrectly or if processing is stopped, the P150 will hang up. If this occurs,
reset the P150. '

9.9.4 Reading Mofion Program/Parameter from a P150 Disk

The following procedure is used to read the motion programs/parameters from the computer
to a P150 disk. This function is only available to GL60H, GL70H and GL40S.

1} Select 6. Loader from the Main Menu.

2) Select 5. Device/Communications Setup from the Loader Menu.

3) Set the devi_be to “P150 Programming Paner”.

4) Match the communications parameters to the setting of the P150 port.
5) Select the database. (Refer to 3.7.3 Selecting a Database.)

6) Select 2. Hgad from Device from the Loader Menu.

7) Select 2. Motion Program (or 3. Motion Parameters).

8) Enter the device address and press the Enter Key.
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9.9.4 Reading Motion Program/Parameter from a P150 Disk cont,

The screen to select the motion programs/parameters will appear.

]Ludn Lagic Bevelepment Ceftware ~ KEAD FROM F150 PROCRAMHING Hlll
Database: TESTL

Hetian mp:1 PPl
Filename: C:\GLARE\DINFRC

Title: MOTION FROGRAN

Date: H-20-1777 #xly: = = - - - - =

Select area te be READ irsm the PISE Pregramning Pansl.
BEdic [EENEAD

YASKWM

Figure 9.48

9) Select the motion programs/parameters to be loaded.

For information on selecting motion programs and parameters, refer to 9.3 Motion Pro-
gram/Parameters Selection.

10) Press F10 (READ).
11) Enter “Y” and press the Enter Key.
12) Check the operations described above and press the Enter Key.

13) Following the instructions on the screen, go online from the P150.

<Esc? ts Quit

Figure 9.49

14) Following the instructions on the screen, operate the P150.

JERD FICH FLSU PROCRARTRE FANEL TATO Ha Ip=<RIc-H

Porforn SAVE speration as usual...

€13 Please 3elect MRNETER LOADER.
€2> LoD PP-25V <h>

€3} Means set parsnstor.medule,sxis asnber
O8> CONFIMM (Fi>

Figure 9.50 ‘
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Reading will start and the current processing status will appear.

15) Following the instruction on the screen, end operation of the P150.

nlp: T

Return te INITIAL DISPIAY to complete lead

1y END <F2>
£2> PREVIONS MBMU <F7>
€3> INITIAL DISPLAY <F7> ar (FO>

Figure 9.51

“Successful READ operation” will appear.
16) Press any key.

Note The P150 should be operated according to the instructions displayed on the screen. If the
P150 is operated incorrectly or if processing is stopped, the P150 will hang up. If this occurs,
reset the P150,
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9.10 Loading viaYENET

The following procedure is used to load or save to the Processor via YENET.
1) Select 6. Loader from the Main Menu.
2) Select 5. Device/Communications Setup from the Loader Menu.
3) Set the device to the MEMOCON YENET-3200.
4) Select the database. (Refer to 3.1.3 Selecting a Database.)

5) Select 3. Write to Device or 2. Read from Device from the Loader Menu.

6) Select 1. Ladder Program.
7) Enter the YENET number and the node number and press Enter Key. ‘

Press the Alt + N Keys to change over the input field to the YENET names input.

| Ladder Logic Develepment Seftwars / VAITE T0 (¢ POKT |
Databaze: TEXTL

Figure 9.52

8) Select the memory area and press Enter Key.

Memory Areas
Select from the areas below using the Space Key or Right and Left Cursor Keys. ‘

CPU and data memory: Ladder program

Comment memory: Available only to GL60S3, GL60H and GL70H

Extended memory: Available only to GL60S3, GL60H and GL70H

All Processors: CPU and data memory, comment memory, extended memory

felect precesctar arsa: [HE Lo
¢¢= ~> ar Epacad ta Tegyle <Eater> te Selact

Figure 9.53
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9) Check the operations described above and press the Enter Key.

VRITL CPU & DAln

FROM: ¢:

10: Fraceszor Frun

Figure 9.54

The current processing status will appear.

Cancelling Processing
By pressing the Esc Key, the loading process can be cancelled. When loading is can-
celled, the data and program inside the CPU will be initialized.

“Successful WRITE Operation” or “Successful READ Operation” will appear.

10) Press any key.
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Environment Settings

This chapter describes how to set up the working environment for the
P150, including selection of screen colors, key assignments, and mne-
monics.
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10.1 Setting Screen Colors

The following procedure is used to set the screen colors.

1) Select 7. Utilities from the Main Menu.

= — —————————|

C o~
Ladder leyic hu-hr-t Saftware ~ Main Mamu
Vorsiew 2.08 Copyright 1971 YASKAUA ELECTRIC CORPORATION
Databass: TEET1 Help: <Alc—H>
Wain Mesu:

Selact Active PLC
Off Ling

. Hetien
5. Leadsr
IEARIEEITECEE

<E> to Exit tn Dun
Il Entar Optien: HB

1
]
i
4
5

Figure 10.1

2) Select 1. Configuration from the Utility Menu.

HENOCON-2C CLAB/S8. 78
Ladder lagic Develepasnt Eaftuare / Utilities
Bakabage: TEFIL Baly: <BLt-H>

UTILITY Memu:
. or Utilicies
3. Detabate Ucilicies
4. Set temgeriry fils
<Ezc) te Rotwrm to Previeus Nems
Entar Option: N

Figure 10.2

3) Select 1. Screen Parameters from the Configuration Options.

HENOCON-2C CLAMES. 28
Laddar Legic Davelepment Seftwars ~ Canfiguration
Batabasa: TEST1 Balp: CRIt=N>

Configuratisn Optisns:

- tar Paramsters
3. Xay 7 Mmomenic Mezighaents
<Esc? te Meturn te Hain Hese
Enter Optisa Humdar: T

Figure 10.3
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10.1 Setting Screen Colors

m._ —_—_

The Screen Parameters Setting Screen will appear.

| ECAEEN PAMNETERS ]

Halp: <Alt-¥W>

Meat BOC computers have dizplays that ars "IN canpatible®,
If ia F thase. this et

e alrens inatantansersi. s Thie ot i e ontad.

iz your digplay "Il conpatiale~? [

.S“o:r displaye havs a tendency tea flicher sr -l-uﬂ'::::v"

n thay are wpdated. Thiz pregran will aveid

. hut
enly if necarsary as there ix a spaad pumalty,

Is the scresn cwrrently Flickering or shewing “swew'?

— e e — VAT XA

Figure 10.4

4) Enter “Y” if the computer is IBM compatible, enter “N” if not.

Enter “Y” and the Enter Key if the screen is unclear or fuzzy and white, enter “N” and the
Enter Key if not.

The Screen Colors Setting Screen will appear,

1

Nelp: CALE-N)

Sample Colsr Sata:

Wate: Tha thwee centacts oa the Iafy vheuld all appenr differently,

£T 13 - Change deas  PORECROUMD (Aic=K> te Save and Exit
€+ 43 - Change ::‘hn! WITE <Esc)> - Quix

— ~— — YASKAUA

Figure 10.5

5) Use the Up or Down Cursor Key to switch between the items to be set.
The items to be set are listed below.
» Foreground: Sets the colors of the background and characters {or lines).
= Highlight: Sets the color which highlights characters and symbols.
» Error foreground: Sets the colors of the display field and error messages.

» Box foreground:  Sets the colors of the display box and comments.
In addition, the color combinations are preset into the Function Keys
and therefore can be selected using these Function Keys.

—10-3 —



Environment Setting
w

6) Specify the colors either by moving the cursor with the Right and Left Cursor Keys or by
using the Function Keys.

The following shows an example for setting the colors according to the display types.

Display Type Foreground Highlight Error Box
Foreground Foreground
Color Display Bright biue Yellow Bright red Brilliant white
Liquid Crystal F4: Monochrome1 {black against white background)
Display (38 NOTE, etc.) | e5: pMonochrome 2 (white against black background)
Plasma Display F4: Monochrome 1 (red against black background) -
(Laptop, etc.) FS5: Moncchrome 2 (black against red background)

Note If setting 1 or 2 described above is selected on color display, the white and black
colors will be reversed.

7) Press the Alt + E Keys to save the setting.
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10.2 Changing Key and Mnemonic Assignments

Note

This section will demonstrate how to assign the Function Keys to input elements used on net-
works or on SFC editing. Using this procedure, Function Keys from F1 to F10 can be freely
assigned to functions, mnemonics and prompts.

Three kinds of items which can be changed are listed below.
* The function number to be assigned to each function

* Mnemonics

« Prompts

When setting the function number, the description will automatically change 1o the corre-
sponding function number. However, the contents of the description cannot be changed.

Ifinstallation of the MEMOCAD-PRO is attempted on a drive otherthan C drive, an error mes-
sage saying, “TKB File not Found” will appear. Once a TKB file is specified, the error will not
occur again. (Refer to 10.2.3 Selecting Assigned Settings)

Function Labels

Prompt
B¢ Th, NG THE Fme Mwn smm D pom mn I

Mnemonic

Figure 10.6

10.2.1 Displaying the Screen for Key/Mnemonic Assignments

The following procedure is used to display the screen for key and mnemonic assignments.

1) Select 7. Utilities from the Main Menu.

HENCCOM-£C GLAB/EA-79
Ladder Legic Davels) t Saftwara ~ Main Menu
Vareisn 288 Copyright 1!!1 YafIAWA ELECTRIC CORFPOMIION
Databass: TEST) Haly: <Als-H)

Y. 0Tl
<E> te Exit te Des
Entar Optian: B

S — P— ————n. YRS KA =

Figure 10.7
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10.2.1 Displaying the Screen for Key/Mnemonic Assignments cont.

2) Select 1. Configuration from the Utility Menu.

MEMOCON-SC CLAR-S4-"20
Ladder Legic Bavelapment Seftwars ~ Utilities
Patakere: TEST1 Help: <AlE-K>

UTILITY Hanu:

g Eurtptcr E:!!hhs

3. Patabase Utilities
4. Sat tewperary file

<Evcr to Maturmn te Frovise: Hewu
Enter Optisn: KN

YREYXAMM =1

Figure 10.8

3) Select 3. Key/Mnemonic Assignments from the Configuration Options.

MEOCON-5C CLAL iR -2
Laddar Lagic Develapnont Ssftwars / Configuration
Database: TESTL Nolp: <Alt=M}

Configuratisn Optisns:

1. Scresn Paramstuire

2. Printar Paramsters

<Eac> te Raturn te Fails Mesu
Enter Optisn Nusber:

Figure 10.9

The screen for selecting the desired key/mnemonic file (extension: TKB) will appear.

~N—yDo% KEY /FNEMONIC mtmm
4 NDOWS: —VIN12e Retive Keyw:
ATl —————ATIDEEN-————JAMNESE PLG: TESTL A1
mGli‘—Eln-l’S‘NLB
R s
[-CHDSETS .
[-CALI ERAT
—RRUSHES
[FPALETTRS
F —Illrol'lﬂ.

-notum—l-mm—-—p

R

tary C:\CLEES\».TXD
ﬁ!nll Find: BRRNAEE <Tak)> switch viadew
e —— e —

B Nebuild J.Mew Pils

Figure 10.10

The screen for selecting files will initially show GLE0S.TKB (Cffline)/GLEOTOL.TKB {On-
line). Do not change these two files as they are preset by MEMOCAD-PRO.,

4) Press F5 (New File) as shown on the selection screen.
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The screen for entering the file name will appear.

Srhoe . FEYMENONIC -u:onm
= NDOAR rgm—-—mm [ Active Xeye —,
[AT] =T | BESN————JAPAMESE MLz TESTL <ALt-H)|
—HOI.WI

GLABS . TXh
CLESTOL. IR

A v
Direct C:\CLERS = TN
Quick ;” Tab> wwitch windew

T.Bebuild B.New File

Figure 10,11

5) Enter the file name in the input field and press the Enter Key.
The extension .TKB needs not be input as it will automatically be set.

A confirmation message will appear asking whether to execute the edit.

KEY/MHENONIC R531GNMENTS
Active Neye: j

Mrace = L
mui n-y 1 WGL& T

{Tak) avitch windew

Figure 10.12

. 6) Enter “Y” and press the Enter Key.
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R
10.2.2 Setting New Key Assignments
The screen for setting the keys and mnemonics will appear.
KEY ~ IMENONIC &STICHIENTS |
Functisn Level: HIO . dalp: <ALC-N
MINCTION
KEY W, EMEMONLC PROMPT DELCRIPTION
FL ﬁ Wi DISC Laval 1 Nenu
B oin B3 Sw Rt vl d e
| o) 244 o4 CALCZ Level 4 Maau
” 245 05 TRANG lon Level %
|« 3 2% e CNVRT vel 6 Moma
n 247 e HTRX1 Punction Lavel 7 Hanu
[ ] 2% b7 SPEC Punct ion Level & Meau
” 247 Yy YENET Punction Level ¥ Meau
L] 250 oA HOT1 Punctisn Level 180 Mesu
sl ) BT A N e
—— YRENAWS =4
Figure 10.13
XEY ~ MMENONIC RSSIGMIENTE ]
Punction Laval: M Relp: <Alc-H>
PEMCTION
Y . MMEMONIC MRGHPT DESCRIPTION
B3 L jF Mermal1y SEeei tencaet
n 3 MG T Paztive traasitisn
M 4 NiC 4 ive tramsitisn
» 5 oDIL — Ca
» & LCIL - cl
» ? TCIL —Irl- Tremzitisn ceil
n hed N Herizeatal Shunt
r n s ] Osrtical t
1 » ok Usrtical Ope
<n|=-i> :- ;:'n:m.“,) E.:i‘::h". <Bu o mu
Figure 10.14 ‘
If a new TKB file was created, its display contents would be the same as its master.

Moving the Cursor

Up and down: Press the Up or Down Cursor Key.
Right and Left: Press the Ctrl + the Right and Left Cursor Key.
Changing function levels: Press the Page Down or Page Up Key. ‘

10.2.2 Setting New Key Assignments
This function allows the user to change the key assignments file to their own preferences to

simplify operation. The example shown below explains how to change the key assignment for
a certain key from a transition coil (TCIL) to a horizontal short circuit (HS).
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1) Press the Page Down Key to display the menu on which transition coil (TCIL) is listed.

l KEY ~ "MEMONIC ASSIGHRENTS ' |

Punctien Lavel: Nelp: <Alt-)

FUNCTION
KEY N ENONIC PROMPT DEECRIPT[ON
P 1 HNarmally epen centact
n 2 ’ Nermally clessd centact
n 3 MC T Festive cransitise
M 4 NIC i tive cranzitisn
» H COIL - 1
1] 6 LCIL —{L>- Latched ceil
|44 7 TCIL =[T1- Ivanzicien cei}
) ke g — Harizental Shunt
» e ] ug f Vertical Bhunt
ne » ot H Usrtical Opan
£Ccrl-PeboAly> te Changs Masignasat
<ALlt-E> te au |=d Exic - <Ell‘=gn!n Quis
e —— ————m PRERAWA =

Figure 10.15

2) Press the Down Cursor Key to move the cursor to the transition coil (TCIL).

Itis possible to move the cursorto the target by pressing the Function Keys (in this case
F7). : _

3) Enter the function number (77) of the horizontal short circuit.

The function number indicates the number assigned to each element. Refer to Appendix
B: Function Key Menu List. It is also possible to use the the Cirl + Page Down/Page Up
Keys to change the setting above.

4) Press the Enter Key to assign the horizontal short circuit (HS) to the F7 key.

I XEY ~ MMEMONIC AESICMMENTS '
Punctisn Level: M Halp: {Alt-H>
PUNCTION
XEY . MNEMONIC JRONeT DETCRIFTION
4 1 NOC: Hermally spea contace
r2 2 HCC 4 Hermally claced centact
n 3 PIC t Feztive transitisn
™M 4 NIC 4 -l-rti.u transitisn
<] s colL - Cail
x 6 LCI =Ly~ Latched coi
» [ LEIL =L>— Latched zoil
. ) ” Hapizental Shunt
” ks ] ) artical Shunt
ne ke (L3 ertical Oyen
LCtrI-PynAlp> e Change A t
<Alt=E)> :. :!u -:d !:!.t v CE:G tlmhi.! J
E— gt 1Y

Figure 10,16

5) Press the Alt + E Keys to save the setting.

Using the procedure above the mnemonics and prompts can be easily changed. Move
the cursor using the Tab Key or the Ctrl + Right Cursor Key.

10.2.3 Selecting Assigned Settings
The key and mnemonic assignments are saved as a TKB file. The following procedure is

used to select the TKB file with the required settings. The default for MEMOCAD-PRO is
GLE80S.TKB.
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10.2.3 Selecting Assigned Settings cont.

1) Select 7. Utilities from the Main Menu.

————— e e e

KENOCON-SC CLAR-SA-78
Ladder legic Devaleupwent Sefsware / Main Menw
Veraien I.08 Copyright L YASKAUA ELECTRIC CORFORATION

Batabasze: TEITL Nelp: <ALt-%>

Main Meau:

1. Salsct Active ML

2. Dffline

3. Oaline

4. Merisn

5. List Sceive FIC

6. Laader

<E> ts Exic to Pup

Enter Oycion: B

e ——— e ——————— VARG =

Figure 10.17

2) Select 1. Configuration from the Utility Menu.

HENOCON-EC GLARS879
Lpddar Legic Develsprant Seftwars ~ Utilities
Batabaze: TESTL Hely: <ale-H>
UTTLITY Mewu:

b g g P

3. Databaxs Urilitiss
4. Est tanperary fils

<{Esc> te Fetwm te Previsus Menu
Enter Opcisn: N

Figure 10.18

3) Select 3. Key/Mnemonic Assignments from the Configuration Options.

MEMOCOM-SC LS 78
Laddar lagic Develapment Seftuare ~ Configuraticn
Batabaze: TEST1 Holp: <Rie—4>

Canfigwratisn Optisns:

1. Scereen Paramsters
2. Frinter Favensters

<Ezcd> te Raturn te Main Mams
Enter Optisn Munber: W

Figure 10.19
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10.2 Changing Key and Mnemonic Assignments

The screen for selecting the desired key/mnemonic file will appear.

o6 KEY /HHENOKIC ASSIGHENTS
TNDOUE STz l Active Keye: TEBT1 I
1) ——————ATI DEFK——— JAPANEEE ric: TEST1 a1E-H>

JTSTYLES
[EPHAPS

TESTL.TiD

Bl.r.ctlry CCLEBS s T XD
Guick Pind: RNEEERENEE  <Tak> switch windew

At
B Mbuild B.ew File e

Figure 10.20

4) Move the cursor to the key/mnemonic file to be selected, and press the Enter Key.

A confirmation message asking whether to execute the edit will appear.

XEY AMEMONIC .sslms
Sctive Keye:

CATe—it>

mnol. TKE
JEST1. TKE

Pirect, CINGLENS = TXR
wulch Find: <Tab) suitch windew
vacKa

Figure 10.21

5) Make sure that “N” is entered, and press the Enter Key.

6) The specified mnemonic assignment will be set and the screen will return automatically
to the Configuration Menu.

Note The mnemonic assignment selected here will remain unchanged the next time the system is
re-started.
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List of Function Key Menus

A.1 Function Key Menu List for Network Editing

Numbers inside parentheses indicate function numbers.

Initial Main [ DISC TC | CALC1 | CALC2 | TRANS | CNVRT | MTRX1 | SPEC | YENET | MOT1
Menu Lvi Lv2 Lv3 Lv4 LV5 LV6 Lv7 Lv8 LVg LVA
(241) ©42) | (243) | (244) | (245) | (246) | (247) | (248) | (249) | (250)

F1 o = - AT AL AT — | :
NOC NCC PTC NTC COIL LCIL TCIL HS Vs os
(1) (2) (3) 4) (5) (6) 7) {77) (78) (79)

F2 +T1.0 +T0.1 +T.01 +UCTR |+DCTR —_— } :
T100 T010 T001 UCTR DCTR HS VS 0Ss

(8) (9) (19) (a1 (12) (77) (78) (79)

F3 +ADD +SUB +MUL | +DIV +DADD |+DSUB |+DMUL |+DDIV
ADD SuB MUL DIV DADD ;| DSUB | DMUL | DDV
(13) (14) {(15) (16) (17) {(18) (19) (20}

F4 +SADD [+SSUB [+SMUL |+SDIV |+SDAD [+SDSB |+SQRT |+DSQR |+SIN +COS
SADD sSsuB SMUL SDiV SDAD SDSB SQRT DSQR SIN cos
(21) (22) (23) (24) (25) {26) 27) (28) {29) (30)
F5 +RTOT [+TTOR ({+TTOT {+BLKM |+FIN +FOUT | +SRCH |[+STAT |+TSET
RTOT TTOR TTOT BLKM FIN FOUT | SRCH | STAT TSET
(31) (32) (33) (34) (35) (36) (37) (38) (39)
F6 +BIN +BCD +SWAP | +SORT |{+BYSL |+BYCM {+BADD
BIN BCD SWAP | SORT | BYSL BYCM | BADD
{44) (45) (46) (47) (48) (49) (50)
F7 +AND +0OR +XOR |+COMP [+CMPR |+MBIT |[+SENS |+BROT [+MROT
AND OR XOR COMP | CMPR | MBIT SENS BROT | MROT | ‘
{51) (52) (53) (54) (55) (56) {57) (58) (59)
F8 +SKP +GOSUB | +READ [+WRIT |+COMM (+FRED |+FWRT
SKP GOSUB{ READ | WRIT |[-COMM | FRED FWRT
(62) (63) (64) {65) {66) (67) (68)

F9 +MBUS !+PEER |+BROD |+BOOK [+POLL |+DIAG |+SND +RCV
MBUS PEER BROD | BOOK | POLL DIAG SND RCV
(69) (70) (71) (72) (73) {(74) (75) (76)

F10 +MOVI [+MVIS  [+MOVM [+MOVL |+MVLS |+ZRN |+JOG {+HNDL |+MON
MOVI | MVIS | MOVM | MOVL | MVLS | ZRN JOG HNDL | MON
(84) (85) (86) (87) (es) (89) {90} (¢1) (92)
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A.l Function Key Menu List for Network Editing

F1+ Shift | ENABLE |DISABL [-ON  [-OFF |[+SET |+REST |DELETE| —— | :
EN DIS FN FF SET REST | DE HS VS oS
(80) (81) (82) (83) (99) (100) | (195) (77) (78) (79)
F2 + Shift DELETE| —— ! :
DE HS VS os
(195) (77) (78) (79)
F3 + Shift DELETE| — | :
DE HS VS 0s
(195) 77) (78) (79)
F4 + Shift DELETE| — t
DE HS VS oS
(195) (77) (78) (79)
F5+ Shift |+DIBT [+DIBR |+SIBT |+SIER DELETE [ — I :
DIBT | DIBR SIBT | SIBR DE HS VS oS
(40) (41) {42) (43) (195) (77) {(78) {79)
F6 + Shift , DELETE | — | :
: | DE HS VS oS
(195) 77) (78) (79)
F7 + Shift [+TWST |+BCNT DELETE | — | :
TWST | BCNT ; DE HS VS 08
(60) (61) ‘ (195) 7 (78) (79)
F8 + Shift , DELETE | —— |
DE HS VS 0s
(195) (77) (78) (79)
F9 + Shift DELETE [ —— |
DE HS VS oS
{195) {77) (78) {79)
F10 + Shift |+POS [+PRM |+VAR [+ARES |+SVON [+ADJ |DELETE| — l :
POS PRM VAR | ARES | SVON | ADJ DE HS Vs oS
{93} (84) (95) {96) (97) (98) (195) (77) (78) (79)
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List of Function Key Menus

prem e ——— AR E___—— S

A.2 Function Key Menu List for SFC Edit

Numbers inside parentheses indicate function numbers.

Initial Main | INSTR | BRANCH | LOOP | TO/FR
Menu SFC1 | SFC2 | SFC3 | SFC4
@262) | (263) (264) (265)

F1 +STEP |+ISTEP |[+MSTEP| —— [C —- | T : y
STEP | INSTEP| MSTEP| TRAN |[CTRAN| LINK | CLL | SDE | DTB | DBB
(104) | (105) (106) (107 | (108) | (113) | (M4) | (123) | (124) | (125)

F2 — — = [ i 1 : [ B
DIVE CONV SIMD SIMC LINK CLL SDE DTB DBB
{115) (116) {117) (118} (113) (114} (123) (124) (125)

F3 —a | - — - “—— I T : - B
LOR LOL LIR UL LINK CLL SDE DTB DBB
(119} (120} {121) (122) (113) (114) (123) (124) (125)

F4 From To M-From M-To | T : b -
FROM TO MENT MRET LINK CLL SDE DTB DBB

(109) (110) {111) (112) (M3 (114) (123) (124) (125)
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Quick Key Operation List

B.1 Quick Key Operations in Network Edit

To use the shortcuts described below, press the keys listed to the right of the desired action.

To move the cursor up: - U + Enter
To move the cursor down: D + Enter
To move the cursor to the left: L + Enter
To move the cursor to the right: R + Enter
To move the cursor to the home position: BEG + Enter
To move the cursor to the end position: END + Enter
To move the cursor to left end : SL + Enter
To move the cursor to right end : EL + Enter
To move to the next network: N + Enter
To move to the previous network: P + Enter
To move to the first network: F + Enter
To move to the last network: LAST + Enter
To alter addresses: Alt+ E
EC + Enter
??? + Enter

To clear assembly registers (AR):
To start up the command submenu:

(?77?.. indicates new address)

\
/

CSM + Enter
To alter a database: AA + Enter
To start up the block submenu: Alt+B

BLM + Enter
To start up the block submenu {(elements): BCM + Enter
Element block: BCB + Enter
To release the element block: UCB + Enter ‘
To copy the element block: CCB + Enter
To move the element biock: MCB + Enter
To delete the element block: DCB + Enter
To jump to the network where the block has been JCB + Enter
saved:
To start up the block submenu (networks): BNM + Enter
Network block: BNB + Enter
To release the network block : UNB + Enter
To copy the network block:: CNB + Enter
To move the network block: MNB + Enter
To delete the network block: DNB + Enter
To jump to the network block: JNB + Enter
To save the network block: NNB + Enter ‘
To load the network block: LNB + Enter
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To start the register edit:

To start the edit submenu:
To start up the comment edit screen:

To start up the comment edit screen (network):

To display the signal names :

To display the comment window:

To allocate the segments:
To start the insert submenu:

To insert a column:

To insert a row:

To insert a network (back):
To insert a network (front):
To start the delete submenu:

To delete an element:

To delete an element (by every vertical short circuit):

To delete a column:

To delete a row:

To delete a network:

Snap shot:

To start up the processor configuration menu:
To start up the global replacement function:

'l;o start up the search function;
To start up the cancel function:
To cancel the last edit;

To restore the edit deleted:

To cancel all the edits performed:
To start up the view submenu:
Mark position:

To jump to the mark position:

To cancel the mark definition:
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B.I Quick Key Operations in Network Edit

M

At+R

ER + Enter
EM + Enter
Tab

EE + Enter
Shift + Tab
ND + Enter
Alt+ L

TS + Enter
Alt + W

TW + Enter
ES + Enter
Insert

IM + Enter
IC + Enter
IR + Enter
INN + Enter
{PN + Enter
Delete

DM + Enter
DE + Enter
DEL + Enter
DC + Enter
DR + Enter
DN + Enter
AS + Enter
PRO + Enter
Alt+ G

G + Enter
Alt+ 8

S + Enter
Alt+ U

UM + Enter
UN + Enter
RE + Enter
CAE + Enter
At +V

VM + Enter
Alt+M

M + Enter
Alt+J

J + Enter
UMK + Enter




Quick Key Operation List
L]

To start the GOTOQ function: Alt+ N

GOTO + Enter
To start the coil submenu: CM + Enter
To start the disable tables: EDT + Enter
To disable the coil: DIS + Enter
To enable the coil: EN + Enter
To force ON the coil: FN + Enter
To force OFF the coil: FF + Enter
To search duplicate coils: At+C

CR + Enter
To start the trace function: Alt+T

CT + Enter
To start the re-trace function: CRT + Enter
To display the Help Screen (current function): Alt+H

HLP + Enter
To display the Help Screen (element explanation): Alt + 1

IH + Enter
To display the Help Screen {comrmand list): Alt+Q

. ~ QH + Enter

To end the network edit: MEN + Enter
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B.2 Quick Key Operations in SFC Edit

M‘

B.2 Quick Key Operations in SFC Edit

To use the shorteuts described below, press the keys listed to the right of the desired action.

The quick key operations that apply to both SFC and network edits are omitted here. Refer to
B.1 Quick Key Operations in Network Edit.

Zoom : At+2Z

Z + Enter
Zoom retumn; Alt + X

ZR + Enter
To delete the SFC: DP + Enter
To start the circuit replacement function: EXCH + Enter
To start the SFC mode submenu: SMM + Enter
To start the condition setting menu: SCM + Enter
SFC mode (initialization) : INIT + Enter
SFC mode (reset): RESET + Enter
SFC mode (preset): PRE + Enter
To start the simulation submenu: SSM + Enter
Simulation: FORED + Enter
Simulation (active): ACT + Enter
Simulation (disabie): DA + Enter
Simulation (hold): HLD + Enter
Simulation (reset): RDS + Enter
Simulation (release altogether): CLRS + Enter
To start the used status display submenu: SUM + Enter
Used status display (step): STEPU + Enter

Used status disblay {transition):
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Cable Wiring Diagram

C.1 Cable Wiring Diagram

YASKAWA GL60S
IBM PC/AT IOP Module
FG 1 ] FG
X | 3 21 TXD
whl— —<_  Hlw
RIS | 7 4| RIS
CIS | 8 :’ E 5| CIS
GND | s 7| GND
DSk | 6 6| DSR
>k
DIR | 4 9t DIR
D-SUB 8-pin
{female)

\ /D-SUB 9-pin (male)

e B

/ ]' Shielded, twisted-paired

Hood cover cable Hood cover

Figure C.1 1 Cable between IBM PC/AT and YASKAWA IOP Module
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1/O Configurations of GL-series .
w

D.1 1/O Configurations of GL-series PLCs

To channel 3
Channel 1 Channei 2
COMM —omm———
Iop ———— . .
CPU L
. Auxiliary power:
Main power Upto 31
supply _ll supply g}‘tigr;s max,
mounted.

Rack 1 4{5l 86 1/ 2/3|4(5|6(7|8

L Ll |
RIOD  Slots RIOR  Slots
Rack 2 1]12|13{4]|5|6|7]|8!9

<

Auxiliary | i | j
power Slots  Auxiliary power. Slots

supply supply ‘

Rack 3 1|2|3la|5|6[7|8]0 1] 2|3|4{5{6|7]|8]9

]
Auiliary | | i |
power Siots  Auxilia wer Slots
supply suppl vPe
Rack 4 1/2{3[4|5/6/7|8]9 1(2{3l4]5|6]718]°9 ‘
|
Auxiiary— |} | ] r |
power Slots  Auxili wer- Slots
supply sUu p|arypo
U Station t
Rack 5 1|2{3la|5|6]7/8|9
|
Auxiliary—l | ]
power Slots
supply

Figure D.1 Configurations of GL60S, GL60H and GL70H ‘
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D.1 1/0 Corfigurations of GL-series PLCs

Note 1) Siot 1 through slot 3 can be used to mount Moduies on rack 1 of channel 1 (the local
channel. Slot1 through slot 6 can be used if COMM and RIOD Modules are not
mounted.. Up to 31 stations can be mounted for channels 2 and 3 {(remote channels),
with up to four racks allowed in each station.

2) The maximum number of Discrete Input, Discrete Output, Register Input and Register
Output Modules that can be mounted is 256 Modules each, 1,024 I/O Modules in total.

The input and output combinations can be freely arranged without restrictions as long as
the following conditions are met:

« Discrete inputs + Discrete outputs < 4,096

« Input Registers + Output Registers < 512
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I/0 Cenfigurations of GL-series

Main power
supply —}
Rack 1 1(2]3|4]|5]6] 718
L
Slots
-_l_l cPU
170 buffer\\
Rack 2 ™~ (1| 2[3)j4]{5]6|7|8|9
i |
Auxiliary power Slots
supply
e] buﬁer\\U
Rack 3 S l1]2|3)4als(6;7|8]9 ‘

Auxiliary power | |
supply Slots

| ¢
/O buffer

~
Rack 4 ™~ |11l 2(3|4|5|6] 7} 8|9

Auxiliary power

Figure D.2 Configurations of GL40S

Note 1} Up to 4 Mounting Bases can be used, including the various small Mounting Bases that ‘
are available.

—D-4—




. D.1 YO Configurations of GL-series PLCs

2) Up to 35 1/O Modules can be mounted to the 35 slots provided. The input and output
combinations can be freely arranged as long as the following conditions are met.

» Discrete inputs + Discrete outputs < 512
« Input registers + Output registers < 128

3) Optional Modules, including the COMM Module (Extension Communications Module),

PC Link Module, and Servo Interface Module, must be mounted to the MB40 Mount
Base.
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